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- INTRODUCCION

iBienvenido!

Muchas gracias por adquirir Clarion. Tiene ahora en sus manos la herramienta mas poderosa y
flexible para el desarrollo de aplicaciones. Muy pronto, usted podra apreciarlo por si mismo.

Niveles de usuario/desarrollador

Clarion funciona a varios niveles, y respalda a todo nivel de usuario o desarrollador.

Es un sistema de desarrollo automatico, manejado mediante asistentes

(wizards)

Cuando usted necesita una aplicacion “simple” para el mantenimiento de una base de datos, el
trabajo le llevara sélo algunos minutos usando Clarion. La clave esta en el diccionario de datos. Si
el Generador de aplicaciones (Application Generator) conoce los archivos o tablas que usted
necesita, y como se vinculan, puede construir una aplicacién completa. De manera que todo lo que
usted tiene que hacer es elegir uno o mas archivos, e indicar el tipo de relaciones que tienen entre
si (si son dos o mas). En el breve cursillo de Inicio rapido de este libro encontrard una
demostracion de lo facil que es todo el proceso.

Asi, el Asistente para Aplicaciones (Application Wizard) puede crear una aplicacién completa
usando el concepto genérico de las aplicaciones Clarion. Lo llamamos el concepto browse-form
(“procedimiento de visualizacion/ficha” ), que se extiende directamente desde la estructura misma
de la base de datos. La aplicacién funciona asi: (1) El usuario final navega por la base de datos --
por toda ella o parcialmente, en un archivo de datos o multiples bases de datos relacionadas--
desplazandose por una lista, en la que cada item representa un registro. La ventana en que esto se
realiza se llama “browse” (pronudnciese /braus/). (2) El usuario selecciona un registro de la lista
para realizar una accion , como modificar los datos. Esto generalmente se hace en una ventana
separada, en que los campos de la base de datos aparecen en cajas de edicién separadas. Esto se
Ilama una “ficha o formulario de actualizacién” (update “form’’). Una ficha puede también aceptar
datos nuevos. (3) Opcionalmente, el usuario final puede consultar un valor de una tabla vinculada
durante el ingreso de datos a la ficha. Esto abre otro browse en una ventana separada. El usuario
puede elegir un item, cerrando la ventana y colocar el valor en la caja de edicion de la ficha. Esto



se llama “consulta” (lookup). Esto seria la descripcion mas genérica. Ademas, cada ventana de
visualizacion o browse, que puede navegarse desde la barra de herramientas, se abre en un hilo de
gjecucién separado, con su propio buffer de registro, lo que permite un manejo de datos mas
seguro. Se pueden seleccionar multiples ordenamientos por claves (“keys™) dando cLIC sobre una
lenglieta. Un DOBLE cLIC sobre un registro de la lista abre una ficha de actualizacion, con
comprobacion automatica de uso concurrente (para aplicaciones multiusuario) y, opcionalmente,
restricciones de integridad referencial, que mantienen las relaciones de la base de datos.

Cualquiera puede hacer todo esto. Se empieza sencillamente, escogiendo un archivo de datos de
la lista.

Es un ambiente de desarrollo visual

Con Clarion, colocar un control en una ventana hace mucho mas que en otras herramientas rapidas
para el desarrollo de aplicaciones, que tipicamente una vez colocado el control para la interfaz con
el usuario, esperan que usted escriba el cadigo para hacerlo funcionar. Con Clarion, usted afiade un
template o plantilla, que contiene el control y todos los elementos de datos requeridos y el cédigo
gjecutable. Esto significa que no hay que escribir el codigo, basta un cLIC para obtener una
solucion completa: el control de interface del usuario, y el cédigo que lo hace trabajar. Es mas,
cada template tiene su propia interfaz de usuario. Cuando se observan las propiedades del
template, se encuentra la lengiieta “Actions” (acciones). Mediante acciones como responder a una
caja de diadlogo, escoger un item de una lista desplegable, o llenar un casillero, puede modificarse
el funcionamiento del template de modo que responda exactamente a las necesidades de la
aplicacién. Durante el cursillo que aqui presentamos, habra muchas oportunidades para configurar
estas acciones. El cursillo sobre el Generador de aplicaciones en la seccion Aprendiendo Clarion
lo introduce a todas las herramientas de desarrollo rapido de aplicaciones (RAD) que tiene el
programa.

Cuando se usa la interfaz de los templates para especificar tales comportamientos, el Generador de
aplicaciones escribe el cédigo fuente Clarion que los implementa. Se trata de un cddigo orientado
a objetos, construido de la biblioteca de clases de aplicacion de Clarion (Application Builder Class
[ABC] Library), por lo que es un codigo compacto y muy eficiente. Mediante los templates, usted
puede realizar una enorme cantidad de programacion totalmente configurada a sus necesidades,
sin necesidad de escribir ni una sola linea de cédigo a mano.

La magnitud y el alcance del lenguaje Clarion pueden parecer imponentes a primera vista. La
Referencia del Lenguaje (Languaje Reference) tiene unas 1000 paginas. Una de las grandes
ventajas de tener el sistema de templates, adicionalmente a la capacidad de escribir codigo
manualmente, es que usted puede irse introduciendo al lenguaje, al ritmo y profundidad que desee.
Si no le agrada el modo en que los templates resuelven un problema en particular, puede usarlos al
principio, so6lo para salir del paso. Luego, puede utilizar la interfaz del propio template para
hacerlo mas a su gusto. Finalmente, cuando domina el lenguaje Clarion, puede escribir una
solucion propia, con completa libertad. (Nota: ademas puede comprar templates de terceras partes
para tener otro modo de resolver los problemas).

Los usuarios avanzados de computadoras que normalmente no escriben programas, pueden hacer
esto con facilidad.
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Es un lenguaje de programacién completo

En su nivel méas basico, se puede codificar una aplicacion completamente a mano, utilizando el
lenguaje Clarion de cuarta generacién. Clarion tiene un alto nivel de abstraccion, lo que lo hace
muy “legible”, y una sintaxis de base de datos compacta, de manera que facilmente puede
manipularse un registro, o grupos de éstos. No necesita saber Clarion para crear una aplicacion...
pero si conocer como trabaja, le ayudara a comprender lo que hacen las aplicaciones, lo que
mejorara su calidad. El cursillo sobre el Generador de aplicaciones en la seccion Aprendiendo
Clarion, lo estimula a escribir una pequefia porcion de codigo Clarion dentro de la fuente
generada por el template, y el cursillo sobre el Lenguaje Clarion (en la misma seccion) lo
introduce plenamente a la codificacién manual.

Los desarrolladores profesionales apreciaran realmente el lenguaje Clarion. Fue disefiado desde
el vamos para programadores de aplicaciones de negocios. Su facilidad de aprendizaje (en
comparacion a otros lenguajes de bajo nivel) no le impide tener una performance deslumbrante.
El compilador de TopSpeed convierte todo el codigo, sea escrito a mano o mediante el Generador
de aplicaciones, en cédigo binario altamente optimizado.

NOTA: No importa en qué nivel intente trabajar finalmente: lo hara mucho mejor si
practicatodos los cursillo hasta el final.

Qué hay en esta seccidn

Esta es la introduccion al entorno Clarion. La siguiente es una lista de partes de esta seccion, y
resume su contenido:

Introduccion Capitulo uno: presenta Clarion y las instrucciones para
cargarlo en la computadora.

Cursillo para un rapido comienzo Capitulo dos: unos pocos pasos faciles con el Asistente
(Wizard) de Comienzo Réapido le permiten crear una
aplicacién completa en cinco minutos. Luego, en menos
de una hora, este capitulo le ensefiara a usar el Wizard
de Aplicaciones y los wizards de procedimientos para
crear una aplicacion simple, y luego extender su
funcionalidad a un programa elaborado que trabaja con
dos archivos. Esto se lograra sin escribir ni una sola
linea de cddigo.

Flujo de desarrollo Capitulo tres: un repaso del concepto Clarion de
desarrollo de aplicaciones. Describe todas las
herramientas del ambiente de desarrollo.



Donde encontrar mas informacion

El primer lugar para buscar es la seccion How do I ... ? (“Coémo hago para ...?""). Esos temas
responden muchas de las preguntas comunes que se hacen los recien llegados a Clarion. Oprima el
boton How do I ... ? en la seccidon de Help Contens para ir a esa seccion.

Clarion tiene un muy amplio sistema de ayuda. La ayuda hipertextual aparece cuando oprime la
tecla F1, o elige una de las ordenes del menl Help. La ayuda en linea se maneja mediante la caja
de dialogo, para ofrecer ayuda sensible al contexto cuando la necesita.

También hay un nimero de libros que se incluyen con Clarion.

Primeros pasos con Clarion

Es este volumen, que suma dos volimenes separados del original en inglés: Getting Started
(esta seccién) y

Learning Clarion (Seccion: Aprendiendo Clarion)

Esta Gltima seccion contiene dos cursillo paso a paso. El primero es sobre el Generador de
aplicaciones, que ofrece una introduccion amplia a todas las herramientas del entorno de
desarrollo. La segunda presenta el lenguaje de programacion Clarion en si.

Application Handbook (Manual de las aplicaciones)

Es el manual de las herramientas Clarion que utilizardA mas durante el desarrollo de
aplicaciones (en el formato .PDF en el CD de la edicion estandar). Describe los templates
que se incluyen con el producto, brinda una documentacion completa de la biblioteca de
clases de construccion de aplicaciones (ABC Library) que utiliza el codigo generado por los
templates, y ofrece informacion profunda sobre los controladores (drives) de archivos de
Clarion.

Language Reference (Referencia del lenguaje)

La guia completa al lenguaje Clarion (en el formato .PDF en el CD de la edicion estandar).
Este libro ofrece descripciones de la sintaxis completa de Clarion, y todas las ordenes
disponibles, con ejemplos de cada una. El Language Reference se organiza mediante
topicos funcionales. El texto completo de este libro también esta disponible en la ayuda en
linea. Cuando se trabaja en el Editor de texto, coloque el punto de inserccion sobre
cualquier funcion o sentencia Clarion, luego oprima FI para obtener ayuda sobre ese tema.

User’s Guide (Guia del usuario)

Provee una descripcion clasificada por distintas tareas del entorno de desarrollo, ordenada
por los componentes principales (en formato .PDF en el CD de las ediciones estandar y
profesional).

Programmer’s Guide (Guia del programador)

Coleccién de articulos que tratan en profundidad varios aspectos de la programacion en
lenguaje Clarion y articulos sobre la personalizacion del entorno de desarollo (disponible
solamente en las ediciones profesional y empresarial, en formato .PDF en el CD de la
edicion profesional). También contiene la guia completa al lenguaje de templates de



CapPiTULO 1 INTRODUCCION 11

Clarion, lo que ofrece descripciones de todas las sentencias y funciones, con ejemplos de
cada una, con demostraciones claras de como escribir templates propios.

ReportrWriter User’s Guide (Guia del usuario del ReportWriter)

Documenta el ReportWriter for Windows™ de Clarion. Esta es una herramienta
independiente para la confeccion de informes (incluida solamente en las ediciones
profesional y empresarial -en formato .PDF en el CD de la edicion profesional), que
también esta disponible como producto separado.

Enterprise Tools (Herramientas empresariales)

Documenta las herramientas disponibles para desarrollos cliente/servidor (Data Dictionary
y Syncronizer), desarrollo en grupo (Version Control / Team Developer) y las herramientas
Data Modeller. Documenta ademas la Busines Math Library (Biblioteca de funciones de
matematica empresarial) y Wise for Clarion (herramienta para usuario final que permite
crear instalaciones). Este manual esta incluido solamente en la version empresarial (algunas
componentes también estan disponibles como producto separado).

Wizatron Handbook.

Documenta los wizatrons, generacion avanzada de la tecnologia de asistentes Clarion,
quienes “aprenden” como usted trabaja, y se convierten en su asistente de programacion
automatizado (sélo disponible con la edicion empresarial).

Master Index (Indice general)

Un listado completo de indice para toda la documentacién impresa y tipo .PDF que viene
con cada edicion de Clarion (impresa solamente en la edicion empresarial, en formato .PDF
del CD en todas las demas ediciones).

Todos los libros que estan en formato .PDF en el CD (o en disquetes separados, en el caso de las
versiones en espafiol) son accesibles mediante el programa Adobe Acrobat Reader, que también
puede instalarse desde el CD de Clarion. Pueden hacerse blsquedas por tema o palabra en estos
archivos .PDF, y también pueden imprimirse, si se desea.

Importante: si cualquier parte del texto on-line contradice la documentacion impresa, la
documentacién en linea tiene precedencia. TopSpeed Corporation hace el mayor esfuerzo por
asegurar que la documentacion impresa esté al dia. Sin embargo, el tiempo requerido por los
impresores puede causar algunas inexactitudes: podemos actualizar los archivos de ayuda hasta el
lanzamiento mismo de una revisién del producto; pero los materiales impresos deben
“alcanzarlos” después.
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Convenciones en la documentacion

Convenciones tipogragicas:

Bastardillas

VERSALITAS

Negritas

LETTER GOTHYC

Convenciones del teclado

Indican qué debe tipearse en el teclado, como
por ejemplo Escriba esto. También, ocasional-
mente, se utilizan para destacar algunas
palabras o frases, o indicar expresiones en
idioma extranjero.

Indican pulsaciones de teclas, como ENTER 0
ESCAPE, 0 dar un cLIC con el mouse.

Indican érdenes u opciones de un mend, o del
texto en una ventana de didlogo. Note: este
estilo también puede usar una familia
tipografica diferente, para igualarse a las
negritas en Helvética que utiliza Windows
como fuente del sistema.

Se utiliza para diagramas, listados de cddigo
fuente, para comentar ejemplos, y para
ejemplos del uso de sentencias de cadigo.

FI

ALT + X

Indica una Unica pulsacion de tecla. En este
caso, oprima y suelte la tecla FI.

Indica una pulsacion combinada. En este caso,
oprima la tecla ALT y seguidamente pulse la
tecla X, luego suelte ambas teclas.



Informacién sobre el producto

Registro

Antes de comenzar a usar Clarion, llene y envie la tarjeta de registro que se encuentra en la caja a
UNISOFT, Uruguay 263 piso 5 (1015), Buenos Aires, Argentina 6 a su Representante local. Esta
tarjeta le permite gozar de varios beneficios importantes. Una vez registrado, puede usar los
servicios de Apoyo Técnico, y recibira automaticamente anuncios y notificaciones de mejoras al
producto.

Apoyo técnico

En la Argentina

¢

Los usuarios registrados en la Argentina y paises de habla hispana disponen de
apoyo técnico gratuito via Internet en la direccion: http://www.clarion.com.ar (o
también, ww.unisoft.com.ar) mediante Servicios de Newsgroup y FTP. Un equipo de
experimentados técnicos locales (CST: Clarion Support Team Argentina) respondera
a sus dudas. También pueden obtener asistencia por correo electrénico a soporte@
unisoft,com.ar, o por fax al teléfono (+54-11) 4374-9469.

Existen también planes alternativos de soporte técnico por abono anual u horas de
consultoria, como el “Corporate Support” que incluye asistencia telefénica ilimitada,
seguimiento de problemas, asesoria y otros servicios. Para mas informacion
consulte al (+54-11) 4372-7243.

Apovyo internacional

Puede recibir apoyo técnico ilimitado para Clarion en CompuServe Information Service y en
Internet. Los empleados de TopSpeed, asi como los Asociados de Apoyo Técnico Certificados
TopSpeed (un grupo voluntario de usuarios Clarion conocidos como Team TopSpeed),
responderan a sus preguntas oportunamente. Ademas, podra recibir consejos y respuestas de otros
usuarios Clarion. Recomendamos ampliamente que nuestros clientes hagan uso de estos servicios.

1.

En CompuServe escriba GO TOPSPEED para ingresar al foro de apoyo técnico de
TopSpeed.

En Internet, ingrese al grupo de noticias comp.lang.clarion, mediante cualquier servidor de
Usenet server.

En Internet, ingrese al grupo de noticias topspeed.products en tsnews.clarion.com server.

También en Internet, visite la pagina Web de TopSpeed en http://www.topspeed.com. para
mas recursos de Clarion.

También puede obtenerse servicio telefénico pago de la Coporacion TopSpeed al nimero (+1)
(954) 785-4556.
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Sistema de respuestas por fax

TopSpeed ofrece también acceso telefénico mediante fax para acceder a los documentos técnicos y
comerciales mas comunes. Los documentos en linea incluyen folletos de productos, documentos
técnicos, reimpresiones de articulos, listas de precios, e incluso una actualizacion de los Ultimos
productos TopSpeed (“What’sHot™).

Para pedir documentos especificos, disque (+1- 954) 4785-4555, oprima 53 y escuche las
instrucciones del sistema. ElI men( es interactivo y accesible. Quienes llaman por primera vez
pueden pedir una lista de documentos disponibles para hacer su eleccién. Luego puede ingresar el
numero de codigo del documento, y el material le sera transmitido inmediatamente. Puede acceder
al sistema desde su maquina de fax o desde cualquier teléfono multifrecuente.

El programa de instalacion: Setup

El programa Setup descomprime y copia los archivos Clarion a su disco rigido.

¢ En todos los sistemas operativos, le ofrece opciones para instalar los varios
componentes, tales como los archivos de ejemplo.

+ En todas las versiones de Windows, pregunta antes de actualizar la via de acceso (PATH) en el
archivo AUTOEXEC.BAT, para incluir el directorio Clarion.

¢ En Windows 3.x pregunta si debe instalar los iconos del Program Manager para el entorno de
desarrollo Clarion, y los archivos del Debugger (depurador), de ayuda y ReadMe.

¢ En Windows 95 y Windows NT, sugiere instalar todos los iconos del entorno de desarrollo
entre los programas del menu de inicio (“Start™).

Requerimientos del sistema

Puede ejecutarse el entorno de desarrollo Clarion en cualquier sistema que cumpla con los

requerimientos minimos para Microsoft Windows 3.x, Windows 95 ™, o Windows NT. Estos son
nuestros minimos recomendados:

¢ Windows 3.x, 8 Megabytes de RAM.

¢ Windows 95, 16 Megabytes de RAM.
¢ Windows NT, 32 Megabytes de RAM.
.

Minimo de 12 a 35 Megabytes de espacio de disco libre, segin las opciones de configuracion
(“Setup”) elegidas.

Las aplicaciones que usted desarrolle con Clarion se ejecutardn  confortablemente en
computadoras que cubran solamente los requerimientos minimos para esos sistemas operativos.
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Iniciando el Setup

Para empezar el programa de Setup de Clarion en Windows 3.x:
1. Inserte el CD de instalacion de Clarion en el dispositivo de CD-ROM.

2. Desde el Administrador de Programas, o el Administrador de Archivos u otro programa capaz
de ejecutar un programa, elija: File > Run.

Escriba D:\SETUP en el didlogo (Donde D: es la letra asignada a su unidad de CD-ROM), y
oprima el botén de OK.

El programa Setup presenta una pantalla introductoria y algunos datos adicionales. Le pide indique
las opciones de configuracién deseadas.

Para iniciar el programa Clarion Setup en Windows 95:

1. Inserte el CD de instalacion en el dispositivo de CD-ROM.

2. Desde el mend de Inicio, escoja Configuracion a Panel de Control.
3. Elija Afadir/Quitar Programas, y oprima el botén de Instalar.

El Asistente de Windows 95 lo guiara a través del proceso de instalacién.

Opciones de instalacion

Después de iniciar Setup, se mostrara un grupo de pantallas del Asistente que muestran una
variedad de opciones:

1. Escoja las opciones de configuracion ofrecidas por las pantallas (como el disco y directorio de
destino) oprimiendo el botén Next para desplazarse por las pantallas de opciones.

Setup instalara los componentes principales del entorno de desarrollo Clarion a un
subdirectorio BIN ubicado a un nivel mas bajo del directorio de destino que usted ha indicado.

El programa de instalacién instala todos sus archivos al directorio de destino, y a los
subdirectorios que estan por debajo de éste. No instala archivo alguno en otros directorios.

Durante la instalacion, apareceran barras de avance para mostrar la copia de los archivos.
2. Elija Yes o No cuando Setup pregunta si puede modificar el PATH.

En Windows 3.x y Windows 95, el entorno de desarrollo Clarion necesita que el subdirectorio
BIN esté listado en la variable de entorno PATH. Si elije No, debera modificar manualmente el
archivo AUTOEXEC.BAT.

El Unico cambio adicional que hace Clarion a sus archivos de sistema es afiadir su propia
seccion al archivo de inicializacion de Windows (WIN.INI), cuando se lo ejecuta por primera
vez.
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3. Elija Yes o No cuando Setup pregunta si instalard los iconos en un grupo de
programas Clarion o en el menu de Inicio.

4. Elija Yes o No cuando Setup pregunta si debe mostrar el archivo ReadMe.

Si no desea leerlo inmediatamente, encontrara el icono correspondiente en el grupo del
Administrador de Programas (o en el menu de Inicio) que crea Setup. Recomendamos leerlo
tan pronto como Setup haya copiado todos los archivos.

5. Oprima el botén OK cuando Setup haya terminado.

Ejecucién de Clarion

Para ejecutar Clarion, ubique el icono correspondiente en el grupo de programas Clarion y dé
DOBLE CLIC sobre él, o simplemente un CLIC en el icono del mend Inicio.

Aparece el entorno de desarrollo Clarion, listo para trabajar.

+ Encontrara una guia rapida para las partes del entorno de desarrollo, como un diagrama de los
iconos de la barra de tareas, en el capitulo tres de esta seccion.

+ Siga ahora con el capitulo dos de este libro para crear dos aplicaciones impresionantes (desde
el diccionario de datos, a las ventanas del browse, a las ventanas de forms) todo en menos de
una hora.
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» - INICIO RAPIDO: CURSILLO

En Clarion, puede crear un diccionario de datos y una aplicacion funcional, sin necesidad
de codificar. Todo lo que necesita es definir los campos del archivo de datos y el
Asistente de Inicio Répido ( Quick Start Wizard) crea una aplicacion Windows
completa... en cinco minutos, si usted digita rapidamente. La aplicacion incluye un
procedimiento de ficha de actualizacion para mantener el archivo, una visualizacion
(browse) sobre todas las claves de ordenamiento, y tantos informes como claves.

Usando el Asistente de Inicio Rapido, solamente necesita definir el nombre de cada
campo del archivo de datos, su formato de visualizacion (display picture) e informacion
sobre las claves. Todo lo demas esta previsto en los valores por omision. jEI Quick Start
Wizard se encarga de lo demas!

En este capitulo:

e Usara el Quick Start Wizard para crear un archivo de Clientes y una aplicacion
para mantener el archivo, luego compilara y ejecutara el programa.

e Utilizara Quick Load (“Carga rapida™). Este es otro atajo de Clarion que le permite
afiadir rapidamente un archivo a un diccionario de datos.

e Definira una relacion entre dos archivos en el Dictionary Editor, incluyendo las
reglas de integridad referencial.

e Usara el Generador de Aplicaciones para afiadir mas funcionalidad a la aplicacion,
usando uno de los Procedure Wizards (Asistentes de Procedimiento) de Clarion.

¢ Finalmente utilizara el Application Wizard (Asistente para Aplicaciones) para crear
una segunda base de datos relacional completa, a partir del mismo diccionario de
datos.

Todo esto llevara unos quince minutos, sin necesidad de “codificacion” alguna por su
parte. Hacia el fin del capitulo, tendra dos aplicaciones completas para una base de datos
gue contiene dos archivos.

iBienvenido! jA comenzar!



Asistente de Inicio Rapido
(Quick Start Wizard)

Creacion de un diccionario y de una aplicacion

Punto de comienzo:
Debe tener abierto solamente el entorno de desarrollo
Clarion. El didlogo Pic debe estar abierto.

En primer lugar, debemos crear un directorio C:\CLARIONS\TUTORIAL para las aplicaciones
que creara este libro. Este cursillo asume que usted ha instalado Clarion en C:\CLARIONS. Si
usted usa otro directorio, debe modificar las instrucciones correspondientes.

Crear un directorio de trabajo

1. Cambie a la herramienta apropiada del sistema operativo que utilice (Administrador de
Archivos, Explorador, etc.) y cree un nuevo directorio llamado TUTORIAL bajo el
subdirectorio Clarion5.

2. Regrese a Clarion.

Cree su primera aplicacion Clarion

1. En lacaja de didlogo Pick (“Escoger™) oprima el boton New... (“Nuevo”).

Aparece el dialogo New. Es una caja de didlogo estandar Abrir Archivo de Windows, que le
permite cambiar el directorio y escribir el nombre de archivo.

Now ____ ___ EA

Guardar er: I = Tutorial

Mombre de archivo: |QwTutDr |ﬂ|
Guardar como IAppIication [*.app) ;I Cancelar
archivos de tipo: .

W ls ¢

2. Elija Aplicattion (*.app) de la lista desplegable Save as type (“Cuardar como...”)
3. Elija el directorio C:\CLARIONS\TUTUORIAL.
4. Tipee QWKTUTOR en el campo File name (“Nombre de archivo”)

El Quick Start Wizard usa esto tanto como nombre de aplicacion y diccionario para crear
QWKTUTOR.DCT (el archivo del diccionario de datos) y QWKTUTOR.APP (el archivo de la
aplicacién). Se pueden usar nombres de archivo largos, pero no lo haremos en este cursillo en
consideracién a los usuarios de Windows 3.1.



5.

Tilde la caja Use Quick Start, luego oprima el botén Save (“Guardar”). Aparece el dialogo
Clarion Quick Start (“Comienzo rapido™).

Clarion Quick Start [x]

Application Mame: | [T oY AR sl WA TRRRR ta Rete] _I
Data File Name: | Prefis: | E_ .

ancel |
File Crriver. TOPSPEED

-

Field Name Picture Key
=l Inzert |
Dielete |

Definicién del archivo de datos

1.

Oprima TAB dos veces, escriba Cliente en el campo Data File Name y oprima TAB
nuevamente.

El Asistente de Inicio Rapido utiliza este nombre como el nombre del archivo de datos.
Adviértase que toma las tres primeras letras, CLI, y las coloca en el campo Prefix (“prefijo”).
El prefijo de un archivo identifica inequivocamente los campos que pueden ser iguales (salvo
por el prefijo) en miltiples archivos.

Oprima TAB para aceptar CLI como el prefijo.

A continuacion, debe elegir el controlador de archivos (File Driver). Este campo indica, por
omision, TOPSPEED (uno de los dos sistemas propios de Clarion).

Oprima TAB para aceptar TOPSPEED como controlador de archivos.

Esto lo lleva a la caja de listado donde se definen los campos.

NOTA: Bajo Windows 3.1, debe tener cargado SHARE.EXE o el
controlador de Windows VSHARE.386 para utilizar el
controlador de archivos TopSpeed. Las versiones mas recientes
de Windows hacen esto autométicamente.

Escriba NumCliente en la primera fila de la columna Field, y oprima TAB.

Esto crea un campo llamado NumCliente. EI Quick Start Wizard también utiliza este nombre
para los encabezamientos de columna y de indicadores. El indicador (prompt) se utiliza
siempre que coloque el campo en una ventana. Los encabezamientos de columna se utilizan en
los informes y en las cajas de listados.

Escriba N4 en la columna Picture, y oprima TAB.

Esto especifica el formato de visualizacion para los controles de la ventana y de los informes,
lo que declara implicitamente el tipo de datos para el Quick Start Wizard.

Clarion Quick Start | %]
Application Mame: [ C:\clarionB\T utarial\Qw T utor. app _|
DataEile Name:  [Clizntes Prefie: [CLI E_ I

aNCel |
File Crriver. TOPSPEED >
Field Hame Picture [ Key
Nurniliente: N4 Autonumber Insert |
Delete |

En la columna Key, oprima la FLECHA-ABAJO para mostrar las opciones. Destaque Autonumber
(“Autonumeracion™), y oprima TAB.



De este modo se creard una clave exclusiva con este campo como componente. Al especificar
Autonumber, la aplicacion asegura que cada cliente tenga un numero distintivo, que
automaticamente se incrementard cada vez que se afiada un cliente. El Asistente de Inicio
Rapido crea browses e informes basados en cada clave que se crea. Esta clave permitira el
desplazamiento entre registros ordenados por NumCliente.

El cursor se ubica automaticamente en la fila siguiente, permitiéndole definir el siguiente
campo.

7. Escriba Empresa en la columna Field, y dé TAB.
Esto crea un campo llamado Empresa para utilizar como el nombre de la empresa del cliente.
8. Escriba S20 en la columna Picture, y pulse TAB.

Esto espcifica el formato de nimeros mostrado en los controles de ventana y de informe. En
este caso, el tipo de datos es un campo STRING de 20 caracteres.

9. En lacolumna Key, oprima la FLECHA-ABAJO para mostrar las opciones. Destaque Duplicate, y
dé TAB.

10. Termine de definir el archivo creando los campos restantes, segin la siguiente tabla:

FIELD PICTURE KEY

Nombres S20 (sin clave)
Apellidos S20 (sin clave)
Direccion S20 (sin clave)
Ciudad S20 (sin clave)
Provincia S3 (sin clave)
CP P####P | Duplicate

Adviértase el formato (P####P) especificado para el campo CP (Codigo Postal). Es un “patrén
de visualizacion y archivo” que formatea los digitos para el codigo postal.

Clarion Quick Start E
Application Mame: [C; i
Apphcation Name: |C.\ELAF!IDN5\Tutu0rlal\qwtutor.app _I
Data File Mame: | Clientes Prefix: IELI m—
ancel |
File Diver: |TOPSFEED =
Field Mame Ficture K.y
MNumCliente M4 Autonumber Inset |
Empresa 520 Duplicate
Mombres 520 Dielet
Aipelidos 520 _elee |
Direccion S20
Ciudad 520
Frovincia 53 - |
CF PHESHF Duplicate —I —I
| |
Help |
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Cierre del Asistente v creacion de la aplicacion

1. Cuando haya definido todos los campos, oprima el botén OK.

El Asistente le preguntara si ha terminado de definir los campos. Al oprimir el botén OK, se
crea la aplicacion y aparece la caja de dialogo Application Tree.

[E] UpdateClientes [Form] - Update the Clientes File

- [El PrintCLIKeyCP (Repart] - Print the Clientes File by CLI:KeyCP oK |
-2 PrintCLEKeyMumnCliente [Report] - Print the Clisntes File by CLIK. —

OwTutor.app - Application Tree M= E I
Procedure |Modu|e| Template | Hame | LCategory I Global
I Properties. .. I
ENS R 14 i [Frame] - Clarion 5 Quick Application for C:ACLARIONSAT utuoni, FEE
—1-E] BrowseCligntes [Browse) - Browse the Clientes File &I

Cancel |
Help |

Advierta la estructura de la aplicacion. En la parte superior del “arbol” se ubica el
procedimiento Main (“Principal™), que crea un marco de aplicacion MDI (Multiple Document
Interface: Interfaz de documentos multiples). Este procedimiento contiene el menu que llama a
los demas procedimientos.

Debajo del procedimiento Main se ubica un procedimiento BrowseClientes (Browse) con un
procedimiento UpdateCliente (Form) anexado. El visualizador (browse) muestra los datos
basado en las tres claves que se especificaron al definir los campos. También puede ver tres

informes (reports) basados en esas claves.

La aplicacién esta completa, sin necesidad de que usted suministre mas informacion.

Los iconos de la barrade

El boton Ejecutar

tareas son, de izquierda a
derecha: Elegir, Nuevo,

9 HBSH 6%

Abrir, Guardar, Hacer,
Eiecutar v Depurar.

2. ElijaProject » Run (u oprima el boton Ejecutar en la barra de tareas).

El Generador de aplicaciones crea el coédigo fuente para sus aplicaciones, realiza la
compilacion, el linkeado y ejecuta el programa resultante.

jFelicitaciones! jSu aplicacién ya esta en funcionamiento!

Explorando la aplicacion

En primer lugar afiadamos algunos registros.

1. ElijaBrowse » Browse the Clientes file

2. Oprima el botén Insert en la barra de tareas.

Botdn de Agregar Botén de Cambiar Boton de Borrar

Los iconos de la barra de tareas son, de
izquierda a derecha: Inicio del archivo,
Pagina arriba, Arriba, Encontrar, Abajo,
Pagina abajo, Fin del archivo, Elegir,
Aareaar. Cambiar. Borrar. I[dem v Avuda.

7 4 «M\Sﬁ s&(ﬁ
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1. Una vez que haya tipeado los datos del primer cliente, pulse el boton OK para cerrar la ventana
de ficha y guarde el registro.

Con ésto demostramos el concepto de las aplicaciones Browse-Form de Clarion. La lista de
visualizacion Browse muestra los registros de la base de datos, y el procedimiento Form se usa
para actualizar (agregar, cambiar o borrar) los registros individuales del archivo. Clarion
también admite el concepto de Scrolling Form (“Ficha deslizante™), en que los registros pueden
modificarse directamente sobre la lista de visualizacion (trataremos ésto mas alelante).

#+ Application =]

File  Edit Browsze Beportz ‘wWindow Help
M 44 4 3 - bbb o = A = 3z P

% Browse the Clientes File

CLI:KeyMurmnClisnte | CLI:K.eyEmpresa I CLI:K.epCP I

Mum Cliente

| Erowsing Records [ | [

2. Agregue algunos registros mas (también puede dar cLIC DERECHO [con el botén derecho del
mouse] sobre la lista deslizante y escoger Insert del menu contextual, para afiadir registros).
Vea como cada vez que afiade un nuevo registro al archivo de Clientes, el valor del campo
NumCliente aumenta automaticamente de a uno. Observe los distintos ordenamientos para la
consulta en el procedimiento browse,luego varie el tamafio de las columnas y utilice la barra de
desplazamiento horizontal para examinar los datos en los campos que estan ocultos a la
derecha de la pantalla. Si lo desea, también puede imprimir informes.

3. Elija File > Exit para salir de la aplicacién.

También puede intentar ejecutar el programa (QWKTUTOR.EXE) desde el Administrador de
Archivos o el Explorador de Windows: es un verdadero ejecutable de Windows que no necesita
el entorno Clarion para ejecutarse.

Ahora salvaremos el trabajo y saldremos del Generador de Aplicaciones para modificar el
diccionario de datos que hemos creado. A continuacion afiadiremos un segundo archivo
relacionado, al diccionario.

4. Elija File » Close, o pulse el botén OK para cerrar el Generador de Aplicaciones.
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Asistente de Carga Rapida
(Quick Load Wizard)

Puede afiadir rapidamente un archivo al diccionario de datos utilizando la opcion Quick Load
en el Editor del Diccionario. Este Asistente trabaja de una manera similar al Asistente de Inicio
Rapido: se introduce el archivo (nombres de los campos, formatos y claves), y se crea una
definicion del archivo en en diccionario. Esta opcion esta disponible siempre que se afiade un
nuevo archivo al diccionario.

Afnadir un archivo

En esta seccion afiadiremos un archivo para guardar los nimero telefénicos de los clientes. Esto
permite que cada cliente tenga tantos ndmeros telefénicos como sea necesario (lo que crea una
relacion de uno-a-muchos).

Uso de Quick Load en el Editor del Diccionario

1. Elija File > Open (u oprima el botén Open en la barra de tareas).
Aparece la caja de didlogo Open.

2. Elija el tipo Dictionary (*.dct) de la lista desplegable Files of type, seleccione
QWKTUTOR.DCT, y oprima el botén Open.

Aparece la caja de didlogo Dictionary Editor.

# Dictionary - QwTutor. DCT 1.0

Fil r-Related Fil
W dde
Add g Add BElEtiarn
_IPloperﬁieS. . Fioperies,..
Fields/Keys...
[elete
Delete
Browse
4 I I ﬂ Corvert 4 I I j
Dictionary Properties.. | Synchronize | Cloze | Help

3. Oprima el botén Add File.

Aparece otra caja que pregunta: “Do you want to use Quick Load?” (“Desea utilizar la carga
rapida?).

Add File [x]

@ Do you want to use Quick Load 7

| Tes I I Nl I | Lancel I

Oprima el botén YES.

4. Aparece la caja de didlogo Clarion Quick Load. Advierta que es muy similar al dialogo del
Asistente de Inicio Rapido.
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Clarion Quick Load [ x|
Dats File Name: [T elefonas Prefic |UEN | x|
P "

File Diriver TOPSPEED hd C :
anced |
Field Name

Type Key

Seleccione el campo Data File Name (“Nombre del archivo de datos”), y escriba Teléfono y
pulse TAB.

Oprima nuevamente TAB para acepta TEL como prefijo.

A continuacion, se le pide elegir un controlador de archivos (File Driver).

Oprima TAB para aceptar TOPSPEED como controlador.

Esto lo conducira a la caja de los listados en que se definen los campos.

Escriba NumCliente en la primera linea de la columna Field Name, y oprima TAB.

Esto crea un campo llamado NumCliente. Este campo es el vinculo (link) al campo NumCliente
en el archivo Clientes. Usar los mismos nombres de campos facilita vincular los dos archivos.
En el codigo que Clarion genera, el prefijo del archivo se afiade a los nombres de campo (con
dos puntos [:] como separacion), lo que produce nombres exclusivos para los campos que
comparten el mismo nombre en archivos separados.Por lo tanto, este campo se llamara en
realidad, TEL:NumCliente, mientras que el campo en el archivo de Clientes se llama
CLI:NumCliente.

Escriba N4 en la columna Picture, y oprima TAB.

En la columna Key, oprima la FLECHA-ABAJO para mostrar las opciones. Elija Duplicate y dé
TAB.

Esto especifica una clave que permite asientos duplicados, lo que permite tener mas de un
registro para cada cliente. Asi puede crearse una relacion de uno-a-muchos entre los dos
archivos (un cliente puede tener muchos teléfonos).

El cursor se ubica en la proxima fila, lo que permite definir el campo siguiente.

11.En la columna Field Name de la fila siguiente, escriba DDN, y oprima TAB.

12.En la columna Picture, escriba P(0###)P, y oprima TAB dos veces (no se define una clave)

para continuar con el campo siguiente.

Esta accion formatea el campo DDN (Discado Directo Nacional) como un cero mas tres
digitos, rodeado por paréntesis, que es la forma estandar para los cddigos de telediscado en
Argentina. La norma es muy similar en todos los paises, pero puede adaptarla localmente, si
fuera necesario.

13. Complete el archivo creando los campos de la tabla:

FIELD PICTURE KEY
Telefono P###H-####P | (Sin clave)
Descripcion |S20 (sin clave)
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14. Cuando termine de definir los campos, oprima el botén OK.
El Asistente le preguntara si ha terminado de definir los campos.
15. Oprima el boton OK.
El Asistente crea las definiciones del archivo, y lo afiade al diccionario.

Configqure el archivo Telefonos para usar el concepto de Ficha deslizante
(Scrolling Form)

Dado que este archivo tiene sélo cuatro campos, resulta un buen ejemplo del tipo de archivo
adecuado para modificar datos sobre la lista deslizante.

1. Destaque el archivo Teléfono de la lista Files, y oprima el boton Properties...
(“Propiedades™)

2. Elijala lengiieta Options.
3. En el control User Options (“Opciones del Usuario™), escriba EDITINPLACE.

Asi advertira a los Asistentes (“Wizards”) de Clarion que generen codigo que le permita
modificar los datos del archivo directamente en la caja de visualizacién deslizante (browse).

Edit File Properties [ x|
Qenarall Comments Dptions |
[T Do Not Auto-Populate This File
User Options :
EDITINPLACE 1=
[

Ok I Cancel | Help |

4. Oprima el botén OK.

Afadir unarelacién

Obviamente, deseamos que el archivo Telefonos contenga los nimeros telefénicos de los clientes.
Esto significa que los dos archivos deben estar relacionados. En este caso, un cliente puede tener
muchos teléfonos, lo que la convierte en una relacion “uno-a-muchos”. Para definir esta relacion,
debemos vincular los archivos en el diccionario de datos, para proveer al Generador de
Aplicaciones con la informacion necesaria para acceder a los registros relacionados.
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Establecer unarelacion entre dos archivos

1.

Seleccione Cliente en la caja de didlogo Files y oprima el boton Add Relation.

Aparece el didlogo New Relationship Properties (“Nuevas propiedades de la relacion™).
Aqui se definen las relaciones.

Mew Relationship Properties E
General |E0mments| Options |
Relationship for ELIENTE.J
’VLIDB Primary Key INone hd
Child
’VBeIated File: INone vl Foreign Key INmE v ‘

Asegurese de que el campo Type indique 1:MANY (uno-a-muchos).

En el campo Primary Key (“Clave Primaria™), oprima la tecla FLECHA-ABAJO para desplegar
las opciones, seleccione KeyNumCliente, y oprima TAB.

Esta es la clave del archivo Clientes (el lado “Uno” de la relacién), que se usara para vincular
los archivos.

En el campo Related File (“Archivo relacionado”), oprima FLECHA-ABAJO para mostrar las
opciones, detaque Telefono y dé TAB.

En el campo Foreign Key (“Clave foranea”), oprima FLECHA-ABAJO para desplegar las
opciones, seleccione KeyNumCliente y dé TAB.

Esta es la clave del archivo Teléfono (el lado “Muchos” de la relacion) que se usara para
vincular los dos archivos.

A continuacion, los campos relacionados en las claves deben ser “mapeados”, de manera que el
Generador de Aplicaciones sepa exactamente cuales son los campos que se relacionan entre si.
Dado que usamos nombres de campo idénticos, esto resulta facil.

Oprima el botén Map By Name (“Vincular por el nombre™).
Los campos vinculantes entre ambos archivos aparecen en las dos cajas Field Mapping.

Mew Relationship Properties [ x|

General |Cummenls | Options I

elallonshlp far CLIENTE"
’V 1 MANT = PBrimary Key IKe}'NumEIlente - ‘
Child
’V Related File Telefonos ~|  Eoreign Key IKeyNumCIiente - ‘
Field Mapping
Clientes -» KeyMumClignte Telsfonos > KeyNumCliente

CLI:MumCliente -» TEL:MumCliente TEL:NumClignte -» CLI:MumCliente

Ml I

Map By Hame | tdap By Order |

On Update Cascade *| OnDelete

"Heferenllal Integrity Canstraint
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1. Elija Cascade (“En cascada”) de la lista On Update (“Cuando se modifica”) en la caja

Referential Integrity Constrains (“Restricciones de integridad referncial).

2. Elija Cascade en las lista On Delete en la caja Referencial Integrity Constrains.

El cddigo fuente generado mantendra en forma automatica la integridad referencial entre los
dos archivos. El cursillo de la seccion Aprendiendo Clarion lo explica mas ampliamente. Vea
también Using the Dictionary Editor en la User’s Guide para un breve tratamiento de la teoria
de las bases de datos relacionales.

3. Oprima OK para cerrar la caja de didlogo New Relationship Properties.

El Diccionario ahora aparecera ast:

{ Dictionary - QwTutor.DCT 1.0 ==l E3 I
File: ~Fielated F
E_ Add Fil ]
Teletonos 4"EI
Add Alias | Add Relation |
Froperties... | i |
Fields.-"ﬁeys...l
Delete |
LDelete |
Browse |
4 | ﬂ Convert | 4 | j
Dictionary Properties... | Synchronize | Cloze | Help |

4. Elija File > Save, u oprima el botén Save en la barra de tareas para guardar el diccionario

de datos.

5. Seleccione File > Close, u oprima el boton Close en la caja de didlogo de Dictionary para

cerrar el diccionario.



Asistentes para Procedimientos
(Procedures Wizards)

Ademas del Asistente de Inicio Rapido, Clarion tiene también Asistentes que crean procedimientos de
visualizacion de archivos, fichas o informes (Browse, Form o Report), con tanta facilidad como el
Asistente de inicio Rapido crea un diccionario de datos y una aplicacion. Estos asistentes estan
disponibles siempre que se crea un nuevo procedimiento en una aplicacion ya existente.

Ahora usaremos el Browse Wizard para crear un procedimiento de visualizacion para el archivo
Teléfono. También puede crear el procedimiento de actualizacion (Form), pero no esta vez, dado que
las modificaciones podran realizarse directamente sobre la visualizada (“edit in place™)

Carga del Generador de aplicaciones

1. Elija File » Pick (u oprima el botén respectivo en la barra de tareas).

2. Seleccione la lengueta Application, destaque C:\CLARIONS\TUTURIAL\QWKTUTOR.APP, y
luego oprima el botén Select.

Aparece la caja de didlogo Application Tree (“arbol de la aplicacion™).

Modificacion del procedimiento de ficha

1. Destaque UpdateCliente (Form) en el arbol de la aplicacion , y dé cLIC DERECHO para activar el
menu contextual.

Este menu le permite el acceso directo a las herramientas del Generador de Aplicaciones, sin
necesidad de abrir primeramente las Propiedades del procedimiento.

# Clarion 5 [qwtutor.app)

File Archive DataModeller Edit Applicstion  Procedure Project Setup Window Help

G S £C %

%" qwtutor.app - Application Tree [_[Olx]
Procedure IModuIel Temp\_atelﬂamelgategoryl Gilobal |
I | Properties.. I
—1-[Z Main (Frame] - Clarion 5 Quick Application for C:\CLARIONS, T utuorid ;
— -E BrowseClientes [Browse] - Browse the Clientes File ﬂl
(IS L po-t-Clienieg Eaglndaic the Clientes File
B PrintCLIKeyCP (R, Fropeties 5 File b CLIK.2yCP ok
L[ PrintCLKeyNums v Files e Clientes File by CLIK, =
v Window Cancel |
Hepart
v Data
Procedurss &I
Embeds
Farmulas
v Extensions
Module
Source
Synchronize
<| | Delete 3
| Rename

El men( contextual muestra una tilde (v') junto a las herramientas que contienen datos.
2. Dé un cLic sobre Window.

Aparece el Disefiador de Ventanas (Window Formatter). Aqui puede modificar visualmente la
ventana y sus controles.

3. Elija Control » Push Button, o dé cLic sobre la herramienta Boton en la caja de herramientas
de Controles (la que tiene un icono que se parece a un botén OK).
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4. Dé cLic cerca del angulo inferior izquierdo de la ventana para colocar el nuevo control (bot6n)
debajo de la hoja con lengtieta (tab sheet).

i Update the Clientes File X|

General | Help
Hum Cliente: <l

Empresa: I—
Maombres: I—
Apelidos: I—
Direccion: I—
Ciudad: —

Provincia: I
CF: I aooo

= Butt.onél ! Ok I Cancel |

5. Con el nuevo botén seleccionado, dé cLIC DERECHO para activar el didlogo Ilamado Button
Properties.

6. Escriba Teléfonos en el campo Text.
Esto cambia el texto que aparecera sobre el botdn.
7. Seleccione la lengieta Actions (“Acciones™).

Es en esta lengiieta donde usted especifica lo que hace el control. En este caso, deseamos que
Ilame a un procedimiento browse para mostrar todos los registros del archivo Teléfono que se
vinculan al registro actual del archivo Clientes.

8. Elija Call a Procedure de la lista desplegable When Pressed.
Aparece la caja de definicion de procedimientos (Procedure Definition) sobre la ficha de

Acciones.

General I Extra IQUIUI | Help IEUsiliun Actions |

~Menu/Button Control Prompty—————————————————————
‘when Pressed Call a Procedure >

~Procedure Definition

Procedure Mame: VerT elefonod |:l

[ Initiate Thread
Thiead Stack: 25,000 =
Mon Threaded Procedure Call Definition——————

Parameters:

Beturn Value Yariable: | =

™ Reference Assign?
Requested File Action: INone -

Files | Embeds |
Fant... | 0K I Cancel | Help |

9. Escriba VerTelefonos en el campo ProcedureName, y oprima el boton OK.
Asi se le da nombre al procedimiento que se llamara cuando el usuario imprima el botén.

10. Elija Exit! del menu para regresar al Arbol de Aplicaciones y oprima el botén Yes cuando se
le pregunta si guarda los cambios en la ventana.

Aparecera el procedimiento VerTeléfonos en el arbol como un item para elaborar (ToDo).



Uso del Asistente para browse

Los Asistentes de procedimientos generan procedimientos completos basados en la informacién
minima que provee el usuario en respuesta a una serie de ventanas de dialogo del Asistente que
hacen una pregunta por vez.

Ejecucion del Asistente para browse

1. Dé poBLE cLIC sobre el procedimiento VerTeléfonos (ToDo).

Aparece la ventana Select Procedure Type. Esto le permite elegir la plantilla (template)
que el Generador de Aplicaciones utilizara para crear el codigo fuente.

2. Destaque el template Browse, marque el casillero Use Procedure Wizard, luego oprima el
boton Select.

El secreto para poder usar los Asistentes de Procedimiento es marcar con una tilde el casillero
Use Procedure Wizard. En la pantalla siguiente destaque BrowseWizards y oprima
Select.

A& Select Procedure Type A Select Procedure Wizard

I ‘ Select I | ‘ Select I
External - Extemal Procedure

—-[(3 Class ABC - Application Builder Class Templates c -I =13 Class ABCWizards - Clarion 5 \izard Templates
B s in  Page-Loaded List Box ﬂl e 10 - Lreate a new record browsing procedure ﬂl
Form - View / Edit a Recard from a File -] Browsewizatron - Create New Browse Procedure

= Class ‘Wizatrons - Wizatron driver
Frame - Multiple Document Main Menu Help Help

Menu - Single Dacument Menu

Process - Sequential Record Processar

Fiepoit - Generic Reporting Procedue

Source - Source Procedure

Splash - Splash window

< Viewer - Yiew a A5CI (text) file

~E] ‘window - Generic Window Handler

=0 Class CRCSABcRpls - CPCS [A8C) Enhanced Reporting Templates v |

= UnivAbcProcess - Universal ABC Process Procedurs _'d
»

| »

goooooooo

4
¥ Use Procadurs wWizaid 4

3. Después de leer la primera informacion de la caja de dialogo del Asistente, oprima el botén
Next para empezar a crear el procedimiento.

Browse Wizard - File Access [ x|
which file do you want ta browse?
e — [Telefonos |E
—
<Back Nexts Einish Cancel

4. Escriba Teléfono en el casillero de ingreso de datos (u oprima el boton ... y elijalo de la lista),
respondiendo a la pregunta “;Which file do you want to browse?”( ; Qué archivo desea
visualizar?), y oprima el botén Next.



Browse Wizard - Key Sequence [X]

Y'ou can browse & file using a single record key or vou can use all of the
record keys declared for a file.

mmsm——

IF you uze all the keps, they will be placed on tab controls that change the
e seguence of records displayed in the list bow,

[ Browse using all record keys

Access Key: ITEL KeyMumCliente |

<Back | HNext> | Finish | Cancel |

5. Despeje el casillero Browse using all record keys (“Visualizar utilizando todas las claves
de busqueda), oprima el botén ... y elija TEL:KeyNumCliente de la lista, y oprima el bot6n
Next.

Esto especifica la clave que se utilizard para ordenar los registros para su visualizacion en el
listado.

6. Deje en blanco el casillero Update Procedure (“Procedimiento de actualizacion”) y oprima
el boton Next.

Este casillero de ingreso de datos le permite indicar el procedimiento que el Asistente para
Browse creara para actualizar los registros del archivo Teléfono. En este caso, esto es
innecesario, ya que el Asistente creara el cddigo apropiado para poder modificar el archivo
sobre el listado mismo (in place), lo que elimina la necesidad de un procedimiento de
actualizacion (Ficha). Sin embargo, si no hubiéramos especificado EDITINPLACE en las
opciones del usuario del archivo, el Asistente para Browse Ilamaria al asistente para Fichas
para crear el Procedimiento Ficha. Nombrando aqui un “Update procedure” evitamos el
trabajo de tener que activar luego el Asistente para Fichas.

Browse Wizard - Update Procedure

The browse procedure can select & record to be processed by an update
procedure. | you enter an update pracedure, nsert”, "Change". and
"Delete’ buttans will be placed in the browse window.

p

You may use the default update procedure name, or you may specify pour
awn pracedure name. To use the default name, leave the Update
Procedure blank.

Update Procedure: [ i

<Back I Hext> I Einish | Cancel |

7. Marque el casillero Call update using popup menu, y oprima el botéon Next.

Esto permite que los usuarios utilicen un men( contextual (que aparece cuando dan cLIC
DERECHO sobre el listado) para llamar al procedimiento de actualizacién (o la capacidad de
realizar modificaciones en el listado mismo).

Browse Wizard - Call Update Procedure [<]

Mow that pou've specified an updste procedure, you might want your users
to be able ta call the update by clicking the right mouse button on a list box
iten, i f s alone.

<Back I Mext> I Einish Cancel
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8. Despeje el casillero Provide buttons for child files (“Hacer botones para archivos hijos”),
y oprima el botén Next.

Browse Wizard - Parent File Handling B

If the Recaord Key that you specified to uge as the Access Key iz the key
uged in a Many1 relation, [In other wards, thiz file iz a child of anather file]
how do you want the selection of the parent recard to take place?

Parent Record Selection:
" Do not select by parent record
' Select parent record via button

& issime that the parent record i acivel

<Back I Hexts I Einish | Cancel |

9. Seleccione el botén de radio Assume that the parent record is active (“Presumir que el
registro «padre» esta activo”), luego oprima el botén Next.

Esto asegura que el procedimiento se configura para mostrar solamente los registros Teléfono
que estan vinculados al registro del archivo Clientes activo en la memoria cuando se llama al
procedimiento.

Browse Wizard - Select Button [x]

A browsze procedure can be uzed to lookup a record for an entry field. If
uzed for this purpose, the browse window should include a "Select
button.

I~ Provide a5

t buttore

<Back I Mexts I Einish | Cancel |

10. Despeje el casillero Provide a “Select” button (“Crear un botén «Select») y oprima el
boton Next.

Dado que este procedimiento no se utilizara para consultar datos que el operador deba ingresar
en una ficha, el boton Select resulta innecesario.

Browse Wizard - Control Model [ ]

A& Browse procedure can use any of the fallowing Contral Models:

Button: Traditional Insert, Change, Delete, DK and Cancel approach
Toolbar: Browse contrals are populated on a comman toolbar
Both: Employs both control models

‘w'hich Control Model should the Application use?——
’V  Button & Toobad " Both

<Back I Hests I Finizh | Cancel |

11. Deje configurado el boton de radio Which Control model should the aplication Use
(“¢Qué tipo de controles usara la aplicacién?”) en Toolbar (“Barra de herramientas”), y oprima
el boton Next.

12. Pulse el boton Finish para aceptar el valor por omision del casillero Overwrite existing
procedures (“Sobreescribir los procedimientos existentes™).



El Asistente para Browse crea ahora el procedimiento Browse para el archivo Teléfono. Si no
hubiéramos especificado EDITINPLACE en las opciones del usuario del archivo Teléfono, el
Asistente para Browse también crearia un procedimiento de actualizacion (Form) para
mantener los registros del archivo Teléfono. Cuando termina, deja activa la ventana
Procedure Properties del nuevo procedimiento Browse.

13. Oprima el boton OK para regresar al Arbol de Aplicaciones.

Procedure YerTelefonos Properties | x|
Procedure Mame: WerT elefonos J Files | oK. I
Template: Window[ABC] —

Cancel
Dezcription: 1 he Tl : Files J Jﬂl J
Category IBruwse Report | J
Prototype: I e
Module Mame: IqwtutDDB.ch hd J e | J Help I
[ Declare Globally Procedures |
Parameters: [
. Embed: |
Retun Walue: I—J SR
wfindow Behavior | Formulas |
Browse Box Behaviar | J [ —
Update Button _—I

v Usze Edit in Place
Configure Edit in place |
Update Procedurs [ =l

Observe el nuevo procedimiento que se ha creado para usted en el Arbol.

“ qwtutor.app - Application Tree

i

Procedure |Module I Template I Mame | Categomy I Global

Properties. ..

-2 Main [Frame] - Clarion 5 Quick Application for C:ACLARIONS,T ubuar
— -E BrowseClisntes [Browss] - Browse the Clisntes Fils
! B 2] UpdateClientes [Form)] - Update the Clientes File
[ER /o7 elefonos [Bro e Telefo ]
= ] PrintCLl:KeyCP (Repart] - Print the Clientes File by CLI:KeyCP
2l PrintCLEKeyNumClisnte [Report] - Print the Clientes File by CLEE, Cancel

Project

Help

dy i

14. Escoja Project » Run (u oprima el botén Ejecutar sobre la barra de herramientas).

Tiene ahora una aplicacion relacional completa, con multiples ordenamientos para la
visualizacion de los listados del archivo padre, una exploracion del archivo hijo limitado a los
registros vinculados a un registro del archivo padre, y cédigo de integridad referencial para
asegurar que la base de datos no se corrompa con registros hijos “huérfanos”.

Oprima el nuevo boton Teléfonos y afiada registros al archivo Telefono para cada uno de sus
Clientes.

15. Cuando haya terminado de explorar su aplicacién, escoja File > Exit para retornar a Clarion.

16.Elija File > Close (“Archivo: Cerrar”), o pulse el botén OK para cerrar el Generador de
Aplicaciones.
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iY, finalmente, el Asistente para Aplicaciones!

Todos los asistentes que hemos visto: Quick Start, Browse, Form, y Report son herramientas
poderosas. Sin embargo, Clarion tiene otro Asistente, aln mas potente en su arsenal de
herramientas para la superproductividad.

El Asistente para Aplicaciones (Application Wizard) crea una aplicacion completa a partir de un
diccionario de datos. Este diccionario puede tener tantos archivos como se quiera; pero deben estar
completamente definidos, incluyendo relaciones entre los archivos, reglas de integridad referencial
y de integridad de los datos, que pueden definirse en el Dictionary Editor.

Para facilitar el uso del Asistente para aplicaciones, el Dictionary Editor tiene opciones de
propiedades de cada archivo, campo Yy clave; todas expresamente disefiadas para interactuar con
los Asistentes, para permitirle personalizar las aplicaciones que crea para usted.

Usar el Dictionary Editor para configurar las opciones del
Asistente

1. Elija File » Pick (u oprima el botén Elegir de la barra de herramientas).

2. Seleccione la lengiieta Dictionary, destaque C:\CLARIONS\TUTORIAL\QWKTUTOR.DCT, y
oprima el botén Select.

3. Destaque el archivo Clientes y oprima el boton Fields/Keys...

4. Elija la lengleta Keys, dé cLic sobre KeyNumCliente para activarla, y oprima el bot6n
Properties.

Aparece la caja de didlogo Edit Key Properties.
5. Elija la lengiieta Options.

Las configuraciones de esta lengieta se utilizan para especificar el comportamiento de los
Asistentes. Las opciones en la mitad superior de la ventana se utilizan con el conjunto estandar
de plantillas incluidas con Clarion. La caja User Options es para el uso de plantillas
adicionales provistas por terceros, lo que permite especificar restricciones u opciones para €sos
Asistentes que no estén cubiertas por las opciones estandar.

6. Marque el casillero Do Not Auto-Populate This Key.

Cuando este casillero estd marcado, el Asistente para Aplicaciones no utilizara esta clave al
crear un procedimiento Browse para el archivo. Esto eliminara la lenglieta CLI:KeyNumCliente
en el procedimiento Browse del archivo Clientes.

Hay mucho méas que esto que puede hacerse en el Dictionary Editor para personalizar el
trabajo de los Asistentes. Al finalizar este cursillo, consulte la Seccion Optimizing the Wizards
del Application Handbook para mas informacion sobre este importante tema.
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Edit Key Properties
General | Aftributes | Comments Dptions |Eields |
v Do Not Auto-Populate This Key
Fopulation Order: |N0rmal il
Lger Options :
=l

DK I Cancel | Help |
Oprima el botén OK.

En la caja de didlogo Field / Key Definition, oprima el botén Close.

Pulse el boton Close en el dialogo Dictionary. Cuando se le indique, oprima el botén Yes
para guardar el diccionario.

Eso es todo. A continuacion, haremos que el Asistente para aplicaciones genere la aplicacion
completa.

Uso del Asistente para Aplicaciones

El Asistente para Aplicaciones produce aplicaciones completas sobre la informacion que usted suministra en
respuesta a una serie de ventanas del Wizard que van pidiendo un dato por vez.

Crear una nueva aplicacion

1.

5.

Elija File > New > Application

Aparece el didlogo New.

Elija el directorio C:\CLARIONS\TUTORIAL

Escriba APPWIZ en el campo File Name.

Despeje el casillero Use Quick Start, y oprima el boton Save.

Aparece la caja de didlogo Application Properties.

oppteaion Properies |
Application Fie: [APPWIZ 200 T |
Dictianary File: |C.\clariunS\tuluUrial\QwTulUr.DCT J Carcel |
First Procedure: | tdain
Destination Type: |Executabla [.EXE] =l Help |
Help File: | =
Application Template: |ABC J
ToDo Template: [TaDoE0) £
¥ Application wizard

Oprima el botén... a la derecha del casillero de ingreso de datos Dictionary File.

Aparece la caja de didlogo Select Dictionary.
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6. Destaque el archivo C:\CLARIONS\TUTORIAL\QWKTUTOR.DCT vy oprima el botén Open.

7. Marque el casillero Application Wizard (“Asistente para Aplicaciones”), y oprima el botén
OK. Seleccione luego Application Wizard pulse el boton Select.

A& Select Application Wizard

1 Class ABCwizards - Clarion 5 Wizard Templates
Application'sizard - Creat

Clazs “Wizatrons - WWization driver

L] Applicationwizatron - Create Mew Application

8. Oprima el botén Next.

Application Wizard

9. Oprima el botén Next.

Application Wizard - File Usage
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10. Oprima el boton Next.

Application Wizard - Control Model I

The Application *izard can generate applications uzing any of the
fallowing Control Models:

Button: Traditional Inzert, Change. Delete, OK. and Cancel approach
Toolbar: Brawse controls are populated on & common toolbar
Both: Employs bath contral models

" Button o  Both

"W'hich Control Model should the &pplication use?——

<Back I Neut» I FEinish | Cancel

11. Oprima el bot6n Finish.

Application Wizard - Finally...

If you are creating new procedures with names that already exist in pour
application, the old procedures can be ovenwritten or the new procedures
can be suppressed.

r

The procedure specified as pour First Procedure will always be
averwritten by the application wizard!

Feports can be generated for every file in the dictionary. Y'ou may choose
whether ar not to generate these reparts.

¥ Generate Reports for each file

<Back I IlEnt || Finish I Cancel

12.Elija Project > Run (u oprima el botén Ejecutar en la barra de herramientas)

APPWIZARD _app - Application Tree =] |

Procedure |M0dule I Template I Name I Category | Global

Froperties. ..

- . = o " —- Praject
= Z] BrowseClientes [Browse] - Browse the Clientes File e

: E] UpdateClientes {Form] - Update the Clientes File

— -[E] BrowseT elefono (Browse] - Browse the Telefono File

(- 2 SelectClientes [Browse] - Select a Clientes Record
+[Z] PrintCLI:KeyCP [Report] - Frint the Clientes File by CLI:KeyCP Cancel
~[El PrintCLI:KeyE mpresa [Repart] - Print the Clientes File by CLI:K.ev
<& PrintCLE:KeyMurnClients (Repart] - Print the Clisntes Fils by CLEK
‘3 PrintTEL:K.eyNumCliente [Feport] - Print the Telefono File by TELY

gy

Help

jFelicitaciones!. Su segunda aplicacion completa ya esta ejecutandose.
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Ahora puede explorar esta nueva aplicacion, y compararla con la que ya cred. Advertira que hay
algunas diferencias menores entre las dos. Estas diferencias se deben simplemente a que
construimos la primera aplicacion de una pieza por vez, en lugar de utilizar el Asistente para
aplicaciones.

Qué sigue

Si puede hacerse tanto con los “atajos” de Clarion, ;qué mas podra hacerse con todas las demas
herramientas que ofrece?

Ademas de los Asistentes, Clarion tiene un conjunto de herramientas de productividad en el
Generador de Aplicaciones, empezando por los templates de Control, Extension y Codigo que
permiten afiadir mas funcionalidad a los procedimientos. Estas herramientas facilitan el modificar
y personalizar los procedimientos tanto como los Asistentes, jy ninguna le exige escribir nada de
cédigo!

El préximo capitulo de este libro trata la filosofia de desarrollo subyacente a Clarion. Le
sugerimos leerlo con cuidado. Se trata de un material de apoyo importante porque, como hemos
visto, Clarion es una herramienta de desarrollo distinta a otras. Comprender la filosofia de Clarion
le hara mas facil remontar la curva de aprendizaje.

El cursillo sobre el Generador de Aplicaciones se encuentra en la seccion Aprendiendo Clarion.
Alli se presentan todas las herramientas de Clarion, y también le demostrara cuanto poder estara a
su disposicién cuando finalmente escriba algo de cédigo fuente usted mismo, para obtener mayor
funcionalidad.

Por favor, siga adelante. Apenas hemos rasgufiado la superficie, jy ain hay mucho mas!
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» - PANORAMA DEL PROCESO DESARROLLO

El Tao de Clarion

“Tao” significa “el Camino” en chino. Clarion es un camino completamente nuevo para crear
aplicaciones de Windows. jAsi lo demuestran las aplicaciones que acaba de crear en unos 30
minutos! Sin embargo, Clarion va mucho mas alld que sus Asistentes, de manera que ahora
dedicaremos un tiempo a explicar los conceptos centrales detras de estas herramientas.

Clarion es un lenguaje de programacion

A la base de Clarion (como herramienta de desarrollo) se encuentra el lenguaje de programacién
Clarion. Se trata de un lenguaje de cuarta generacion, de propdsitos generales, totalmente
orientado a objetos, que ha sido altamente optimizado desde su creacién para el desarrollo de
aplicaciones comerciales de base de datos. El lenguaje Clarion es el poderoso instrumento que
tiene ahora en sus manos. Pero Clarion es mucho mas que el lenguaje solamente: es también un
completo juego de herramientas disefiadas especificamente para la creacion y el mantenimiento de
aplicaciones de bases de datos.

En el nivel superior del lenguaje Clarion se encuentra el entorno de desarrollo. Es un conjunto de
herramientas completamente integrado que han sido especialmente disefiadas para el Desarrollo,
Mantenimiento y Mejoramiento Rapido de Aplicaciones. (Estas actividades son conocidas en
inglés como: Rapid Application Development, RAD; Rapid Application Maintenance, RAM;
Rapid Application Enhancement, RAE). Estas herramientas se orientan hacia la generacion
automatica del codigo fuente Clarion, de manera que usted no tenga que escribirlo. Es éste el
poder de Clarion: aunque usted puede escribir su propio codigo fuente, el conjunto de herramientas
puede generar (y regenerar) la mayor parte del cddigo “estandar”, dandole libertad para que usted
se concentre sobre los aspectos creativos de la aplicacién.

Niveles de abstraccion

Hay un principio en computacion que indica que, cuanto mas uno se aleja de los “fierros” (del
cédigo binario), mas productivo se puede ser.

Algo de historia

Las primeras computadoras se programaban en binario, lo que hacia muy dificil el trabajo del
programador. Luego aparecio el lenguaje Assembly (o “ensamblador”) que facilitd la tarea,




haciendo que el cédigo pudiera ser leido en términos “humanos”. Cada sentencia del lenguaje
Assembly producia s6lo una instruccion para la maquina.

Los primigenios programadores de Assembly advirtieron que escribian en forma repetitiva las
mismas secuencias de instrucciones para ejecutar funciones computacionales habituales. Debido a
esto, crearon los lenguajes de Tercera Generacién (3GL, como Fortran, C, PL/1, etc.) de manera
que cada sentencia de uno de estos lenguajes produjera mdaltiples instrucciones de maquina para
esas tareas habituales, lo que hacia ain mas productivos a los programadores. Con esto, se
elevaron a un nivel de abstraccion mas alto, mas alejado de los “fierros” del computador. La
desventaja era que s6lo podian generarse secuencias estandarizadas de codigo de maquina, lo que
hizo perder algo de la flexibilidad de trabajar directamente en Assembly.

En la actualidad: lenguajes 4GL

El mismo proceso se ha repetido para la creacion de los lenguajes de Cuarta Generacion (4GL)
como Clarion. Por ejemplo, el lenguaje Clarion maneja automaticamente todas las tareas comunes
de Windows (como el redibujo de la pantalla), que los programadores deben escribir
personalmente en los lenguajes 3GL. En Clarion, un clasico programa que diga solamente “jHola,
mundo!” lleva apenas nueve lineas de codigo fuente, jmientras que en C/C++ se deben escribir
mas de ochenta!

En términos generales, cuanto mas alto sea el nivel de abstraccion, méas productivo puede ser el
programador. A medida que sube el nivel de abstraccion, el trabajo del programador rinde mas, ya
que la computadora se encarga de los aspectos rutinarios, generando cédigo normalizado para
tareas comunes. Este es principio fundamental detras del juego de herramientas que componen
Clarion.

El secreto de la productividad.

El “problema” con operar a niveles méas altos de abstraccion es perder la flexibilidad para hacer las
cosas exactamente del modo que uno quiere. Con Clarion, este problema esta resuelto.

El secreto de la verdadera productividad sin pérdida de flexibilidad es éste: siempre hay que
operar al mayor nivel de abstraccién que se pueda para que el trabajo se haga, a la manera que
uno quiere que se haga. El juego de herramientas Clarion contiene mudltiples niveles de
abstraccion, lo que le facilita trabajar al nivel mejor para hacer exactamente lo que se necesita
hacer. Uno nunca se encuentra “atrapado” en un nivel alto o forzado a “arreglarselas” a bajo nivel.
El juego de herramientas genera cddigo fuente Clarion, orientado a objetos, utilizando la biblioteca
de construccion de aplicaciones de alto nivel (Application Builder Class [ABC] Library) y, cuando
hay necesidad, se puede afiadir cédigo propio a bajo nivel, para incrementar la funcionalidad de los
templates.

En otras palabras, el secreto de la productividad es trabajar con mas inteligencia, no mas
arduamente. Esto es lo que Clarion le permite hacer: escribe el cédigo estandar de manera que
usted no deba escribirlo personalmente. Pero tiene la suficiente flexibilidad como para que usted
afiada todos los “chiches” que desee (lo que resulta mucho mas entretenido).



Niveles de abstraccion de Clarion

En este punto, usted ha trabajado con los niveles de abstraccién mas altos de Clarion: los
Asistentes. Mas adelante, usted interactuara con la mayor parte de los elementos siguientes
(dejamos los titulos en inglés, porque es como los encontrara en los menus del programa):

Dictionary Editor (“Editor del Diccionario”)

El Diccionario de datos es el punto central de almacenamiento de todas las definiciones de los
archivos de datos y de las configuraciones preestablecidas para el ingreso de datos. Si hay
necesidad de tomar estas definiciones de un archivo de datos ya existente, el Diccionario puede
importarlas consultando el archivo de datos mismo.

Application Wizard

El Asistente para Aplicaciones genera una aplicacion “estandar” completa en s6lo minutos,
basado en las definiciones de datos y configuraciones del Diccionario.

Procedure Wizards

Los Asistentes para Procedimientos generan procedimientos comunes (como listados para
visualizacion -browse--, o fichas de ingreso de datos) basados en las configuraciones
establecidas en el Diccionario de datos.

Procedure Templates (“Plantillas para Procedimientos™)

Generan procedimientos comunes (como el ment del marco general de la aplicacion, o los
informes) basados en el disefio de ventana o de informe que usted crea en el Disefiador de
Ventanas y el Disefiador de Informes, y en las opciones que usted elija de las propuestas por el
template para crear el procedimiento.

Control Templates (“Plantillas de Control™)

Afiaden controles “estandar” a los disefios de ventana o de informe (como un control de
exploracion de arbol de archivos) y generan todo el codigo necesario para controlar su
desempefio.

Extension Templates (“Plantillas de Extension”)

Generar cadigo adicional en un procedimiento, que afiade funcionalidad sin relacion a ningin
control especifico (como el display de fecha y hora en la barra de estado principal de la
aplicacion).

Code Templates (“Plantillas de Cédigo™)

Generan codigo en un procedimiento que usualmente realiza una tarea Unica, relacionada a un
control especifico (como, por ejemplo, validacion del ingreso de datos).

Embedded Source Code (Incorporacion de codigo fuente)

Es posible escribir codigo propio en cualquiera de los muy numerosos puntos de insercion
(Embed Points), para personalizar o modificar el comportamiento del cédigo generado por los
Asistentes.

Source Template (Plantilla para codigo fuente)

Este Asistente le permite escribir enteramente a mano los procedimientos en lenguaje Clarion,
conservando la aplicacion dentro del Generador de Aplicaciones.



Bibliotecas: Windows APl'y C

En cualquier punto del cédigo Clarion que usted escriba (procedimientos completos o puntos
de insercidn), puede llamar directamente a funciones de la API de Windows o de una biblioteca
de funciones comunes en C, si fuese realmente necesario (los prototipos de funciones del
lenguaje C se incluyen en las ediciones profesional y empresarial de Clarion).

Cadigo C/C++ y Modula-2

Usted puede escribir las funciones C/C++ o Modula-2 que necesite, compilarlas con los
compiladores TopSpeed incluidos en las ediciones profesional y empresarial (también
disponibles separadamente) y linkearlas a la aplicacién Clarion.

Como puede verse, los niveles de abstraccién disponibles en Clarion cubren toda la gama, desde el
Generador de Aplicaciones hasta escribir codigo C (jo incluso Assembly, si quiere trabajar tanto!).

La clave de Clarion para la méaxima productividad

La clave es trabajar siempre al maximo nivel posible de abstraccién:
+ Deje que el Asistente para aplicaciones cree una aplicacion “inicial” para usted.

¢ Utilice los Asistentes para Procedimientos para afadir procedimientos nuevos, si son
necesarios.

¢ Modifiqgue lo que sea necesario en cada Asistente para Procedimiento utilizando las
herramientas interactivas de Clarion (como los disefiadores de Ventanas y de Informes).

¢ Afada Plantillas de Control, Extensién y Cddigo, si son necesarias para aumentar la
funcionalidad de la aplicacion.

+ Personalicela incorporando algo de cédigo fuente en los puntos de insercion.

¢ Cuando haya algo que ningin template pueda hacer, utilice la plantilla de Cédigo Fuente
(Source Template) y escriba en el lenguaje Clarion (u obtenga una plantilla de terceros que
haga lo que necesita).

¢ “Tirese a lo profundo” recurriendo a los niveles de la APl de Windows y la programacion en
C/C++ cuando sea absolutamente necesario.

He ahi la filosofia Clarion de trabajar con més inteligencia, no mas arduamente, dejando que el
conjunto de herramientas haga el trabajo repetitivo. Asi su productividad llegara muy alto, en
comparacion con otras herramientas que haya usado.

Programacién controlada por templates

El Generador de Aplicaciones es “controlado por templates”. Esto significa que es una herramienta
que cambia segln las configuraciones de la plantilla que se use para generar el codigo. Las
plantillas de procedimiento, control, extension y codigo todas escriben lenguaje Clarion por usted,
dandole un tremendo impulso a su productividad. Los templates de Clarion ofrecen muchos de los
beneficios de la programacion orientada a objetos, especialmente la capacidad de reutilizacion, y
el conjunto de plantillas estandar genera verdadero codigo orientado a objetos utilizando la



biblioteca de construccion de aplicaciones de alto nivel (ABC Library). Esto convierte a las
plantillas en la verdadera clave del Desarrollo Rapido de Aplicaciones que ofrece Clarion.

¢, Qué es un template?

En Clarion, un template no es una herramienta de generacion de cédigo “de un solo uso”, que
después usted deba encargarse de mantener (como las llamadas “plantillas” o “templates” de otros
lenguajes), sino que es una herramienta permanentemente interactiva que pide la
informacion especifica necesaria para generar el cédigo. Si usted cambia la informacion, el
template escribe cédigo diferente la proxima vez que genera la aplicacién. Es esta interactividad lo
que permite el Mantenimiento Réapido de aplicaciones.

Los templates de Clarion le permiten insertar su propio codigo fuente Clarion en cualquiera de los
numerosos puntos de insercion disponibles dentro de cada plantilla. Esto hace innecesario
mantener el cédigo generado para modificar el comportamiento de la aplicacion. También
garantiza que las personalizaciones especiales no seran sobreescritas la proxima vez que se genera
el codigo fuente: el template respeta el cédigo insertado dentro de su propio codigo. Esta facilidad
de personalizacién y adaptacion hace de los templates la clave para el Mejoramiento Rapido
de Aplicaciones.

Todos los templates se guardan en el archivo de registro (REGISTRY.TRF). Este archivo
contiene codigo ejecutable preescrito y estructura de datos que pueden modificarse y reutilizarse.
Se puede usar el Registry para modificar el disefio de la ventana estandar de cada template para
que aparezcan del modo que usted prefiere al crear un procedimiento.

Las plantillas de Clarion son modificables. También pueden afiadirse templates de terceros, o usted
puede escribir los propios, y usarlos ademas de, y conjuntamente con los templates originales. Esto
hace del Generador de Aplicaciones una herramienta infinitamente extensible.

;/COmo se usan los templates?

Al crear un procedimiento nuevo, usted debe identificar la plantilla de procedimiento que genera el
codigo apropiado a la tarea que debe desarrollar, y luego puede personalizarlo con las herramientas
de desarrollo. Estas plantillas incluyen elementos como “ventanas de visualizacién de listados”
(browses), para ver grupo de registros, y “ventanas de fichas o formularios” (forms) para modificar
un registro por vez. Si el procedimiento es para una ventana que incluye un men, las acciones del
menu se afiaden automaticamente al arbol de procedimientos, y se las marca inicialmente como
“ToDo” (por realizar).

El modo habitual de personalizar o modificar un procedimiento es ejecutar una de las herramientas
de disefio. Los Disefiadores de Ventana y de Informe son herramientas de disefio visuales que
permiten trabajar mediante el método de “apuntar y dar cLic”. Usted s6lo debe tomar un control de
una caja de herramientas, dar cLic para ubicar el control, y luego un CLIC DERECHO para
modificarle las propiedades.
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Una vez que se ha creado un procedimiento, también se pueden usar las plantillas de Control,
Extension y Codigo para afiadirle ain mas funcionalidad. Las plantillas de Control contienen
controles y generan todo el cddigo ejecutable necesario para usarlas y mantenerlas. Todos los
controles preconfigurados que aparecen en los disefios de ventanas estandar en los templates de
procedimientos son en realidad plantillas de control que realizan todas las funciones necesarias.

Las plantillas de extensién afiaden codigo ejecutable que incrementa la funcionalidad del
procedimiento. Cada uno ofrece instrucciones en pantalla sobre qué datos debe proveer el
programador para incorporar la funcionalidad del template a la aplicacién.

Otra forma de adaptar un procedimiento es afiadir codigo incorporado propio. EI Generador de
Aplicaciones muestra un arbol que indica todos los puntos de insercion de que se dispone: antes,
durante o después de la légica principal del procedimiento, y para cada “evento” que puedan
generar la ventana o los controles incorporados. También se puede escribir codigo incorporandolo
dentro del cédigo fuente generado. Asi uno puede elegir el punto légico exacto en que debe
gjecutarse el codigo, para luego escribirlo “a mano”, o activar una plantilla de Cadigo para que lo
haga en su lugar. El Generador de Aplicaciones produce todo el cddigo fuente a partir de los
templates y de las modificaciones personales que usted haya realizado (incluyendo el cédigo
fuente incorporado).

Clarion tiene una amplia variedad de templates estandar para ayudarlo a desarrollar aplicaciones
rapidamente. Asi como el capitulo Cursillo para un rapido comienzo lo introdujo a los Asistentes,
el cursillo sobre el Generador de Aplicaciones en la Segunda Seccién de este manual lo introduce
al uso de las plantillas de Clarion para producir cualquier aplicacion de Windows que necesite.
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El entorno de desarrollo contiene varias herramientas principales, todas las cuales son accesibles
entre si. Al utilizar el Generador de Aplicaciones, hay botones y menuds que llevan a otras

herramientas.

El siguiente esquema de flujo muestra como todas las herramientas interacttian entre si y con el
registro de los templates, ubicando al Generador de Aplicaciones al centro de todo el proceso:

Template Definitions Data Definitlons
Templata Reglstry Data Dictionary
{REGISTRY.TRF) (. DCT)

Definiciones de Plantillas

Definiciones de Datos

{ ]

Embedded Source
Text Editer

Editor de Texta

Application Generator
(~.APP)

Generador de Aplicaciones
Formulas

Farmula Editer
Editor de Farmulas

Window Structures
Window Formatter

Dizefiadar de Vertanas

Report Structures
Baport Formatter

Disefiadar de Infarmes

Source Generatlon
[REGISTRY.TRF)

Zeneracion de Cod. Fuente
A

!
: 3

Generated Source Code
[~.CLW)

Chdigo Fuente Generado ¥ Linkeado

Complle & Link Options
Projact System
Cipciones de Compilacion

1 J
e

Compile & Link

Compilacié-n y Linkeado
A

Executable
{.EXE Flie)

Ejecutable

Debugger

Depurador




Esta seccion ofrece una descripcion de cada herramienta, en el orden que un programador tipico
utilizando el Generador de Aplicaciones podria encontrarlas. Cada herramienta contiene cajas de
didlogo que el programador rellena para indicar las funcionalidades de la aplicacién al Generador
de Aplicaciones. Cuando usted lo desea, el Generador de Aplicaciones genera el cddigo fuente
especificado, y el Project System lo compila y linkea para convertirlo en un programa ejecutable.

Programar en Clarion es, de variadas maneras, un viaje personal a través de una serie de cajas de
didlogo. No hay una secuencia obligatoria que deba seguirse; aunque haber llenado algunos es un
prerrequisito para alcanzar otros.

El Editor del Diccionario

El Diccionario de Datos (un archivo .DCT), se mantiene mediante el Editor del Diccionario. Aqui
se guarda una descripcion de la base de datos, que incluye los archivos, claves, indices,
controladores, relaciones entre archivos, campos, reglas para la validacién de campos,
restricciones para la integridad referencial, y mas. Este es el primer archivo que uno crea cuando
disefia una aplicacion.

Se pueden crear las definiciones de archivo “desde cero”, o pueden importarse las definiciones de
archivos de datos existentes. Si usted posee la edicién empresarial, puede utilizar el Sincronizador
de Diccionario para coordinar un diccionario de datos Clarion con un diccionario del motor SQL.
Esto permite tomar de una vez todas las definiciones de archivo de una base de datos SQL ( lo que
elimina muchisimo trabajo) y mantener el diccionario de datos Clarion coordinado
permanentemente con el ambiente SQL RDBMS, sin importar los cambios que haga el
Administrador de la Base de Datos SQL.

Las otras herramientas del entorno de desarrollo utilizan la informacion en el Diccionario para
permitirle, por ejemplo, colocar facilmente campos de datos en una caja de dialogo disefiada para
el usuario final. EI Generador de Aplicaciones crea codigo para todas las sentencias que acceden a
los archivos de datos, basandose en como esta construido el Diccionario. De hecho, jel Asistente
de Aplicaciones puede generar una aplicacion totalmente funcional basada exclusivamente en su
Diccionario de Datos!

El Generador de Aplicaciones

El Generador de Aplicaciones genera el cddigo fuente de la aplicacién, un procedimiento a la vez,
basado en las plantillas que se han elegido del template registry. Permite afiadir variables de
memoria globales y locales, y adaptar los procedimientos con herramientas de disefio visual y
cadigo fuente insertado.

El Generador de Aplicaciones da acceso a las deméas herramientas del ambiente de desarrollo para
poder personalizar el aspecto y la funcionalidad de las ventanas, menus, informes y otros
elementos de la interfaz con el usuario. Los templates proveen sus propios controles (que aparecen
dentro del Generador de Aplicaciones), que le permiten al programador dar la informacién
necesaria para que el template personalice la funcionalidad deseada.



El Disefiador de Ventanas

Aqui se realiza el disefio visual de todas las ventanas y controles de la aplicacion (todo lo que ve el
usuario final). Genera automaticamente el cdédigo fuente para los elementos que usted disefia
visualmente sobre la pantalla.

El Disefiador de Informes

El Disefiador de Informes trabaja con el Generador de Aplicaciones de una manera muy similar al
Disefiador de Ventanas. EI programador se limita a poner controles en una pagina de informe. En
tiempo de ejecucion, el motor de informes procesa los registros, encargandose de todo el manejo
de las paginas impresas, division de datos en grupos, encabezamientos y pies de pagina, segin se
especifique.

El Editor de Textos

El Editor de Textos es un editor de programacién plenamente funcional que se puede usar para
escribir el cédigo fuente que su aplicacion necesite. Lo mas probable es que, al usar el Generador
de Aplicaciones, utilice el Editor de Textos para crear cddigo fuente insertado, personalizando la
operacién del procedimiento. O, también, se pueden crear aplicaciones completas “desde cero” (si
realmente quiere tomarse todo es trabajo).

El Editor de Textos resalta mediante colores las distintas partes de la sintaxis, lo que facilita
identificar las distintas partes del lenguaje Clarion, al leerlo y modificarlo. También tiene
capacidad plena de busqueda y reemplazo, ademas de las herramientas habituales para la edicion.

El Editor de Formulas

El Editor de Férmulas le ayuda a generar y manejar formulas simples o complejas, basadas en todo
tipo de expresiones matematicas o alfanuméricas. El Editor de Formulas ofrece comprobacion de
la sintaxis, y acceso inmediato a todas las variables, funciones y operadores, de manera que las
férmulas generadas son siempre sintacticamente correctas.

El Sistema de Proyecto

El Generador de Aplicaciones crea automaticamente el archivo de proyecto (.PRJ) de las
aplicaciones. Este archivo contiene opciones para la compilacién y el linkeado, como si incluir
codigo para depuracion, opciones de optimizacion, archivos externos, archivos de codigo fuente,
bibliotecas y otros archivos que deban incluirse en los procesos de compilacion y linkeado.

Los Depuradores

La depuracion de un programa generalmente requiere ejecutar un programa e irse deteniendo
repetidamente en varios puntos de su ejecucion para examinar el valor de distintas variables, para
determinar la causa de los errores l6gicos que pueda tener. Los Depuradores (Debuggers) Clarion
(tanto de 16 como de 32 bits) tienen varias ventanas que muestran el codigo fuente, los contenidos
de las variables, procedimientos activos, y mucho mas.
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Hay tres cursillos sobre el uso de los Depuradores contenidos en el User’s Guide. Le
recomendamos estudiarlos, después de terminar todos los cursillos de este libro.

Avuda en linea

Clarion ofrece una amplia ayuda en linea sensible al contexto, desde casi cualquier pantalla. Dé un
CLIC sobre el boton Help, u oprima F1.

La seccién Common Questions (“Preguntas habituales”) de la ayuda en linea ofrece instrucciones y
ejemplos para realizar tareas comunes en las aplicaciones. Usted puede copiar y pegar ejemplos de
cédigo directamente desde el sistema de ayuda a su programa. Elija Help >  Contents, y luego
oprima el botén How do I...? (“¢C6mo hago para...?"”)

El Sistema de ayuda en linea de Clarion incluye un archivo principal de ayuda, ademas de archivos
auxiliares. Puede buscarse en los archivos en linea mediante palabras clave y mediante un indice.
Para realizar bisquedas en los archivos auxiliares, abralos directamente con el Explorador de
Windows o el Administrador de Programas.

¢, Qué sigue ahora?

¢A donde ir para conocer mas sobre la programacion con Clarion?

+ Continde con la seccion Aprendiendo Clarion . Los dos cursillos que siguen estan disefiados
para introducirlo a todas las herramientas de desarrollo que Clarion ofrece.

¢ Unisoft ofrece diversos cursillos.
¢ Llame al 372-7243/9850 o0 374-2998/9469 para informarse.

¢ Los usuarios registrados en la lengua hispana, pueden consultar a la siguiente pagina de
Internet: http://www.unisoft.com.ar.

¢ Unase (o forme) un Grupo de Usuarios Clarion local, y participe en proyectos de estudio
conjunto con otros desarrolladores Clarion.

+ Participe en el foro de TopSpeed en CompuServe (GO TOPSPEED) o en el grupo de noticias
de Internet comp.lang.clarion, para formar una red con los programadores Clarion de todo el
mundo (jMuy recomendado!)

Buena suerte, y jadelantel. La potencia de programacion que Clarion pone en sus dedos sigue
creciendo a medida que usted mas la conace.
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INTRODUCCION

iBienvenido nuevamente!

La seccion anterior presento el entorno Clarion y los Asistentes. Ahora estudiaremos como usar el
resto de las herramientas que ofrece Clarion para crear aplicaciones efectivas. Esta seccion
contiene dos cursillos, a niveles muy diferentes.

¢ Cursillo sobre el Generador de Aplicaciones que lo familiariza con todas las herramientas
del Entorno de Desarrollo Clarion.

+ Cursillo sobre el Lenguaje Clarion que presenta este lenguaje y lo pone en contacto con el
tipo de cddigo que genera el entorno de desarrollo.

Qué hay en esta Seccion

Cursillo sobre el Generador de Aplicaciones

Capitulos 1 al 12: presentacion de todas las principales herramientas de desarrollo Clarion.
Comienza en la etapa de planificacion de la aplicacion , lo que lleva hacia la creaccion del
diccionario de datos con el Editor del Diccionario, y lo conduce para crear una aplicacion
completa con el Generador de Aplicaciones. Al terminar el cursillo, usted habra creado una
aplicacién completa de ingreso de pedidos y emision de informes.

Utilizara el Generador de Aplicaciones y trabajara con las plantillas de Procedimiento, Control
y Cédigo para producir esa aplicacion. Trabajara con el Disefiador de Ventanas y de informes.
Usara el Editor de Textos para incorporar codigo fuente Clarion en el codigo fuente generado
por las plantillas.

Cursillo sobre el lenguaje Clarion

Capitulo 13: Presenta el lenguaje a nivel de programacién manual. Comienza con el simple
“iHola mundo!”, y después lo conduce hacia la creacion de ejemplos sencillos de los
procedimientos mas comunes de las aplicaciones Clarion; todo mientras se explica la
funcionalidad del codigo que usted escriba, y su vinculacion con el cédigo que produce el
Generador de Aplicaciones.
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Convenciones en la documentacion

Convenciones tipograficas:

Bastardillas Indican qué debe tipearse en el teclado, como
por ejemplo: Escriba esto. También,
ocasionalmente, se utilizan para destacar
algunas palabras o frases, o indicar expresiones
en idioma extranjero.

VERSALITAS Indican pulsaciones de teclas, como ENTER 0
ESCAPE, 0 dar un cLIC con el mouse.

Negritas Indican 6rdenes u opciones de un menu o texto
en una ventana de dialogo. Note: este estilo
también puede usar una familia tipografica
diferente, para igualarse a las negritas en
Helvética que utiliza Windows como fuente del
sistema.

LETTER GOTHIC Se utiliza para diagramas, listados de cédigo
fuente, para comentar ejemplos, y para
ejemplos del uso de sentencias de cadigo.

Convenciones del teclado

Fl Indica oprimir y soltar una tecla; en este caso,
por ejemplo FI.

ALT+X Combinacion de teclas, en este caso, oprima la
tecla ALT y mientras lo hace, pulse X, y luego
suelte ambas teclas.



Anatomia de una base de datos

Describiremos aqui brevemente los elementos basicos del disefio de bases de datos. Solamente nos
proponemos ofrecer un repaso del tema para quiénes no estan plenamente familiarizados con los
conceptos comunes del disefio de bases de datos. Los desarrolladores experimentados pueden
omitir esta seccién y avanzar directamente al proximo capitulo.

Definiciones

Una base de datos (database) es un conjunto de informacion (datos) organizada en un sistema
de archivos, registros y campos. La base de datos se mantiene mediante uno 0 mas programas o
aplicaciones informaticas.

La unidad basica de almacenamiento de datos es un campo (field). Un campo es un sitio donde se
guarda informacion de un mismo tipo. Por ejemplo, un campo puede almacenar un nombre y otro
campo puede guardar un ndmero de teléfono.

Un grupo de campos diferentes que se vinculan légicamente conforman un registro (record). Un
registro contiene toda la informacion vinculada a un tema. por ejemplo, todos los campos con
informacidn sobre un estudiante (nombre, direccién, nimero de teléfono, ndmero de estudiante,
etc.), estan reunidos en el registro del alumno. Este se asemeja al expediente o ficha que la escuela
tiene de cada estudiante.

Un conjunto de registros vinculados I6gicamente conforman un archivo (file). Siguiendo la
analogia, una colecion de todas las fichas de alumnos producen el archivo general de estudiantes.
Esto se asemeja a los archivadores donde se guardan los expedientes de los alumnos.

Otra forma de visualizarlo es mediante una planilla:

Humber First Mame | Lazt Mame I ajor
06657223 |Dan Headman E nglizh
169-91-7542 | Gary Pack E nglizh
105.22.0862 | Diane uirn E nglizh
141-02-7461 | Alvin L Bailey Computer Science
123-44-9999 |Dehb Erown Computer Science
1071-71-063 Computer Science
190439124 | Nina Rabb S acialagy
23875138 | Steve Stare Sociology
188677396 | Raobin Bailey Business
164108264 |Jokhn Uber Buziness
207953939 | Brian il Busziness
1TEE2-4EED | Robert M acdanald Law

En este formato, la tabla completa es un archivo, cada fila es un registro, y las columnas
representan campos.

Una base de datos es una coleccion de archivos vinculados, también llamados tablas (tables).
Esto se asemeja a un grupo de ficheros en que se guardan todos los registros de la escuela. Un
fichero guarda los archivos con los datos personales de los alumnos; otro, con datos sobre los
cursos; y un tercero, con informacion sobre el personal.
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Una base de datos es un conjunto de tablas que guardan entre si relaciones definidas El buen
disefio de bases de datos separa la informacion en archivos relacionados que se vinculan mediante
campos de enlace. Pronto veremos mas sobre esto.

Resumen:

Uno 0 mas campos se combinan para formar un registro.
Uno 0 mas registros se combinan para formar un archivo.

Un conjunto de archivos vinculados es una base de datos.

Sistemas y controladores de archivos

Hay numerosos formatos de archivos utilizados en las PCs. Se trata de los formatos fisicos de
almacenamiento en el disco que utilizan los programas que mantienen los archivos de datos.
Clarion admite numerosos formatos, gracias a la tecnologia de controladores (drivers) de
TopSpeed. Estos controladores permiten a los programas Clarion leer y escribir esos distintos
formatos.

La edicion estandar trae controladores para los formatos TopSpeed, Clarion, ASCII, BASIC y
DOS. Las ediciones profesional y empresarial incluyen Btrieve, ODBC, Clipper, dBase Il y IV, y
FoxPro. Si necesita utilizar datos de otro sistema de archivos, puede adquirir los controladores
apropiados y afadirlos a las ediciones profesional y empresarial. Péngase en contacto con su
distribuidor para conocer si el driver que necesita esta disponible.

Cada sistema de archivos tiene sus particularidades y limitaciones. Para méas informacion, consulte
el apéndice Database Drivers en la User’s Guide.

Tipos de datos

Los campos pueden guardar muchos tipos diferentes de datos, pero cada campo individual puede
guardar solamente un tipo. Cuando se define el campo, se especifica el tipo de datos. Por ejemplo,
para guardar un nimero de 0 a 100, se usa un campo definido como un Unico BYTE ocupa menos
espacio que uno definido como nimero decimal (un byte puede guardar cualquier nimero entero,
sin signo, entre 0y 225).

Clarion admite los siguientes tipos de datos (documentados plenamente en el capitulo 3 de la
Referencia del Lenguaje):

Alfanuméricos (Alphanumeric)

STRING Campo que guarda un numero especifico de caracteres
alfanuméricos y otros caracteres ASCII.

PSTRING Campo que guarda una cadena de caracteres con un byte inicial de
longitud que indica el ndmero de bytes en la cadena. Este es el tipo
de datos utilizado en el lenguaje Pascal y el tipo de datos
“LSTRING” del Administrador de Registros Btrieve.
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CSTRING

Entero (Integers)

BYTE

SHORT

USHORT

LONG

ULONG
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Campo que guarda una cadena de caracteres y que termina en un
cararer nulo; ASCII cero (0). Este tipo de datos usado en el
lenguaje “C” y el tipo de datos “ZSTRING’ del Administrador de
Registros Btrieve.

Campo de un byte que guarda un entero sin signo de 0 a 225
positivo).

Campo de dos bytes que guarda un entero con signo, de -32.768 a
32.767.

Campo de dos bytes que guarda un entero sin signo de 0 a 65.535
(positivo).

Campo de cuatro bytes que guarda un entero con signo desde
-2.147.483.648 a 2.147.483.647.

Campo de cuatro bytes que guarda un entero sin signo desde 0 a
4.294.967.295.

Numeros de coma flotante (reales) (nUumeros con fracciones)

REAL

SREAL

BFLOATS

BFLOAT4

Campo que guarda un ndmero de ocho bytes con signo y coma
flotante, con 15 digitos significativos.

Campo que guarda un ndmero de cuatro bytes, con signo, con
coma flotante y seis digitos significativos. EI SREAL utiliza el
formato de short real (precisién simple) de los procesadores Intel
8087.

Variacion del REAL, este tipo almacena un nimero de ocho bytes
con signo, coma flotante y ocho bytes segln el formato de doble
precision del BASIC de Microsoft.

Variacion del tipo de datos SREAL, un campo BFLOAT4 guarda
un ndmero de cuatro bytes, con signo y coma flotante, que utiliza
el formato de precision simple del BASIC de Microsoft.

Numeros decimales empaquetados (packed decimal)

DECIMAL

PDECIMAL

Campo que guarda un valor decimal empaquetado, con signo, que
va desde  -9.999.999.999.999.999.999.999.999.999.999 a
9.999.999.999.999.999.999.999.999.999.999.

Campo que guarda un nimero decimal con signo en el formato
decimal empaquetado de Btrieve e IBM/EBCDIC. La Unica
diferencia entre un DECIMAL y un PDECIMAL es el lugar
donde guarda el signo.



Otros tipos de datos

DATE Campo de cuatro bytes que guarda una variable de fecha en el
formato del Administrador de Registros Btrieve.

TIME Campo de cuatro bytes que guarda una variable de hora en el
formato del Administrador de Registros Btrieve.

GROUP Campo légico que contiene mdltiples campos de datos. Por
ejemplo, un campo GROUP Ilamado NumTeléfono podria
contener dos campos: DDN y Teléfono. Un campo de grupo
(Group) puede usarse en forma conjunta o cada uno de sus
componentes individuales.

PICTURE Aunqgue PICTURE no es un tipo de datos, cuando se lo selecciona,
declara un tipo de datos STRING con un formato de visualizacion
0 mascara (como @P###P) que define el nimero de caracteres de
la cadena. El formato de visualizacién utilizado para la
declaracién del campo se ingresa en el campo “Record Picture”.
Esto resulta practico para campos cuyo formatos de
almacenamiento y de visualizacion sean diferentes.

Ordenamiento de los datos: claves e indices

Uno de los aspectos mas poderosos de una base de datos informatizada es la capacidad de ordenar
datos de muchos modos diferentes. Hacer esto manualmente requiere multiples copias de las
fichas, muchas carpetas y mdltiples archiveros. También llevaria mucho tiempo archivar cada
copia en los distintos lugares, segun su ordenamiento.

Por el contrario, en una base de datos informatizada, el ordenamiento requiere solamente definir
una serie de “claves” o “indices”. Estos declaran ordenamientos adicionales al orden fisico de los
registros dentro del archivo de datos. En algunos sistemas de archivos las claves se mantienen en
archivos separados, en otras, comparten el mismo archivo que los datos. La tecnologia de
controladores de archivos de TopSpeed maneja transparentemente esas diferencias.

Las claves e indices son funcionalmente equivalentes. Solo difieren en la forma en que se
mantienen en cada aplicacion:

¢ Una clave es mantenida en forma dinamica. Cada vez que se afiade, modifica o borra un
registro, se actualiza el ordenamiento. Las claves sirven para ordenamiento de uso frecuente.

¢ Un indice no se mantiene dinamicamente, ya que se lo construye (build) sélo cuado es
necesario. Los indices son Utiles para crear ordenamientos de uso ocasional, como para los
procesos que se corren a fin de mes, o a fin de afio.

Siguiendo con nuestro ejemplo de un archivo escolar, supongamos que queremos ordenar los
registros de alumnos de dos modos: alfabéticamente por nombre, y por nombre dentro de cada
materia. Esto produce dos ordenamientos alternados.



123-44-3333

Deh

B rowin

P Lurnbser First Mame | Last Mame b sjor
1871-02-7481 | Alvin L B ailey Cormputer S cience
188-67-7336 | Robin Bailep Business

Computer Science

101-F1-0630  [Jemy CompLke
206-65-7223 | Dan Headman English
116-62-4660 | Rabert Macdonald Law
168-91-7542 | Gay Fack English
102-22-0862 | Diane Quinn English
180-43-9184  |Mina Robb Sociology
223-87-5138 [ Stewve Stone Sociology
164-10-8264  |John ber Business
207-95-2939 | Brian Wilzay Businzs:

Este ejemplo utiliza una clave de un componente sobre el nombre de los estudiantes.

El siguiente ejemplo tiene dos componentes en la clave: curso y nombre del estudiante. Una clave
puede contener mas de un campo, lo que permite ordenamientos dentro de otros
ordenamientos.

Humber First Mame | Last Mame [GET |
206-65-7223 | Dan Headman Englizh
168-91-7242 | Gary Pack Englsh
105-22-0863 | Diane Quirm Englizh
141-02-7467 | AlwinL Bailey Computer Science
-44—99 [eb Brown Computer Scisne

Ut-r1-0540 te CE
180-43-9184 | Nina Robb Sociology
223-87-5133 | Steve Stone Sociology
188-67-7396 | Rabin Bailey Busiress
164-10-8264  |.Jahn Uber Buziness
207-95-3339 | Brian il Business
116-62-4660 | Robart M andon ald Law

Ordenamientos ascendentes y descendentes

Algunos sistemas de archivo permiten ambos tipos de ordenamiento para las claves o sus
componente (como, por ejemplo, el sistema de archivos TopSpeed). Otros sistemas solamente
sustentan el orden ascendente, lo que significa que los datos sélo pueden ordenarse de menor a
mayor (por ejemplo, el sistema de archivos Clarion).

El siguiente ejemplo tiene dos componentes en la clave: Afio de graduacion (descendiente), y
nombre del estudiante).

First Marme




Uso de las claves como limitadores

Supongase que desea crear un informe de inscripcién a cursos de una base de datos que contiene
informacidn de los Gltimos quince afios. Para este informe, sdlo nos interesan los Gltimos tres afios.
Se puede reducir drasticamente el tiempo de procesamiento si se usa una porcion del archivo de
datos que contenga solamente los registros de los Ultimos tres afios. Esto se hace en dos etapas:

¢ En primer lugar, debe definirse una clave para ordenar los datos por la fecha de cada curso.

¢ Después, hay que definir los limites que nos interesan. Un limite de alcance (range limit),
también llamado “limite de busqueda” especifica un subconjunto (subset) a procesar, tomada
del archivo completo. Solamente se consideraran los registros que caen dentro del limite.

En este ejemplo, solo se procesara un quinto de los registros (suponiendo que cada afio tiene
similares caracteristicas). Al reducir el nimero de los registros en un 80 por ciento, el tiempo de
procesamiento disminuye en la misma proporcion.

Relaciones entre archivos

Uno de los fines del disefio de bases de datos relacionales es reducir los datos redundantes. La
regla basica es que los datos deben ubicarse solamente en un lugar. Esto apareja dos clases de
beneficios: en primer lugar, reduce las exigencias de espacio de almacenamiento. En segundo
lugar, facilita el mantenimiento de la base de datos. Para alcanzar este objetivo, las bases se
dividen en archivos separados, pero relacionados, mediante un proceso llamado normalizacion de
los datos.

El primer paso es mover los datos que se repiten a distintos archivos. Por ejemplo, si un estudiante
podia tomar un maximo dede seis materias, hay que disefiar el fichero de estudiantes para contener
seis campos de materias (matl, mat2, mat3, etc.). Pero no se usaran todos esos campos en cada
registro. Si un estudiante toma las seis materias, su registro estara completo; pero si otro estudiante
toma solamente una, habra seis campos vacios en su registro. Por esta razén, los campos de
materias se mueven a un archivo separado, lo que elimina la necesidad de reservar espacio para
campos vacios. Esto crea una relacién uno-a-muchos. (Un estudiante puede tomar Muchas clases)
entre el archivo de estudiantes y el archivo de materias.

El siguiente paso es mover los datos redundantes a archivos separados. Cada campo en el archivo
de estudiantes debe depender de la clave primaria (NUmero de estudiante). EI nombre, direccién y
teléfono permanecen en el archivo de estudiantes. Pero la descripcion del curso de cada estudiante
podria moverse a un archivo separado. Esto elimina la necesidad de repetir la descripcion del curso
para cada alumno dentro de ese Curso. Para hacerlo, hay que afiadir un campo de nimero de Curso
al archivo de estudiantes y al archivo de cursos. Esto crea una relaciéon de muchos-a-uno (Muchos
estudiantes siguen Un curso) entre el archivo de estudiantes y el archivo de cursos.

Una vez que se ha “normalizado” el almacenamiento de informacion, los datos relacionados se
vinculan haciendo que cada archivo tenga un campo idéntico a otro en el archivo relacionado. Un



campo de enlace podria ser el nimero de estudiante, el nimero de curso, o un ndmero de aula.
Cualquier campo (o grupo de campos) que identifica en forma univoca un registro en el archivo

primario, puede usarse como enlace.

Se pueden encontrar ejemplos de esas relaciones en el archivo de datos.

+ Un profesor ensefia muchas (varias) materias( uno-a-muchos).

Ll N

Nunbe Fizl Haine

14: Ben

Cescriztion Scheduled Time|Room Mumber |
icrocomputers hd 4 SC0 il
icrocarmputers kA 1100 381
Logic & Algerithms kA 1200 am
Logic & Algcrithms T-Th1:z00 30

¢ Muchos estudiantes compartirdn un curso (muchos-a-uno).

101-7A10630 | Jemy Cade Englizh
Z06-BR-7223 | Dan Headman Ernglizh
168-91-7542 | Gay Fack Englizh
105220863 | Diane Quinn English

141 -02-7 481 &lwinL Bailey Compuker 5cience
123-44-9993 | Deb Erown Computer Science
180-4359184 | Mina Fiabb Socialogy
2298786138 | Steve Stone Sociology
188677396 | Hohin Bailey Busineszz
164-10-8264 | Johin Lber Buziness
2079552933 |Bran Wil o Busimesz
116-62-4660 | Robert Macdonald Law

Bases de datos: resumen

¢ Una base de datos es un conjunto de informacién (datos organizado en un sistema de
campos, registros y archivos.

¢ Los campos pueden guardar muchos tipos diferentes de datos, pero cada campo individual
solo almacena de una sola clase.

¢ Cadaporcion de informacion debe guardarse en un solo lugar.

¢ Uno o mas campos componen un registro. Uno o mas registros componen un archivo. Un
grupo de archivos relacionados componen una base de datos.

¢ Lo programas Clarion pueden acceder a numerosos sistemas de archivo mediante el uso de
controladores de archivos.

¢ Las claves e indices declaran ordenamientos distintos del orden fisico de los registros dentro
del archivo, y pueden contener mas de un campo, lo que permite ordenamientos secundarios
dentro de un ordenamiento.

¢ Los limites de busqueda (range limits) permiten procesar un subconjunto de registros, lo que
reduce el tiempo de procesamiento.

¢  Los archivos se relacionan a través de campos comunes, que contienen datos idénticos, lo que
ayuda a eliminar informacion redundante.
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LECCION 1 PLANEAMIENTO DE LA APLICACION 69

1 - PLANEAMIENTO DE LA APLICACION

Por regla general, cada minuto invertido en planear la aplicacion, ahorra diez minutos después.
Este capitulo describe informalmente el proceso de planeamiento de la aplicacion que crearemos
en los capitulos subsiguientes. En el mundo real, probablemente habria que crear una
especificacion funcional previa, por escrito, de las aplicaciones a realizar. Esta descripcion
informal define:

¢ Las tareas que realiza la aplicacion.

+ Los datos que la aplicacién mantiene, y como los guarda.

Como punto de inicio, la aplicacion del cursillo del Generador de Aplicaciones usa el
diccionario de datos de la aplicacién que usted ya cre6 usando los Asistentes en la seccién anterior
de este manual. Extiende el concepto a un sistema simple de Pedidos, usando el diccionario de
datos para el seguimiento de los clientes.

Definicion de las tareas de la aplicacion

La aplicacion mantendra los archivos de clientes y de pedidos para una empresa industrial. La
primera tarea para planear lo que la aplicacion hara es evaluar lo que la empresa espera que haga.

Para los fines de este cursillo, la aplicacion que crearemos es un sistema simple de ingreso de
pedidos. Es comun que los clientes hagan pedidos telefénicos para uno o mas productos por vez. A
la noche, el departamento administrativo imprime la orden para deposito.

Por lo tanto, la aplicacion debe proveer:
+ Cajas de didlogo de ingreso de datos, para tomar el pedido, 0 modificarlo después.

+ Acceso a la lista de clientes desde dentro de los formularios de pedido. La lista de clientes es la
que ya se creo con el Asistente para un Rapido Comienzo, guardado en el archivo de clientes.

¢ Acceso a la lista de nimeros de repuestos (articulos) que fabrica la compariia desde los
formularios de ingreso de pedidos.

+ Ventanas de visualizacion de transacciones de ventas.
+ Procedimientos que mantengan la lista de Productos e informacién sobre Clientes.

¢ Informes impresos.
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La primera tarea al planear la estructura de archivos es evaluar qué datos necesita la aplicacién, y
cémo guardarlos con un minimo de duplicaciones.

El buen manejo de las bases de datos requiere mantener archivos de datos separados para cada
"entidad" o grupo de datos. Las "entidades de datos" que mantendré esta aplicacién son:

Cliente Nombre y direccion de los clientes (ésta dltima s6lo
cambia si el cliente se muda). Creado en el "Cursillo
para un rapido comienzo", conjuntamente con el
archivo de Teléfonos.

Pedidos Informacion basica necesaria para ensamblar los datos
necesarios para imprimir una nota de pedido. Hace
"consultas" a la informacion de otros archivos, como
nombre y direccion de los clientes. Cuando una persona
hace un pedido nuevo, se afiade un registro a este
archivo.

Detalle Producto, precio y cantidad de un articulo dado en un
pedido: la informacion variable de cada pedido Aunque
esto produce un duplicado de la informacidn de precios
en el archivo de Productos, debe mantenerse aqui el
precio del momento de la venta. De lo contrario, el
monto variaria cuando cambien los precios en archivo
Productos.

Productos Informacion sobre los productos vendidos por la
empresa, incluyendo su numero, descripcion y precio.
Estos datos cambian solamente cuando hay un cambio
de precios, o0 se afiade un producto. *

*Nota del Traductor: En la version original, el archivo de Productos se llama "Products”
y, por ejemplo, el de Teléfonos, "Phones". Como se ve, ambos nombres de
archivos no superan las ocho letras permitidas tradicionalmente por el DOS. En
castellano, tanto "Productos" como "Teléfonos" tienen mas de ocho letras. Si
usted usa Windows 3.x debera llamar a estos archivos "Producto” y "Teléfono".
Quienes usen Windows 95 y superiores podran usar cualquier denominacion. En
adelante, para facilitar la lectura en estos casos y otros similares usaremos el

nombre de archivo largo.

Nota 2: El diccionario de datos permite ingresar nombre de archivo y de campos con
acentos, como "Teléfonos", y éstos son procesados correctamente por el

Generador de Aplicaciones. Al

verificar la traduccion de este manual

descubrimos, sin embargo, que algunas partes de Clarion no funcionaban bien
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con acentos; y que causan dificultades dificiles de diagnosticar. Aconsejamos no
usar acentos en nombres de archivos, campos o claves. Si pueden usarse (y es
aconsejable hacerlo) en la interfaz de usuario: etiquetas de campo,
encabezamientos de columnas, leyendas explicativas, etc. Estos elementos
pueden predefinirse sin problemas en el Diccionario de Datos(HDC).

Archivo de clientes

El archivo de Clientes guarda datos "constantes" como nombres y direcciones. Resulta eficiente
guardar esta informacién en un solo lugar, lo que facilita realizar una Unica actualizacién cuando
hay un cambio. También ahorra espacio, evitando duplicados de informacion en el archivo de
Pedidos. De lo contrario, si hubiera mil pedidos de la compafiia XYZ, la direccion se repetiria
1000 veces. La reduccion de las necesidades de almacenamiento mediante el recurso de guardar
los datos s6lo una vez se llama normalizacion.

Los datos de clientes requieren un campo que identifique univocamente al cliente. EI nombre de la
empresa no sirve, porque podria haber duplicados. Por ejemplo, podrian existir registros multiples
para un cliente llamado" Ferreterias <<La Manguera>>" si tiene varias sucursales. La aplicacion
que ya hemos realizado especificaba que el campo NumCliente seria una clave autonumerada, que
crea y guarda nimeros exclusivos para cada cliente.

El campo NumCliente sirve como "clave primaria“(primary key) para el archivo de datos.
Cualesquiera otros archivos que se vinculen al archivo de Clientes deben declarar el campo
NumCliente como "clave foranea"(foreign key). Una clave primaria es un campo, 0 una
combinacién de campos, que singulariza univocamente cada registro de un archivo. Una clave
“foranea” es un campo, o0 una combinacion de éstos, en un archivo (o tabla) cuya clave debe ser
igual auna clave primaria en otro archivo vinculado.

Debido a que hay muchos pedidos para cada ndmero de cliente, la relacién entre el archivo
Clientes y el archivo Pedidos serad de uno-a-muchos (1:Many). Decimos que el archivo de clientes
es el archivo padre y que el archivo pedidos el hijo.

Archivo de Teléfonos

El archivo Teléfonos guarda los nimeros de cada cliente, y pueden haber muchos nimeros por
cada cliente.

El archivo de Teléfonos también incluye un campo de texto en el que indicamos si el ndmero de
teléfono pertenece a la oficina, al fax, al celular, o al domicilio particular. Usando el diccionario de
datos, especificaremos que el control de ingreso de datos sea una lista desplegable, con las
opciones precargadas.
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Archivo de Pedidos

El archivo de pedidos toma informacion de cada transaccion desde todos los demaés archivos
(como los datos del cliente). Debido a que gran parte de la informacién basica de este archivo se
imprime en la "cabecera"” de la Nota de Pedido, suele llamérselo "Cabecera de Pedidos".

Cada transaccion de ventas requiere un registro en el archivo de Pedidos. El registro se vincula a la
informacion del cliente gracias al nimero de cliente. Debido a que algunos pedidos pueden tener
un solo articulo, y otros mas de diez, habra que crear un archivo separado de "Detalle" que se
vincule con el nimero Unico del pedido. Esto crea una relacion de uno-a-muchos, con el archivo
de Pedidos como padre y el archivo de "Detalle" como hijo. Los productos pedidos se identifican
por sus codigos de producto, en el archivo de "Detalle".

De modo que el registro de Pedidos tiene un nimero de cliente para vincularlo a los datos del
cliente (clave foranea) y un ndmero exclusivo de pedido, para vincularlo al "Detalle”. Crearemos
una clave primaria multicomponente sobre ambos campos, para crear facilmente un procedimiento
de visualizacion (browse) ordenado por cliente y por nimero de pedido.

El Archivo de Detalle

Este archivo guarda los articulos ordenados por sus codigos de producto (clave foranea que
referencia el archivo Productos), sus precios, cantidades, y tasa imponible. Un campo adicional
guarda el nimero de pedido, que se vincula al archivo de Pedidos en un relacién de muchos-a-uno.

El archivo de Detalle duplica la informacion de precios ya guardada en el archivo de productos.
Esto se debe a que los precios pueden variar. Es importante guardar el precio dentro del archivo
de detalle, porque de lo contrario, si el precio se modificara, el mddulo de facturacién tomaria
precios diferentes a los acordados con el cliente al momento del pedido.

El archivo de Productos

Este archivo guarda los nimeros exclusivos de cada producto, descripciones y precios. Cuando el
vendedor busca un producto por su nombre, la aplicacion inserta el nimero de producto en el
registro de Detalle. El codigo de producto es la clave primaria: ningun articulo puede tener un
numero repetido, y cada producto debe tener un nimero. Un campo adicional contiene la tasa
imponible de ese producto.

Integridad Referencial

La integridad referencial se refiere al proceso de controlar todas las modificaciones al campo clave
de un archivo determinado, para asegurarse que se mantiene la validez de la relacion padre-hijo.
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También significa vigilar que todos los registros "hijos" tengan "padres"” validos; de manera que
no queden registros "huérfanos” en la base de datos.

Debido a que los datos para una transaccién dada residen en varios archivos, esta aplicacion debe
mantener la integridad referencial. Esto es critico, sin embargo, muchas otras herramientas de
desarrollo de bases de datos exigen que uno escriba procedimientos manuales para asegurarlo. El
Generador de Aplicaciones lo implementa automaticamente en el codigo fuente generado, cuando
usted elige unas pocas opciones del Diccionario de Datos.

Es esencial que la aplicacion no permita modificar un registro de modo que deje un valor vacio o
duplicado en un campo clave primario. Por ejemplo, es necesario limitar la capacidad del usuario
final de crear un nimero de Cliente duplicado. Si dos compafiias distintas compartiesen su nimero
de cliente, correriamos el riesgo de registrar un pedido a la empresa equivocada.

Esquema completo de la Base de Datos

El esquema siguiente ofrece un panorama de la base de datos completa.Si se lo mira desde el
punto de vista de un vendedor que toma un pedido telefdnico, el archivo de pedidos graba de
quién es el pedido, el Detalle guarda los articulos pedidos, y los archivos de Clientes y Productos
guardan informacién constante sobre ambos temas.

CustMumber 4= CustNumber _

FlrstName \ OrderMumber rderMumber _

_ nyAmaunt ProdMumber rodNumber

LastName

Company CustNumber CrderDate Quantity ProdDesc
Address Area CrderNote FrodAmount ProdAmount
City Phone TaxRate TaxRate
State Description

Zip

El cddigo de articulo consulta la descripcion y el precio. El cddigo de cliente busca el nombre y la
direccion del cliente. Otros datos, como la fecha de la operacién, se llenan automaticamente
(consultando la fecha del sistema, por ejemplo).

Finalmente, el cursillo creara un diccionario de datos nuevo, al que usted copiara los archivos que
se definieron anteriormente, al nuevo diccionario.

En cuanto a la aplicacion creada, debido a que el cursillo es un instrumento pedagégico que
intenta mostrar lo que Clarion puede ayudarle a hacer, no creara un sistema de pedidos a escala
completa. Sin embargo, ciertas partes de la aplicacion seran muy reveladoras, para que aprenda
cémo aplicar procedimientos similares en sus propias aplicaciones.
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Interfaz de la aplicacion

La tarea mayor que sigue antes de empezar a codificar es planear la interfaz con el usuario. En
una aplicacion de negocios como esta, es importante que el vendedor ubique rapidamente los datos
gue necesita para que pueda registrar la venta y atender la préxima llamada. Por lo tanto, la
aplicacién deberia poner todos los datos importantes a la vista, desde el principio, de manera que
ningdn ingreso o modificacién de datos esté a mas de un botdn u orden del menu de distancia.

Ademas, la empresa ya usa otras aplicaciones Windows; por lo que es importante que la aplicacion
tenga una apariencia y comportamiento comin con las demas. Los usuarios finales aprenden mas
rapidamente una interfaz familiar.

Para implementar las tareas, la aplicacion deberad ejecutarse de un modo consistente con los
lineamientos que indicamos mas abajo. Aunque lo que sigue no sustituye a una real especificacién
del programa, debera servirnos a los fines del Cursillo.

+ Dado que la aplicacion manejara el mantenimiento de los archivos de los clientes, articulos, y
pedidos en distintos formularios, es necesaria la Interfaz para Documentos Mdltiples (MDI).

o La aplicacion debera tener una barra de tareas con botones para cargar formularios y
ventanas de visualizacién (browse) para controlar su funcionamiento.

+ Para mantener coherencia en la interfaz, las principales opciones del mend seran Archivo,
Editar, Ver, Ventana y Ayuda. El mend de archivo accede a los procedimientos de impresion y
salida. Los botones de la barra de herramientas llaman a las cajas de didlogo para modificar un
registro existente (si esta seleccionado en un browse) o para afiadir /borrar registros, y para
desplazarse por los archivos. EI ment Ver llama los procedimientos para examinar los archivos
de datos. Ventana y Ayuda realizan las acciones habituales.

+ Cuando se afiaden nuevos pedidos, la gente de ventas deberia poder elegir clientes y productos
de listas deslizantes. Muchos datos del pedido (direcciones, descripciones y precios) deberian
irse "llenando" a medida que fuese necesario.

Ahora que hemos descrito en modo bastante completo la aplicacién, estamos listos para empezar a
trabajar. El primer paso es crear el diccionario de datos.
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2 - CREACION DE UN DICCIONARIO DE DATOS

Este capitulo ensefia como:

+ Crear un nuevo diccionario de datos.

+ Copiar y adaptar las definiciones tomadas del Diccionario creado por Quick Start.
+ Vincular los archivos y especificar las restricciones de integridad referencial.

+ Pre-formatear los controles de ventana para los campos.

Este cursillo presume que usted ha finalizado el Cursillo para un Inicio Rapido de la
primera parte de este libro.

Archivos del Cursillo

Le recomendamos realizar el cursillo completo, especialmente si el entorno de desarrollo
Clarion le resulta totalmente nuevo( e incluso si ya ha usado versiones anteriores de Clarion).
Como habra visto en el cursillo anterior, el enfoque de Clarion con su Generador de Aplicaciones
manejado por templates es muy diferente de otros entornos de desarrollo en lenguajes de tercera y
cuarta generacion. Si hace el curso enteramente, obtendra los mejores resultados de esta nueva
herramienta.

Los archivos completos del cursillo residen en el directorio

\CLARIONS\EXAMPLES\TUTOR. Los ofrecemos para que pueda ver el resultado final del
cursillo y compararlo con su aplicacion. Solamente deberian presentarse diferencias superficiales.

Si usted ya es un programador Clarion experto, puede examinar los archivos terminados, mas que
hacer el cursillo por si mismo. Sin embargo, le recomendamos que al menos lea completamente
este cursillo, dado que hay métodos de trabajar en el entorno que no pueden adquirirse
simplemente " tirandose a la pileta" y trabajando con las herramientas. Este cursillo demuestra
ciertas caracteristicas del entorno de desarrollo que no aparecen en primera vista.

Nota: Cuando hay mdltiples maneras de hacer la misma tarea, este cursillo
mostrara varias, para demostrar la flexibilidad del entorno de desarrollo
Clarion.



Creacion del Diccionario

Siempre que se crea una nueva aplicacion, primero hay que definir el diccionario de datos
(archivo .DCT). El Generador de Aplicaciones toma toda su informacién del diccionario: los
archivos de datos que usa la aplicacién, sus relaciones mutuas, ademas de informacién adicional
como el formateo predefinido de los controles.

Por regla general, cuanto mas prevision y trabajo se ponga en disefiar el diccionario de datos, mas
podra hacer el Generador de Aplicaciones. Y, cuanto mas trabajo haga el Generador de
Aplicaciones por usted, jmenos tendra que hacer usted mismo !

Cuando en el cursillo anterior, ejecutamos el Asistente para un Rapido Comienzo, simplemente
definimos el archivo de datos. Ahora, presentamos el Editor del Diccionario.

Punto Inicial :
Debe tener abierto el entorno de desarrollo Clarion, y cerrada la caja de
didlogo Pick (Escoger).

Indicar el nombre del nuevo diccionario

1. ElijaFile » New del menu.
2. Dé CLIC sobre la opcion Dictionary.

Mew EE

Guardar en; Ia Tutuarial j gl Ig__éé
gwhutor.dct

Hombre de archive: [ TUTORIAL
Guardar como bipo; IDiclionar_l.J [*.det] j Cancelar |

Aparece el didlogo New.

Dar nombre al nuevo archivo de diccionario
1. Seleccione el directorio o carpeta \ CLARIONS\ TUTORIAL
2. Escriba TUTORIAL en el campo File Name.

Clarion agrega la extension: el archivo de diccionario tiene por nombre completo
TUTORIAL.DCT. Puede usar nombres de archivos largos si utiliza un sistema operativo de 32
bits (Windows 95 o NT). La versién en inglés de este cursillo no usa nombres largos, para



hacerlo valido para todos los usuarios, incluyendo los de Windows 3.x. Como hemos
explicado, en esta versién castellana ocasionalmente permitimos que la longitud exceda los
ocho caracteres, para facilitar la lectura. Los usuarios de sistemas operativos que no admitan
esta mayor longitud, deberan truncar los nombres respectivos.

Nota: El Diccionario de Datos permite ingresar nombres de archivos y de campos
con acentos, como "Teléfonos", y éstos son procesados correctamente por el
Generador de Aplicaciones. Al verificar la traduccion de este manual
descubrimos, sin embargo, que algunas partes de Clarion no funcionan bien
con acentos; y que causan problemas dificiles de diagnosticar. Aconsejamos
no usar acentos, en nombres de archivos, campos o claves. Si pueden
utilizarse (y es aconsejable hacerlo) en la interfaz de usuario: etiquetas de
campo, encabezamientos de columnas, leyendas explicativas, etc. Estos
elementos pueden predefinirse sin dificultades en el diccionario de datos (HDC).

3. Oprima el boton Save para crear el archivo.

Esto crea un archivo de diccionario de datos vacio. La barra de titulo muestra el nombre de
archivo.

Especificar una descripcion del diccionario

1. Oprima el boton Dictionary Properties (Propiedades del Diccionario).
Aparece la caja de didlogo respectiva.
2. Seleccione la lengiieta Comments, y escriba Diccionario del Cursillo.

La lenglieta Comments permite escribir notas de texto libre sobre el diccionario. Es opcional,
pero extremadamente (til para programadores que quizas deban volver a revisar un proyecto
después de varios meses de intervalo.

Este dialogo también ofrece un boton de contrasefia (Password), que evita que otros usen
este diccionario. No hay necesidad de llenarlo durante el Cursillo, pero es una caracteristica Util
para tener en cuenta.

Dictionary Properties [ x|
Properties Eommentsl
Diccionario del Cursillo B
]
Ok I Cancel | Help |

3. Cierre la caja de dialogo Dictionary Properties oprimiendo el botén OK.
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Copiado de archivos de uno a otro diccionario

Puede usar las 6rdenes normales de copiar y pegar de Windows para copiar las definiciones de
archivos de otro diccionario ( 0 para copiar campos de un archivo a otro). En otras palabras, una
vez que esta definido... Para que preocuparse por redefinirlo si basta con copiar lo que ya se
ha hecho!

Copia de la definicién del archivo Clientes

Abra el otro diccionario de datos, elija un archivo, y cépielo

1. ElijaFile » Pick del mend, luego elija la lengiieta Dictionary.
2. Seleccione el archivo QWTUTOR.DCT del listado de archivo, y oprima el boton Select.

Se abre otra caja de dialogo de Diccionario, que contiene las definiciones de archivo de la
aplicacién realizada con Quick Start. Muévala, y vera que ambos archivos .DCT estan abiertos.

# Dictionary - C:ACLARIONS5\TutuoriahTUTORIAL.dct 1.0
File: | Felated File

£ Dictionary - qwtutor.dct 1.0
File: ~Related File
Clientes

&dd File <= Clientes

Add Alias 4dd Relation |

Properties. ..

Telefono

Figlds/Keys...

Delete |

Delete

LEEElE

Browse

Dict 4 I I ﬂ Convert

- Diigtionary Properties.. | Synchronize

3. Elijael archivo Clientes de la lista Files.

E

=

]
g
L=
(1]
T
o
=]

4. Elija Edit » Copy (uoprima CTRL+C)
5. Dé CLIC sobre la caja de dialogo del diccionario TUTORIAL.DCT.

Esto convierte al diccionario Tutorial en activo.
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6.

7.

Elija Edit > Paste (o pulse CTRL+V).

Aparece la caja de didlogo Edit File Properties.

Esta operacion no solamente copia la definicion del archivo, también copia los campos y
claves.

Oprima el botén OK para cerrar la caja de didlogo Edit File Properties.

Copia de la definicion del archivo de Teléfonos

Utilicemos ahora las 6rdenes de copiar y pegar para copiar la otra definicién de archivos.

Elija el archivo v copielo

1.

Dé cLic sobre la caja de dialogo del diccionario QWKTUTOR.DCT.

2. Elijael archivo Teléfonos de la lista Files.
3. ElijaEdit » Copy (uoprima CTRL+C).
4,

5. Elija Edit » Paste (uoprima CTRL+V).

Pulse CTRL+F6, 0 de cLIC sobre la caja de dialogos del diccionario TUTORIAL.DCT.

Aparece la caja de didlogo Edit File Properties.

Pulse el boton OK para cerrar la caja de didlogo Edit File Properties.

Cierre el archivo de diccionario creado por Quick Start

1.
2.

Dé cLic sobre la caja de dialogo QWKTUTOR.DCT.

Oprima el botén Close, o elija File » Close.



Vinculacion de los archivos y configuracion de las
opciones de integridad referencial

Se pueden copiar las definiciones (incluyendo sus claves), pero Clarion no puede copiar las
relaciones entre archivos de otros diccionarios. Por lo tanto, debe redefinir las relaciones entre esos
dos archivos.

Definir el primer lado de la relacién

Definiremos la relacién de modo diferente que lo hicimos en el ejercicio anterior. Esta vez lo
haremos desde el lado de Muchos (“hijo”) en lugar del lado Uno(“Padre™), sélo para demostrar
que puede hacerse.

1.

Destaque el archivo Teléfonos, y afiada el botén Add Relation.
Aparece la caja de dialogo New Relationship Properties. Dado que el Gltimo archivo
seleccionado fue Teléfonos, estableceremos la relacion desde su perspectiva.

Cada Cliente puede tener mas de un teléfono. “Cliente” es el Padre, en una relacion padre-
hijo. Por lo tanto, es una relacion de muchos a uno (MANY: 1), vista desde Teléfonos a Cliente.

Elija MANY:1 de la lista desplegable Type en el grupo Relationship for Teléfonos.
. Elija KeyClienteNum de la lista desplegable Foreing Key.

~Relationzhip for TELEFOKO
Type IMANY:1 j Foreign Key (ST

Esta es la clave que se vincula a una clave primaria en el archivo de Clientes; por lo tanto, se
trata de una clave foranea.

Definicién del otro lado de la relacion

1.
2.

Elija Clientes de la lista desplegable Related File en el grupo Parent.
Elija KeyClienteNum de la lista desplegable Primary Key.

En la relacion padre —hijo, la clave foranea del hijo debe relacionarse con una clave primaria
en el padre. Véase Anatomia de una base de datos, en el Capitulo 4 de esta seccién, y el
articulo Databasabe Design en la Programmer’s Guide, para mas informacién sobre la teoria
de las bases de datos.

Pulse el boton Map by Name para vincular los campos.

Puede usar este botén porque dio el mismo nombre a los campos que se vinculan en ambos
archivos. Esta es una muy buena préactica para adoptar dado que, a largo plazo, hace la
aplicacién mucho mas facil para mantener. Cuando uno regresa para hacer cambios a un
proyecto que terminé tiempo atras, es mucho mas facil reconocer los campos vinculados, si
tienen el mismo nombre a ambos lados de la relacion.



Configuracién de las restricciones de integridad referencial

Al indicar estas restricciones, se puede especificar cdmo el Generador de Aplicaciones escribe el
cadigo fuente que maneja lo que ocurre si un usuario final intenta modificar un valor en una clave
primaria, o si intenta borrar un registro “padre” con “hijos”. Si no se establecen las restricciones,
el usuario podria comprometer la integridad de la base de datos creando registros “huérfanos”, de
dos maneras: borrando un registro “padre” o cambiando el valor del campo relacional. En las
aplicaciones que se generan con las plantilla de Clarion Application Builder Class, el cddigo
necesario para mantener esta integridad esta incorporado a la biblioteca de construccion de
aplicaciones (ABC).

Para este cursillo, especifique que la aplicacion debera actualizar la clave foranea, si se cambia el
valor de la clave primaria. También, especificaremos que no podra permitirse al usuario borrar un
padre que tenga hijos.

1. Elija Cascade (“En cascada”) de la lista On Update (“Cuando se modifica”) en el grupo
Referential Integrity Contraints.

Hacer un cambio en cascada significa que la aplicacion extiende el cambio y actualiza la clave
foranea (del archivo hijo), en todos los registros hijos vinculados a ese registro padre.

2. Elija Restrict (“Restringir”) de la lista On Delete (“Cuando se borra™)
Restringir el borrado quiere decir que la aplicacién no permite eliminar un padre con hijos (el
usuario debe borrar primero a los hijos).

3. Presione OK para cerrar la caja de didlogo New Relationship Properties.

R eferential [ntegrity Canstraint
’7 On Update Cazcade j On Delete

En este punto, el Diccionario se vé asi:

£ Dictionary - tutorial.dct 1.0

File: Related File

Cligntes Add Fi |
Telefonn U=
Add Alias | Add Relation |

Observe las pequefias flechas a la derecha del nombre de archivo vinculado en la lista Related
Files. Indica la naturaleza de la relacién entre los dos archivos.

Dos signos (>>0<<) apuntan al lado “muchos” desde el lado “uno”. Un signo (>0<) apuntan al
lado “uno” desde el lado “muchos”. Por lo tanto, Teléfonos <<-> Clientes indica que muchos
registros de teléfonos pueden estar vinculados a un registro de Cliente.

Guarde su trabajo

Es un buen hébito guardar el trabajo frecuentemente, mientras desarrolla las aplicaciones (las
fallas y cortes de luz vienen sin previo aviso). Para hacerlo, elija File » Save, u oprima el
botén Guardar en la barra de herramientas. Esto escribe el archivo del diccionario al disco.



Pre — definicion de los formatos de control de
ventanas

Dentro del diccionario de datos, se pueden especificar las propiedades por omisién de los controles
de las ventanas que serviran para modificar los campos que usted defina. También se pueden
especificar ciertas reglas de integridad de datos, configurando las Comprobaciones de Validez
(Validity Checks) y el valor inicial del campo. Estas opciones son factores clave para
ayudar al Generador de Aplicaciones a hacer la mayor parte del trabajo para usted.

Acceso ala cajade didalogo Field Properties

1. Destaque el archivo Clientes en la lista Files.
2. Pulse el boton Fields/Keys.

La caja de dialogo Field/Key Definition le permite modificar las propiedades de cualquier
campo o clave en el archivo.

= Field / Key Definition - Clientes [tutorial.dct) [_[O] ] |

Fiekds |Keps |

B3 Empresa
-3 Mombres
- Apelidos
-] Direccion
= Ciudad
-F3 Provincia
‘= CP

o | 3
Inzert | P[operliesl Delete |EI il

Close | Help |

3. Elija el campo Provincia, y oprima el botdn de Properties.

Aparece la caja de didlogo Edit Field Properties, con la opcion Quick Start preseleccionada
en este campo.

Configurar las Comprobaciones de Validez

1. Elija la lengleta Validity Checks.

Esta ficha le permite configurar limites para los campos numéricos, especificar que el valor de
un campo debe ser igual al mismo campo en otro archivo relacionado, que debe ser verdadero
o falso o, como en este caso, que el valor del campo debe estar en una lista que usted especifica
en esta caja de dialogo.

2. Elija el botén de radio Must be in List (“debe figurar en la lista”)

3. Escriba lo siguiente en la caja de opciones (Choices):
BA|SF|ER|CBA | MZA

Cada opcion debe estar separada por una barra vertical (| ).
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Asi se define la lista de opciones permisibles. En este caso, el diccionario especifica que
solamente las abreviaturas de esas cinco provincias argentinas son aceptables. Usted

especificara que el control por omision para este campo es una lista desplegable.

En el teclado en espafiol, la barra vertical se obtiene oprimiendo ALT (botdn de la derecha) + 1

(del teclado normal, no numérico).

Edit Field Properties - Provincia

General | Aﬁributesl Commantsl Dpt\omsl Help  Malidity Checks |Wimduw I Beporll

€ NoChecks

Chaices: [B4ISFERICEAMZA

Walues [
£~ Cannot be Zero or Blank

€ bust be in Mumeric Range
™ Lowest I 0.0 33 ™ Highest I 0.0 33

£ Must be True or Fakse

True Yalue: | Falsa Value: |

£ Must be in File
File Label: I -

% Must be in List

Lhoices: [EAISFERICEAMZA

Walues, |

oK I Cancel

Help

Confiqurar un valor por omision

1. Seleccione la lengiieta Attributes.

2. Escriba ‘BA’ el campo Initial Value (“Valor inicial”), incluyendo las comillas simples (en el

teclado Windows en espafiol es la tecla a la derecha del nimero 0)

Asi se especifica que, siempre que aparezca el control, el valor por omisién sera “BA”. Los
valores iniciales pueden ahorrar mucho tiempo para el usuario final; en este caso, si la mayoria
de los clientes estan ubicados en “BA”, evita que deban buscarlo en la lista cada vez que se
afiade un nuevo cliente. Las comillas simples son necesarias porque también es posible
nombrar una variable o funcién como valor inicial de un campo, que irian sin comillas
(advierta que hay reglas algo distintas para los valores iniciales de variables en memoria).
Como en este caso, el valor inicial es una cadena de caracteres, las comillas simples la

identifican como tal.

Edit Field Properties - Provincia

General Altributes ICUanenlsl Dgliunsl Help I\_/alidily Checks I Wfindow | Bepurtl

Lase Typing Mode Flag:
& Nomal © Set Insert [ Immediate
 word Capitalize 7 Set Ovenwite [ Password
" Uppercase " Do Mot Reset [ Read Only
Justification: lﬁ
Dffsst: 0 =
Initial % alue: | ‘B
Estemal Name: |
Place Over: - |

TR I Cancel Help
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Especifique un control de ventana por omision

1. Elijalalengiieta Window.

Cuando se especifica Must be in List, la ventana por omision del campo es una estructura
OPTION con bhotones de RADIO. Estos aparecen como default en la lista Windows
Controls.

2. Elija Drop List (“Lista desplegable”) en la caja Control Type.

La lista de Window Controls muestra ahora solamente un PROMPT (‘Indicador’) y un
control LIST (“lista™) con el atributo DROP (“desplegable”).

Edit Field Properties - Provincia

General | .ﬁ.ﬂributeal Eu:ummentsl Elgtiu:unal Help I"-_falidity Checks indow |Bepu:urt|

“findow Controls: Contral Type:

Cornbo

Drop Combo
O ption

E ik

Text

Image

Froperties. .. |
4 | | ﬂ Reset Cantrolz |

] I Cancel | Help |

3. Oprima el botén OK para cerrar la caja de dialogo Edit Field Properties.
4. Oprima el botén Close para cerrar la caja de dialogo Field/Key Definition.
5. ElijaFile » Save, uoprima el boton Guardar en la barra de herraminetas.

En el capitulo siguiente, aprendera como afiadir un archivo al diccionario de datos, comenzando
completamente “desde cero”, sin usar Quick Start o Quick Load. Comprobara lo facil y rapido que
es, aun sin usar los Asistentes.
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.» - INCORPORACION DE ARCHIVOS Y CAMPOS

Definicidn de archivos de datos nuevos

Después de copiar y maodificar los dos archivos definidos en la aplicacién de Inicio Rapido, esta
listo para afiadir un nuevo archivo desde cero.

Punto de Inicio:
El archivo TUTORIAL.DCT (diccionario) debe estar abierto.

Creacion del archivo de Pedido

Especificacion del rétulo, el prefijo v ladescripciéon

1. Pulse el boton Add File, en la caja de didlogo Dictionary.

2. Cuando aparece la caja de dialogo Add File, con la pregunta si desea usar Quick Load,
oprima el botén No.

Aparece la caja de didlogo New File Properties. Clarion utiliza la informacion que se
incorpora aqui para declarar la estructura del archivo(FILE).

3. Escriba Pedidos en el campo Name, y oprima TAB.

Este campo solamente acepta un rotulo valido para Clarion, que identifique univocamente la
estructura de datos. Un rétulo puede contener solamente, letras, ndmeros, y el caracter de
subrayado(_ ) o los dos puntos y debe empezar con una letra o subrayado. Las sentencias del
cddigo ejecutable usan este rétulo para referirse al archivo.

Después de oprimir TAB, aparece automaticamente “PED” en el campo Prefix. El prefijo es un
modo de identificar inequivocamente los campos que tienen el mismo nombre en distintos
archivos de datos. Por ejemplo, PED:NumCliente es el campo NumCliente en el archivo
Pedidos, mientras que CLI:NumCliente es el campo del mismo nombre en el archivo Clientes.
También puede identificar de forma univoca los campos utilizando la sintaxis de Calificacion
de Campos (tratada en Language Reference).

4. Escriba Cabecera de los pedidos en el campo Description.
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Esta descripcion aparece junto al rétulo del archivo de datos, en la lista del Diccionario. Si
elige la lenglieta Comments, puede escribir una descripcién mas larga. Esta descripcién
puede resultar muy Gtil cuando se vuelve al archivo para realizar mantenimiento del programa.

Eleccion del controlador de archivo

1.

Elija TopSpeed de la lista desplegable File Driver.

Esta accion declara el formato de archivo para los datos como TopSpeed. Este es el mas nuevo
de los dos formatos propios que la Corporacién TopSpeed a desarrollado (el otro es Clarion).

La seccion Database Driver del Application Handbook provee informacion sobre que clase de
datos admite cada controlador, ademas de otra informacién Gtil como las extensiones de
archivo por omision para los archivos de datos y/o indices. También ofrece sugerencias y
trucos para elegir el controlador adecuado para la tarea, cuales controladores son mejores
cuando su aplicacién debe manejar una gran base de datos que se actualiza frecuentemente, o
qué controladores son mejores cuando lo que mas importa es el menor tiempo de blsqueda.

Oprima el botén OK.

Puede aceptar los valores por omisién de todas las demas opciones. Se cierra la caja de dialogo,
y la caja Dictionary muestra el archivo Pedidos, con la aclaracion “Cabecera de los pedidos”
a su lado.

Dar nombre alos archivos Detalle y Productos

Creacion del archivo Detalle

1.

Oprima el botén Add File en la caja de didlogo Dictionary.

Elija No cuando se le pregunta si desea usar Quik Load(“Carga Rapida”).

Escriba Detalle en el campo Name.
Escriba Detalle (lineas) de pedidos en el campo Description.
Escriba DETAL en el campo Prefix.

Esta personalizacion del prefijo por omision (cambiarlo de “DET” a “DETAL”) hace mas
legible el codigo. Aunque lo convencional para los prefijos son tres caracteres, también puede
Ser mas, como vemos aqui.

Elija TOPSPEED de la lista desplegable FileDriver.

Acepte todas las demas opciones preconfiguradas.

Oprima el botén OK.

Creacion del archivo Productos

1.
2.

Oprima el botén AddFile (no utilice Quick Load).

Tipee Productos en el campo Name.
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{7 Dictionary - tutorial_.dct 1.0

—File: ~Related File
i —— A Fie s T olefong
Detalle - Detalles (lineas) de log pedidc 4|
Pedidoz - Cabecera de loz pedidos Add Relat
Productos - Productos en venta Add Aliaz | Elation |
Telefono
ml Eraperties... |
Fieldz/F.eps... |
[Nelete |
Delete |
Browsze |
1 I I ﬂ Corwert | 4 | ﬂ
Dictinhary Properties. . | Synchronize | Cloze | Help

Tipee Productos en venta en el campo Description.
Escriba PROD en el campo Prefix.

Elija TOPSPEED de la lista desplegable File Driver.
Oprima el botén OK.

o g &~ w

Guarde su trabajo

1. ElijaFile » Save, u oprima el boton Guardar de la barra de herramientas.

En este punto, la caja del Diccionario se ve asi:

Definicion de los campos

Definicion de un Pool de Campos

En este momento definiremos varios campos que seran campos de vinculo entre los archivos de la
base de datos. Usaremos una facilidad del Diccionario de Datos llamada Pool de Campos (Field
Pool) para asegurarnos que éstos estan definidos exactamente igual en los archivos que los
requieran.

1. Presione el botén Add File.
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Un Pool de Campos es tratado en el Diccionario de Datos como un archivo, ain cuando no general
cédigo alguno en las aplicaciones. Usted puede definir en el Diccionario de Datos tantos pools de
campos como desee, sin embargo no es usualmente necesario emplear méas de uno.

2. Elijala opcion Pool.

3. Tipee CamposPool en el campo Name.
4.

5. Oprima el botén Ok.

Escriba POOL en el campo Prefix.

Abra la venta de Definicion de Campos y Claves

1.
2.

Ilumine el archivo CamposPool en la lista Files.
Oprima el botén Field/Keys...

Esta ventana muestra todos los campos v las claves definidas en un archivo. Ya que se trata de un
archivo nuevo esta en blanco. Podriamos empezar afiadiendo campos, pero en su lugar
comenzaremos copiando un campo del archivo de clientes.

Dé cLic sobre la barra de titulo de la ventana Field/Key Definition, y arrastre para poder ver la
caja de didlogo del Diccionario que esta abajo.

Destaque el archivo Clientes en la lista Files del Diccionario. Advierta que el foco se desplaza a
esta ventana

Presione el botén Fields/Keys...

Ahora aparece otra venta Field/Key Definition con los campos definidos en el archivo
Clientes.

Eleccion y copiade un campo

1.
2.
3.

Elija el campo NumCliente de la lista Fields.
Elija Edit > Copy (u oprima CTRL +C).

Elija Window > Field/Key Definition — Campos Pool (o dé cLic sobre la ventana abierta
para ponerla en foco).

Elija Edit > Paste (u oprima CTRL + V).
Aparece la Caja de Dialogo Edit Field Properties.
Oprima OK para cerrar la Caja de Dialogo Edit Field Properties.

Este es el campo que oficiara de vinculo para la relacion entre los archivos Clientes y Pedidos. Los
campos de vinculo entre distintos archivos siempre se definen iguales, de manera que copiar la
definicion es una forma de ingresar la definicion existente en el Pool de Campos.

Derivando un campo existente

1.

Seleccione Window > Field/Key Definition — Clientes (o dé cLic sobre la ventana abierta
para ponerla en foco).

Destaque el campo NumCliente de la lista Fields y presione el boton Properties.
Aparece la caja de didlogo Edit Field Properties.

Escriba POOL:Cliente en el campo de Derived From.
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4.

Esto significa que el campo CLI:NumCliente es ahora derivado del campo POOL:NumCliente. El
término “derivado de” significa que la definicion del campo POOL:NumCliente es el “padre” y
todos los campos “hijos” que son derivados de él, automaticamente comparten todos sus atributos.

El derivar la definicién de los campos de campos existentes, le brinda la posibilidad de hacer los
cambios en un solo lugar y aplicarlos en cascada a todos los campos derivados. Por ejemplo, si
necesitaramos cambiar la definicion del campo NumCliente en todos los archivos que lo emplean,
simplemente hariamos los cambios en la definicion de POOL:NumCliente y los aplicariamos en
cascada a todos los campos derivados. Esto puede hacerse eligiendo Edit > Distribute Field
luego de efectuar los cambios en POOL:NumCliente.

Oprima OK en la caja de didlogo Edit Field Properties.

Anadir el resto de los campos al Pool de Campos

1.

Seleccione Window > Field/Key Definition — Campos Pool (o simplemente dé CLIC sobre
la ventana abierta para darle foco).

Presione Insert para abrir la caja de dialogo New Field Properties.

Una vez que se ha comenzado a definir campos nuevos aparece automaticamente una caja de
didlogo New Properties después de afiadir cada campo. Esto acelera el proceso de afadir
campos multiples. Después de afiadir el dltimo, simplemente debe apretarse el botén Cancel
sobre la caja de dialogo en blanco para regresar a la caja Field/Key Definition.

Escriba NumPedido en el campo FieldName.

Este campo sera el vinculo entre los archivos Pedidos Y Detalle.

Elija SHORT en la caja Data Type.

Esto especifica un entero corto (-32.769 a 32.767).

Presione el botén OK.

Escriba NumProducto en el campo Field Name.

Este vinculara el archivo Detalle con el de Productos.

Seleccione SHORT de la lista desplegable para el campo Data Type.
Presione el botén OK.

Presione el botén Cancel.

Reaparec la caja de didlogo Field/Key Definition.

10. Presione el botén Close.

Definicion de los campos del archivo de Pedidos

En este punto, regrese al archivo Pedidos y preparese a definir los campos.

Abrir las ventanas Field/Key Definition.

1.
2.

Destaque el archivo Pedidos de la lista Files.

Oprima el botén Fields/Keys... .
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3. Oprima el botén Insert para abrir la caja de dialogo New Field Properties.

Escriba NumCliente en el campo Field Name.

5. Presione el botdn ellipsis (...) a la derecha del campo Derived From.

Aparece un ventana de seleccion que contiene una lista, en forma de arbol, con todos los
campos ya definidos en el diccionario. Usted puede derivar un campo nuevo de otros existente,
ya sea en un archivo, global data o pool de campos.

Ilumine el campo NumCliente en CamposPool y presione el botén Select.

El nuevo campo sera automaticamente una copia perfecta del campo del cual fue derivado. El
boton con un icono igual a una flecha circular, a la derecha del boton ellipsis (...), permite
refrescar el campo derivado segun la definicion del campo “padre” si fuera necesario (pero es
mucho mas simple elegir Edit > Distribute Field luego de modificar el campo “padre™).

Presione el botdon OK para cerrar la caja de dialogo New Field Properties.

Este campo oficiara de vinculo entre el archivo de Pedidos y de Clientes.

Derivar el campo NumPedido

Este proporciona una identificacién Unica para cada pedido.

1.
2.
3.
4.

Escriba NumPedido en el campo Field Name.
Presione el botdn ellipsis (...) a la derecha del campo Derived From.
Destaque el campo NumPedido de CamposPool y oprima el botén Select..

Presione el boté OK para cerrar la caja de didlogo New Field Properties.

Definir el campo Monto Factura

Este campo guarda el valor total del pedido.

1.
2.
3.

Escriba MontoFactura en el campo Field Name.
Elija DECIMAL de la lista desplegable Data Type.
Escriba 7 en el campo Characters.

Esto especifica el nimero total de digitos en el nimero (a ambos lados de la coma decimal).

Escriba 2 en el campo Places (“Lugares decimales”).

General |Aﬂributes | Comments I Options | Help I Walidity Checks I window I Fepart I
Field Hame: | MontaF actura

Derived From: | Jﬁl
Description: |

Diata Tupe: Im

Base Type: | J

Characters: I 7 il Places: | 2 2]

Diimensions: | 1] i” 02 | 02 | 02

Fiecord Ficture I—

Screen Picture: I@n'IDZ— Jil - << HH

Prompt Tegt: |Mont0 Factura:

LColumn Heading: |Mont0 Factura

™ Freeze

T Cancel Help




LECCION 3

5. Oprima el botén OK.
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Definicién del campo Fecha

El campo guarda la fecha en que se realizo el pedido.

1. Escriba FechaPedido en el campo FieldName.

2. Escoja LONG de la lista desplegable DataType.

LONG es el tipo preferido para guardar fechas con el controlador de TopSpeed. Alli se
contiene un valor de Fecha Estandart Clarion (véase Language Reference para mas
informacion sobre las Fechas y Horas Estandar de Clarion).

3. Tipee @d5 en el campo Screen Picture (“patron de visualizacion™).

Este patron de visualizacion especifica el formateo por omision de los “caracteres” del campo.
En este caso @d5 significa formato de fecha DD/MM/YY. La caja de didlogo muestra una
representacion del texto formateado junto al campo.

4. Seleccione la lenglieta de Atributos (Attributes) y escriba TODAY() en el campo Initial

Value.
Mew Field Propeities [ %]
General Altrbutes |Comments I Optians | Help I Walidity Checks I Window I Bepart I
Case——————  Tuping Mode Flag
& Nomal © Set |nsert [ Immediate
" Word Capitalize " Set Ovenwite [ Passward
¢ Uppercase & Do Mot Reset ™ Read Only
Justification: |Hight x
Offzet: 1
Initial ¥ alue: [TODAY]
Ezternal Mame: |
Place Over: |N0ne x
Cancel | Help |

El codigo generado coloca la fecha de hoy en cualquier control, cuando adiciona un registro,
utilizando la funcién incorporada TODAY ().

5. Pulse el botén OK.

Definicion del campo Nota

Esto permite incluir una nota breve para instrucciones especiales del pedido.

1. Tipee Nota en el campo FieldName.
2. Elija STRING de la lista desplegable Data Type.

3. Escriba 80 en el campo Characters.

Esto especifica 80 caracteres.

4. Oprima el botén OK.
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Cierre la caja de didlogo New Field Properties

Todos los campos estan definidos, y estaria abierta ahora una caja de didlogo New Field
Properties.

1. Oprima el boton Cancel para cerrar la caja de didlogo New Field Properties.

2. Presione el botén Close para cerrar la caja de didlogo Field/Key Definition.

Definicion de los campos del archivo Detalle

En este punto, definiremos los campos del archivo Detalle.

Derivar la definicion del campo vinculo

1. Destaque el archivo Detalle en la lista Files y oprima el boton Insert para abrir la caja de
dialogo New Field Properties.

Escriba NumPedido en el campo FieldName.
Presione el botdn ellipsis (...) a la derecha del campo Derived From.

Destaque el campo NumPedido en CamposPool y oprima el botén Select.

o~ 0w DN

Presione el boton OK para cerrar la caja de dialogo New Field Properties.
Este campo sera el vinculo entre los archivos Pedidos y Detalle.
Derivando el campo NumProducto

Este campo permite relacionar este archivo y el de Productos.

1. Tipee NumProducto en el campo Field Name.
2. Presione el botén ellipsis (...) a la derecha del campo Derived From.
3. Destaque el campo NumProducto en CamposPool y oprima el boton Select.

4. Presione el botén OK para cerrar la caja de dialogo New Field Properties.

Definiciéon del campo Cantidad

Este campo guarda la cantidad pedida.

1. Escriba Cantidad el campo Field Name.
2. Elija SHORT como el tipo de dato (Data Type)
3. Oprima el botén OK.

Definicion del campo ProdPrecio

Esto guarda el precio unitario del producto al momento del pedido.
1. Tipee ProdPrecio en el campo Field Name.

2. Elija DECIMAL como el tipo de dato.

3. Escriba 5 en el campo Characters.
4

. Escriba 2 en el campo Places.
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5. Oprima el botén OK.
Definicion del campo Tasalmponible

6. Tipee Tasalmponible en el campo Field Name.
7. Elija DECIMAL como el tipo de dato.

8. Escriba 4 en el campo Characters.

9. Escriba 2 en el campo Places.

10. Oprima el boton OK.
Cierre la caja de didlogo New Field Properties

Todos los campos estan definidos, y estaria abierta ahora una caja de didlogo New Field
Properties.

1. Oprima el boton Cancel para cerrar la caja de didlogo New Field Properties.

2. Presione el botén Close para cerrar la caja de didlogo Field/Key Definition.

Definicion de los campos del archivo de Productos

En este punto, definiremos los campos del archivo de Productos. Este es el dltimo archivo.

Derivar la definicion del campo vinculo

1. Destaque el archivo Productos en la lista Files de la caja de dialogo Dictionary.
Puede que sea necesario mover algunas ventanas para hacerlo. El foco se desplaza a la caja de
dialogo del diccionario.

2. Oprima el botén Field/Keys... .
Ahora se abre una nueva ventana Field/Key Definition con los campos definidos para el
archivo de Productos.

3. Presione el boton Insert para abrir la caja de didlogo New Field Properties.

4. Escriba NumProducto en el campo Field Name.

5. Presione el botdn ellipsis (...) a la derecha del campo Derived From.
6. Destaque el campo NumProducto en CamposPool y oprima el boton Select.
7. Presione el botéon OK para cerrar la caja de dialogo New Field Properties.

Este campo sera el vinculo entre los archivos Detalle y Productos.

Definicion del campo Descripcion

Este campo lleva la descripcion del producto.
1. Escriba Descripcion en el campo FieldName.
2. Elija STRING de la lista desplegable Data Type.
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3. Escriba 25 en el campo de caracteres (Characters).
4.

CLARION 5™

Oprima el botén OK.

Definiciéon del campo Precio

1. Tipee Precio en el campo Field Name.
2. Elija DECIMAL como el tipo de dato.

3.
4
5

Escriba 5 en el campo Characters.

. Escriba 2 en el campo Places.

. Oprima el botén OK.

Definicion del campo Tasalmponible

1.

5.

Tipee Tasalmponible en el campo Field Name.

2. Elija DECIMAL como el tipo de dato.
3.
4

. Escriba 2 en el campo Places.

Escriba 4 en el campo Characters.

New Field Properties E

General |Aﬂributas| Commentsl Dgtionsl Help IYaI\dil}l Checks I “Window I Beportl

Field Mame: | T azalmpanible

Derived From: | | "’3'

Description: |

Data Type: DECIMAL -
Ease Type: J

Characters: I 4 i‘ Flaces: | 2

Dimensions: | 03 | 0z | 0 ﬁ” 1=
Record Picture: l—

Screen Ficture: l@nEZ— Jil -f.uH

Frompt Text: |Tasa Imponible

LColurmn Heading: | Taza lmponible

[T Fresze

oK I Cancel Help

Oprima el botén OK.

APRENDIENDO CLARION

Cierre de la cajade dialogo New Field Properties y guardar el trabajo

Todos los campos han sido definidos, y deberia estar activo una nueva caja de dialogo New Field
Properties.

1. Oprima el boton Cancel para cerrar esa caja de dialogo.

2. Oprima el botén Close en cada caja de didlogo Field/ KeyDefinition abierta.

3. Escoja File » Save u oprima el boton Guardar de la barra de herramientas.
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. - INCORPORACION DE CLAVES Y RELACIONES

Ahora que tenemos definidos todos los archivos, podemos afadir claves y, después, especificar las
relaciones entre los archivos. El Asistente de Inicio Rapido ya definio las claves de los dos
archivos creados para la aplicacién del primer cursillo. En este capitulo, definiremos las claves del
resto de los archivos

Punto de Inicio:
El archivo TUTORIAL.DCT (diccionario) debe estar abierto.

Definicidon de claves del archivo Pedidos

Los campos en el archivo de Pedidos que se vinculan a otros archivos en la base de datos son los
campos NumPedido y NumCliente.

+ El campo NumPedido se vincula al archivo Detalle.

NumCliente NumCliente
Nombres NumPedido NumPedido
Apellidos MontoFactura NumProducto
Empresa Fecha Cantidad
Direccion Nota ProdPrecio
Ciudad Tasalmponible
Provincia

CP

No deben existir duplicados o valores nulos (vacios) de pedidos en ese archivo: se trata de su

clave primaria.

Hay muchos registros de Detalle para un Gnico ndmero de Pedido. Por lo tanto, esta es una
relacion de uno-a-muchos: el archivo de Pedidos es el “Padre” del archivo de Detalle.

+ El campo NumClente se vincula al archivo de Clientes.

Habra valores duplicados en el campo NumCliente. La clave que definimos en el archivo de
Pedidos es foranea. La clave del archivo de Pedidos no permite duplicados y valores nulos, y

fue definida como la clave principal de ese archivo.

Puede haber multiples Pedidos de cada Cliente, lo que lo hace una relacién de muchos-a-uno:

el archivo de Pedidos es el “hijo” del archivo de Clientes.
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Creacion de la Clave Primaria

Dar nombre a la clave

1. Destaque el archivo Pedidos en la lista Files.
2. Oprima el botén Field/Key...

3. Elijala lenglieta Keys.

4. Oprima el botén Insert.

Aparece la caja de didlogo New Key Properties.

5. Escriba KeyNumPedido en el campo Key Name.
Como convencién mnemotécnica, le sugerimos incorporar la palabra “key” y el nombre del
campo en el nombre de la clave (como lo hace el Asistente para un Rapido Comienzo).

6. Seleccione la lenglieta Attributes, marque el casillero Require Unique Value (“Se requiere
un valor exclusivo™), y también marque el casillero Primary Key.
Esto especifica que la clave es primaria. El codigo fuente generado automaticamente evita que
el usuario ingrese valores duplicados o nulos.

7. Marque la caja Auto Number.

El codigo generado por los templates incrementara el nimero de clave a cada nuevo registro.

Hew Key Properties I

General Attributes |I:0anents| Options I Eieldsl

External Hame: I
¥ Bequire Unique Yalue
v Primary Fey
[v Auto Mumber
[" Case Sensitive
¥ Exclude Empty Keys

Cancel Help

8. Seleccione la lengieta Fields.

Designar el campo clave

1. Oprima el boton Insert.

Aparece la caja de dialogo Insert Key Component (“Indique componente de la clave™), para
que usted especifique el campo o los campos que componen la clave.

2. Dé poBLE cLIC sobre NumPedido.

Esto afiade el campo a la lista de los campos componentes para esta clave.
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MNew Key Properties

General | Altributes | Commentsl Options Eields |

Sart Order————
"5' Azcending

' Descending

Inzert |
Delete |
|,

0K I Cancel | Help |

3. Oprima el botén OK.

K|

Aparece una nueva caja de didlogo New Key Properties, para especificar una nueva clave.

Designar una clave foranea

Ahora podemos definir la clave del NumCliente. Los duplicados son permisibles en este archivo.
Se vincula a la clave primaria en el archivo Clientes, por lo que es una clave foranea.

1. Escriba KeyNumCliente en el campo Key Name.
2. Seleccione la lengieta Attributes.

La clave permite duplicados, de manera que deje las configuraciones preestablecidas.

New Key Properties [ X]

General Attributes |C0anents| Dgtionslfieldsl

Esternal Mame: I
[T Requite Urique Value
I Primary Key
™ Auto Mumber
[T Caze Sensitive

¥ Exclude Empty Keys

ok I Cancel | Help

3. Seleccione la lenglieta Fields.

4. Oprima el botén Insert.

Aparece la caja de didlogo Insert Key Component, para que especifique un campo o
campos para la clave.

5. Seleccione NumCliente y oprima el boton Select.
6. Oprima el botdn OK.

Cada vez que termina de definir una clave, aparece una caja de didlogo New Key
Properties, para que incorpore la proxima.
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7. Oprima el botén Cancel para cerrar la caja de dialogo New Key Properties.

La caja de dialogo del archivo Pedidos ahora aparece asi:

= Field / Key Definition - Pedidos [tutorial.dct] !IEIE I

Figlds Feps

=123 KeyMumClignte

----- =1 MumnClisnte [ASCENDIMNG)

o | »

Inzert | F'[opertiesl Delete |E| il

Cloze | Help |

8. Oprima el botén Close para cerrar la caja de dialogo Field/key Definition.

9. ElijaFile » Save, u oprima el boton Guardar de la barra de herramientas.
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Definicidn de Claves del archivo de Detalle

Los campos en el archivo de Detalle que se vinculan a otros archivos en la base de datos son
NumProductos y NumPedido.

___Detalle
NumCliente / NumPedido / NumProducto
Descripcion

NumPedido NumProducto

MontoFactura Cantidad Precio

Fecha ProdPrecio Tasalmponible
Nota Tasalmponible

+ EIl campo NumPedido se vincula al archivo Pedidos.

Habra valores duplicados en el campo NumPedido que se vincula a registros en el archivo de
Pedidos. La clave que definimos en el archivo de Detalle es otra clave foranea. La clave del
archivo Pedidos no permite duplicados ni valores nulos, y fue definida como clave primaria.

Puede haber mas de un registro de Detalle para un determinado NUmero de Pedido. Por lo
tanto, se trata de una relacion de muchos-a-uno, siendo el archivo Detalle el “hijo” del archivo
Pedidos.

El campo NumProducto se vincula al archivo Productos.

Habra valores duplicados en el campo NumProducto en los registros del archivo Detalle. Puede
haber mas de un registro Detalle (linea del pedido) referenciado a un Gnico Numero de
Producto. Por lo tanto, tenemos aqui otra relacién de muchos-a-uno, siendo el archivo Detalle
el “hijo” del archivo “Productos”.

Definicion de la primera clave foranea

Defina KeyNumProducto de manera que pueda haber duplicados valor NumProducto en este
archivo.

1. Destaque el archivo Detalle en la lista Files.
2. Oprima el bot6n Fiel/Keys...
3. Seleccione la lenglieta Keys.
4.
5
6

Oprima el botén Insert.

. Tipee KeyNumProducto en el campo Key Name.

. Seleccione la lenglieta Attributes.

Esta clave permite duplicados, de manera que deje todos los valores preestablecidos.

Seleccione la lengieta Fields.
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New Key Properties

Gereral  Adtributes |C0anents| Dgtionslfieldsl

External Mame: II
I Bequire Urique Yalue
™ Primary Key
I Auto Mumber
[T Caze Senzitive

V¥ Exclude Empty Keys

0K I Canicel Help

8. Oprima el botén Insert.

9. Elija NumProducto y haga DOBLE CLIC.
10. Oprima el boton OK.

Aparece una caja de didlogo Key Properties en blanco, esperando que usted especifique otra
clave.

Definicion de la segunda clave foranea

Tipee KeyNumPedido en el campo KeyName.
Seleccione la lengieta Fields.

Oprima el botén Insert.

Seleccione NumPedido y haga DOBLE CLIC.

Oprima el botén OK.

o g M 0w DR

Oprima el botén Cancel para cerrar la caja de didlogo New Key Properties en blanco.

La caja de dialogo Field/Key Definition del archivo de Detalle se ve ahora asi:
= Field / Key Definition - Detalle [tutorial.dct) == I

Fields Keys

L NumProducto [&5CEMDIMNG]
-3 KeyNumPedido
w3 NumPedido [ASCENDING]

| 3
Inzert | F'[npeltiesl Delete |i| il

Close | Help

7. Oprima el botén Close para cerrar la caja de didlogo Field/Key Definition.

8. ElijaFile » Save, u oprima el boton Guardar de la barra de herramientas.
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Definicidn de claves para el archivo de productos

Solamente un campo en el archivo de Productos se vincula a otro archivo en la base de datos: el
campo NumProducto.

¢ NumProducto se vincula al archivo Detalle.

/ NumProducto
NumProducto Descripcion
Cantidad Precio
ProdPrecio Tasalmponible

Tasalmponible

No debe haber ndmeros de pedido duplicados o nulos en el archivo de Productos, ya que es una
clave primaria.

Para cada NumProducto en el registro puede haber muchos registros Detalle. Esta es una
relacion uno-a-muchos, en que el archivo Productos es “Padre” del archivo Detalle.

Crear la clave primaria

Nombrar la clave

. Destaque el archivo Productos en la lista Files.
. Oprima el boton Field/Keys...

. Elija la lenglieta Keys.

1

2

3

4. Oprima el botén Insert.

5. Escriba KeyNumProducto en el campo KeyName.
6

. Elija la lenglieta Attributes.

New Key Properties E

General Attributes |C0mments| Dgtionslfieldsl

External Mame: I

W Bequire Urique Valus

W Primary Key

[~ Case Sensitive

W Ezclude Emply Keys

0K I Cancel | Help |

7. Marque el casillero Requiere Unique Value, y también el casillero Primary Key.

8. Marque el casillero Auto Number.



102 CLARION 5™ APRENDIENDO CLARION

9. Elijala lengieta Fields.

10. Oprima el boton Insert.

11. Elija NumProducto y haga DOBLE CLIC.
12. Presione el boton OK.

Aparece una caja de dialogo Key Properties en blanco, lista para la definicion de otra clave.

Definicién de una clave alfabética

Los usuarios probablemente querran ver la lista de Productos en orden alfabético, de manera que
afiadiremos la clave correspondiente.

1. Escriba KeyDescripcion en el campo Key Name.

2. Elijalalengieta Fields.

3. Oprima el botén Insert.

4. Elija Descripcion, y haga DOBLE CLIC.

5. Oprima el botén OK.

6. Oprima el botén Cancel para cerrar la caja de didlogo Key Properties en blanco.

La caja de didlogo Field / Key Definition del archivo Productos se ve asi:

= Field / Key Definition - Productos [tutorial_dct]

Ficlds Feys |

----- 1 MumProducta [ASCENDING)
=23 KeyDescripeion

« | »

Inzert | F'_rupeltiesl Delete | &.l ‘?‘l

Cloge | Help |

7. Oprima el botén Close para cerrar la caja de dialogo Field/Key Definition.

8. Escoja File » Save, u oprima el botén Guardar de la barra de herramientas.



LECCION 4 INCOPORACION DE CLAVES Y RELACIONES 103

Definicidn de relaciones entre archivos

Definicion de las relaciones de "Pedidos"

Ahora que tenemos definidas todas las claves, podemos afiadir relaciones. Una vez definidas
éstas, se pueden afiadir las Comprobaciones de Validez de los campos que sélo deben contener
valores ya existentes en otro archivo. Estas son las Ultimas etapas para completar el diccionario de
datos.

+ KeyNumPedido vincula el archivo de Pedidos al archivo de Detalle en una relacion de uno-a-
muchos..

¢ KeyNumCliente vincula el archivo Pedidos al archivo de Clientes en una relacién muchos-a-
uno.

Definicion de la primera relacion

1. Destaque el archivo Pedidos de la lista Files.

n

Oprima el botén Add Relation.

El tipo preconfigurado es 1:MANY, que es el correcto en este caso.
Elija KeyNumPedido de la lista desplegable Primary Key.
Escoja Detalle de la lista deaplegable Related File.

Elija KeyNumPedido de la lista desplegable Foreign Key.

o o~ W

Oprima el botén Map by Name ("Correlacionar por nombre").

Esto establece la relacion vinculando todos los campos en las dos claves que comparten el
mismo nombre.

Configuracién de las restricciones de integridad referencial

1. Elija Cascade de la lista On Update.

Esto indica a los templates que deben generar codigo para actualizar automaticamente todos los
registros "hijos" vinculados, cuando cambia el valor de la clave padre.

2. Elija Restrict de la lista On Delete.
Esto impide que el usuario borre un archivo "padre" que tenga archivos "hijos" vinculados.
3. Oprima el botén OK.

Definiendo la sequnda relacién

1. Destaque el archivo Pedidos de la lista Files.
2. Oprima el boton Add Relation.
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Edit Relationzhip Properties I

General |Eomments I Options I

~Relationzhip for PEDIDOS

Type |1 AT LI Erirnary K.eyp enMumPedido
~Child
Related File IDetalle LI Foreign K&y |k eyNumPedido LI
~Field M apping
Pedidoz - KepMumPedido Detalle -» FeyMumPedido
PED:MumPedido -» DETAL:MumPedido DETAL:NumPedido -» PED:MNumPedido

e [T [

Map By Name | kap By Order |

On Update Cazcade j On Delete IHestrict LI

ok I Cancel | Help |

"H eferential Integrity Constraint

Escoja MANY:1 de la lista desplegable Type.

Advierta que cuando elige MANY:1 , los indicadores de los campos Primary Key y Foreign
Key intercambian lugares. Esto ocurre porque estamos definiendo las relaciones desde el punto
de vista del archivo"hijo"; es el lado contrario de la relacion que hicimos previamente. Una
clave primaria siempre esta en el archivo "padre”, mientras que una clave foranea siempre
pertenece al archivo hijo.

Elija KeyNumCliente de la lista desplegable Foreign Key.

Elija Clientes de la lista Related File.

Esto establece el archivo de Clientes como el "Padre" en esta relacion
Escoja KeyNumCliente del listado desplegable Primary Key.
Oprima el botén Map by Name.

Configurar las resticiones de integridad referencial

1.

Elija Cascade de la lista On Update.

Aungque estamos definiendo esta relacion desde el lado del archivo "hijo", las restricciones de
integridad referencial se mantienen sobre las acciones del archivo "padre".

Elija Restrict de la lista On Delete.
Oprima el botén OK.

La caja de didlogo del Diccionario deberia verse asi:
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# Dictionary - tutorial.dct 1.0

iFile Related File
Clientes Add File <3 Detalle
Detalle - Detalles (lineas] de loz pedidc s i {e--3 Clientes
Pedidos - Cabecera de los pedidoz h
Praductas - Productos en venta Add Alias Add Relation |
Telefono

Properties... Properties...

Fields/Keys. .

Delete

il

CDelete

PEEELE

Browse

4 I I ﬂ Corvert

e

1L

Dictionan Properties... | Synchronize Cloge | Help

Elija File » Save, u oprima el botén Guardar de la barra de herramientas.

Definicion de las relaciones del archivo Detalle

Cada vez que se define una relacion en el Editor del Diccionario, es valida para ambos archivos a
la vez. Por lo tanto, dado que ya ha definido todas las relaciones del archivo Pedidos, solamente
queda una relacién por definir.

Esta Ultima relacién pertenece al archivo Detalle.

¢ La clave KeyNumPedido vincula el archivo de Pedidos al de Detalle en una relacion de uno-a-
muchos. Esto ya se ha definido.

¢ La clave KeyNumProducto vincula el archivo de Detalle al archivo de Productos en una
relacién de muchos-a-uno.

Definir la relaciéon

Destaque el archivo Detalle de la lista Files.

Oprima el botén Add Relation.

Elija MANY:1 de la lista desplegable Type.

Elija KeyNumProducto de la lista desplegable Foreign Key.
Escoja Productos de la lista deaplegable Related File.

Elija KeyNumProducto de la lista desplegable Primary Key.

N o o bk~ w D

Oprima el botén Map by Name (“Correlacionar por nombre™).
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Configuraciéon de las restricciones de integridad referencial

1. Elija Restrict de la lista desplegable On Update.

Esto impedira que se cambien los ndmeros de producto.
2. Elija Restrict de la lista desplegable On Delete.
3. Oprima el botén OK.

La caja de dialogo del diccionario ahora deberia verse asi:

7 Dictionary - tutorial.dct 1.0
File ~Related File
Cligntes Add File < ¢--» Pedidos
Detalle - Detalles [lineaz] de loz pedid —I (g P
Pedidas - Cabecera de los pedidas :
Froductos - Productos en venta Add Alias Add Relation |
Telefono —I
ml Properties... |
Fields.ﬂ'ﬁe_l,ls...l
Delete |
Delete |
Browse |
1 I I ﬂ Corvert I 4 | | ﬂ
Dictionary Properties. . | Sunchronize | Cloze | Help

4. ElijaFile » Save, u oprima el boton Guardar de la barra de herramientas.
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Definicion de comprobaciones de validez dependientes
de larelacion

Ahora que hemos definido todas las relaciones entre archivos, podemos configurar las
comprobaciones de validez de los dos campos que esperamos poner en las fichas o formularios.

¢ Cuando se ingresa un nuevo registro de Pedidos, podemos especificar que el NumCliente

corresponda a un registro ya existente en el archivo de Clientes.

+ Cuando se entra un nuevo registro de detalle, podemos especificar que el NumProducto debe

coincidir con un registro ya existente en el archivo de Productos.

Definicién de la comprobacion de validez de los registros de pedidos

o g A~ wDd PR

7.
8.

[lumine el archivo Pedidos en la lista Files.

Oprima el botén Fields/Keys...

Ilumine (destaque) NumCliente y oprima el boton de Properties.
Seleccione la lengieta Validity Checks.

Seleccione el boton de radio Must Be In File ("Debe existir en el archivo...)
Elija Clientes de la lista desplegable File Label.

Esta accion requiere que el campo contenga solamente valores  verificados, mediante la
consulta al registro correspondiente en el archivo Clientes.

Como esto se valida utilizando la informacién sobre relaciones del archivo, no es posible
configurar esta comprobacion de validez hasta que hayan sido definidas las relaciones.

General | Attibutes | Comments I Options | Help  Yalidity Checks |Winduw I FBeport I

" Mo Checks
Choices: |

Walues: |
" Cannat be Zera ar Blank

' Must be in Numeric Flange

T Lowest noo 32 ™ Highest I 0.00 33
= Must be True or Falze
True alue: | Falze Walue: |

' Must be in File
Filz Label:

' Must be in List
Choices: |

Yalues: |

OK I Cancel Help

Oprima el botén OK.

Oprima el botén Close para cerrar la caja de dialogo Field/Key Definition.
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Definicién de comprobaciones de validez para los registros de Detalle

Destaque el archivo Detalle de la lista Files.

Oprima el botén Field/Keys... .

Destaque NumProducto y oprima el botén Properties.
Elija la lenglieta Validity Checks.

Elija el boton de radio Must Be In File.

© g &~ w b E

Elija Productos de la lista File Label.

Edit Field Properties - NumProducto [ %]

General I Attributes I Commerts I Dgtlonsl Help  ¥alidty Checks |W|nd0w I Beportl
€ Mo Checks
Choices: |

Walues: |
" Cannot be Zero or Blank

" Must be in Mumeric Range

™ Lowest I noo 32 ™ Highest I 0.00 33

' Must be True or False
True ' alue: | False Value: |

¢ Must be in Flle
File Label:

= Must be in List
Choices: |

Yalues: |

0K I Cancel Help

7. Oprima el botén OK.
8. Oprima el botén Close para cerrar la caja de dialogo Field / Key Definition.

El diccionario de datos ya esta completo. En el siguiente capitulo, importaremos datos
existentes desde otra aplicacién, para mostrarle lo facil que es de lograr.



£
) - IMPORTACION DE DATOS PREEXISTENTES

Conversion de archivos de datos

Usted puede tener datos de aplicaciones heredadas que quiere conservar y usar en las aplicaciones
Clarion . Para esto, este capitulo le ensefiara a:

+ Importar una definicién de archivo a partir de datos preexistentes.

¢ Recorrer y modificar un archivo usando el Administrador de Base de Datos (" Database
Manager")

¢ Coémo convertir datos de un formato de archivo a otro.

Punto de inicio:
El archivo TUTORIAL.DCT debe estar abierto.

Importacion de una definicion de archivo .CSV

Una forma sencilla de convertir archivos de datos es exportar los datos existentes de la aplicacion
anterior a archivos de valores separados por comas(.CSV). Se trata del formato de archivo
utilizado originalmente por el lenguaje Basic, en que los datos se contienen entre comillas dobles,
los campos estan separados por comas Y los registros se separan mediante un retorno de carro y
avance de linea. El controlador Clarion de archivos BASIC lee y escribe estos archivos .CSV.

Importaremos la definicion de un archivo .CSV existente que contiene datos de Clientes, luego
generaremos un programa simple de conversion de datos (para demostrar lo facil que es), que los
colocara en un archivo TopSpeed.

Importacion de la definicion de archivo

1. ElijaFile » Import File.

Select File Driver Ea

File Driver : Bi&SIC [Comma Delimited)

Cancel |

2. Seleccione BASIC de la lista desplegable y luego oprima el botén OK.
Aparece la caja de didlogo Open BASIC File.
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3. En el campo Filename, escriba c:\clarion5\examples\tutor\importl.csv y luego oprima el
boton OK.

Open BASIC File E

Fileparmne : I amplesitutorlmport].cey J

Optians : I Cancel |

Aparece la caja de didlogo Edit File Properties.

4, Oprima el botén OK.

Edit File Properties E

General | Comments I Optians |

Usage: @& File © Global ¢ Pool

M ame: m

Description: |

Prefig: IIrnp—

File Driver: |EASIE [Camma Delimited) LI
Driyer Options: |

Owher Name: |

Full Pathnarne: | C:ACLARIOMEME xampleshtutortdmport] . cav

[~ Enable File Creation [¥ Open in Current Thread ™ Export Fields
r Reclaim Delsted Records [T Use OEM Collation ™ 32Eit Oy
™ Encrypt Data Records [ Enable Field Binding
[~ Freeze
akx Cancel | Help |

Ahora tiene la definicién del archivo IMPORT1.CSV. El siguiente paso sera echar un vistazo a
los datos en el Administrador de Bases de Datos.

Modificacion de los datos

Dé cLic bERECHO sobre el archivo IMPORT1.CSV, ilumine Browse IMPORT1 y luego dé cLic
para llamar al Administrador de Bases de Datos.

Froperties
Fields/Feyz

& Import]
Convert

Cut Chrle
Copy  Chl+C

Delete
Refresh File
Diigtribute File

El Administrador de Bases de Datos de Clarion le permite modificar en forma directa los datos de
los archivos. Se trata de una herramienta para el programador, disefiada para permitirle hacer
todos los cambios necesarios en los archivos. Esto significa que no hay salvaguardas contra
violaciones de la integridad referencial o de la integridad de los datos. Por lo tanto, esta
herramienta debe usarse con mucho cuidado.
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Advierta que el primer registro contiene los nombres de campos, no datos. Este es el modo
estandar de construir archivos .CSV. También, esos nombres de campo son exactamente los

mismos que los nombres de campo de las definiciones del archivo Clientes (lo que facilitara
mucho la conversion )

Conversion de un archivo de datos

En este punto, usted esta obsevando a los datos del archivo .CSV en el Administrador de Bases de

Datos Clarion.Lo siguiente es llevar esos datos a un archivo TopSpeed, para que los programs
Clarion puedan usarlos.

Generacion de un programa convertidor de archivos

1. ElijaFile » Convert File (u oprima CRTL+V)

Aparece la caja de didlogo File Convert.

2. En el campo Target Filename, escriba Clientes.TPS como nombre del nuevo archivo
(eliminando todo el texto preconfigurado que habia en el campo).

3. Oprima el botén de tres puntos suspensivos (...) junto al campo Target Structure.
4, Destaque Clientes, y luego oprima el botén Select.

La caja de didlogo File Convert deberia aparecer ahora asi :

File Convert

Source Filenare: IIDNS'\ExampIes\tutor\lmporﬂ.cw J ok |

Source Dictionary: IC:\CL&HIDNE‘\TUTUDHIAL\TUT J

Cancel |

Source Structure: IImporH |
Help

T arget Filename: I |JMEAE sampleshtutoryClisntes. tps J

Target Dictionary: I C:ACLARIOMZATUTUORIALLTUT J
Target Shucture: IEIientes

Generated Source: IC:\CL&HIDNS\TUTUDHI.&L\ED J
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Cuando oprima el botén OK, esto generara todo el codigo Clarion necesario para tomar los
datos del archivo fuente (Source Filename), y copiarlos en un nuevo archivo de
destino(Target Filename), utilizando el formato de archivo especificado en la estructura de
destino (Target Structure).

La mejor razén para generar codigo fuente Clarion para la conversion de datos es darle la
oportunidad de modificar el cédigo antes de su compilacion y ejecucion, lo que da la
oportunidad de manejar cualquier necesidad especial que uno pueda tener referente a la
conversion. Esto hace completamente flexible el proceso de conversion para manejar cualquier
situacién que pudiera presentarse.

Oprima el botén OK.
Aparecera un mensaje que anuncia la generacion del cédigo fuente.
Oprima el botén OK para regresar al Administrador de Bases de Datos.

Oprima el botén Exit para salir del Administrador de Base de Datos.
Borrado de la definicién del archivo IMPORT1

El Unico fin de esta definicion era permitir que el Administrador de Bases de Datos generara el
cadigo de conversién. Por lo tanto, podemos eliminarlo ahora del Diccionario de Datos.

Estando iluminado IMPORTZ, oprima el boton Delete.
Oprima el botén Yes cuando se le pregunte si confirma el borrado.

Oprima el botén Close para salir del Editor del Diccionario de Datos, y oprima el boton Yes
para guardar los cambios al salir.

Compilacion vy ejecucidon del programa convertidor

Elija File > Open (u oprima CTRL+0).

Seleccione Clarion source (*.clw) de la lista desplegable File of type.
Seleccione la carpeta C:\CLARIONS\TUTORIAL.

Destaque el archivo CONVERT.CLW y oprima el botén Open.

# Clarion 5 [demo1._app] - [C:A\CLARIONSAT utuorial\Convert. clw] | _ 2] x]
D File  Archive DataModeller Edit Search Project Setup Window Help -|E'|5|

O GEH ZC# i 8 |

PROGRAM ﬂ

HAP
CheckError(),LOHG
END

SourceName STRIHG{258)
TargetName STRING(268)
Count ULOHG
Import1 FILE,DRIVER({'BASIC"),NAHE{SourceName) ,PRE{ IN}
RECORD RECORD
CustHumber STRING(32)
Company STRINE(32)
FirstHane STRING(32)
LastName STRING(32)
Address STRING(32)
city STRING({32)
State STRING(32)
Zipcode STRING({32)
END

EHD
Clientes FILE,DRIVER{ ' TOPSPEED") ,NAME{TargetName) ,CREATE ,PRE(CLI)
KeyNumCliente KEY(+CLI:NunCliente),0PT,NDCASE
KeyEmpresa KEY(+CLI:Empresa),DUP ,NOCASE
KeycP KEY({+CLI:CP}),DUP,NOCASE
RECORD RECORD
NumGliente LONG
Empresa STRING({28)
Hombres STRING(28)
Apellidos STRING(28) _lj
4 »

[ [Line: 1 [Cal 1 [Ingert [



Aparece el Editor de Texto Clarion, con el archivo cargado para modificar.

El Administrador de Bases de Datos creé el cédigo fuente de conversién en este archivo, que
contiene todo lo necesario para leer los datos del archivo BASIC vy copiarlo al archivo
TopSpeed.

5. Elija Project » Set ....

Select Project BHE
Buscaren: | ‘2 Tutucrisl =] g' = =
Coarvett.pri

Hombre de archiva: IEnnvert

Archivos de Hipo: IF'rniec:t File [*.prj) j Cancelar |

Aparece la caja de didlogo Select Proyect.

6. Elija Proyect file (*.prj) de la lista desplegable File of type.
7. Seleccione el directorio C:\CLARIONS\TUTORIAL.
8. Destaque el archivo CONVERT.PRJ, y luego oprima el botén Open.

El Adminstrador de Bases de Datos generé también el archivo CONVERT.PRJ al mismo
tiempo que el archivo fuente CONVERT.CLW.

Cada programa Clarion tiene un Proyecto ("Project") que controla las opciones para la
compilacion del cédigo fuente y el linkeado para producir el archivo .EXE resultante. En el
caso de programas codificados a mano (y conversiones de archivos generadas por el
Administrador de  Bases de Datos), estas configuraciones se contienen en un archivo .PRJ.
No hay necesidad de un .PRJ cuando se usa el Generador de Aplicaciones, dado que el archivo
.APP mismo contiene todas las configuraciones del Proyecto.

En este punto, podriamos modificar el cédigo fuente para realizar cualquier conversion de
datos que se necesite (véase los temas en la ayuda en linea sobre: How to Convert a File-
Generate Source y How to Make a Field Assignment para mas informacion sobre como
adaptar el cédigo de conversion de datos). Sin embargo, no hay nada que debamos hacer en
este proyecto, asi que basta con compilar y ejecutar el programa.

9. Elija Project » Run (uoprima CRTL+R)

Esto compila el programa, lo linkea a un .EXE, y corre el ejecutable resultante para realizar la
conversion de archivos. Mientras corre el programa, aparece una ventana de estado, que
indica el estado de la conversion. Dado que hay s6lo unos pocos registros que convertir en este
caso, desaparecera muy pronto y probablemente no podra verla.

10. Elija File » Close para cerrar el archivo y salir del Editor de Texto.



Prueba

Ahora puede comprobar los datos en el nuevo archivo, abriéndolo con el Administrador de
Bases de Datos y desplazandose por los registros.

Elija File » Open (uoprima CTRL+0)

Elija Database file de la lista desplegable File of type, ilumine el archivo CLIENTES.TPS, y
oprima el botén Open.

Se abre una caja de dialogo que pregunta por el Controlador (driver) del archivo, la contrasefia
(password), y opciones necesarias para abrir el archivo.

C:ACLARIONSAT utuorial\Clientes_tps

Diiver:  [TOPSPEED |

Owuner : I ]

Options : I Cancel |

Seleccione TOPSPEED de la lista desplegable Driver, y oprima el boton OK.

Esto demuestra otra forma de abrir el Administrador de Bases de Datos, distinta que desde el
Editor del Diccionario.

Adviértase que el primer registro contiene los nombres de campo y no datos, asi como ocurria
en el archivo en el archivo IMPORT1.CSV. No se necesitan tales nombres en este archivo, de
modo que puede borrar este registro indtil.

Con la barra deslizable ubicada sobre el primer registro, oprima DELETE, luego oprima el
boton Yes cuando se le pregunte si confirma el borrado.

Oprima el botén Yes cuando se le pregunte si desea hacer un archivo de respaldo(backup).

El Administrador de Bases de Datos siempre pregunta si desea hacer una copia de seguridad
antes de realizar cualquier tipo de modificacion de los datos. Siempre es buena idea premitir
que lo haga (jpor las dudas!).

Oprima el botén Exit.

Aparece un mensaje que pregunta si se desea guardar los cambios realizados en el archivo
CLIENTES.TPS. Este dialogo ofrece una oportunidad adicional para deshacer los cambios
realizados, si se da cuenta que fue un error efectuar modificaciones. Yes guarda los cambios y
sale; No revierte el archivo al estado en que estaba cuando usted ingresd al Administrador de
Bases de Datos y sale, y Cancel lo devuelve al Administrador.

Oprima el botén Yes para guardar los cambios realizados.

Ahora usted ha convertido algunos datos existentes importantes al formato TopSpeed para que
las aplicaciones Clarion puedan usarlos. En el siguiente capitulo, comenzaremos a construir
una aplicacion "desde cero" usando el Generador de Aplicaciones.
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6 - EMPEZANDO LA PROGRAMACION

Uso del generador de Aplicaciones

Habiendo completado el Diccionario de Datos, ahora puede utilizarse el Generador de
Aplicaciones para crear la aplicacion. Este capitulo muestra como:

+ Crear el archivo .APP, que guarda todo el trabajo del proyecto.
o Definir el primer procedimiento (Main) para crear un marco de aplicacion MDI, y cémo
Illamar a los procedimientos desde el menu de la aplicacion.

Punto Inicial:
Debe estar abierto solamente el entorno de desarrollo Clarion.

Creacion del archivo .APP

1. ElijaFile » New » Application.

2. Seleccione Application (*.app) de la lista desplegable Save as type.
3. Seleccione el directorio C\CLARIONS\TUTORIAL.

4. Escriba TUTORIAL en el campo File Name.

5. Despeje el casillero Use Quick Start, y oprima el botén Save.
Aparece la caja de dialogo Application Properties.

6. Tipee TUTORIAL.DCT en el campo Dictionary.

7. Despeje el casillero Application Wizard.

Este cursillo del generador de Aplicaciones no utilizara los Wizards, para demostrar como usar
las herramientas que provee Clarion

Application Properties I
Application File: |Tutu0rial.app J oK I
Dictionary File: | c:\elarionShutuarialtutarial dot J Cancel |
First Pracedure: | b ain
Destination Type: [Ex=cutable [EXE] =l Help |
Help File: | IO
Application Template: |AB C J

[ToDoil2BC) =

8. Oprima OK para cerrar la caja de dialogo Application Properties.



Creacion del procedimiento principal (Main)

Aparce la caja de didlogo con el arbol de la aplicacién (Application Tree). Este presenta un listado
de todos los procedimientos de la aplicacion en un arbol légico que ofrece una guia visual que
muestra el orden en que un procedimiento llama a otro. Lo vimos por primera vez en el Cursillo de
Inicio Rapido.

El procedimiento Main es el punto de inicio. La aplicacion del cursillo sera un programa con
interfaz de documentos multiples (MDI). Por lo tanto, el lugar natural donde empezar es definir el
procedimiento Main utilizando el template Frame para crear un marco de la aplicacion.

Seleccion del tipo de procedimiento para Main

1. Teniendo a Main destacado en la caja de didlogo Application Tree, oprima el botdn
Properties.

2. Destaque Frame en la caja de dialogo Select Procedure Type, despeje el casillero Use
Procedure Wizard, y oprima Select.

& Select Procedure Type [ x|
I | Select I
—1-[[3 Class ABC - Application Builder Class Templates =
Browse - Browse Fields in a Page-Loaded List Box ﬂl

External - Extemnal Procedure
Form -View / Edit a Record from a File

Frame - Multiple Document bain Menu Help |

tenu - Single Document Menu
Process - Sequential Record Processar
Repart - Generic Reporting Procedure
Source - Source Procedure

Splash - Splash ‘Window

Yiewer - View a ASCI [test] file

“windaow - Generic Window Handler

—1-[[3 Class CPCSAbcRpts - CPCS [ABC) Enhanced Reporting Templates v

> - UnivabcProcess - Universal ABC Process Procedure _Iﬂ
3

00000000000

4
[T Use Procedure Wizard

Aparece la caja de didlogo Procedure Properties. Define la funcionalidad y las estructuras
de datos del procedimiento.

3. Escriba SplashScreen en el campo Splash Procedure.

Esto da nombre al procedimiento que contiene una pantalla de apertura que aparecera
brevemente mientras el usuario abre la aplicacion.

Procedure Main Properties
Pracedure Mame: Main Files | oK I
Template: Frame[ABC]

f Cancel
D escription: I J Jﬂl J
Categony: Eeport | J
Pratotype:
Module Mame: ITutuoDD‘I.ch vl J Data | J Help |
[ Declare Globally Procedures |

Parameters: | o |
Retum Walue: I J =mhees

‘window Behavior | Formulas |
Splazh Procedure: I_SplashSc:leen ILI J Estersians |

Drate and Time Dizplay | =
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Generalmente la primera tarea cuando se crea un procedimiento es disefiar la ventana principal.
Se pueden colocar controles, o si el template ya tiene controles, puede personalizarlos.

El marco de la aplicacion jamas lleva controles sobre si. Windows no lo permite. Sin embargo,
personalizaremos el titulo de la ventana (el texto que aparece en la barra de titulo). Luego
afiadiremos items al menU predefinido, que también esta preconfigurado en la plantilla del
procedimiento Frame, y crearemos una barra de herramientas para la aplicacion (una barra de
herramientas si puede incluir controles).

Modificacién de la ventana Main

1. Oprima el botén Window.

Aparece el Disefiador de Ventanas. Aqui estan todas las herramientas necesarias para disefiar
visualmente la ventana y sus controles.

2. ElijaView > Show Propertybox para mostrar la barra de herramientas flotante Property
(si no esta ya presente).

3. Dé un cLic sobre la ventana de titulo para darle foco , con lo que apareceran asas (“manijitas”
o0 handles) coloradas en los bordes de la ventana.

4, Escriba “Aplicacion del cursillo” en el campo Text en la barra de herramientas flotante
Property, luego oprima TAB.

¥ Window Formatter

Exitl Edit Control Alignment Menu Toolbar Populate Yiew Preview

v X mxeanaag s @

| AodicocindolCursle M= 80
File Edit Window Help

Coniral ______F|
’T Str Pro: [26]
e [ 86 =
- L2 o I
Text: |Applicaci0’n del Cursillo @ @
Lser I— [osrs e H Hoel
Font: I—E / . . ’j
Size: | ~| B U a [vex o il

o _ _'ILI

| APPLICATION[pplicacién del Cursilo’] AT(,.310,200) STATUS(,80,120.45).5 |

Esto modifica el texto del titulo en la ventana de muestra. Asegurese de que las asas estén
dentro del marco de la aplicacion de muestra al ejecutar este paso.
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Edicion del menu

Desde el menu del Disefiador de Ventanas, puede llamar al Editor de Menus, que permite afiadir o
modificar los items del menu de la ventana del marco de la aplicacion. Al agregar cada item, se
puede seleccionar la lengiieta TAB para nombrar el procedimiento a ejecutar cuando el usuario
escoge ese item.

Por cada nuevo procedimiento que se afiade al men(, el Generador de Aplicaciones agrega un
procedimiento “ToDo” (“por hacer”) al arbol de la aplicacion. Después puede definirse la
funcionalidad de ese procedimiento, de la misma manera que ahora se estd definiendo la
funcionalidad del marco de la aplicacion.

Cuando el Generador de Aplicaciones genera el codigo fuente para la aplicacion, automaticamente
abre un nuevo “hilo de ejecucion” para cada procedimiento llamado desde el menu principal (lo
que es necesario en toda aplicacién MDI).

Agregado de items al menu

1. Desde el menu del Disefiador de Ventanas, elija Menu » Edit Menu (o simplemente dé
DOBLE cLIc sobre la barra de acciones del mend en el disefio de ventana).

Aparece el Editor de Menus. Muestra el menu en forma jerarquica en un listado a la izquierda.
Los campos a la derecha permiten nombrar y personalizar los menus desplegables y sus items.

Esta plantilla viene ya provista con el men( “estandar”. Contiene érdenes basicas como Exit
en el mend File, las 6rdenes comunes Cut, Copy, y Paste, y las 6rdenes de manejo basico
de ventanas que se encuentran cominmente en una aplicacion MDI.

Menu Editor [ <]
b % e ®| b l¥l| General |.ﬂgpearance I Actionsl
Mﬁéﬂ%"ﬁ'gpl ﬂ Menu Text: |
ile
ITEM Print Setup... UzeVariable; |
ITEM SEFARATOR .
ITEM Edait Message: |
END Help ID: |
MEMU &Edit
ITEM Cutt 5td ID: | =1
ITEM &Copy Positior: lﬁ
| ITEM #Pasie R Hormal
CEND rHot Key
MENU &w/indow Key: | _|
ITEM Thkile

ITEM &Cazcade Menu Text: |

ITEM &Arrange lcons
MD

rFlag
MEMU &Help

ITEM &Contents

ITEM &Search for Help On...

R 21|
Help | Close |

2. llumine la segunda sentencia END (véase la ilustracion).

El Editor de Menu inserta nuevos item inmediatamente debajo de la seleccion iluminada. El
menl a afiadir se llamarda Formularios. Contendra tres items: Productos, Clientes y
Pedidos. Aparecera en la barra de mend justo antes del mend Window.

3. Oprima el botén New Menu del extremo superior izquierdo (0 presione SHIFT+INSERT).
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4.

Esto inserta una nueva sentencia MENU, y su sentencia END correspondiente.

Escriba Fo&rmularios en el campo Menu Text y oprima TAB.

Menu Editor [x]
b % e E| = l¥l| Geperal |Appearanc:e I Qctionsl
MENUBAR - Meru Text: |F0&rmularios|
MENU &File ;
ITEM Pliint Setup... Usze Y ariable: |?F0rmularios
ITEM SEPARATOR :
ITEM Eduit Message: |
END Help ID: |
MENU &Edit
ITEM Cut Std 1D: | =]
ITEM &Copy Pasition: |
ITEM &Paste (R Mormal
END rHot ey
MENU Fofrmularios Key: | _|
END :
MENU Ewindow Menu Teut: |
ITEM Tile
ITEM &Cazcade ~Flag
gy Bhnange lcons I Disable ltem [ Hide
MENU &Help [ Right Justify
a4 » I vI

Help | Cloze |

Esto define el texto que aparecera en el mend. El ampersand (&) sefiala que el caracter
siguiente (r) estara subrayado y proveera un “atajo del teclado” (el usuario podrd oprimir
ALT+R para activar este menQ).

Adreqgar el primer item del menu

1.

Oprima el botén Newltem (o presione INSERT).

Esto actualiza la lista a la izquierda de la caja de dialogo, cambiando el texto del men( que
acaba de afiadir a “Fo&rmularios”. Agrega un nuevo ITEM de menu -una orden en el mend
desplegable- bajo Fo&rmularios, y antes de la sentencia END que va con el mend
&Formularios.

Escriba &Clientes en el campo Menu Text y oprima TAB.

Aparece ?FormulariosClientes en el campo Use. Esto es una “equivalencia” (equate) del item
de mend, al que se referiran las sentencias del cédigo fuente. El signo de interrogacion
antepuesto (?) indica que es un rétulo de campo equivalente (field equate label) (véase el libro
Language Reference).

Elija la lenglieta Actions.

Los indicadores permiten nombrar un procedimiento a ejecutarse cuando el usuario seleccione
el item del ment Formularios » Clientes.

Elija Call a Procedure de la lista desplegable When Pressed (“Cuando se oprima”).
Aparecen nuevo indicadores para que nombre el procedimiento a llamar y otras opciones.
Escriba VerClientes en el campo Procedure Name.

Esto crea un procedimiento “ToDo” (por hacer) en el arbol de la aplicacion.

Marque la casilla Initiate Thread (“Abrir un hilo de ejecucion”).

El procedimiento VerClientes mostrara una ventana “hija” MDI, siempre debe comenzarse un
nuevo hilo de ejecucion para cada ventana MDI que se Ilame directamente desde el marco de la
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aplicacién. El campo Thread Stack (“Pila del hilo de ejecucion™) muestra el valor minimo
recomendado.

Menu Editor E
0 % e E| =t l¥l| General I Appearance fSctions |
MaréﬁﬁlAEF'l ﬂ ~Menu/Button Control Prompt
" |CalaProcedve ]
ITEM Piint Setup.. ‘when Pressed - Call a Procedure
ITEM SEFARATOR Procedure Definitior
ITEM Edxit Procedure Mame: IVerCIientes I:I
Eﬂpé?»lu AEdit ¥ initiate Thread
i
ITEM Cuit Thread Stack: 258,000 =
ITEM &Capy Theaded Procedure Call D finitio
ITEM &Paste Parameters:
END -
MENL Folmularios Feturn Thread Yariable: | J
ITEM &Clientes
END
MENL &wfindow
ITEM Tiile

ITEM &Cascade
ITEM &awrange lcons
END

Embeds |
Help | Cloze |

Adicion del sequndo item del menu

1.

Oprima el botén Newltem.

Esto actualiza la lista a la izquierda, cambiando el texto del texto que acaba de agregar a
“&Clientes”.

Escriba &Productos en el campo Menu Text y oprima TAB.
Aparece ?FormulariosProductos en el campo Use.

Normalmente, la siguiente etapa es definir la accion que realizara este item del mend (lo que se
gjecutard cuando el usuario final escoge esta opcion). Esta vez, saltaremos esta accion,
solamente en este item. Mas tarde, usted creard un procedimiento copiandolo, y luego
adjuntandolo al mend, sélo para demostrar esta capacidad del entorno Clarion.

Adicion del tercer item del menu

o a0 &~

Oprima el botén Newltem.

Escriba &Pedidos en el campo Menu Field y oprima TAB.

Aparece ?FormulariosPedidos en el campo Use.

Elija la lengiieta Actions.

Elija Call a Procedure desde la lista desplegable When Pressed.
Escriba VerPedidos en el campo Procedure Name.

Marque el casillero Initiate Thread.

Cierre del Editor de Menu y del Disefiador de Ventanas

1.

Oprima el botén Close para cerrar el Editor de Mend.

Esto lo regresa al Disefiador de Ventanas.



2. Elija la opcién Exit! y responda Yes cuando se le pregunte si guardard los cambios a la
ventana.

Esto lo regresa a la caja de dialogo Procedure Properties.
3. Oprima el botén OK para cerrar caja de dialogo Procedure Properties.

Esto lo regresa a la caja didlogo Application Tree (“Arbol de la Aplicacion™). Hay ahora tres
nuevos procedimientos marcador como “ToDo”: VerCliente, VerPedidos, y SplashScreen.
Estos fueron los procedimientos que usted nombré en Editor de Mends.

“* Tutuorial.app - Application Tree

Procedure |M0dule| Template | Hame I Qategor}ll Global

Froperties...

Project

[Z] SplashScreen [ToDo)
Z VerClientes [ToDo)
----- 2 ¥erPedidos [ToDo)

Cancel

dpdayid:

Help

4. ElijaFile » Save, uoprima el boton Guardar en la barra de herramientas.

Creacion del procedimiento SpalshScreen

Nombramos un procediemiento Splash (“pantalla de presentacion™), y ahora lo crearemos.
1. Destaque el procedimiento SpalshScreen (ToDo) y oprima el botén Properties.

2. Seleccione Splash en la caja de didlogo Select Procedure Type, despeje el casillero Use
Procedure Wizard, y oprima el botén Select.

Aparece la caja de didlogo Procedure Properties. No hay nada que tengamos que hacer con
este procedimiento en el cursillo, salvo aceptar todas las opciones preconfiguradas.

Procedure SplashScreen Properties E
Procedure Mame: SplazhScreen oK I
Template: Splash(&BC

emp.a '_3 (S 1 J Cancel I
D escription: I J d
Category: J
Frotatype:
M odule Mame: |TutuoDD2.ch vl J i | J Help I
I Declare Globally Procedures |
Parameters: |
Embeds |
Return Walue: I J
‘window Behavior | Formulas |
The Splash Window will sutomatically cloze .
when the user makes a selection on the frame. Extensions |
*Y'ou can customize any other ways to cloze the
window.

Display Time [in seconds): |5 —
¥ Cloze when the uzer clicks an the zplash window.

3. Oprima el botén OK.
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Adicion de una barra de herramientas de la Aplicacién

Llamar al Disefiador de Ventanas y crear la barra de herramientas

1. Destaque el procedimiento Main.

2. Dé cLIc DERECHO para activar el men( contextual.
Adviértase que este menl contextual tiene un grupo de opciones que equivale a la columna de
botones ubicada a la derecha de cada ventana de Procedure Properties. Este menu
contextual da acceso directo a todas las herramientas Clarion que se usan para modificar
procedimientos existentes, para que no tenga que pasar por la ventana Procedure
Properties cada vez.

Tutuorial. app - Application Tree | (O] x| I
Procedure |Modu\e| Template | Name I Qategoryl Gilobal |
| Properties. .. I
| = U I —r—— :
E SplashScreen [Splash) IFepels FiafEe! |
- VerClientes [ToDo) Files
B VerPedidos [ToDo) v Window oK
EEepart: —
v Data Cancel |
Procedures
Embeds
Formulas Help |
v Extensions
i adule
Source
Synchronize
Delete
" Rename N

3. ElijaWindow.

4. En el mend del Disefiador de Ventanas, elija Toolbar » NewToolbar (“Barra de
herramientas > Nueva”).
Esto afiade la barra de herramientas, que siempre aparece inmediatamente debajo del mend, a
la ventana de muestra. Puede afiadir cualquier control a la barra de herramientas dando cLic
sobre un icono de herramienta en la caja flotante de herramientas Controls, y luego dando
CLIC sobre su barra de herramientas.

A Window Formatter
Exil Edit Contol Alignment Menu Toolbar Populate View  Prewiew!

v x & al/a =3 e

=
+ Applicacién del Cursillo _ Ol =] lo
File Edit Formularios Window Help
n
|

Texk
Use
Eont -
Size: ~| Bru e Jore| [l

| | _’ILI

| TOOLBAR AT(0.0..25) [MODE : Toolbar
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Colocar el primer botén

1. Dé cLic sobre la herramienta de botdn (el que se ve como botén “OK™).

2. Dé cuLic en el area de la barra de herramientas de la ventana, justo debajo del angulo superior
izquierdo.

3. Dé cLic bErRecHO sobre el boton que acaba de colocar, luego elija Properties del menu
contextual.
Aparece la caja de didlogo Button Properties.

A& Window Formatter
Exitl Edit Contral Alignment Menu Toolbar Populate  View  Preview!

|lvx Bl anzg @
| Applcaciandol Cursil__________________________________Mm=EB

File Edit Formularios Window Help

L] a
= Button 1 :
| = N - E—

Froperties.
Actions..
Embeds...

Eant.
Eeu.
Alert.
Pasition
List Box, Format |

Duplicats
Delete

[Custar...
pen
Synchronize

Text: Button 1
Usz:  [7Buttond
Foe [ [
Sze [ [-] BS U fvex [oiE| il

g I of

EUTTOM[Button 14T (8.14.45,14) USE(?ButtonT] [MODE : Mormal

4. Borre el contenido del campo Text.
Colocaremos imagenes en esos botones, en lugar de texto, para dar una apariencia mas
contemporanea al disefio.

5. Escriba ?BotonCliente en el campo Use.
Este es el rétulo de campo equivalente para referenciar el botén en el cddigo. Incluimos la
palabra “boton” para la legibilidad del cédigo.

Button Properties I

General |E:-:t@ |§0I0r | Help IEosilion | éctionsl

Text:
Use: TBotonClients

Justification: |0 efault - l

tode
" Hide [ Disable [ Skip [ Scral

[T Transparentl Freeze

Cancel Help

Fant... |
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10.
11

12.
13.

14.
15.
16.
17.

18.
19.
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Elija la lenglieta Extra.
Marque el casillero Flat.

Despliegue la lista Icon, desplacese hasta el fondo y dé cLic sobre Select File ... Aparece la
caja de didlogo Select Image File.

Button Properties E I

General Extra |§0I0r I Help |Eositi0nlgctions|

lcon: C:WCLARIOMSYE xamplesitutoriyCustomer. g ifﬂ J
Optiar:
[ Flat ™ Required ™ Default Button
[ Immediate
Delay: 04 Repeat: I ] 3:
STD id: =]
Drop 1D I

Font... | DK I Cancel I Help |

Elija el archivo C:\CLARIONS\EXAMPLES\TUTOR\CUSTOMER.GIF, y oprima el boton
Open.

Seleccione la lengiieta Help.
Escriba Ver listado de clientes en el campo Tip.

Esto afiade una acotacién, que aparecera cada vez que el cursor del mouse se detenga sobre el
boton.

Elija la lenglieta Position.

Seleccione los botones de radio fijos (Fixed) para tanto el largo(Width) como la altura
(Height).

Configure el largo (Width) a 16 y la altura (Height) a 14.

Elija la lengiieta Actions.

Elija Call a Procedure de la caja desplegable When Pressed.
Elija VerClientes de la caja desplegable Procedure Name.

Este es el procedimiento que usted nombro en el item Formularios » Clientes. Oprimir el
boton llamard al mismo procedimiento. A menudo, un boton de 6rdenes en una barra de
herramientas sirve de atajo para ejecutar una opcion del mend.

Marque el casillero Initiate Thread.

Oprima el botén OK.

Colocaciéon del sequndo boton

1.
2.

De cLlIc sobre la herramienta “botén”.

De cLic sobre el area de la barra de herramientas de la ventana en que estamos trabajando,
justo a la derecha del primer botdn. Aparece otro botdn, etiquetado “Button2”.
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De cLIC DERECHO sobre este botén, y elija Properties del menu contextual.

Borre el campo Text.

Escriba ?BotonProductos en el campo Use.

Elija la lenglieta Extra.

Marque la casilla Flat.

Despliegue la lista de iconos (Icon), desplacese hasta el fondo y dé CLIC sobre Select File...

Seleccione el archivo de ejemplo C:\CLARIONS\EXAMPLES\TUTOR\PRODUCTS.GIF, y
luego oprima el botén Open.

© © N o g > w

10. Seleccione la lengueta Help.
11. Escriba Ver listado de productos en el campo Tip.
12. Oprima el botén OK para cerrar la caja de dialogo Button Properties.

Normalmente, en este punto se adjunta una accion al boton. Por ahora, saltearemos esa accion.
Mas tarde, para demostrar el uso de los puntos de insercion de codigo, copiaremos un
procedimiento, y lo llamaremos en el punto de cédigo fuente que maneja qué debe hacerse
cuando el usuario final oprime el botén.

Colocaciéon del tercer boton

1. Dé cLic sobre la herramienta “boton”.
2. DécLicen el area de la barra de herramientas, al lado del segundo botén.

3. De cLIC DERECHO sobre el botén que acaba de ubicar, luego elija Properties del menu
contextual.

Borre el contenido del campo Text.

Tipee ?BotonPedidos en el campo Use.

Seleccione la lengiieta Extra.

Marque la casilla Flat.

Despliegue la lista Icon, desplacese hasta el fondo y dé cLic sobre Select File... .

Elija el archivo C:\CLARIONS\EXAMPLES\TUTOR\ORDERS.GIF, y oprima el botén Open.
10. Elija la lengueta Help.

© ©o N o a &

11. Tipee Ver listado de pedidos en el campo Tip.

12. Seleccione la lengiieta Actions.

13. Elija Call a Procedure de la lista desplegable When Pressed.
14. Elija VerPedidos de la lista desplegable Procedure Name.

Este es el nombre del procedimiento que escribi6 en el item de mend Formularios >
Pedidos.

15. Marque con una tilde el casillero Initiate Thread.
16. Oprima el bot6n Ok.
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Cambiar el tamafno de los botones y alinearlos

El disefiador de Ventanas trae un juego de herramientas de alineamiento que facilitan el ajuste y
alineamiento de los controles.

1.

Con el botén Pedidos todavia seleccionado, de cTRL+cLIC en el boton Clientes.

Esto pone “manijitas” o “asas” alrededor de ambos botones, y el botén Clientes tiene asas
rojas, lo que indica que posee el foco.

Dar cTRL+cCLIC es la accion de “seleccion multiple” que permite realizar acciones en varios
controles a la vez. Una vez que se han seleccionado controles multiples, también puede
moverlos ARRASTRANDO cualquiera de los controles seccionados, 0 pueden usarse cualquiera
de las herramientas de alineacion (Alignment), que actGan sobre todo el grupo seleccionado.

Con ambos botones todavia seleccionados, de cTRL+cLIC sobre el botén Productos.

Ahora los tres botones tienen asas y el tltimo boton seleccionado, Productos, las tiene rojas, lo
que indica que posee el foco, y es el “control maestro” para el alineamiento.

Dé cLIc DERECHO Y elija “Alineamiento superior” (Align Top) del men( contextual.

Cuando tiene seleccionados controles multiples, un CLIC DERECHO muestra un menu contextual
de alineamiento, en lugar del mend contextual del control aislado. Esta accion alineara los tres
botones a la altura de Productos.

Dé cLic DERECHO Y elija “Espaciamiento horizontal” (Spread Horizontally) del menu
contextual.

Esto distancia en forma proporcional los tres botones. Que no estén demasiado separados, jpara
dejar lugar para lo que viene!

Adgregar los botones de control del Browse

1.

Elija Populate » Control Template... (0 dé CLIC sobre la herramienta Control Template:
la que se ubica en el angulo inferior derecho de la caja flotante de herramientas Controls).

Aparece la caja de didlogo Select Control Template.
[lumine el template FrameBrowseControl, y oprima el botén Select.
Dé cLic en la barra de herramientas de la ventana, a la derecha del botén Pedidos.

Sobre la barra de herramientas aparecen los trece botones de control del browse. Ya conoce
esos botones, por la aplicacion que cred en la seccion anterior. Estos botones controlan el
desplazamiento del listado y la llamada al procedimiento de actualizacién que creara mas
adelante.

El disefio de pantalla debera verse ahora muy parecido a esto:
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A& Window Formatter [_[o]=]

Exitl Edit Contral Alignment Menu Toolbar Populate  View  Preview!
v x #acla8=3iEQ
\ Applicacién del Cursillo _ (O] x]f0 8
File Edit Formularios Window Help

m’@ih;éwwﬁwwm‘f@:&mw?

Text  |Applicacicn del Cursilo ”
e [
Fant: - / He® D

Size: -] BF U n Fex o {l D

°€ o — o

APFLICATION[Applicacion del Cursila) AT(,.310,200), S TATUS(1.80,120,45)5Y [MODE : Mormal

Cierre el Disefiador de Ventanas y quarde el trabajo

1. Escoja la seleccion del menu Exit! y responda Yes cuando se le pregunte si desea guardar los
cambios en la ventana.

Esto lo devuelve directamente al arbol de la aplicacion, que contiene los mismos dos
procedimientos, marcados como “por hacer” (ToDo): VerClientes y VerPedidos.

2. ElijaFile » Save, u oprima el botén Guardar de la barra de herramientas.

Prueba de una aplicacion en desarrollo

1. Con el arbol de la aplicacién abierto, elija Project » Run, u oprima el botén Ejecutar de la
barra de tareas.

El Generador de Aplicaciones genera el cédigo fuente, mostrando el avance del proceso en una
ventana de mensaje, procedimiento por procedimiento.

A continuacién aparece la ventana Make, mostrando el progreso del trabajo del compilador y
linkeador.

c:hclarionShtutuonalttutuorial. app [ %]

Compiling tutuobel_clw ;I el e
No erors =.
M aking tutuocbc_obj [tutuorial.clw changed)
Compiling tutucbe.clw

No erors

M aking tutuor~2.obj [file does not exist)
Compiling tutuorial. clw

No erors

Making 1.obj ial.clw changed) Diebug
Compiling tutuo001 _clw

No erors

Making 2.obj ial_clw changed)
Compiling tutuoDD2_clw

Mo emors Cancel
Making 003.obj [ ial.clw changed)
Compiling tutuo003._clw

No errors
Maki 004_obj

Statistics

ul

=} (=]
e =

orial.clw changed)

K
Including: ABBROWSE INC

=
o
No enors 1
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Luego aparece la ventana inicial de la Aplicacion, que deberia ser aproximadamente asi:

£ Applicacién del Cursillo H=E

1 File Edit Formularios Window Help

|m;@&h§@%@@ﬁ%%%%vk§*@w%?

Thiz iz your application!

‘wiritten uzing Clarion 5

TopSpeed

2. Oprima uno de los botones de la barra de herramientas, o escoja uno de los items del men(
Formularios.

Aparece el siguiente mensaje:

Esta capacidad le permite probar la aplicacién en modo progresivo, sea que haya disefiado
todos los procedimientos o no.

En el proximo capitulo lo completaremos.

Procedure not defined I

& The Procedure YerClientes haz not been defined.

3. Oprima el botén OK para cerrar la caja de mensajes.
4, ElijaFile » Exit para cerrar la nueva aplicacion.

Durante todo el resto de este cursillo, no tenga reparos en generar y ejecutar (Make and Run) la
aplicacién en desarrollo, en cualquier punto en que el cursillo le indique guardar el archivo.

Estudio del cédigo fuente generado

Veamos ahora lo que el Generador de Aplicaciones ha hecho. El propdsito del generador de
Aplicaciones( y sus Templates) es escribir el cddigo fuente Clarion por usted. No hay “magia
en lo que hace este conjunto de herramientas para crear aplicaciones: todo se resume en el
lenguaje de programacién Clarion.



1. Teniendo abierto el arbol de la aplicacion , dé cLic sobre la lengiieta Module.

Esto cambia su vision de la aplicacion del arbol que muestra la légica con que se van llamando
los procedimientos a los madulos de cddigo fuente creados para la aplicacion.

2. llumine el médulo TUTORIAL.CLW, dé cLIC DERECHO para mostrar el menU contextual y
luego dé cLic sobre Module.

Esto lo lleva directamente al Editor de Texto, para observar el Gltimo cédigo fuente que genero
(la Gltima vez que oprimié el botén Ejecutar). Cualesquiera cambios que haya hecho desde la
altima vez que generd el codigo no seran visibles aqui.

“ tutuorial.app - Module view

Procedure  Module |Temp|_ate I Name | Categomy I Global |
I Properties... I
- tutuarial ch - Default Pragram . Project |
= tutuo007 . chw - Generated Source Module
LB Main (Frame) Data
=l tutuol02, chv - Generated Source Module Embeds Ok, |
o [E] SplashScreen [Splash)
= tutuo003, el - Generated Source Module = Cancel |
El VerClientes [ToDo] Sgnchionize
=] tubuo004, clw - Generated Source Module DE'IL
‘.0 VerPedidos (ToDo) Help |
4 »

El archivo TUTORIAL.CLW es el médulo de programa principal de esta aplicacion, donde se
contiene todo el codigo y las declaraciones de datos globales. No se deje asustar por todo este
codigo. Una vez que haya terminado con el cursillo, puede consultar la “Introduccion al
lenguaje Clarion” al final de este libro y familiarizarse mas con el lenguaje Clarion (que, de
hecho, es muy simple).

% Clarion 5 [tutuorial. app] - [C:\clarionS\tutuorialtutuorial. clw]
D File  Archive Databodeller Edit Search Project Setup Window Help _|E'|5|

G SeH #C#¥ w0l aH

PROGRAH ﬂ

_ABCD11Mode_ EQUATE({B)
_RBCLinkHode_ EQUATE{1)

INCLUDE " ABERROR . INC *),0NCE
INCLUDE( *ABFILE.INC ') ,0NCE
INCLUDE(*ABUTIL.INC *),0NCE
INCLUDE ¢ * ABWIMDOW. IMC* ) ,0NCE
INCLUDE ¢ *EQUATES .CLY* ) ,ONCE
INCLUDE( *ERRORS _CLY" ) ,0NCE

INCLUDE " KE¥CODES .CLU" ) ,0NCE

HAP
MODULE( " TUTUDBC .CLW")
DctInit PROCEDURE
Dctkill PROCEDURE
END
*-—— Application Global and Exported Procedure Definitions ----——-----—--—-—-
MODULE( " TUTUDBAT .CLYW")
Hain PROCEDURE H
EHD
EHND

sl o

| [Line: 23 [Cal 7 | Inzert |
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3. Cuando haya terminado de observar el cddigo, elija File » Close para cerrar el Editor de

Texto y regresar al Generador de Aplicaciones.

Pero NO vaya a elegir File » Exit, o saldra completamente de Clarion for Windows.
Ahora dé cLic sobre la lengiieta Procedure.

Hacerlo, cambia su vista de la aplicacion en el arbol de procedimientos.

Destaque el procedimiento Main (Frame), de CLIC DERECHO para activar el mend contextual, y
dé cLic sobre Module.

Esto lo lleva de nuevo al Editor de Texto, a observar el Gltimo codigo fuente que genero para el
procedimiento Main. De nuevo, los cambios que haya realizado en el generador de
Aplicaciones desde la Gltima vez que gener6 codigo no apareceran en este codigo.

Quizas advierta que justo debajo de la seleccion Module habia otra llamada Source. No las
confunda, ya que hacen cosas muy diferentes. Mas adelante demostraremos la seleccidn
Source.

# Clarion 5 [tutuorial.app) - [C:\clarion5Atutuonial\tutuo001_clw]
[ File Archive DataModeller Edit Search Project Setup ‘window Help =] x|

P HSH 2C¥ vy &

MEMBER({ ' tutuorial.clu") * This is a MEMBER mod

IHCLUDE{ "ABTOOLEBA.IHC" ) ,0HCE
IHCLUDE({ "ABWINHDOW.IHC" ) ,0HCE

MAP
INCLUDE( "TUTUDB&1.IHC") ,0NCE *Local module pro
INCLUDE( "TUTUDB82 .INC") ,0NCE *Req'd for module
INCLUDE( "TUTUDBA3 .IHC ") ,0NCE tReq’'d for module
INCLUDE( "TUTUDABY  THC") ,0NCE *Req'd for module
EHD
Main PROCEDURE t*Generated from proced
FilesOpened BYTE
SplashProcedureThread LONG
AppFrame APPLICATION( *Applicacidn del Cursillo*}),AT(,,318,198),S
MEMUBAR
MEHU{'&File"') ,USE{?FileMenu} -
4| 3
[ [Line: 17 [Col: 1 [Inzert

Si hace cambios en el cédigo, puede compilar y ejecutar el programa para ver que efectos
causan los cambios. Sin embargo, los cambios realizados aqui se perderan la
préxima vez que genere el codigo fuente. Por lo tanto, no es buena practica realizar
cambios aqui.

Esta capacidad de ver codigo fuente es muy Util para estudiar cédigo generado para determinar
el contexto dentro del cual aparecera el cédigo que desee afiadir en los puntos de insercién
(més adelante trataremos esto).

Cuando haya terminado de observar el cédigo, elija File > Close para cerrar el Editor de
Texto y regresar al Generador de Aplicaciones.



7 - CREACION DE UN BROWSE

Creacion una ventana Browse

En este capitulo, crearemos una ventana de visualizacién de listados(browse) parecida a la que cre6
para usted el Asistente para Inicio Rapido. El Generador de Aplicaciones usa las mismas plantillas,
que generan el mismo cédigo fuente basico; pero haciendo asi tendra la oportunidad de "hacerlo
desde cero”. Esto demuestra todo lo que los Asistentes pueden hacer por usted, y cuanto puede hacer
usted también. Empezaremos la ventana browse de Clientes.

Punto de inicio:
El archivo TUTORIAL.APP debe estar abierto.

Creacion de la visualizacion del listado de clientes

Usted recordara que el Asistente para Inicio Rapido cre6 una ventana para el procedimiento browse
de Clientes, que se veia asi:

% Browse the Clientes File I

CLI:KeyNumCliente | CLI:KeyErmpresa | CLI:KeyCP |

Mum Cliente | Empresa Mambres I Direccion

4] |

Ahora, crearemos una similar utilizando el template de procedimiento Browse.

Seleccidon del tipo de procedimiento para VerClientes

1. Dé posLE cLIC sobre VerClientes en el arbol de la aplicacion.

2. Destaque (ilumine) la plantilla Browse en la caja de dialogo Select Procedure Type,
verifique que la casilla Use Procedure Wizard no esté marcada y oprima el botén Select.

Se abre la caja de didlogo Procedure Properties.
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Hacer ajustable el tamafio de la ventana

1
2.
3.

4.

En la caja de didlogo Procedure Properties, oprima el botéon Extensions.
En la caja de didlogo Extensions and Control Templates, oprima el botén Insert.

Ilumine WindowResize en la caja de dialogo Select Extension, y oprima el boton Select.
Esta Plantilla de Extension genera codigo para manejar automaticamente el ajuste de tamafio y
reubicacion de todos los controles de la ventana cuando el usuario cambia el tamafio de la
ventana, o cuando oprime los botones de Maximizar o Restaurar.

Oprima el botén OK para cerrar la caja de didlogo Extension and Control Template.

Modificacién del procedimento Browse

1
2.

En la caja de didlogo Procedure Properties, oprima el botén Window.

Dé cLic DERECHO sobre la ventana de titulo de la ventana, y elija Properties del mend
contextual.

Tipee Browse Clientes en el campo Text.
Elija Resizable de la lista desplegable Frame Type.

Seleccione la lengiieta Extra y marque el casillero Maximize Box.
Estos dos Ultimos pasos le permiten al usuario cambiar el tamafio de la ventana durante la
gjecucion.

Oprima el botén OK para cerrar la caja de dialogo Window Properties.

Llenado y disefio de una caja de listado

Utilizando el Disefiador de Cajas de Listado, puede llenar y dar formato a los campos del
diccionario de datos que aparecen en las columnas de la lista.

Prepararse a dar formato a la ventana de listado

Dé cLICc DERECHO sobre la caja de listados en la ventana, y elija List Box Format... del menu

contextual.
# Window Formatter [_ O] =]
Exitl Edit Control aAlignment Menu Toobar Populate  Wiew  Preview!
v % e sllanag i @
Bl
i Browse Clientes O] x] 640x480 800
' 3
Properties.
Actions...
Embeds.
m L]
Eont..
Eey...
Alert.
XS] n Mo | e ] |
Duplicat
Insert | Change I Delete 6::;0:5 Close ’T Str Pro: [nel
Mpen.. N v
Synchronize & g B8
opeity - [+l &
e [ B e Y
Use: PList
P — ZHe®
Size: : BIu Foe [ete “

| Bl LILI

[LIST AT[5.5,235,1000,USE?List)IMM HvSCROLL MSG(Browsing Records'),FRL [Horz. or Vert. Move: SHIFT +diag
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Aparece la caja de didlogo Select Field, que da acceso a los archivos definidos en el diccionario.
El listado Files muestra todos los archivos seleccionados para usar en este procedimiento en un
orden jerarquico, o arbol de archivos (File Schematic) que incluye el control de cajas de listado.

Elija el archivo y los campos para colocar en el listado

1. lumine el item "ToDo" debajo de FilemBrowsing List Box y oprima el botén Insert.

Select Field [ x|
Files Figlds -

=-[Z7 File Schematic
=-[1] FileBrowsing List Box
D <TaDox
(I3 OTHER FILES
[0 GLOBAL DATA
(23 MODULE DATA tutuo003. chw
(] LOCAL DATA VerClientes

Al JL3 [ NI N 2
Insert | Exit | Uelete | Selech I Hew | Cancell

2. Destaque el archivo Clientes en la caja de didlogo Insert File, y oprima el botén Select.

Esto afiade el archivo al arbol en la caja de didlogo Select Field, que ahora muestra el archivo
Yy SUS campos.

3. Oprima el botén Edit.

4, Destaque KeyNumCliente en la caja de didlogo Change Access Key y oprima el bot6n
Select.

Esto es importante, porque indica el orden de visulaizacion de los registros. Si no se especifica
una clave, los registros aparecen en el orden en que fueron incorporados al archivo (también
Ilamado "orden de los registros™)

Select Field
Files : Figlds :

—D File-Browsing List Box ~E CL:Empresa

Clientes - CLI:KeyNumCliente ~E CLI:Nombres

~[I3 OTHER FILES B Clipelides

[ GLOBAL DATA ~F CLl:Direccion
#~[Z3 MODULE DATA tutuo003.cle ~ CLkCiudad
“-[Z] LOCAL DATA VerClientes ~E CLI:Provincia
B3 CLECP
T I | NI I
Irsert | Edit | Delete | Select I Mew | Cancel |

5. llumine CLI: Empresa en la lista Fields, y oprima el botén Select. Esto lo regresa al Disefiador
de Cajas de Listado, con el campo selecionado afiadido a la lista. La lengleta de la derecha le
permiten disefiar la apariencia del campo.
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# List box formatter |_ (O] x|
HE T [« o BOL~Empress™ @5 20@H1H
General |Appearance|
~Header
Heading text: IEmpresa
‘width: an s Scrollbar: I 03:
Justificatior: ILeft v[ Indent: | DE[i
~Data
Picture : I@SZU J
Justification: ILeft hd l Indent : I DH:
~Flag:
[™ Right Border [C Fized ™ Color
" Besizeabls [ Last on line " Style
™ Underline [C Locator
Help | ak I Cancel | Lpply |

Aplicacion de un formato especial al primer campo

1. Elija la lenglieta General marque los casilleros de "Borde Derecho" (Right Border) y
"Permitir cambio de tamafio" (Resizable). En tiempo de ejecucidn, esto afiadira un borde vertical
reconfigurable a la derecha del campo.

2. Dé un cuic sobre las flechas hacia arriba de las cajas de "Sangria" (Indent) para dar una ligera
sangria al texto de la cabecera y al contenido del campo.

# List box formatter |_ (O] x|
Empresa |
SIS
SSSSSTEIBEIIIEI58S
! i

I B0LM )M ~Empresa™ @5 20@H1#

General |Appealance |
~Header

Heading text: I Empresa

“width: I an 3: Serollbar: I 03:
Justification: ILelt A l Indent; I 1 3:
~Data

Picture : I @520 J
Justification: ILelt - I Indent : I 3:
~Flag

¥ Right Border [ Fixed ™ Color

¥ Besizeable ™ Last online [ Stie

" Underline [T Locator

Help | oK I Cancel | Lpply

Llenado del segundo campo

1. Oprima el boton New Column (Insertar columna nueva).

Lice SRy

\— New Column (Insert)
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2. Destaque CLI:Nombres en la lista Fields, y oprima el botén Select.

3. Despeje los casilleros de "Borde Derecho” (Right Border) y "Permitir cambio de tamafio”
(Resizable).

El Disefiador de Cajas de Listado automaticamente “arrastra” esas opciones del Gltimo campo
afiadido a los campos que se sigan afiadiendo, lo que hace muy facil incorporar campos
maltiples con similares opciones de formato. En este caso, el borrar las marcas de los casilleros
borra el divisor de columnas entre esta columna y la siguiente, que sera el campo Apellidos.

A& List box formatter H= K=

Empresa

$35384303893490434 348

K| ul

PO IR | [ 8001 Nombres~ @3 2024

ﬁ CLI:E rpresa General |Appearance|
~Header
Heading text: I Mombres
“width: I an 3: Scrollbar: 0 :
Justification: ILeft - l Indent: I 1 3:
~Data
PFicture : I @520 J
Justification: ILeft hd l Indent : I 1 3:
~Flag:
" Right Border [ Fixed ™ Colar
[" Besizeabls ™ Laston line " Siyle
™ Underling [T Locator

Help ok I LCancel | Apply

Llenado del tercer campo

1. Oprima el botén de New Column.
2. llumine CLI:Apellidos en la lista de campos (Fields), y oprima el boton Select.
3. Marque los casilleros Right Border y Resizable.

Esto nuevamente afiade el divisor de columnas ajustable entre esta columna y la préxima.

Adgrupamiento de algunos campos

e

1. Presione el boton Nuevo Grupo (Agrega un Grupo).

2. Presione up ARROW para ilumninar el nuevo grupo. \— New Group (Shift+Insert)

Esto le permitird agregar una cabecera de grupo para la informacion referida al domicilio. Esta
Gltima aparece “sobre” las cabeceras de los campos, y visualmente une los datos contenidos en
las columnas que abarca.

3. Tipee Datos del Domicilio en el campo encabezado (Heading Text).

Esto proporciona el texto a la cabecera de grupo. Todo campo que se agregue a la derecha
quedara incluido en el grupo, hasta que se defina un grupo nuevo.
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£ List box formatter

Empresa Nombres Apellidas

Direccion
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Note que los efectos que se producen por agregar campos y efectuar modificaciones se reflejan
en la caja de listado de muestra que aparece en la parte superior del Disefiador de Cajas de
Listado. Ademas puede emplear los tres botones ubicados a la derecha del de New Column para
eliminar la columna correspondiente al campo iluminado (Delete Column), mover la columna
a la izquierda (Move Column Left) o mover la columna a la derecha (Move Column
Rigtht), respectivamente.

TETE o A T
el

Move Column Right (Ctrl+Down)

Delete Column (Delete) J \—

Move Column Left (Ctrl + Up)

4. llumine CLI:Direccion en el Disefiador de Cajas de Listado.

Llenado del guinto campo

1. Oprima el boton New Column.

2. llumine CLI: Ciudad en la lista Fields, y oprima el botén Select.

Llenado del sexto campo

1. Oprima el boton New Column.

2. Destaque CLI:Provincia en el listado de Fields, y oprima el boton Select.

Llenado del séptimo campo v salida del Disefiador
1. Oprima el Populate.

2. Destaque CLI:CP en el listado de Fields, y oprima el botén Select.

3. Oprima el botén OK para cerrar el Disefiador de Cajas de Listado.
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Adicion de las lengletas

Cuando el Quick Start Wizard cre6 este procedimiento, tenia controles de lenglietas que cambiaban
el orden de visualizacion de la lista segun la lenglieta seleccionada. Por lo tanto, afiadiremos esta
funcionalidad para mostrar lo facil que es hacerlo.

Afadir la Hoja de Propiedades vy la primera lenglueta

1. Dé cLic sobre la ventana de titulo para que aparezcan las asas rojas en los bordes de la ventana.

2. Coloqgue el cursor del mouse directamente sobre el asa central de la parte superior, y ARRASTRE
para aumentar el espacio en la parte de arriba.

IT Str Pro: [2E]

ez
Lr

[e 75 25 =

Vi ®

EE @ : Property Sheet
FoE e B T
4 I JN

e iz ) [

3. Dé cLic sobre el control de propiedades de la hoja (Property Sheet) en la caja flotante de
herramientas Controls (la que parece varias carpetas de archivo y esta a la derecha del circulo).

4, Dé un cLic sobre y a la derecha de la caja de listado para colocar la hoja de propiedades y un
control de lenglieta .

5. ARRASTRE el "asa roja" del angulo inferior izquierdo de manera que aparezca justo abajo y a la
izquierda del boton Insert.

6. ARRASTRE el "asa roja" del angulo inferior derecho de manera que aparezca justo abajo y a la
izquierda del boton Close.

Esto modifica el tamafio de la hoja de propiedades de modo que parezca que la caja de listado y
los botones estan sobre la lengiieta. De hecho, no lo estan, y no queremos que estén, dado que
deseamos que estos controles sean visibles, sin importar la lengleta que el usuario haya
seleccionado. La ventana se veria ahora mas o menos asi:

n =] =]
Tab 1 |
Empresa Nombres Apellidos Iﬂ
L £
=
Insert | Change I Delete Select Close |
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7. Dé cLic sobre el texto "Tab 1", en el campo Text de la caja flotante Property.

8. Escriba KeyNumCliente en el campo Text en la caja flotante de herramientas Property y pulse
TAB.

Esto cambia el texto de la lengueta. El texto es libre, pero si se pone el nombre de la clave,
también indica el orden de visualizacion .

Adicion de las demas lengietas

1. Dé cLic sobre el Tab control en la caja flotante de herramientas Controls (es la que se parece a
una sola carpeta).

R St P

[ 5] /3% =

R [
=8 (3B B8 8 [ios)

e o g [

2. Dé cLic inmediatamente a la derecha KeyNumCliente para colocar la nueva lengiieta .

3. Escriba KeyEmpresa en el campo Text de la caja flotante de herramientas Property, y oprima
TAB.

4, Dé cLic sobre el Tab control en la caja flotante de herramientas Controls.

5. Dé cLic inmediatamente a la derecha de la lenglieta KeyEmpresa para colocar la siguiente
lengieta.

6. Escriba KeyCP en el campo Text de la caja flotante de herramientas Property, y oprima TAB.

Esconder los botones

Cuando el Asistente de Inicio Rapido cred este procedimiento no tenia botones de Agregar,
Cambiar, Borrar y Cerrar; o al menos, justed no pudo verlos al ejecutar el programa! En realidad, los
botones estan alli, pero estan escondidos para que el usuario utilice solamente los botones de la
barra de herramientas para modificar el archivo.

El "secreto” es que los botones de la barra de herramientas simplemente ordenaban a los botones
escondidos del procedimiento Browse que hagan lo que siempre hacen. Por lo tanto, cuando usted
disefia un procedimiento Browse sin utilizar los Asistentes, necesita tener los botones de
actualizacion sobre la pantalla; pero no es necesario que el usuario los vea el ejecutar el programa.

1. Dé cLic perecHO sobre el boton Close de la ventana de muestra, y luego dé cLic sobre
Properties... en el men( contextual.
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Marque el casillero de "Esconder” (Hide), y oprima el botén OK.

Esto afiade el atributo HIDE al control, de manera que no sea visible en pantalla durante la
gjecucién. Claro que siempre puede vérselo en el Disefiador de Ventanas.

Dé cLic DERECHO sobre el boton Select, y luego dé cLic sobre Properties... .
Marque el casillero Hide, y oprima el botén OK.

Dé cLic DERECHO sobre el boton Delete y dé cLIC sobre Properties....
Marque el casillero Hide, y oprima el botén OK.

Dé cLIc DERECHO sobre el boton Change.

Marque el casillero Hide, y oprima el botén OK.

Dé cLIc DERECHO sobre el boton Insert y dé cLIC sobre Properties... .

10. Marque el casillero Hide, y oprima el botén OK.

Mover los botones y cambiar el tamarfio de la lista

No hay necesidad de desperdiciar el espacio que ocupan esos botones (que el usuario no puede ver),
de manera que los sacaremos de en medio.

1

Dé cLic sobre el botén Close y luego oprima MAYUS+CLIC Y ARRASTRE el boton hacia arriba,
dentro del listado.

ARRASTRAR Un botén con la tecla MAYUS (SHIFT) oprimida permite mover el control en la linea
recta: si empieza a moverlo hacia abajo sélo ira hacia arriba y hacia abajo; si empieza a moverlo
hacia un lado, s6lo se desplazara horizontalmente.

Oprima el botén NO cuando se le pregunte si desea moverlo dentro de la lengiieta (Tab).

Dé cLic sobre el boton Select y luego dé crTL+CLIC sobre los botones Insert, Change y Delete
para seleccionarlos todos, y luego dé cLic y arrastre los botones hacia la caja de listado.

ARRASTRAR controles multiples simultaneamente permite moverlos manteniendo sus posiciones
relativas dentro del grupo.

Oprima el botén NO cuando se le pregunte si desea moverlos dentro de la lengleta (Tab).
Ahora, usaremos el espacio ganado para extender el listado.

Dé cLic sobre la caja de listado, y ARRASTRE el asa inferior del centro hacia abajo, para
prolongar la lista.

Prueba del Browse de clientes

El Disefiador de Ventanas tiene un modo de prueba, que ofrece una vista preliminar de cémo
aparece la ventana sobre el escritorio. Dado que se trata de una ventana MDI, aparecera dentro del
marco del Disefiador de Ventanas.
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Elija Preview! en la barra del menu del Disefiador de Ventanas.

% Browse Clientes H=l B3
KeyNumCliente |KcyEmpresa | KcyCPl

Empresa Nombres Apellidos ;|

[ | | >|v|

Oprima Esc (o el boton X) para regresar al Disefiador de Ventanas.

Ordenamientos de visualizacion

Ahora que han sido colocadas las lenglietas, debemos indicar a la caja de listado qué ordenamientos
utilizar.

1

Dé cLIc DERECHO sobre la caja de listado, y elija Actions... de menU contextual.

La caja de listado es en realidad una plantilla de control BrowseBox que ha sido colocada en la
ventana preconfigurada de la plantilla de procedimiento Browse, en el Registro de Plantillas
(Template Registry) ( véase la User’s Guide para mas informacion sobre el Template Registry).
Esto significa que tiene indicadores asociados que le indicaran como llenar el listado y las
acciones a realizar.

Los indicadores que aparecen en la lengleta Actions vienen directamente de los templates (en
este caso, la plantilla BrowseBox). De esta manera, puede comunicarse a las plantillas
exactamente qué codigo deben generar para producir exactamente la funcionalidad que usted
necesita. Esos indicadores, sus usos y significados, estan cubiertos en la Guia del usuario y
en la ayuda en linea de cada ventana en que aparecen.

Seleccione la lengiieta de funcionamiento condicional (Conditional Behavior).
Oprima el botén Insert.
Escriba CHOICE(?Sheetl) = 2 en el campo Condition.

Esto indica la condicion bajo la cual se utilizara el orden alterno de visualizacion. Esta expresion
utiliza la funcién CHOICE del lenguaje Clarion (véase Language Reference) para detectar
cuando el usuario ha elegido la segunda lenglieta de la hoja. El cddigo generado usara esa
expresion en una sentencia condicional que cambiard el orden de visualizacion cuando el
programa se ejecute.

Oprima el botén con tres puntos suspensivos(...) junto al campo Key to Use.

Destaque CLI: KeyEmpresa y oprima el boton Select en la caja de dialogo Select Key.



Conditional Browse Behavior

Additional Sart Fields |

Fieset Fields | Scroll Bar Behavwvior |

Conditian: |CHOICE[?Sheetl] = 2 [ o |

Foey to Uge: |ELI:Ke}IE mpresa J Cancel |
Locator Behawviar |

Record Filter: I Help

Range Limit Eield: | I —l—

Fange Limit Type: |Cunent Value =

Ahora, cuando el usuario elija la segunda lengieta, la plantilla de control BrowseBox generara
codigo para elegir la clave del campo Empresa. No necesita saber qué hacer con la primer
lengieta, dado que siempre utiliza la clave de acceso que configuramos en el arbol de archivos

(File Schematic).
7. Oprima el boton OK.

8. Oprima el botén Insert.

9. Escriba CHOICE(?Sheetl) = 3 en el campo Condition.

10. Oprima el boton con tres puntos suspensivos(...) junto al campo Key to Use.

11. Destaque CLI: KeyCP y oprima el botén Select en la caja de dialogo Select Key.

12. Oprima el botén OK.

List Properties
Eenerall Extra IEDIDr IHglp IEosition Actions |

Default Behavior Conditional Behavior |Hot Fieids { 4[|

Delete | .| &

Inzert Properties

Fies |

Embeds |

[ x|

Cancel |

Fant... |

Help |

13. Oprima el boton OK para cerrar la caja de didlogo List Properties.
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Cierre el Browse de Clientes

Elija Exit! en la barra del menG del Disefiador de Ventanas, y guarde los cambios en la ventana,
cuando se le indique.

Oprima el botén OK en la caja de didlogo Procedure Properties para cerrarla.

Elija File » Save, u oprima el botén Guardar para grabar el trabajo realizado.
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Creacion de un procedimiento de actualizacion

En el capitulo anterior, disefiamos la caja de listados del procedimiento browse de Clientes, y
afiadimos lenguetas para cambiar el orden de visualizacion. Para terminar con el procedimiento
basico, nombraremos el procedimiento de actualizacion (update procedure). Este es el
procedimiento que maneja la accién de los botones de Agregar, Cambiar y Borrar (Insert, Change
y Delete).

Punto de inicio:
El archivo TUTORIAL.APP debe estar abierto.

Incorporacion de un procedimiento “ToDo”

1. Destaque VerClientes en la caja de dialogo del arbol de la aplicacion, y oprima el bot6n
Properties.

Aparece la caja de dialogo de propiedades del procedimiento (Procedure Properties). Hay
tres modos de llegar a esta caja de dialogo, para que usted use el que mas le convenga:

+ Destaque el procedimiento y luego oprima el botén Properties.
¢ Dé DOBLE CLICK en la caja de dialogo del arbol de la aplicacion.
+ Dé cLic DERECHO sobe el procedimiento y elija Properties del menu contextual.

2. Escriba FichaCliente en la caja de entrada de datos Update Procedure ubicada al pie de la
caja de didlogo Procedure Properties.

Esto da nombre al procedimiento que permite afiadir y modificar(actualizar) los regitros que
muestra el browse. El nuevo procedimiento aparece en el arbol de la aplicacion como “Por
Hacer” (ToDo”).

3. Oprima el botén OK para cerrar la caja de dialogo Procedure Properties.

% tutuorial_app - Application Tree

Pracedure |M0dule I Template | Hamelgategnryl Glabal |
| ‘ Properties... I
=13 Main [Frame] —
>D SplashScreen [Splash] st
ERER =rClientes [Erowse)

- -0 FichaCliente (ToDo)
. [F] WerPedidos [ToDo)
Cancel

dy e

Help




Advierta que no tuvo que iniciar un nuevo hilo de ejecucion para este procedimiento. Debe
correr sobre el mismo hilo que el browse, para que el usuario no pueda abrir una ventana de
ficha o formulario para cambiar un registro, después active la ventana de browse de nuevo, y
abra otra ficha sobre el mismo registro. En otras palabras, jno seria bueno dejar que el usuario
intente cambiar el mismo registro dos veces a la vez!

Creacion del procedimiento de Ficha o Formulario

El procedimiento de actualizacion debe utilizar el template Form Procedure para crear un
procedimiento que el usuario final pueda utilizar para mantener los registros.

Seleccionar el tipo de procedimiento para FichaCliente

1.
2.

Dé poBLE cLIC sobre FichaCliente en el arbol de la aplicacion.

llumine la plantilla de procedimientos Form, despeje el casillero Use Procedure Wizard, y
oprima el boton Select.

Aparecera la ventana Procedure Properties. Advierta que esta caja dialogo luce diferente a
las de los deméas procedimientos con que hemos trabajado, porque los indicadores a la
izquierda varian segln cada tipo de Procedure template. EI Application Handbook y la ayuda
en linea describen las opciones de personalizacion disponibles en cada caja de didlogo
Procedure Properties.

Procedure FichaCliente Properties
Frocedure Mame: FichaCliente ? Files | ok I
T emplate: window[AB )

i Cancel
Description: I J Jﬂl J
Categaory: |Farm Eeport | J
Frotatype: |
Module Mame: [tutuo005, chey | o Daa | J Help |
™ Declars Globally Procedures |
Farameters: | —— |
Returt ' alue: I J S8
Window Behavior | Formulas |
—Save Button Propertie .
Allawy: ¥ Inserts ¥ Changes W Deletes Jml
Field Priming on Inzert | Messages and Titles I
~Record Yalidation
Control Yalue Y alidation Conditions..
[ Yalidate when the contral is Accepted
¥ Validate during Non-Stop Select
Do Mot Validate. |

Oprima el botdn Files para nombrar el archivo sobre el que trabajara el formulario.

Aparece la caja de didlogo File Schematic Definition.

Destaque el item “ToDo” debajo de la expresion “Actualizacion del archivo en el disco
(Update Record on Disk) y oprima el boton Insert.

5. Destaque el archivo Clientes en la caja de didlogo Select File, y oprima el boton Select.
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File Schematic Definition [ x|

Files :

=1L File Schematic
— -[Z3 Update Recard an Disk

E Clientes

(7] OTHER FILES

(] GLOBAL DATA

[:| MODULE DATA tubuo005. chy

D LOCAL DATA FichaCliente

AU 2
Ihzert I Edit | Delete |

6. Oprima el botén OK para regresar a la ventana Procedure Properties.

Hacer ajustable el tamafio de la ventana

1. En lacaja de didlogo Procedure Properties, oprima el boton Extensions.
2. En la caja de didlogo Extensions and Control Templates, oprima el botén Insert.
3. llumine WindowResize en la caja de didlogo Select Extension, y oprima el boton Select.

Esta plantilla de Extension genera cddigo para manejar automaticamente el ajuste de tamafio y
reubicacion de todos los controles de la ventana cuando el usuario cambia el tamafio de la
ventana, o cuando oprime los botones de Maximizar o Restaurar.

4. Oprima el botén OK para cerrar la caja de dialogo Extensions and Control Templates.

Modificacion de las propiedades de la ventana

1. En lacaja de didlogo Procedure Properties, oprima el botén Window.

2. Dé cLic DERECHO sobre la ventana de titulo, y elija Properties del menu contextual.
3. Elija Resizable (“tamafio ajustable”) de la lista desplegable Frame Type.

4. Seleccione la lenglieta Extra y marque el casillero Maximize Box.

Estos dos ultimos item permiten que el usuario modifique el tamafio de la ventana durante la
gjecucion.

5. Oprima el botén OK para cerrar la caja de dialogo Window Properties.

Llenado de los campos

El disefio proconfigurado de la ventana ya contiene tres campos. El botén OK que cierra la caja de
dialogo, aceptando lo ingresado por el usuario y graba la informacién en el disco. El botén Cancel
que cierra el formulario sin grabar cambios. Y el campo textual provee un mensaje informativo
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la accion que esta realizando sobre el registro. Esta accion se llama en

1. ElijaOptions » Show Fieldbox

£ Window Formatter M= =
Exitl Edit Control Alignment Menu Toolbar Populate Yiew  Freview!
v x @& claxnaaia
. A
Popiic Pl 60
Clientes k3|
MumCliente (LOMNG]
Empreza [STRING]
Mombres [STRIMG)
lpelidos [STRING)
Direccion [STRIMG]
Ciudad [STRING)
Frovincia [STRING]
CP (LONG)
]
[« | I
Er—
’T Str Pro: [28]
0K I Cancel | $5555555555555555555555555555555595
Property E
Teut: IUpdate Fecords...
Lse: I
Eont: | = [rex o il

|

Size: I I:I B U

_l

ol

[W/INDOW/[Update Records...).AT(18.5,289,159). 5YSTEM GRAY MAX RESIZE, [Multi Select: CTRL+left click or CTRL+drag

Esto muestra una caja flotante de herramientas que contiene todos los campos especificados en

el arbol de archivos de la aplicacion.

Dé cLic sobre NumCliente en la caja flotante de herramientas Populate Field, y mueva el

cursor sobre el disefio de la ventana.

El cursor cambia a una cruz y un “librito” que indica que el campo proviene del diccionario de
datos.

Dé cLic cerca del angulo superior izquierdo de la ventana.

Esto coloca tanto el campo como su etiqueta asociada. Estos controles traen todas las

configuraciones especificadas anteriormente en el diccionario.

Dé DOBLE cLIC sobre Empresa en la caja flotante de herramienta Populate Field.

El DoBLE cLIC coloca inmediatamente tanto el campo como su etiqueta justo debajo de los

primeros campos que acaba de colocar. Podria seleccionar
hicimos con el primero, pero es mucho mas rapido con DOBLE CLIC.

Dé DOBLE cLIC sobre Nombres en la caja flotante de herramientas Populate Field.

Dé poBLE cLIc sobre Apellidos en la caja flotante de herramientas Populate Field.

Dé DOBLE cLIC sobre Direccidn en la caja flotante de herramientas Populate Field.

Dé poBLE cLIC sobre Ciudad en la caja flotante de herramientas Populate Field.

y colocar cada campo como
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9. Dé DOBLE CLIC sobre Provincia en la caja flotante de herramientas Populate Field.

Esto coloca la etiqueta y la lista desplegable. En el diccionario de datos predefinimos este
campo como un control de Lista con el atributo DROP. Dado que los valores validos
(BA|SFIERICBA|MZA) que contiene ya estan predefinidos, no hay necesidad de modificar su
formato.

10. Dé poBLE cLIC sobre CP en la caja flotante de herramientas Populate Field.

La ventana de la ficha o formulario se ve ahora asi:

£ Window Formatter M= =
Exit! Eontrol Alignment  Menu  Toolbar Populate  Wiew  Preview!

v X & e anegg i

: Al
Populate Fild 8
. Clientes k3|
Num Cliente:  <<<# HumCherts LONG]
Empreza [STRING]
Empresa: | Nombres (5 TRING)
2 pelidos (STRING]
. Direccion [STRIMG]
Nombres: | Ciudad [STRING]
Frovincia [STRING]
Apellidos: | P (LONG)
Direccion: I
Ciudad: f | 0|
Poving: [ =] Er—
o =
1
0K I Cancel | §5555555555555555555555555555555555 ¥l & uu
: EACBERRE
Iewt:  [@Prunsp % o Y
Use: |ELI:EF' / . . ’j
Font: | = [rex o gl
Size: I I:I B/ U h
Al I _'l_I
[ENTRY [(@PH#HHRPLAT(54.116.26.10L USE(CLI.CPLRIGHT(1] [MODE : Nomal

Mover y alinear los campos

Para una apariencia mas profesional, debemos mover los campos y alinear los margenes de todos
los controles.

Ubicacion de los campos en sus posiciones aproximadas

1. Dé cLic sobre el listado Provincia.

2. ARRASTRE mientras mantiene oprimida la tecla de mayudsculas (MAYUS+ARRASTRE) la lista
Provincia a la derecha, mas cerca de su etiqueta.

MAY US+ARRASTRE limita el movimiento del control al plano en que comenz6 a moverse (sea
vertical u horizontal).

3. Dé cTrL+cLIC sobre la etiqueta Provincia.
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Cuando se da cTrL+cLIC sobre un control, las asas del control seleccionado previamente se
vuelven azules, mientras que las del control recién seleccionado aparecen en rojo. Ahora hay
dos controles seleccionados.

4. Mueva la lista desplegable Provincia y su etiqueta (dé cLIC y ARRASTRE sobre cualquiera de
los controles seleccionados), arriba y a la derecha de los controles Ciudad.

Cuando se han seleccionado controles multiples, se los puede mover en grupo, de igual manera
que se desplazaria un control individual.

Dé cLic sobre el control de ingreso de datos CP.
Oprima MAYUS+ARRASTRE sobre la caja de CP, a la izquierda, mas cercano a su etiqueta.

Dé cTrL+cLIC sobre la etiqueta CP.

o N o O

Mueva la caja de ingreso de datos CP y su etiqueta arriba y a la derecha de los controles
Ciudad y Provincia.

Quiza deba ensanchar un poco la ventana para lograrlo.
9. Dé cLic sobre la caja de ingreso de datos Apellido, a la derecha, mas cerca de su etiqueta.
10. Dé SHIFT+ARRASTRAR sobre la caja Apellido hacia la izquierda, mas cerca de su etiqueta.
11. Dé cTRL+cCLIC sobre la etiqueta Apellido.
12. Mueva la caja de ingreso de datos Apellido mas arriba y a la derecha de Nombres.

Ahora la ventana deberia aparecer aproximadamente asi:

£ window Formatter M= =
Exitl Edit Control Alignment Menu Toolbar Populate “iew Preview!

v X 5 el anaa i a

_ |
| UpdateRecords..|jfouer 8
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Num Cliente:  <<<# HumClert [LONG)
Empreza [STRING]
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B — - L pelidos (STRING)
. Apellidos: I} Direccion [STRING]
Nombres: | =P s = Ciudad (5TRING]
Frovincia [STRING]
CP (LONG)
Direccion: I
Ciudad: [ Erovincia:l | QP:I 0000 | |
Er—
’T Str Pro: [26]
) 8 =
0K I Cancel | 55555555555555555555555555555555559 ¥ & I;Il_'l
Property x| EE @ @
Iext  [@s20 i
Use: |ELI:ApeIIidos / . . ’j
Font: | = [rex [oiE gl
Siee: | = Bsu _ 5
Kl _l _'l_I

|[ENTRY(R520).AT (197.33,73.10)USE(CLI:Apelidos) [MOCE : Normal
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Alineamiento final de los controles

1. Escoja Option » Show Alignbox (“Mostrar caja de alineacion”)

El disefiador de Ventanas tiene una caja flotante de herramientas que
contiene el mismo juego de herramientas de alineacién que estan
disponibles a través del ment Alignment.
herramientas Alignbox puede no verse exactamente igual que la
mostramos aqui, debido a que es posible cambiar la forma de cualquiera
de las barras flotantes ARRASTRANDO sus bordes. Inténtelo y comprobara
su flexibilidad. Gracias a esta técnica podra configurar su espacio de
trabajo como lo desee.

La caja flotante de

149

N - |

2. Dé cLic sobre la primera etiqueta en el angulo superior izquierdo.
Este debe ser la etiqueta NumCliente. Cuando le da cLic deben aparecer las asas alrededor.

3. Dé cTrL+CLIC en las cuatro etiquetas ubicadas inmediatamente debajo de la primera.

A medida que da cTrL+cLIC sobre cada control, las asas del que estaba seleccionado
previamente pasan a azul, y las del control recién seleccionado aparecen rojas. EI control con
las asas rojas es el “punto de referencia” o “ancla” para la operacion de alineamiento. Todos
los demas controles se alinean en relacion al que tiene las asas rojas.

Con las cinco etiquetas seleccionadas deberia verse asi:

£ Window Formatter

Exitl
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Mombres (STRING)
Emplesd | pelidos (STRING)
Apellidos: g'i[?:lcf::o[gﬁ:ﬁrﬁnﬁr\jm
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4. Oprima el botén Align Left (el boton superior a la izquierda) en la caja flotante de
herramientas Align.

Los controles se alinean por el lado izquierdo, con respecto al Ultimo item seleccionado (con
las asas rojas).

Para identificar los controles en la caja de herramientas Align, simplemente coloque el cursor
del mouse sobre el control y espere medio segundo hasta que aparezca la acotacién
identificatoria.

5. Oprima el botén Spread Vertically en la caja flotante de herramientas Align.
Los controles se distribuyen en forma pareja entre el primer y el Gltimo botén seleccionados.
6. Dé cLic sobre el primer control de ingreso de datos (NumCliente)

7. Dé cTrL+cLIC sobre los controles de ingreso inmediatamente abajo, para seleccionarlos a
todos.

8. Dé cLic berecHO y elija “alineacion izquierda” (Align Left) del mend contextual que
aparecera.

Esta es otra forma de activar las herramientas de alineacion. EI mend contextual de
alineamiento aparece solamente cuando ha seleccionado mdltiples controles.

9. Dé cLIc DERECHO y elija Spread Vertically del menl contextual.

Esto deberia alinear todos los controles de ingreso de datos con las etiquetas respectivas, que
ya hemos sometido a este alineamiento.

10. Dé cLic sobre la caja de ingreso de datos Apellidos.

11. Dé cTrL+cLIC sobre los tres controles a la izquierda (la etiqueta, el campo Nombres y la
etiqueta).

12. Elija alineamiento horizontal (Align Horizontally) de la caja flotante de herramientas Align
0 del menu contextual (CLIC DERECHO).

Hay otra forma de elegir controles maltiples en el Disefiador de Ventanas: utilizar el lazo.

13. Coloque el cursor del mouse ligeramente sobre y a la derecha del primer control en la fila
inferior (que seria Ciudad).

14.Dé CTRL+CLIC y ARRASTRE ligeramente hacia abajo y a la derecha hasta que el dibujo de la
caja rodea los cinco controles de la derecha (las etiquetas y campos de Ciudad, Provincia y
CP), y suelte el boton del mouse.

Las asas rojas aparecen en el campo CP y las azules en los demas controles.
Esta es la técnica del “lazo”.

15. Elija el alineamiento horizontal (Align Horizontally) sea de la caja de herramientas flotante o
del menu contextual de alineamiento (CLIC DERECHO).

16. Use esa misma herramienta para alinear los campos NumCliente, Empresa y Direccién con sus
etiquetas respectivas.
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La ventana deberia aparecer ahora asi:

£ Window Formatter M= =
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La ventana esta casi lista. Ahora afiadiremos una caja de listado para los registros de Teléfonos
vinculados.

Adicion de un template de Control BrowseBox

Los templates (plantillas) de control generan todo el codigo fuente requerido para crear y mantener
un tipo de control, o grupo de controles, especifico en la ventana. Todos los controles de ingreso
de datos que acabamos de colocar no son simples controles, ni plantillas de control, porque no
necesitan codigo extra para cumplir sus funciones normales. Las plantillas de control se usan
solamente cuando un control especifico necesita funcionalidad extra no provista por el control
mismo. Por ejemplo, los botones OK y Cancel son ambos template de control: el botén OK guarda
el archivo al disco, mientras que la plantilla de control Cancel realiza toda la “limpieza” necesaria
para cancelar la operacién en curso.

Ahora vamos a colocar un template de control BrowseBox que muestra todos los registros del
archivo Teléfonos vinculados al registro actual de Clientes.

Colocaciéon del template de control

1. Elija Populate » Control Template, o dé cLic sobre la herramienta Control Template en
la caja flotante de herramientas Controls (Gltimo icono de herramientas a la derecha, en la fila
inferior).




2. En la caja de diadlogo Select Control Template destaque BrowseBox, y oprima el botén

Select.

El cursor cambia a una cruz y un librito.

3. Dé cLic justo debajo de la caja de ingreso de datos Ciudad para colocar el control.

Aparece la caja de seleccién de campos para que usted elija el archivo que se mostrara en este

BrowseBox.
4. Elijael item “ToDo” debajo de la caja File-Browsing List Box y oprima el boton Insert.
5. Destaque el archivo Teléfonos en la caja de dialogo Insert File, y oprima el botén Select.
6. Destaque el archivo Teléfonos en la lista Files, y oprima el boton Edit.
7. Destaque KeyNumCliente en la caja de diadlogo Change Access Key, y oprima el boton
Select.
Select Field
Filez - Fields :
=0 File Schematic -
—[:| Update Record on Dizk - TEL:DDN
. [ Clientes - TEL:Teleforo
—[:| File-Browsing List Box - TEL:Descripeion
[ ] T =icforc - TEL:KeyHumCliente
Z] OTHER FILES
[ GLOBAL DATA
; ‘(1] MODULE DATA tutuo005.clw
[:| LOCAL DATA FichaCliente
A o i
Inzert | Edit Select | New | Cancel |

Colocacion de los campos del archivo Telefonos

1. Destaque Tel:NumCliente en la lista Fields, y oprima el boton Select.

Aparece el Disefiador de Cajas de Listado para agregar el resto de los campos que desea

mostrar.

A& List box formatter
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[ Colar
[ Style
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Apply
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Seleccione justificacién izquierda (Left) de la lista desplegable Justification.
Esto cambia la justificacién predeterminada (derecha para valores numéricos).
Oprima el botén New Column.

[lumine (destaque) TEL:DDN en la lista Fields, y oprima el boton Select.
Seleccione Left de la lista Justification.

Oprima el botén New Column.

Destaque TEL:Teléfono en la lista Fields, y luego oprima el boton Select.
Seleccione Left de la lista Justification.

Oprima el botén New Column.

10. Destaque TEL:Descripcion en la lista Fields, y luego oprima el botén Select.

Como paso opcional, modifique las columnas de la ventana para hacerlas suficientemente
anchas para los respectivos encabezamientos. Simplemente, ARRASTRELAS con el mouse.

i b fomater g

Hum Cliente DDM Telefono Descripcion

coof [OfHH)  HHEH-HEHE

<<t [OfHH)  HEE-HEEE  $3ES3853083450084088
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KA J |
AEC |« D BOL~Descriprion @S 20@ 4
T s e
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Heading text: I Descripcion

width: I a0 3: Scrollbar: I i} 3:
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Ficture : I@szu
Justification: ILeft A l Indent :
~Flag:
[~ FRight Border [T Fired ™ Lalor
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™ Undedine ™ Locater
Help | ok I LCancel I Apply |

11. Oprima el botén OK para cerrar el Disefiador de Listados.

Esto coloca la caja de listados en la ventana, en la posicién que hemos especificado. Esto puede
expandir la ventana. Si es asi, puede modificar el tamafio de la ventana ARRASTRANDO las asas,
y moviendo los controles OK, Cancel y Mensaje hacia el nuevo pie de la ventana.

Configuraciéon de los limites de alcance del template

1.
2.
3.

Dé cLIc DERECHO en la caja que acaba de colocar, y elija Actions del mend contextual.
Oprima los puntos suspensivos(...)ubicados junto a Range Limit Field.

Destaque el campo TEL:NumCliente en la lista de componentes de las claves (key
Components), y oprima el boton Select.



4.

6.

Elija “relacion entre archivos” (File Relationship) de la lista desplegable de limite de
busqueda (Range Limit Type).

Oprima los puntos suspensivos (...) junto al campo Related File y elija Cliente de la caja de
didlogo Select File.

Esto identifica al archivo de Clientes como el archivo relacionado. Estas etapas limitan los
registros que se muestran en la caja de listados a solamente los registros vinculados al registro
de Clientes que se esté mostrando en el momento de la consulta.

List Properties E

Qenerall Eutra |En|or I Help |Eosilion Actionz |

Drefault Behavior Ignnditional Behavior I Hat Fieldsz e[m|

[ Quick-Scan Records [buffersd reads)
Loading Method |Page =l
¥ Accept browse control from ToolBar

Laozator Behawiar |

Becord Filter; |
Range Limit Field: [TECNumCliente =
Farge Limit Type: |File Fielationzhip ;l
Rahge limiting file

’VEelated file: IEIientes

Additional Sort Fields |
Reset Figld: | Serall Bar Behawiar |

Fles | Embeds |

Fant... | Ok I Cancel | Help |

Oprima el botén OK de la caja de dialogo List Properties.

Adicion del template de control BrowseUpdateButtons

A continuacién afiadiremos los botones estandar Insert, Change y Delete para el control de la caja
de listados.
Colocacién de otro tipo de template de control

1.

Escoja Populate » Control Template, o dé cLic sobre la herramienta Control Template en
la caja de herramientas Controls (el ltimo icono de la lista, en la fila de abajo).

Destaque la plantilla de control BrowseUpdateButton, y oprima el botén Select.
El cursor cambia a una cruz y un librito.
Dé cLic debajo del extremo inferior izquierdo de la caja de listado.

Aparecen los botones Insert, Change y Delete. Recuérdese: esos son los botones que
permitiran el funcionamiento de los botones de la barra de tareas, y por eso deben estar
presente en el disefio de la ventana. No es necesario que estén visibles para el usuario, de
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manera que puede esconderlos si lo desea. Sin embargo, dado que esta caja de listados
(BrowseBox) se ubica sobre un procedimiento de actualizacion (Form), en esta aplicacion
dejaremos visibles este grupo de botones. Esto permitira usar cualquiera de los dos grupos de
botones. Los botones de la barra de herramientas sélo funcionaran sobre esta lista cuando la
caja de listados tiene el foco (no cuando el usuario ingresa datos en ningun otro control), de
manera que dejar visibles a esos botones asegurara que el usuario pueda mantener facilmente
los registros de Teléfonos.

En este punto, la ventana deberia verse aproximadamente asi:

(O] ]
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Especificar “Modificar in situ” para actualizar los Teléfonos

1.
2.

o g &~ w

Dé cLic DERECHO sobre el boton de “Borrar” (Delete) y elija Actions del menu contextual.
Marque el casillero “Modificacién in situ” (Use Edit in place).

Configurar las acciones (Actions)para un boton sirve para los tres botones del grupo, dado
que los tres pertenecen a la misma plantilla de control. Dado que el archivo Teléfonos tiene
solo un par de campos, no hay necesidad de un procedimiento de actualizacion separado.

Oprima el botén OK.
Elija Exit! para cerrar el Disefiador de Ventanas.
Oprima el botén OK para cerrar la caja de didlogo Procedure Properties.

Elija File > Save, u oprima el botén Guardar de la barra de herramientas.
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9 - COPIADO DE PROCEDIMIENTOS

Los Procedimientos de "Productos"

Ahora que hemos creado el browse de Clientes, podemos reutilizar ese trabajo para el siguiente
procedimiento, copiandolo y cambiando después los campos. En este capitulo, copiaremos el
procedimiento VerClientes para crear VerProductos.

También usaremos los "Puntos de insercion” (Embeds points) para escribir “codigo fuente
insertado”, que Ilame el procedimiento VerProductos desde el menu y barra de herramientas de la
aplicacién. Asi presentaremos los numerosos puntos en que se pueden agregar algunas (o muchas )
lineas de cadigo fuente propio para afiadir funcionalidad a cualquier procedimiento.

Punto de inicio :
El archivo TUTORIAL.APP debe estar abierto.

Copia de los procedimientos

Como se recordara cuando se creé el item de mend Ver » Productos, y el botén de la barra de
herramientas titulado "Productos”, no especificamos un procedimiento a llamar cuando el usuario
final los ejecutara. Empezaremos creando el procedimiento a llamar.

1. Destaque el procedimiento VerClientes en el arbol de la aplicacion .
Este es el procedimiento que copiaremos.

2. Escoja Procedure » Copy...
Aparece la caja de dialogo New Procedure.

3. Escriba VerProductos en la caja de entrada, y oprima el botéon OK.

Mew Procedure

IUerF'deuc:h:us

Cancel |

Debido a que el procedimiento FichaCliente estd enlazado a VerClientes (el que esta
copiando), aparece una caja de dialogo advirtiendo sobre el conflicto de nombres (Procedure
name clash), con opciones para manejar la situacién. La traduccion del mensaje es: "El
procedimiento que estd copiando llama a otros procedimientos. ;Desea que les dé nuevo
nombre automaticamente a los procedimientos Ilamados, utilizar los mismos nombres, o



indicar nombres alternativos en cada caso?". Hay tres botones al pie: " Auto Rename" (dar
nuevo nombre automaticamente),"Same"(dejar el mismo), y "Prompt" (preguntar).

Procedure name clash E

The procedure being copied calls other procedures
Do pou want the called procedures to be automatically
@ renamed, the same procedures to be used, or ta be

prompted far an alternative name for each one called?

[Gichename | [ same || Promet |

4. Oprima el boton Prompt.

Al oprimir este botén, usted le pide al Generador de Aplicaciones que pregunte antes de dar el
nuevo nombre a los procedimientos conflictivos.

Aparece otra caja de mensaje que informa sobre un duplicado de nombre en particular:

Procedure name clash

Procedure FichaCliente is called. Do you want to call the
@ same procedure, or specify a new name?

| Same I | Rename I

5. Oprima el boton Rename.
Aparece la caja de didlogo Alternate Procedure (procedimiento alternativo).

6. Escriba FichaProducto en la caja de ingreso, y oprima el botén OK.

Alternative Procedure E
I FichaProducto

Cancel |

Apareceran los procedimientos VerProductos y FichaProducto en el arbol de la aplicacion. Se
ven "desconectados” del resto de los procedimientos, porque no son llamados por ningln
otro procedimiento (todavia). Ahoranos  encargaremos de eso.

& tutuorial. app - Application Tree

Procedure IMDduIe I Template I Hame | Qateguryl Global |
I ‘ Froperties.. I
=-[E Main [Frame] E
[0 SplashSereen [Splash) ﬂl
- VerClientes [Browse)
“[F FichaCliente [Fom) oK.
[ VerPedidos (T ’—I
- e Cancel |
Help |
4

Trabajando en los puntos de insercion

Los templates de Clarion le permiten afiadir su propio codigo fuente a muchos puntos predefinidos
dentro del codigo generado. Es un modo muy eficiente de lograr la maxima capacidad de



reutilizacion vy flexibilidad del cédigo. El punto en que se introduce el codigo se llama " Punto de
insercién " (Embed Point ). Estos puntos se hallan disponibles para todos los eventos comunes de
la ventana y de cada control, y en muchas otras posiciones Idgicas dentro del cédigo generado.

En este ejemplo, afiadiremos codigo fuente insertado (utilizando una plantilla de Cédigo que
escribira el cédigo fuente por usted) en los puntos donde el usuario final elije la opcion Ver »
Productos del men(, y en el punto en que ese usuario oprime el boton Productos sobre la
barra de herramientas de la aplicacion.

Dar nombre a un procedimiento

1.

Dé cLic DEReCHO al procedimiento Main del arbol de la aplicacion.

Hay varias formas de ingresar a los puntos de insercion dentro de un procedimiento. Dos
aparecen en el menu contextual que acaba de aparecer..

La primera opcion es Embeds, que llama a la caja de didlogo Embedded Source, que
muestra una lista de todos los puntos de insercion dentro del procedimiento.

La segunda forma es la opcion Source, que en realidad genera cédigo fuente para el
procedimiento y llama al "Embeditor" (El editor de texto en modo de insercion de cddigo )
para permitirle modificar todos los puntos de insercion dentro del contexto del codigo fuente
generado. Este Gltimo aparece "grisado” para indicarle que no es posible modificarlo, y cada
punto de insercién posible del procedimiento se identifica mediante comentarios, tras los
cuales usted puede insertar su propio codigo.

Hay ventajas en cada método de trabajo con los puntos de insercién, asi que cubriremos ambos
durante este cursillo. Primero utilizaremos la caja de didlogo Embedded Source.

En el men( contextual, elija Embeds.

Aparece la caja de didlogo Embedded Source, que le da acceso a todos los puntos de
insercién del procedimiento. También se puede llegar aqui con el boton Embeds en la
ventana Procedure Properties, pero es mas rapido mediante el men( contextual. La lista
esta ordenada alfabéticamente o en el orden en que los puntos aparecen en el codigo fuente
generado, segln sea la configuracion de Sort Embeds Alphabetically en las opciones del
entorno (Setup » Application Options).

Oprima el botén Contract All.
Esto facilitara ubicar el punto de insercién especifico que necesite.

Ubique la carpeta Control Event Handling, y dé cLIic sobre el signo + para expandir el
contenido.

La seleccion del mend es un control, tal como una caja de ingreso de datos, o la ventana
misma.

En el lado derecho de la ventana, advertird los botones con las flechas hacia arriba y hacia
abajo y un spin box que le permiten establecer una prioridad (Priority); éstos son importantes.
A veces, el codigo que usted quiere escribir debe ejecutarse antes del cédigo generado por el
template, y otras veces debe ejecutarse después, y en ocasiones debe ejecutarse en algin punto
intermedio dentro del coédigo generado. La prioridad establece la ubicacion exacta de su
codigo embebido. Esto le proporcionan tanta flexibilidad para ubicar su codigo embebido
como es posible. El valor de la prioridad en si mismo, no es importante, pero si su posicion
I6gica dentro del cddigo generado. Pronto aclararemos mas sobre este tema.

Ubique la carpeta ?FormulariosProducto, y dé cLic sobre ella para expandirla.



6. Destaque Accepted, y oprima el botén Insert.
El evento "aceptado” para la seleccién del mend marca el punto del codigo generado que se
ejecuta mientras el usuario elije la orden del mend.

£ Embedded Source _ (O] x|

Exit Edit “iew Mavigate

v 8228 sa B8 en

| Ingert |
+-[0 ?Copy = N
: Eroperiies
o I
w3 Editenu Lzkiz |
+[:| PExit Priarib——
+D FileMenu L | g
+-[3 PFomularios IﬁA
+[:| ?FomulaniosClientes =
+-[1 ?FomulariosPedidos
-3 FomulaiosProductos Source |

B3R ccepted

+- ] &l Events Clos= |

+ -2 "Helpindex

- HelpDnHelp - Help |
el . hd

4

Aparece la caja de didlogo Select embed type con una lista de todas las opciones para
incorporar cédigo. Se puede, simplemente, llamar a un procedimiento (Call a Procedure),
escribir su propio cédigo fuente (Source) en lenguaje Clarion, o utilizar una plantilla de
codigo (Code Template) que escriba el codigo necesario. Esta es una ventaja de editar los
puntos de insercion dentro de la caja de didlogo Embedded Source: puede utilizar las
plantillas de cédigo para que le escriban cddigo, en lugar de tener que hacerlo por si mismo.

% Select Embed Type [ x|
I | Select I
- Call a procedurs =

Cancel
- Source =

—-[(3 Class ABC - Application Builder Class Templates
CalltBCMethod - Call a Methad of an ABC Object

CalProceduretsLookup - Call Procedure az Lookup Help |

ClogeCurrent'findow - Cloze Current ‘Window and Procedure

DigplayPopuptdenu - Displays a popup menu
InitiateT hread - Initiate Thread E: 0

LookupMonRelatedRecard - Lookup Mon-Related Recard

SelectT oolbarT arget - Select target for toolbar

SetdBCProperty - Set a Property of an ABC Object

SetProperty - Set a property on a control

—-[C3 Class CPCS&bcRpts - CPCS [ABC) Erhanced Reporting Templates v

oUoo0ooooo

= DisplayBinary - Display Binary ELOB AMERD
-] DizplayPrintlmageFile - Display/Print an Image File hd
» |

7. Seleccione la plantilla de codigo Initiate Thread, y oprima el bot6n Select.
Una plantilla de codigo generalmente viene con algunas indicaciones e instrucciones para su
uso. Obtiene de usted la informacion que necesita para escribir el cddigo ejecutable, que a su
vez inserta dentro del codigo generado estandar producido por el Procedure template
directamente en este punto de insercion. Esta plantilla de cédigo en particular esta disefiada
para comenzar un nuevo hilo de ejecucién llamando, mediante le procedimiento START, al
procedimiento que usted indique.



8. Elija VerProductos de la lista desplegable Procedure Name.

9.

Esto indica el procedimiento a Ilamar cuando el usuario elige el item del mend. Se trata del
procedimiento que hemos copiado previamente.

Prompts for ImitiateT hread E

Thiz Code Template iz uzed to initiate a Thread. The
code generated will follow the format:

Cancel |
Error Handling
Hel
Nt _ e |

IF HOT START(Procedure)

Procedure Mame: YerProductos =l
Thread Stack: 25,000 4
Error Handling |

Oprima el botén OK.

Dar nombre al procedimiento a llamar mediante el boton Productos de la

barra de herramientas

En este punto, usted podria hacer lo mismo para llamar el procedimiento VerProductos desde el
boton Productos. Sin embargo, hay un modo mas facil de escribir de nuevo este cédigo:
isimplemente Cépielo y Péguelo desde un punto de insercion al otro!

1.

Dé cLic sobre el boton Copy (el botén central del grupo ubicado a la derecha del botén
Contract All).

El Code template que acaba de afiadir todavia deberia estar destacado, asi que esta accion lo
copiara al portapeles de Windows.

Ubique la carpeta ?BotonProductos (en la misma carpeta Control Even Handling en que ya
usted se halla ubicado), y dé cLic sobre ella para abrirla.

llumine Accepted (“Aceptado”) y el botén Paste (“Pegar”) (el boton ubicado a la extrema
derecha del grupo de botones a la derecha del boton Contract All).

Aparece nuevamente la caja de didlogo Procedure name class para advertirle que ya ha
Ilamado una vez este procedimiento.

Oprima el botén “El mismo” (Same).
Ahora este punto de insercion generara el mismo codigo que el anterior.

Oprima el botén Close.

“* tutuonal_app - Application Tree [_ (O] x| I

'

Fracedure |M0dule I Template | Name I Categary I Global

Properties. .. I

-~ &] Main [Frams)
> 2 SplashScreen [Splazh]
— - B WerClientes [Browse]
. L@ FichaCliente Fom)
- E VerPedidos [ToDo)

Project

Cancel

WerProductos [Browse)

Z] FichaProducto [ToDo)

e

Help
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El procedimiento VerProductos ahora “se conecta” debajo del procedimiento Main. Ahora
puede personalizar los procedimientos copiados para que hagan referencia al archivo
Productos.

Modificacién del browse

Cambiar el archivo del nuevo control de listados

1.
2.
3.

S

Dé cLic DERECHO sobre el procedimiento VerProductos y elija Window del ment contextual.
Dé cLic DEReCHO sobre el control de lista elija List Box Format... del ment contextual.

En el Disefiador de Listados oprima el botén de borrar (Delete) repetidamente, hasta haber
eliminado todos los campos.

Cuando haya eliminado el Gltimo campo, aparece automaticamente la caja de dialogo de
Seleccion de Campos.

Destaque el archivo Clientes de la lista de archivos (Files) y oprima el botén Delete.
Destaque “To Do” que reemplaza al archivo de clientes y presione el boton Insert.
Destaque el archivo Productos y presione el botén Select.

Oprima el botén Edit y seleccione KeyDescripcion del la caja de didlogo Change Access
Key.

La caja de didlogo Select Field muestra ahora el archivo y los campos correctos.

Repoblado de los campos

o N o g bk~ w0 DR

9.

Ilumine PROD:NumProducto en la lista Fields, y oprima el botén Select.

Marque las casillas Right Border y Resizeable, e incremente la caja Ident a uno (1).
Oprima el botén New Column.

Marque PROD:Descripcion en la lista de campos (Field), y oprima el botén Select.
Seleccione Left para la justifficacién del dato.

Oprima el botén New Column.

Ilumine PROD:Precio en la lista Fields, y oprima el boton Select.

Incremente la indentacion en el grupo Data a 12. Como la justificacion es decimal se requiere
de este paso para asegurarnos que dejamos lugar para que aparezca la parte fraccionaria

Oprima el botén New Column.

10. llumine PROD:Tasalmponible en la lista Fields, y oprima el botén Select.

Note que la justificacion por defecto es decimal, y que el spin que indica la indentacién del
grupo Data se mantiene en doce (12) tal como lo indicamos en el campo anterior.

11. Oprima el botén OK para cerrar el Disefiador de Listados.

No se preocupe por los botones que aparecen sobre la caja del listado. Recuerde que estos estan
ocultos, y son llamados por los botones de la barra de herramientas.
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Cambiar el nombre de la ventana

1. Dé cLicsobre la barra de titulo de la ventana.

2. Escriba VerProductos en el campo de texto (Text) de la caja flotante de herramientas
Property, y oprima TAB.

Quitar todas las lenguetas

1. Dé cLic justo a la derecha de la lengiieta KeyCP para seleccionar toda la hoja de propiedades.

Para estar seguro de haber dado CLIC sobre el lugar correcto, observe la caja flotante de
herramientas Property, y observe si el campo Use muestra ?Sheetl. Si no es asi, pruebe de
nuevo, hasta lograrlo.

£ Window Formatter H=1 E3
Exit! Edit Control Alignment Menu Toolbar Populate ‘iew  Preview!

lvX &< an=giEa

: [~
T i
"] = ] L] Clientes =
KeyNumCliente |K'3“"E"""'asa | keycp| NomClierts [LONG]
Num Producto | Descripcion Precio | Tasa Imponihle]il Empresa [STRING)
Mombres [STRIMG)
1pelidos [STRIMG]
Diireccion [STRIMG]
Ciudad [STRING]
Frovincia [STRIMNG)
= o
K Bl
Insert | rghange I Delete Select Close | _I
Coniol |
’T Str Pro: [2E]
= ESMiL ¥ & 0Ly
o £ e i el EHHERTE
Test | e E ot -
CC—L o L NEEE i
Usze: PSheetl ‘_E_L =0 H ------
e OO TN
Size: I :IBIH El'[i"a; Wlﬁﬂ
K| | _>l_I
|SHEET AT[2.3,242,145)USE[?Sheet]] [Horz. o Vert. Move: SHIFT+drag

2. Oprima la tecla DELETE.

Todas las lenguetas desaparecen.

Adicion de un localizador

Si la lista de Productos a mostrar es muy larga, el usuario tendra que hacer una extensa blsqueda
antes de encontrar el producto requerido. Inicialmente, todas las cajas de visualizacion de listados
traen un localizador por “pasos” (Step)que va al primer registro que comienza con la letra que el
operador ingrese en el teclado.

Pero, con bases de datos muy grandes, el usuario necesita ingresar varias letras iniciales para llegar
al registro buscado. Un localizador de ingreso (Entry locator) es un campo en el que el usuario
puede escribir. Al oprimir TAB, la lista se mueve hacia el primer registro que coincida con lo
tipeado. Esta caracteristica funciona solamente con claves alfanuméricas (STRING).



1. Si no estd ya presente, elija Options » Show Fielbox para mostrar la caja flotante de
herramientas Populate Field.

Si la caja de herramientas Populate Field todavia muestra los campos del archivo Clientes,
simplemente cierre la caja de herramientas (con DOBLE CLIC sobre la barra de titulo) y reabralo
para refrescar la caja de herramientas con los campos del archivo Productos.

2. Dé poBLE cLIC en Descripcion sobre la caja de herramientas Populate Field.

Esto coloca tanto la etiqueta como la caja de ingreso para el campo ubicado cerca del angulo
superior izquierdo de la ventana. Este es el campo localizador.

3. Elija Exit! del menu para cerrar el Disefiador de Ventanas, y guarde los cambios.

Limpieza de los ordenamientos alternativos

1. Dé cLic DERECHO sobre el procedimiento VerProductos y elija Extensions en el meni
contextual.

Aparece la caja de didlogo Extension and Control Template. Esta caja lista todos los
templates de control que hay en el procedimiento y su etiquetas de acciones (Actions).

Esta caja de dialogo también permite afiadir y mantener templates o plantillas de extension en
el procedimiento. Las plantillas de extension son muy similares a las de control, en que afiaden
funcionalidad especifica al procedimiento, pero la funcionalidad de una plantilla de extension
no se vincula directamente con ningun control que aparezca en la ventana. En otras palabras, se
trata de plantillas que afiaden funcionalidad “tras bambalinas”, sin afectar directamente la
interfaz con el usuario.

Un muy buen ejemplo de los Extension Templates viene en el producto Clarion Internet
Connect. Este contiene (entre otras herramientas) un grupo de plantillas de extension que
automaticamente “traducen” una aplicacion Clarion para Windows en paginas dindmicas
HTML. Esto permite que la aplicacion Clarion funcione por Internet. El usuario solamente
necesita un visualizador con Java habilitado para acceder al programa Clarion. Si esta
interesado, puede obtener mas informacion de TopSpeed o Unisoft sobre Internet Connect.

2. llumine Browse on Productos y presione el boton Locator Behavior (Comportamiento del
localizador).

3. Seleccione Entry de la lista deplegable u oprima OK.

Esto completa los requisitos para el localizador. El campo clave del orden de bisqueda (en este
caso PROD:Descripcion) es el control de localizacion predeterminado.

Locator Behavior E
Lacator: [Entry =l ok I
Locatar Field
r Overnde default locator contral Cancel |
Mew Locator Contral: | |

Help |

Locator Class I

4. Seleccione la lengiieta Conditional Behavior.
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A Extension and Control Templates [ (O] x|

W Show on Procedure Properties

0
a Select a Record from Browse on Default Behavior Conditional Behavior |Hot Fieldst e
E Update a Record from Browse Bol
- Cloge the “Window

< Allows controls to be resized with win

Inzert Froperties Delete Iélil

A 13

Inzert | elete
Help | QK | Cancel | Apply |

5. Oprima el botén Delete dos veces.
Esto elimina las dos expresiones condicionales que ingresamos para el procedimiento
VerClientes.

6. Oprima el botén OK.

7. Elija File > Save, u oprima el boton Guardar de la barra de herramientas.

Creacion del procedimiento Ficha

Cuando dio nuevo nombre a la referencia del Update Procedure mientras copiaba VerClientes a
VerProductos, convirtié a FichaProducto en un procedimiento “ToDo”. Por lo tanto, es necesario
crear una ficha o formulario para actualizar el archivo Productos.

Seleccione el tipo de procedimento para FichaProducto

Destaque FichaProducto, y luego oprima el botén Properties.

Ilumine Form, despeje el casillero Use Procedure Wizard, y oprima el botén Select.
Oprima el botén Files en la caja de dialogo Procedure Properties.

[lumine el archivo “ToDo”, y oprima el boton Insert.

Ilumine el archivo Productos, y oprima el botén Select.

Oprima el botén OK para volver a la caja de didlogo Procedure Properties.

N o g b~ w b

Oprima el botén Window para disefiar el formulario.

Poblar los campos

1. Sinoesta ya presente, elija Options » Show Fieldbox para mostrar la caja de herramientas
PopulateField.
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De DoBLE cLIc sobre NumProducto en la caja de herramientas Populate Field.

Esto coloca automaticamente tanto la etiqueta y la caja de ingreso del campo cerca del extremo

superior izquierdo de la ventana.

De DOBLE cLIc sobre Descripcion en la caja de herramientas Populate Field.

Esto coloca automaticamente tanto la etiqueta y la caja de ingreso abajo del campo ubicado
anteriormente.

De DOBLE cLIC sobre Precio en la caja de herramientas Populate Field.

De DOBLE cLIc sobre Tasalmponible en la caja de herramientas Populate Field.
El formulario aparece asi:

£ Window Formatter |_ (O] =]
Exitl Edit Contral Alignment Menu Toolbar Populate Miew Preview
lvxmz2samzgiEa
Num Producto: I 0 Productas - Productos en ve x]
MHumProducta [SHORT)
PP I [rescripcion [STRIMG)
D pefloie Precio [DECIMAL]
T azalmponible [DECIMAL)
Precio:
Tasa Imponible:
KN 5
' [ |
[Contial _____ K1
’T Str Pro: [2E]
el [ (B 5y
0K I Cancel | 5555555555555555555555555555555 I_x [J [9 -.
SAMik| ¥ & Ly
—— L e 35 o0 EBCATRD
exl: .
- B i g gt T
Use: IPHD:TasaImponibIe "E'm "D W ol e H e
2 i W ] [ 4 K N
See [ [z] BfU =] Y = | FPE @ D

o

o

|[ENTRY([@n-6.2).AT(59,51,55,10),USE[PRO: T asalmporible] DECIMAL{12)

@hinicio| || @ &, A B || GIERFSON Actionlas..|[ A Clarion 5 (tutu... | # Dibuio - Paint

Cambio del titulo de la ventana

1. Dé cLic sobre la barra de titulo de la ventana del formulario.

| 7 Microsott wind - . | |[R8 ol @ <E 17:48

2. Escriba Ficha de productos en el campo de texto (Text) de la caja flotante de herramientas

Property y oprima TAB.

Salida del Disefador de Ventanas vy grabacion del trabajo

1. Elija Exit! Del mend, para cerrar el Disefiador de Ventanas (guarde los cambios).

2. Oprima el botén OK en la caja de didlogo Procedure Properties para cerrarlo.

3. Escoja File »Save, u oprima el botén Guardar en la barra de herramientas para guardar el
trabajo.

El formulario de actualizacion de Productos esta ya listo.



I C - USO DE CONTROL TEMPLATES

Para el procedimiento VerPedidos, creara una ventana con dos cajas de listados que se deslizan
sincronizadamente. Uno mostrara el contenido del archivo de Pedidos, y el otro mostrara los
registros vinculados en el archivo de Detalle. Usaremos un procedimiento Window genérico, y lo
"poblaremos" con control templates.La Unica razon para hacerlo asi en lugar de comenzar con una
plantilla Browse normal es para demostrar otro modo de crear un procedimiento : usando
templates de control colocados en una ventana genérica ( de la misma manera en que fué creado el
mismo template Browse).

Los control templates generan todo el cédigo fuente para crear y mantener un control Gnico o un
grupo vinculado de controles. En este caso, la colocacion de un template de control BrowseBox
permite que el Generador de Aplicaciones produzca el codigo que abre los archivos y pone los
datos necesarios en las estructuras que los visualizan.

Punto de inicio:
El archivo TUTORIAL.APP debe estar abierto.

Creacion del procedimiento
Seleccion del tipo de procedimiento

1. Destaque VerPedidos y oprima el boton Properties.

2. Destaque Window en la caja de dialogo Select Procedure Type y oprima el boton Select.

Modificacion de la ventana

1. Enlacaja de didlogo Procedure Properties, oprima el boton Window.

Aparece la caja de didlogo New Structure. El procedimiento genérico de ventana es como un
papel en blanco donde se define la ventana que uno desea. Dado que no hay un tipo
predefinido de ventana, hay que elegir uno.En este caso, lo que necesitamos es una ventana

“hija” MDI,
New Structure |

Window with OK & Cancel
System Modal Window
MDI Child Window

MDI Parent Frame

Cancel

1=
7~

Help
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2. Destaque MDI Child Window, y oprima el botén OK.

Aparece el Disefiador de Ventanas.

Agrande la ventana, haciéndola aproximadamente el doble que el tamafio original.
Dé cLic DERECHO sobre el titulo, y elija Properties del menu contextual.

Escriba Pedidos en el campo Text.

Elija Resizable de la lista desplegable Frame Type.

Seleccione la lengiieta Extra y marque el casillero Maximize Box.

o N o 0 b~

Oprima el botén OK para cerrar la caja de didlogo Window Properties.

Colocacion de la caja de listados( BrowseBox Control Template)

1. Elija Populate » Control Template 6 dé cLic sobre la herramienta Control Template en la
caja flotante de herramientas Controls (Gltima herramienta a la derecha, fila inferior).

Aparece la caja de didlogo Select Control Template.
2. Destaque la plantilla de control BrowseBox, y oprima el boton Select.
El cursor cambia a una cruz y un "librito".

3. Dé cLic sobre el angulo superior izquierdo de la ventana de muestra.

Colocar los campos del archivo Pedidos en el Disefador de Listados

1. Destaque el item"ToDo" ubicado debajo de File-Browsing List Box y oprima el botén
Insert.

2. llumine el archivo Pedidos en la caja de dialogo Fields, y oprima el botén Select.

w

Oprima el botén Edit y seleccione KeyNumPedido de la caja de didlogo Change Access
Key.

. Destaque PED:NumCliente en la lista de campos (Fields) y oprima el botéon Select.

. Oprima el botén Populate.

4
5
6. Destaque PED:NumPedido en la lista de campos (Fields) y oprima el botéon Select.
7. Oprima el boton New Column.

8. Destaque PED:MontoFactura en la lista de campos (Fields) y oprima el boton Select.
9. Incremente la casilla Indent del campo a doce (12).

10. Oprima el boton New Column.

11. Destaque PED:FechaPedido en la lista de campos (Fields) y oprima el botén Select.
12. Oprima el boton New Column.

13. Destaque PED:NotaPedido en la lista de campos (Fields) y oprima el botdn Select.
14. Seleccione Left de la lista desplegable para la justificacion del campo.

15. Ajuste el tamafio de columnas en la caja de listado de muestra.

16. Oprima el boton OK para cerrar el Disefiador de Listados.



17. Ajuste el tamafio de la caja de listados, ARRASTRANDO el asa del centro del lado derecho hacia
la derecha, haciendo la caja casi tan ancha como la ventana.

Mejora del aspecto de la caja de listados

1. Dé cLic DERECHO sobre la caja de listados, y elija Properties del mend contextual.

2. Seleccione la lengueta Extra y marque los casilleros Vertical y Horizontal en la caja de
didlogo List Properties.

Esto afiade barras de desplazamiento horizontal y vertical a la lista.
3. Oprima el botdn de fuente(Font)

Debido a que un campo (Descripcion) es largo, puede especificar que la caja  de listados
presente una fuente mas pequefia , lo que le permite mostrar mas informacion sin que el
usuario deba desplazar el cursor.

4. Elija una fuente y configure el tamafio en 8 puntos.

Consulte User’s Guide para algunas sugerencias sobre temas como escoger las fuentes
adecuadas para los controles. En general, es bueno limitarse a las fuentes que vienen con
Windows; porque no puede asegurarse que el usuario tenga otro tipo de fuente en su sistema.
La ilustracién muestra la fuente configurada como Arial, que es comun en Windows.

Select Font
Fuente: E stilo de fuente: Tamafio:
o i F— (]
P algerian | |Mormal -
Cursiva .
Arial Black Medrita
T Arial Marrow Meqrita Curziva
T Avial Rounded MT Bol:
H Bazkerville
0 Birwer Gothic: X
H Book Antiqua ;I
~Efecto ~Ejempl
™ Tachada
[ Subrayado
LCalor:
l- MNeqra J Alfabeto:
IDccidental J

5. Oprima el botdon OK para cerrar la caja de dialogo Select Font.

6. Oprima el boton OK para cerrar la caja de didlogo List Properties.

Adicion de la plantilla de botones de actualizacion

A continuacion afiadiremos los botones “Agrega”, “Cambia” y “Borra” (Insert, Change y
Delete) para el control de listados superior. Dado que habra dos listados en esta ventana,
dejaremos esos botones visibles para el usuario. Después, afiadiremos un procedimiento Form para
afiadir o editar un pedido.
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1. Elija Populate » Control Template, o dé cLic sobre la herramienta Control Template en la
caja de herramientas Controls (el dltimo icono a la derecha, fila inferior).

2. En la caja de didlogo Select Control Template, destaque la plantilla de control
BrowseUpdateButtons, y oprima el boton Select.

3. Dé cLic debajo del borde izquierdo de la caja de listado

Los tres botones aparecen juntos. Si lo desea, puede dar cLIC DERECHO sobre ellos, y cambiar
el Texto de la superficie de cada botén (solamente) por las expresiones traducidas “Agrega”,
“Cambia”, y “Borra”.

En este punto, la ventana deberia verse asi:

4 Window Formatter [_ O] ]
Exitl Edit Contiol Alignment Menu Toolbar Populate Wiew Freview!

v X g e anaagia
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 Pedidos S[Ofx]| | 80
Mum Cliente Mum Pedido Morto Factura Fecha Mota - ’T Str Pro: IA_EH
L2 Ol I
[ ER R
~ e
Insert Change Delete / . . ,j
v fore ff
[ |
Text: IPedidos
Use: I
Font: I I:I
Size: I I:I BFuU -
Kl | Ll_l
[w/IND D[ Pedidos | AT[,272,157).5%5 TEM Max RESIZE MDI [Horz. or Wert. Mowe: SHIFT +drag

Designar el procedimiento de actualizacion

1. Dé cLic DERECHO sobre el botén Delete, y elija Actions del menu contextual.

2. Escriba FichaPedido en la caja Update Procedure.

Esto da nombre al procedimiento. Designar el procedimiento de actualizacion para un boton de
este Control template vale para los tres botones.

3. Oprima el botén OK.

Colocacion de la segunda caja de listados

A continuacion, coloque una caja de listados con el contenido del archivo de Detalle. Esta se
actualizara automaticamente cuando el usuario cambie la seleccidn en la lista superior.

1. Elija Populate » Control Template, o dé cLic sobre la herramienta Control Template en la
caja de herramientas Controls (el Gltimo icono a la derecha, fila de abajo).



2.
3.

Destaque la plantilla de control BrowseBox, y oprima el boton Select.

Dé cLic inmediatamente debajo del boton Insert que colocé anteriormente.

Colocar los campos del archivo Detalle en el Disefiador de Listados

1.

&

© © N o o«

11.
12.
13.
14.
15.

Destaque el item “ToDo” ubicado debajo de File-Browsing List Box y oprima el botén
Insert.

Ilumine el archivo Detalle en la caja de dialogo Fields, y oprima el botén Select.
Oprima el botén Edit.

Seleccione KeyNumPedido de la caja de diadlogo Change Acces Key, y oprima el boton
Select.

Destaque Detal:NumPedido en la lista de campos (Fields), y oprima el botén Select.
Oprima el botén New Column.

Destaque DETAL:NumProducto en la lista de campos (Fields) y oprima el botén Select.
Oprima el botén New Column.

Destaque DETAL:Cantidad en la lista de campos (Fields) y oprima el boton Select.

. Oprima el botén NewC Column.

Destaque DETAL:ProdPrecio en la lista de campos (Fields) y oprima el botén Select.
Incremente la casilla Indent del campo a doce (12).

Ajuste el tamafio de las columnas de la caja de listados de muestra.

Oprima el botén OK para cerrar el Disefiador de Listados.

Ajuste el tamafio de la caja de listados, ARRASTRANDO las asas, y dandole un tamafio
conveniente para la visualizacion (deje algo de espacio a la derecha para un botén que
agregaremos despues).

Configuracion de los limites de blisqgueda

1.

Dé cLic DERECHO sobre la caja de listados que acaba de colocar y seleccione Actions del
menu contextual.

Oprima los puntos suspensivos en “Limites de bisqueda” (Range Limit Field).

Destaque el campo DETAL:NumPedido en el listado de componentes (Components), y
oprima el boton Select.

Escoja “Relacion entre archivos” (File Relationship) de la lista desplegable Range Limit
Type.

Oprima los puntos suspensivos junto a “ Archivo Relacionado” (Related File).
Destaque el archivo Pedidos en la lista Select File y oprima el botén Select.

Estas Ultimas cuatro etapas limitan los registros que apareceran en la segunda caja de listados a
solamente aquellos registros de Detalle que se vinculan al registro actual en la caja de listados
de Pedidos.

De esta manera la segunda plantilla de control utiliza la relacion entre archivos definida en el
diccionario de datos para sincronizar la lista de abajo con la de arriba.
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Mejora del aspecto de la caja de listados

1
2.

Dé cLIc DERECHO sobre la caja de listados, y elija Properties del menu contextual.

Seleccione la lengiieta Extra y marque los casilleros Vertical y Horizontal en la caja de
dialogo List Properties.

Esto afiade barras de desplazamiento vertical y horizontal al listado.
Oprima el botén de fuente (Font).

Aungue no hay campos “largos” en este listado, se vera mejor si la fuente es igual a la del
listado superior.

Elija una fuente, y configure el tamafio en 8 puntos.
Oprima el botén OK para cerrar la caja de dialogo Select Font.

Oprima el botén OK para cerrar la caja de didlogo List Properties.

Adicion del template del boton “Cerrar”

Finalmente, puede afiadir un boton Close que cierre la ventana.

1

2.
3.

Elija Populate » Control Template, o dé un cLic sobre la herramienta de plantilla de
control en la caja de herramientas Controls (Ultimo icono a la derecha, lista de abajo).

Seleccione la plantilla de control CloseButton, y oprima el boton Select.
Dé cLic sobre el angulo inferior derecho de la ventana.

En este punto, la ventana deberia verse similar a la siguiente ilustracion. Puede verse mas
grande que él area de muestra en el Disefiador de Ventanas, pero no debera se tan grande como
el escritorio:

£ “Window Formatter |- O] x|
Exitl Edit Control Algnment Menu Toolbar Populate Wiew  Preview!
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4. Elija Exit! del Disefiador de Ventanas para cerrarlo.

Hacer ajustable el tamafio de la ventana

1. Enlacaja de didlogo Procedure Properties, oprima el botdn Extensions.
2. En la caja de didlogo Extension and Control Templates , oprima el botén Insert.
3. Destaque WindowResize en la caja de didlogo Select Extension, y opima el botén Select.

Ya hemos usado varias veces este template de extension, pero esta vez modificaremos su
comportamiento, en lugar de aceptar las opciones prefijadas.

Especificacion de las estrategias de ajuste

1. Marque el casillero de restriccion del tamafio minimo de la ventana (Restrict Minimun
Window Size).

Al marcar este casillero y dejando los campos de anchura y alto minimos (Minimum Width —
Minimum Height) en cero, el template asegura que los usuarios no puedan reducir la ventana
mas alla del tamafio en que fue disefiada.

2. Oprima el bot6n de cancelacion de las estrategias de control (Override Control Strategies).

Aparece la caja de dialogo correspondiente. Aqui se puede especificiar la estrategia de ajuste
de tamafio para los controles individuales.

3. Oprima el botén Insert.
4. Elija ?Insert de la lista desplegable Window Control.

5. Escoja el boton de radio “Fijar la base” (Fix Botton) en la configuracién de opciones Vertical
Positional Strategy.

Esto determina la estrategia de ajuste del boton Insert para mantenerlo a una distancia fija de
la base de la ventana. Ahora, haremos lo mismo para los otros dos botones de actualizacion y la
lista de detalle.

Override Control Strategies
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" FixTop
-

-
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10.

11.
12.

13.
14.

15.

Oprima el botén OK.
Oprima el botén Insert, y elija ?Change de la lista desplegable Window Control.

Elija el boton de radio “Fijar la base “ (Fix Bottom) en la configuracién de opciones Vertical
Positional Strategy, y oprima el botén OK.

Oprima el botén Insert, y elija ?Delete de la lista desplegable Window Control.

Elija el botén de radio “Fijar la base “ (Fix Bottom) en la configuracion de opciones Vertical
Positional Strategy, y oprima el boton OK.

Oprima el botén Insert, y elija ?List:2 de la lista desplegable Window Control.

Elija el boton de radio “Fijar la base “ (Fix Bottom) en la configuracién de opciones Vertical
Positional Strategy, y oprima el botén OK.

Oprima el botén Insert, y elija ?List de la lista desplegable Window Control.

Elija el botdon de radio “Borde inferior Constante
configuracion de opciones Vertical Resize Strategy

(Constant Bottom Border) en la

Esto configura la estrategia de ajuste del listado de Pedidos para que el borde inferior de la lista
se mantenga a una distancia fija del borde de la ventana. Por lo tanto, la lista se extenderd como
sea necesario para llenar el espacio a medida que la ventana se agranda.

Oprima el botén OK (tres veces) para volver a la caja de didlogo Procedure Properties.

Establecer un campo para refrescar (Reset Field)

En la caja de didlogo Extensions and — »

Control Templates, destaque Browse on |
Detail. |
Oprima el boton Resets Fields, y luego _ o |

presione Insert.

Escriba PED:MontoPedido el el campo
Reset Field, luego presione OK.

Esto especifica que la caja de Listado de
Detalle se actualizara cada vez que el valor
del campo

PED:MontoPedido cambie. Esto asegura que
al retornar de la modificacion de un pedido
existente, el cambio efectuado se reflejara en nsett | Properes | _ Delete | .| |

la caja de listado.

Cierre de la caja de diadlogo Procedure Properties y quardado de la

aplicacion

1.
2.

Oprima el botén OK en la caja de dialogo Procedure Properties para cerrarla.

Escoja File > Save, u oprima el botén Guardar en la barra de herramientas para preservar el
trabajo.
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Actualizacion del archivo de Pedidos

Para el formulario de Pedidos, colocaremos los campos en una ficha de actualizacion de archivos,
realizaremos una consulta automatica al archivo Clientes, afiadiremos un template de control
BrowseBox para mostrar y modificar todos los items de detalle, calcularemos el monto de cada
linea, y luego el total del pedido.

Punto de inicio:
El archivo TUTORIAL.APP debe estar abierto.

Creacion del formulario de ingreso de Pedidos

n e

> w

Ilumine FichaPedido en el arbol de la aplicacién, y oprima el botén Properties.

Destaque Form en la caja de dialogo Select Procedure Type, despeje el casillero que
invoca al Asistente (Use Procedure Wizard), y oprima el botén Select.

Oprima el botén Window para abrir el Disefiador de Ventanas.

Haga mas alta la ventana ARRASTRANDO el asa central superior (utilice la barra de
desplazamiento vertical para mover el area de visualizacion, si fuera necesario).
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Colocaciéon de controles de ingreso de datos

En lugar de utilizar la caja flotante de herramientas Fieldbox para cargar los controles, esta vez
utilizaremos la caja de didlogo Select Field para poner numerosos controles.

1. Elija Populate > Multiple Fields, o elija la herramienta Dictionary Field de la caja de
herramientas flotante Controls.

2. En la caja de dialogo Select Field, destaque el item “ToDo” bajo Update Record on
Disk, y oprima el boton Insert.

w

Destaque el archivo Pedidos de la lista Insert File.

>

Destaque PED:Fecha y oprima el botén Select.
5. Dé cLic cercca del extremo superior izquierdo de la ventana.

Esto coloca tanto el campo como su etiqueta. La caja de didlogo Select Field reaparece
inmediatamente, listo para el campo siguiente, lo que hace este método de colocacion de
controles casi tan rapico como la caja flotante de herramientas Fieldbox.

6. Destaque PED:NotaPedido, y oprima el boton Select.

7. Dé cLic justo a la derecha de la caja de ingreso utilizada para la fecha.
8. Marque PED:NumCliente, y oprima el boton Select.

9. Dé CLIC debajo de la etiqueta del campo de fecha.

10. Oprima el botén Cancel en la caja de didlogo Select Field para salir de este modo de
trabajo.

La ventana de la ficha se ve ahora aproximadamente asi:
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Afadir una llamada a un procedimiento de consulta

1.

Dé cLic bEReCHO sobre el control PED:NumCliente y elija Actions del meni contextual.

Las acciones comunes de cada control de ingreso le permiten realizar la validacién de los datos
de ingreso contra un registro en otro archivo, sea cuando el control es seleccionado (justo antes
de que el usuario ingrese datos) o cuando es aceptado (inmediatamente después del ingreso de
datos).

En el grupo When the Control is Accepted, oprima el botén de tres puntos suspensivos
(...) para la caja de ingreso Lookup Key.

Destaque el archivo Pedidos en la caja de didlogo Select Key, y oprima el botén Insert.
Destaque el archivo Clientes en la lista Files, y oprima el botén Select.

Estas ltimas acciones afiaden el archivo Clientes al arbol de archivos del procedimiento como
una consulta automatica desde el archivo Pedidos. Esto generard una “consulta” en el archivo
vinculado Clientes, basado en la relacién de archivos configurada en el diccionario.

Destaque CLI:KeyNumCliente en la caja de didlogo Select Key, y oprima el botén Select.

Esto indica la clave que se utilizara para intentar obtener un registro valido vinculado en el
archivo de Clientes para el valor que el usuario ingrese en este control.

Oprima el botén de puntos suspensivos (...) de la caja Lookup Field.

Destaque CLI:NumCliente en la caja de didlogo Select Component, y oprima el boton
Select.

Esto hace de CLI:NumCliente el campo que debe contener el valor correpondiente al que el
usuario ingrese en el control.

Elija el procedimiento VerClientes de la lista desplegable Lookup Procedure.

Esto Ilama al procedimiento nombrado cuando el usuario ingresa un nimero de cliente
invalido, para que pueda elegir de una lista de clientes.

Entry Properties

General I Extra IEUIDr I Help IEDsitiDn Actions |

~Entry Control Prompt
W'hen the Control |5 Selected——————————————————
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Lookup Key IELI:Ke_I,JNumCIiente J
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¥ Perform Lookup during Mon-Stop Select

Advanced... |

v Force Window Befresh when &ccepted
More Field Assignments. .. I
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10.

11.

12.

13.

14.
15.

Marque los casilleros Perform Lookup during Non-Stop Select (“Realizar consulta
durante la revisién automatica de la ficha”) y Force Window Refresh when Accepted
(“Redibujar la pantalla al aceptar”), para asegurarse que los datos mostrados sean siempre
validos y actualizados.

Oprima el botén Embeds en la lengiieta Actions.

Esto muestra una lista de los puntos de insercion vinculados a este control, Gnicamente. Esta es
la forma mas rapida de llegar a los puntos de insercion de un control determinado, y es el
segundo modo que hemos visto para llegar a un punto de insercién. Hay todavia un tercer
método, que ya trataremos.

Destaque el evento Selected bajo Control Event Handling, y oprima el botén Insert.

El “evento seleccionado” ocurre justo antes de que el control obtenga foco. Este punto de
insercién permite hacer cualquier “configuracién especifica” para este control.

Destaque Source y oprima el boton Select.

Esto invoca al editor de textos para que pueda escribir codigo Clarion. Adviértase que esta
presente la caja flotante de herramientas Populate Field. Siempre que da DOBLE CLIC
sobre un campo en esta caja de herramientas, coloca el nombre del campo (incluyendo el
prefijo) en su codigo en el punto de insercién. Esto no solamente ayuda a la productividad
(menos tipeo), sino que asegura la inexistencia de errores tipograficos (que provocarian errores
en la compilacion).

Escriba el siguiente cddigo:
?PED:NumCliente{PROP:Touched} = TRUE

Es parte del “comportamiento estdndar de Windows” que, si el usuario no ingresa datos a un
control y se limita a oprimir TAB(0 da un CLIC con el ratén) para seguir a otro control, no se
genera la aceptacion de un evento (esto es muy diferente a como trabajan los programas de
DOS). Asi los clientes pueden pasar con TAB sobre el control sin provocar la validacion de los
datos en cada control. Sin embargo, a veces es necesario evitar este comportamiento estandar
para asegurar la integridad de la base de datos.

La sentencia que ha escrito utiliza la sintaxis de asignacion de propiedad de Clarion (véase el
Apéndice C de Language Reference). Configurando PROP: Touched a TRUE (verdadero) en el
evento selected de este control, siempre se genera un evento de aceptacion, sea que el usuario
haya ingresado datos o no. Esto fuerza la ejecucion del codigo de consulta (ingresado en la
lengiieta Actions de la pagina previa). Esto asegura que el usuario ingrese un codigo de
cliente valido; de lo contrario, aparecerd la lista de clientes para permitir elegir un ndmero
valido.

Elija Exit! (y guarde) para regresar a la caja de didlogo Embedded Source.

Oprima el botén Close para regresar a la caja de dialogo Entry Properties, y oprima el
boton OK para cerrarla.

Afadir un control “para visualizaciéon Unicamente”

1.

Elija Control » String, u oprima el boton String en la caja flotante de herramientas
Controls (el icono situado a la derecha de la “gran flecha” en la fila superior).

Dé cLic a la derecha de la caja de ingreso de ndmero de cliente que colocé anteriormente.

Dé cLic berecHO al control de cadena de texto que acaba de colocar, y elija Properties del
menu contextual.
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4. Marque la caja Variable String.

Esto especifica que el control mostrara datos provenientes de una variable, no solamente una
cadena alfanumérica. Aparece la caja de dialogo Select Field.

5. Destaque el archivo Cliente en la lista Files, y elija CLI:Empresa de la lista de campos
(Fields) y oprima el boton Select.

6. Oprima el boton OK y cierre la caja de dialogo String Properties.

Colocacion de las plantillas de control del archivo Detalle

El siguiente elemento clave en esta ventana es un control de listados (browse), sincronizado al
Namero de Pedido de esta ficha. Esto mostrara todos los registros del archivo Detalle vinculados
al registro de Pedidos.

Adicion de una lista Detalle

1. Elija Populate » Control Template o dé cLic sobre la herramienta Control Template en la
caja flotante de herramientas Controls (Gltimo icono a la derecha, fila inferior).

2. Destaque BrowseBox, y oprima el boton Select.
3. Dé cLic debajo de la caja de ingreso de datos de cliente.

4, Destaque el item “ToDo” ubicado debajo de File-Browsing List Box y oprima el bot6n
Insert.

5. Seleccione el archivo Detalle de la caja de dialogo Insert File, y oprima el botén Insert.
6. Oprima el bot6n Edit.

7. Destaque keyNumPedido en la caja de dialogo Change Access Key, y oprima el boton
Select.

8. Destaque DETAL:NumProducto en la en la lista de campos (Fields), y oprima el bot6n
Select.

9. Seleccione Center en la lista desplegable para la justificacion del dato (Data group).

10. Presione el boton New Column.

11. Destaque DETAL:Cantidad en la en la lista de campos (Fields), y oprima el boton Select.
12. Seleccione Center en la lista desplegable para la justificacion del dato.

13. Presione el boton New Column.

14. Destaque DETAL:ProdPrecio en la en la lista de campos (Fields), y oprima el boton Select.
15. Seleccione Center en la lista desplegable para la justificacion del dato.

16. Presione el boton New Column.

17. Destaque LOCAL DATA Ficha Pedido en la lista Files, y oprima el botén “Nuevo” (New).

Este boton New habilita la adicién de una variable local sin necesidad de ir a la ventana de
Procedure Properties y oprima el boton Data. Usaremos esta nueva variable para mostrar
el precio total para cada item (la cantidad multiplicada por el precio unitario).

18. Tipee ItemTotal en el campo Name.



180

CLARION 5™

19. Seleccione DECIMAL de la lista desplegable Type.

20. Escriba 7 como longitud del campo (Characters).

APRENDIENDO CLARION

21. Escriba 2 para la cantidad de decimales (Places) y oprima el botén OK.

22.
23.
24,

25.

26.
27.
28.
29.

E dit Field Properties - ItemT otal x
General |Aﬂributes| Eommentsl Dgtionsl Help Iyalidit_l,l Checks | Wfindo I Beportl
Field Mame: [itemTotal
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Fecord Picture: I—

Screen Picture: I@n'ID2— Jil-«,«ﬂ.ﬂﬂ
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Colurnn Heading: — [Item Tatal

[T Freeze

Seleccione Center en la lista desplegable para la justificacion del dato.

Presione el botén New

Column.

Destaque el archivo Detalle ubicado debajo de file-Browsing List Box y oprima el botén

Insert.

Seleccione el archivo Productos de la caja de didlogo Insert File, y oprima el botén Select.

Esto afiade el archivo Productos al arbol de archivos del template de control como un archivo

de consulta. El registro vinculado se busca automaticamente,

descripcion del producto en la lista.

para que pueda verse la

Select Field
Files : Fields :
3 Fi ctemto o T
=1-[[] Update Record on Disk - PRO:Descripcion
=[] Pedidos - PRO:Precio
w3 Clientes - PRO:Taszalmponible
—1-[Z] File-Browsing List Box
(1] OTHER FILES
(] GLOBAL DATA
(2] MODULE DATA tutuo008. cle
(1] LOCAL DATA FichaPedido
T a0 T I
Inzert | Edit | Delete | Select I Hew | Cancel |

Destaque PROD:Descripcion en la lista Fields, y oprima el botén Select.

Seleccione Left en la lista desplegable para la justificacion del dato.

Modifique el tamafio de las columnas y ajuste el disefio general (como ya lo ha hecho antes).

Oprima el botén OK para cerrar el Disefiador de Listados.
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30. Ajuste el tamarfio de la caja para mostrar todos los campos cargados.

Ahora deberia aparecer aproximadamente asi:
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Sincronizacion de las cajas de listado

Queremos que esta lista muestre solamente los registros que estan vinculados al registro de Cliente
que es sobre el que se esta trabajando. Por lo tanto, debemos especificar un limite de blsqueda

(range limit).

1. Dé cLIc DERECHO a la caja de listado que
acaba de colocar, y elija Actions del men.

2. Oprima el boton con puntos suspensivos (...)
en Range Limit Field.

3. Destaque el campo DETAL:NumPedido en
la lista Components, y oprima el boton
Select.

4. Elija “Relacion de archivos” (File
Relationship) de la lista desplegable
Range Limit Type.

5. Escriba Pedidos en el campo Related File.
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Adicion de un célculo del monto total del pedido

Ahora deseamos calcular el total del pedido que luego guardaremos en el archivo de Pedidos.

1.

9.

Oprima el boton pequefio de flecha, ubicado a la derecha de la lenglieta Hot Fields para
despalzarse por las lengietas, y elija la lengiieta Totaling cuando aparezca.

Oprima el bot6n Insert.
Oprima el botén de puntos suspensivos del campo Total Target Field.

Destaque el archivo Pedidos en la lista de archivos (Files), seleccione PED:MontoFactura, y
oprima el boton Select.

Este es el campo que recibira el resultado del calculo total.
Elija “Suma” (Sum) de la lista desplegable Total Type.
Oprima el botén de puntos suspensivos (...) del campo a totalizar (Field to Total).

Destaque la opcion LOCAL DATA FichaPedidos en la lista de archivos (Files), seleccione
ItemTotal de la lista Fields, y oprima el botén Select.

Este es el campo cuyo contenido se usara en el calculo total. Hasta ahora, solamente hemos
declarado este campo y no hemos hecho nada para introducirle valor alguno, pero pronto lo
haremos.

Elija “Para cada registro leido” (Each Record Read) de la lista desplegable Total Based On.

Browse Totaling
Total Target Field: IPED:MDntnFactura J Ok |
Total Type: |Sum =] e
Field To Tatal: |ItemT0taI

Total Based Or: |Each Record Read x|
Hel
Total Condition: | Ll

Oprima el botén OK, para cerrar la caja de didlogo Browse Totaling.

Afnadir barras de desplazamiento horizontal y vertical

1.
2.
3.

Elegir la lenglieta Extra.
Marcar los casilleros Horizontal y Vertical.

Oprima OK para cerrar la caja de didlogo List Properties.

Adicion de los botones de actualizacion de archivo

1.

Elija Populate > Control Template o dé cLic sobre la herramienta Control Template en
la caja de herramientas Controls (Gltimo icono a la derecha, fila inferior).

En la caja de didlogo Select Control Template, elija la plantilla de control
BrowseUpdateButtons y oprima el boton Select.

El cursor cambia a una cruz y un “librito”.
Dé cLic debajo del listado.
Aparecen juntos los botones de Insert, Change y Delete.

Dé cLic DERECHO sobre el boton Delete, y elija Actions del menu contextual.
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5.

6.

Marque el casillero de “Modificacion in situ” (Use Edit in Place).

Basta con indicar esta opcién en un solo boton, para que la plantilla de control lo marque en los
tres. Utilizaremos la técnica de “modificacion in situ” (edit-in-place) para actualizar los
registros de Detalle, en lugar de un formulario. Esto nos permitira demostrar algunas técnicas
de programacion bastante avanzadas y ver qué faciles son de realizar dentro del Generador de
Aplicaciones.

Oprima el botén OK.

Adicion de un control de solo visualizacion

1

6.

Elija Control » String, o dé cLic sobre la herramienta String en la caja de herramientas
Controls.

Dé cLic debajo del angulo inferior derecho de la caja de listados.

Dé cLic DERECHO sobre el control que acaba de colocar, y elija Properties del menu
contextual.

Marque el casillero Variable String.

Esto especifica que el control mostrara datos provenientes de una variable, no una mera cadena
alfanumérica fija. Aparece automaticamente la caja de dialogo Select Field.

Marque el archivo Pedidos en la lista Files, y elija PED:MontoFactura de la lista de campos
(Field) y oprima el boton Select.

Oprima el botén OK.

Cambio del titulo de la ventana y salida del Disefiador

1.
2.

Dé cLic sobre la barra de titulo de la ventana sobre la que esta trabajando.

Escriba Formulario de pedido en el campo de texto (Text) en la caja de herramienta flotante
Property, y oprima TAB.

£ Window Formatter |_ O] <]
Exill Edit Control Alignment Menu Toobar Populate Wiew Preview!

v X 22 aaxaa s

i Formulario de Pedido Bﬂd
Fecha: | Nota: |
Num Cliente: I D 55555555555555599555
Num Producto | Cantidad | Prod Precio| ltem Total | Descripcion H
E ||
e €0
E— o
d| [E—
Insert | Change | Delete REAEE R E3ATi
TN
S = o
0K I Cancel | 55555555555555555555555555555555555 ety ¥
s o] [ (o)

IR

“Iext: [Farrnulario de Pedida Eort: | =l

Use: | Size: | [zl Bru

] _ ;Ij

[wINDOW( Formulario de Pedida’] AT(18/5,262,175) 575 TEM,GRAY MDI [Horz. orWert. Move: SHIFT+drag
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3.

Elija Exit! para cerrar el Disefiador de Ventanas.

Hacerlo funcionar

Hay un par de cosas que debemos hacer para que este procedimiento adquiera plena funcionalidad:
afiadir una formula, y configurar la “modificacion in situ”.

Uso del Editor de Formulas

Para hacer que ItemTotal calcule el monto de cada registro de Detalle en la caja de listados, es
necesario afiadir una férmula al procedimiento. Esto permitira también realizar la suma total en
PED:MontoFactura.

1

10.

11
12.

Oprima el botén Formulas en la caja de didlogo Procedure Properties.

Aparece la caja de didlogo Formulas. Aqui se listan todas las férmulas del procedimiento.
Oprima el botén New para afiadir una nueva férmula.

Aparece la caja dialogo Formula Editor.

Escriba Item Total Formula en el campo Name.

Oprima el botén de puntos suspensivos (...) en el campo Class.

Destaque Format Browse en la lista Template Classes, y luego oprima el boton OK.

El campo Class simplemente especifica la posicion Idgica dentro del codigo fuente generado en
que se calcula formula. La clase Format Browse indica a la plantilla de control BrowseBox que
efectle el calculo cada vez que formatea un registro para mostrarlo en la caja de listado.

Oprima el botén de puntos suspensivos (...) en el campo Result.

Destaque LOCAL DATA FichaPedidos en la lista Files, seleccione ItemTotal de la lista
Fields, y oprima el boton Select.

Esto da nombre al campo que recibira el resultado del calculo. Este es el campo que definimos
anteriormente en el Disefiador de Listados.

Oprima el botén Data en el grupo de operandos (Operands).

Destaque el archivo Detalle en la lista Files, seleccione DETAL:Cantidad de la lista Fields, y
oprima el botén Select.

Esto lo coloca automaticamente en el campo Statement. Este campo contiene la expresion
que se construye. Si se desea, también se puede escribir directamente sobre él para construir la
expresion.

Oprima el botén * en en el grupo de operadores (Operators).
Este es el operador de multiplicacién.
Oprima el botén Data en el grupo Operands.

Destaque el archivo Detalle en la lista Files, seleccione DETAL:ProdPrecio de la lista
Fields, y oprima el boton Select.
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13. Oprima el botén de comprobacion (Check) para verificar la sintaxis de la expresion.

Aparece una tilde v* verde a la izquierda de la sentencia, indicando que la sintaxis es correcta.
Si aparece una “X” roja, la sintaxis es incorrecta, y aparece destacada la porcion de la sentencia
que debe cambiarse.

Formula Editor
D efinition O perator
Mame: [ItemT atalFamula S O e
Clazz: IFormathwse _I &0
Description: | =[<| =<
Result: [ItemTatal _I 7= <=| AND
OFE | ®0OR
Statement NOT

|DETAL:Cantidad"DE TAL:ProdPrecic] o
perands———

Check | J Data |
|nfarmation Eunctions |
’7 ‘ User |

Help | Qonditionalsl 1] % | Cancel |

14. Oprima el botén OK para cerrar el Editor de Formulas.

Reaparece la caja de dialogo Formulas.

15. Oprima el botdn OK para cerrarla.

Configuracién de la “modificacién in situ”

Ahora debemos configurar las caracteristicas de la “modificacién in situ” (Edit in Place). Ya
hemos usado esta caracteristica en el archivo de Teléfonos, y sencillamente aceptamos el
funcionamiento por omision, debido a que se trataba de un archivo muy simple. Sin embargo,
ahora estamos trabajando sobre una linea del registro de Detalle de un sistema de ingreso de
pedidos, lo que significa que necesitamos validar los datos ingresados por el operador. Para
hacerlo, necesitamos extender la funcionalidad simple que ofrece la Biblioteca de clases ABC.

Configurar clases especificas para las columnas

1. Oprima el boton Extensions en la caja de dialogo Procedure Properties.

2. Destaque Update a Record form Browse Box on Detalle y oprima el botén Configure Edit in
place.

Aparece la caja de dialogo correspondiente. Las opciones de esta caja le permite especificar el
comportamiento del control cuando el usuario ingresa 0 modifica datos y oprime ENTER o
una tecla de flecha, junto con varias opciones de “guardar”. Aceptaremos todos los valores
preconfigurados.

3. Oprima el botén Column Specific.
4. Oprima el botén Insert.

5. Oprima el botdn de puntos suspensivos (...) del campo Field.



6. Destaque DETAL:NumProducto, y oprima el boton Select.

La biblioteca ABC contiene una clase de objetos llamada EditEntryClass que es la clase por
omision de Edit in Place. "Pasaremos por alto" algunos de los métodos de la clase, para esta
columna, para poder modificar el comportamiento por omision. La adicion de este campo a la
lista de campos Column Specific es lo que nos permite "hacer a un lado " los métodos
preconfigurados para este caso. Lo haremos para poder realizar la validacion de ingreso de
datos: queremos asegurarnos que los usuarios solamente puedan ingresar nimeros de producto
validos.

7. Oprima el botén OK.

8. Oprima el botén Insert.

9. Oprima el bot6n de puntos suspensivos (...) del campo Field.
10. Destaque DETAL:Cantidad, y oprima el boton Select.

La clase EditEntryClass solamente ofrece controles de ingreso de datos (ENTRY). Para este
campo, deseamos utilizar un control SPIN, de manera que el usuario lo haga girar hasta la
cantidad que desea. Por lo tanto, necesitamos pasar por alto algunos de los métodos de la clase
preconfigurada también para esta columna, para tener un control SPIN en lugar de un control
ENTRY.

11. Limpie la casilla Use Default ABC.
Esto le permite indicar la clase exacta a partir de la que derivara.
12. Seleccione EditClass de la lista desplegable Base Class.

La EditEntryClass hace mucho mas de lo que necesitamos y de todas maneras vamos a pasar
por alto los métodos. Entonces vamos a derivar y sobre-escribir la clase a partir de la cual se
derivan todas las clases Edit in Place: la EditClass.

Column Specific I

Field |DETAL: Cantidad =l oK |

¥ &llow EditinPlace
Canicel |

rClasz Defintior
Object Mame: |EditInPIace::DET.-’-‘n.L:I:antid

™ Use Default ABC: EditE ntryClass Help |

¥ Use Application Builder Class?

Baze Class:

Include File: |
[ Derive?

e Elass M ethnds

HewClazs Braperties

Befresh Application Builder Class Information

Application Builder Class Wiewer

13. Oprima el boton OK.

14. Oprima el botdn Insert.

15. Oprima el boton de puntos suspensivos (...) para campo Field.
16. Destaque DETAL:ProdPrecio, y oprima el botén Select.

17. Quite la marca del casillero que permite la modificacion in situ ( Allow Edit in Place).



Esto evita que esta columna pueda modificarse.

Solamente los campos del archivo primario del Browse pueden modificarse in situ y la opcion
preconfigurada es que todos los archivos primarios sean modificables. En este caso, significa
que se pueden modificar los campos de Detalle, pero no los de Productos. Sin embargo, en este
caso no queremos que el usuario pueda modificar el precio, porque lo obtendremos
directamente del archivo de Productos, y no deseamos que se lo cambie. Es por esto que
inhabilitaremos el casillero Allow Edit in Place.

18. Oprima el boton OK cinco veces para volver al arbol de la aplicacion.

Utilizacion del Editor de Puntos de Inserciéon (Embeditor)

Dé cLic DERECHO sobre FichaPedido vy elija Source del ment contextual.

Esta opcion del menu abre el Editor de Puntos de Insercion : el tercer método de acceder a esos
puntos. Se trata del mismo editor de textos que ya ha utilizado, pero abierto en un modo especial
que le permite no solamente modificar los puntos de insercion en el procedimiento, sino también
hacerlo dentro del contexto del codigo generado por las plantillas.

El codigo fuente se vera asi :

A FichaPedido (O] x|
Exitl File Edit Search

»hi & =EERE
FichaPedido PROCEDURE tGenerated from procedure template - Hindowﬂ
t Start of "Data for the procedure” Populate Field
t [Priority 1300] Detalls - Detalles (linsas) de x|

. F.eyMumProducto [KEY)
FilesOpened BYTE K eyMumPedido [KE'Y)
Actioniessage CSTRING(48) HumPedido [SHORT]
ItemTotal DECIMAL(Y ,2) HurrPraducto (SHORT)
t [Priority 36688] Cantidad (SHORT)

FrodPrecio [DECIMAL)

* Uiews & Queues T azalmponible [DECIMAL)

BRUWS : -View:Brouse UIEW{Detalle}

PROJECT (DETAL :HumProducto)
PROJECT (DETAL :Cantidad)
PROJECT{DETAL :ProdPrecio)
PROJECT (DETAL :HumPedido) ﬂ—l J
JOIN{PRO:KeyHumProducto,DETAL :HumProducto}

PROJECT{PRO:Descripcion)

PROJECT{PRO :HumProducto}

EHND

END
Queue -Browse QUEUE tQueue declaration for browsefcombo box usir
DETAL -HumProducto LIKE{DETAL :HumProducto) *List box control field - type derived from
DETAL :Cantidad LIKE{DETAL :Cantidad) tList box control field - type derived from
DETAL :ProdPrecin LIKE{DETAL :ProdPrecio} tList box control field - type derived from
ItemTotal LIKE{ItemTotal) tList box control field - type derived from
PRO:Descripcion LIKE(PRO:Descripcion) tList box control field - type derived from
DETAL zHumPedido LIKE{DETAL :NumPedido} *Brouse key field - type derived from field
PRO :HumProducto LIKE(PRO:NumProducto) tRelated join file key field - type derived
HMark BYTE t3tores entry’s marked status
ViewPosition STRING{1824) tEntry’s file position string hd
] »
[ |Line: 1 =] [Inzert [
Wnicio| | @ & A B || SyEPsON Acti.. || A Clarion 5 (. T Microsoft Wa..| [ Dibuio - Paint | R S 1017

Adviértase que la mayor parte del cédigo se ubica sobre un fondo gris, y que los puntos en que
usted escribié codigo tienen fondo blanco. Hay ademas comentarios identificatorios para cada
punto de insercion. Se pueden ver 0 no €sos comentarios segun sea Ssu opcién en Setup »
Application Options. Una vez que se hayan familiarizado con ellos, posiblemente desee
quitarlos para ver mas del cadigo propiamente dicho.

Usted advertird que aparecid brevemente un mensaje : "Generating tutorial".



Este editor muestra todos los puntos de insercion posibles que podrian generarse para el
procedimiento. Adviértase la distinciéon: el editor no muestra el cédigo que sera
generado, sino todo el cédigo que podria ser generado, si usted eligiese cada
opcién posible y colocara coédigo en cada punto disponible. Es muy improbable que
usted alguna vez haga esto. Por lo tanto, se muestra muchisimo mas cédigo en este editor que
cuando se ha compilado la aplicacién. Una vez que terminemos aqui, daremos una mirada al
cadigo generado para apreciar la diferencia.

Al lado derecho de la barra de herramientas hay cuatro botones que son muy importantes para
conocer cuando se trabaja en este editor. Son (de izquierda a derecha): Punto de insercion
anterior, Punto siguiente, Punto utilizado anterior, y Punto utilizado siguiente (si
detiene el puntero del mouse sobre ellos vera las acotaciones en inglés para cada uno de los
botones). Permiten ir rapidamente de un punto de insercion a otro, especialmente cuando ya ha
escrito cddigo en algunos.

Deteccion de Pedidos modificados

Una de las cosas que deseamos que haga este procedimiento es detectar cambios a los pedidos
existentes, y asegurarse que no se provoquen desajustes de datos entre los archivos Pedidos y
Detalle. Este sistema guarda el monto total de un pedido en el campo PED:MontoFactura, de
manera que cuando el usuario cambia un item del Detalle en un Pedido existente, debe hacerse que
el registro se actualice. Hay una forma muy simple de hacerlo, lo que nos permitird demostrar el
flexible manejo de errores que realiza la biblioteca ABC.

1. Dé cLic sabre el botén Punto de insercién siguiente (unas cinco veces) hasta que llegue
al punto  de insercién inmediatamente anterior a la linea de codigo en la que se lee
ThisWindow CLASS(WindowManager), (esto deberia ser en [Priority 7500].

Cada punto de insercion tiene potencialmente 10.000 niveles de prioridad dentro. Este sistema
de prioridades esta disefiado para permitir insertar el codigo antes o después del cédigo
generado (sea mediante los Templates ABC de Clarion o de terceras partes). Esto hace que el
sistema de insercion sea completamente flexible, permitiéndole afiadir su codigo en cualquier
punto l6gico que se necesite, antes o después de cualquier "trozo" de cddigo generado.

2. Escriba el codigo siguiente:

LocalErrGroup GROUP IEsta linea debe ir exactamente sobre la columnal
I(aparecera en color rojo), ya que se trata de una
letiqueta de procedimiento.

USHORT (1)
USHORT(99)
BYTE (Level:Notify)
PSTRING( 'Guardar el pedido’)
PSTRING('Ha cambiado un item. Oprima el boton OK")
END
SaveTotal LIKE (PED:MontoFactura)

Los templates ABC de Clarion generan cddigo orientado a objetos utilizando la biblioteca
ABC. Esta biblioteca contiene una clase de manejo de errores llamada ErrorClass. La porcion
de cddigo que hemos escrito declara un LocalErrGroup GROUP (exactamente en la manera
que requiere la ErrorClass: véase el Application Handbook) que contiene un nimero de error
"personalizado” y un mensaje que estamos definiendo para el uso del objeto ErrorClass de
nuestra aplicacion. La declaracion SaveTotal es una variable local que se define COMO
(“‘LIKE’, siempre con el mismo tipo de datos) el campo PED:MontoFactura. Utilizaremos esta
variable para guardar el total del pedido cuando el usuario actualice un pedido existente.



£ FichaPedido |_ (O] =]
Exitl File Edit Search

) (212l sl el

t [Priority 7588] e

LocalErrGroup  GROUP fEopElatelie
USHORT(1) Detalle - Detalles [lineas) de:l
USHORT(99) . K.eyMumProducto [KEY)
BYTE(Level:Hotify) eyt umPedida [KEY)
PSTRING('Guardar Pedido'} MumPedido [SHORT)
PSTRING{'Ha cambiado un item. Oprima el botdn OK') MumProducto [SHORT)

END Cantidad [SHORT]

SaveTotal LIKE(PED:HontoFactura) ?L_'”SiTI:%CD';L?eE%E'SHAL]

* End of "Data for the procedure®

ThisWindow CLASS (WindowManager)

AddHistoryField PROCEDURE{SIGHED Control,SIGHED FieldHumber)}

AddHistoryFile PROCEDURE{ *GROUP RecBuf ,*GROUP HistBuf)

AddItem PROCEDURE{BrowseClass BC)

AddItem PROCEDURE(FileDropClass FD) ﬂ—l j

AddItem PROCEDURE{SIGHED Control,BYTE Action})

AddItem PROCEDURE{ToolbarClass TC}

AddItem PROCEDURE{ ToolbarUpdateClass TF)

AddItem PROCEDURE{TranslatorClass Translator)

AddItem PROCEDURE{WindowResizeCGlass RC)

AddUpdateFile PROCEDURE(FileHanager FH)

Ask PROCEDURE({ ) ,DERIVED

Init PROCEDURE({ ) ,BYTE ,PROC ,DERIVED

Kill PROCEDURE({ ) ,BYTE ,PROC ,DERIVED

Open PROCEDURE({ ) ,DERIVED

PostCompleted PROCEDURE( )

PrimeFields PROCEDURE({ ) ,PROC ,DERIVED

PrimeUpdate PROCEDURE({ ) ,BYTE ,PROC ,DERIVED

Reset PROCEDURE{BYTE Force=8),DERIVED

RestoreField PROCEDURE{SIGHED Control),DERIVED -

4 »

|Embed Data for the procedure [7500] |Line: B8 |Col 29 [Inzert [Modified

Elija Search > Find para traer la caja de dialogo Find.
Escriba ThisWindow.Init en el campo Find what, y oprima el boton Find next.
Esto nos lleva directamente al método ThisWindow.Init

En en punto embebido inmediatamente siguiente a la linea SELF.Errors &= GlobalErrors
(deberia ser [Priority 5600] ), escriba el siguiente codigo:

GlobalErrors.AddErrors(LocalErrGroup)  !Afiadir manejo personalizado del error

IF SELF.Request = ChangeRecord ISi se estda cambiando un registro
SaveTotal = PED:MontoFactura IGuardar el monto original del pedido
END

Este codigo llama al Método AddErrors del objeto GlobalErrors para afiadir el
LocalErrGroup a la lista de errores disponibles que maneja el objeto. El objeto
GlobalErrors es una instancia de la ErrorClass que los templates ABC declaran globalmente
para manejar todas las condiciones de error en la aplicacion. La adicion de nuestro
LocalErrGroup habilita al objeto GlobalErrors a manejar nuestra condicion
"personalizada” de error. Esto demuestra la flexibilidad de la biblioteca ABC de Clarion. La
sentencia IF detecta cuando el usuario esta modificando un pedido existente y guarda el total
original.

Este punto de insercion se ubica en ThisWindow.Init PROCEDURE que realiza algunas
tareas necesarias de inicializacion. Este es un método virtual del objeto ThisWindow. Este es
el objeto que dirige todo el codigo de ventanas y de manejo de controles.



Quizas usted no lo haya percibido, pero las plantillas ABC generan exactamente una linea de
codigo fuente ejecutable dentro del FichaPedido PROCEDURE en si ( GlobalResponse =
ThisWindow.Run ) de manera que toda la funcionalidad del FichaPedido PROCEDURE se
efectla en métodos objeto; sean métodos virtuales especificos al FichaPedido
PROCEDURE mismo 0 a métodos estandar de la biblioteca ABC. Esto se aplica a cada
procedimiento generado por los templates ABC. La generacién de cédigo plenamente
Orientado a Objetos hace que éste sea muy compacto y eficiente: solo el cddigo que
necesariamente debe ser diferente en un procedimiento individual se maneja diferentemente.
Todo lo demas es codigo estandar que reside en solamente un lugar, y que ha sido comprobado
y depurado para asegurar un funcionamiento coherente y confiable.

£ FichaPedido |_ (O] =]
Exitl File Edit Search

» DS (212l sl el

SELF .Errors &= GlobalErrors -]

* [Priority 5668]

GlobalErrors.AddErrors{LocalErrGroup) tATiadir manejo personalizado de Error

IF SELF.Request = ChangeRecord t5i estd cambiando un registro
SaveTotal = PED:HontoFactura tGuardar el monto original del pedido |

EHD

* Setup Toolbar Object

SELF .AddItem{Toolbar}

* Initialize the procedure

CLEAR{GlobalRequest})

CLEAR{GlobalResponse})

* [Priority 6588]

* Procedure setup standard formulas
SELF .AddUpdateFile{Access:Pedidos)

SELF .HistoryKey = 734

SELF .AddHistoryFile(PED:Record ,History: :PED:Record) Populate Field

SELF .AddHistoryField{?PED:Fecha,4) - - -
SELF .AddHistoryField{?PED:Nota,5) Detall - Detales lineas) de x|

SELF .AddHistoryField(?PED:NunCliente,1) eyMNumProducto (KEY)
= = P . eyt umPedido [KEY)
SELF .AddHistoryField{?PED :HontoFactura,3) MumPedida (SHORT]
SELF .AddItem{?Cancel ,RequestCancelled) MumPraducta [SHORT)
t [Priority 7300] Cantidad [SHORT)
FrodPrecio [DECIMAL)
* Open Files T azalmponible [DECIMAL)

Relate:Clientes.0Open
FilesOpened = True
SELF.Primary &= Relate:Pedidos
SELF .0kControl = 70K

IF SELF.Primelpdate() THEN RETURN Level:Hotify. <| | :J

t [Priority 7688] -
JCl] ’
| Embed ‘Windowh anager Method Executable Code Section [5600] [Line; 509 [Col: 79 [Insert Madified

La Programacion Orientada a Objetos (POQ) en Clarion comienza con la estructura CLASS.
Vea CLASS en Language Reference para el tratamiento de la sintaxis POO. La guia del
programador ( Programer’s Guide ) contiene varios articulos que tratan la POO en
profundidad, y hay una documentacién completa de la Biblioteca ABC de Clarion.

Escriba ThisWindow.Kill en el campo ";Encontrar qué ?"( Find what), y oprima el botén
"Encontrar el proximo"(Find next) .

En el punto embebido inmediatamente siguiente a la linea CODE (deberia ser en [Priority
2500] , escriba el siguiente cadigo:

GlobalErrors.RemoveErrors(LocalErrGroup) IQuitar error personalizado

Esto llama al método de la Biblioteca ABC para quitar nuestro error “personalizado”. El
método ThisWindow.Kill es un procedimiento de "limpieza" (realiza tareas a la salida) que se



ejecuta cuando el usuario termina de trabajar en el procedimiento FichaPedido, de manera que
ya no se necesita el manejo de error.

A FichaPedido =] B3
Exit! File Edit Search
ol 8 B
ThisWindow.Kill PROCEDURE
Detalle - Detalles (lineas) de x|
ReturnUalue BYTE ,AUTO [KeyNumProducto [KET) I

Start of "Windowlanager Hethod Data Section™
[Priority 5888]

F.epMumPedido [KEY)
NuriPedido (SHORT]
NumProducto [SHORT)
Cantidad [SHORT]
ProdPrecio [DECIMAL)
ITasalmporible [DECIMAL)

End of “WindowHManager Hethod Data Section™

CODE

t Start of "WindowHanager Method Executable Code Section™
t [Priority 2588]
GlobalErrors.RemoveErrors{LocalErrGroup)
* Parent Call

ReturnValue =PARENT.Kill()

t [Priority 56858]

tQuitar error personalizadoe

t Short-stop if kill called already

IF ReturnUalue THEH RETURN ReturnUalue.
IF FilesOpened

t [Priority 5608]

t Call Close file methods Buscar
Relate:Clientes.Close
t [Priority 6588] Buscar: lthiswindow.ki\l

END
t [Priority 7380]

™ Sélo palabra complsta

"Direc:iﬁn—l Cancelar

 Aniba +
[T Mapiisculas y mintsculas G (O Al

t Save window information

t [Priority 8588] hd
I v

|Embed Windowanager Method E xecutable Code Section [2500] |Line:599  [Col 72 [Insert | Modified

Escriba EVENT:CloseWindow en el campo Find what, y oprima el boton Find next.

En el punto embebido inmediatamente siguiente a EVENT:CloseWindow (debe ser en
[Priority 2500] , escriba:

IF SELF.REQUEST = ChangeRecord AND | ISi se cambia un registro
SELF.RESPONSE<>RequestCompleted AND | !y no se oprime el boton OK
SaveTotal <> PED:MontoFactura ly cambian los registros de detalle
GlobalErrors. Throw(99) Imostrar "error personalizado”

SELECT(?0K) ly luego seleccionar el boton OK
A FichaPedido =] B3
Exit! File Edit Search
S =) BB
t [Priority 7588] B
* End of “Window Event Handling"
OF EVENT:CloseWindow
* Start of "Window Event Handling™
* [Priority 7588]
IF SELF.REQUEST = ChangeRecord AND | *8i se cambia un registro
SELF.RESPONSE <> RequestCompleted AHD | ty no se oprime el botdn OK
SaveTotal <> PED:HontoFactura ty canbian los registros de detalle
GlobalErrors.Throw(99) tmostrar error personalizado
SELECT({70K) ty luego seleccionar el botdn OK
CYCLE
END
t End of “Window Event Handling"
OF EUENT:CloseDoun []
* Start of "Window Event Handling™
* [Priority 7588]
* End of “Window Event Handling"
OF EVENT:0penWindow Populate Fizld
t Start of "Window Event Handling™ - - —
% [Priority 7500] Detalle - Detalles [linsas) de =
FeytlumPraducto [KEY)
4 End of “Window Event |Fiiiid X} |keyhiumPedido (KEY)
OF EVENT:LoseFocus hunPedda [SHAAT)
% Start of "Window Eves B4 JEVENT Closeiwfinom g:,nﬁ:;gﬁ&a??ﬂn
t [Priority 7508 A i
L Y ! [ 5élo palabra completa Direccic | ?iff,féﬂigf%géﬂ%]
t End of “Window EVent| — oo inseulss = Ariba % Abajc
OF EVENT:GainFocus = | 0 ﬂ
* Start of "Window E - hd
I r
|Embed Windaw E vent Handing |Ln: 2280 [Cot 7 [Insert | Modified



Este codigo detectara cualquier intento del usuario de salir del procedimiento sin guardar el
registro de Pedidos después de hacer cambios a un pedido existente. Advierta la barra
vertical(]) al final de las primeras lineas de cddigo. Son absolutamente necesarias. La barra
vertical es el caracter de continuacion del lenguaje Clarion. Esto significa que las tres primeras
lineas de continuacion de este cédigo forman una Unica sentencia logica, que evalla tres
condiciones separadas y solamente ejecutara la sentencia GlobalErrors. Throw(99) si las tres
condiciones son verdaderas.

Pasar por alto las clases de "Modificaciéon in situ"

Bien, acabamos de ver un ejemplo de cdmo usted puede usar la biblioteca ABC en su propio
cadigo insertado. Ahora le mostraremos como pasar por alto una clase para proveer funcionalidad
especial, no provista por la biblioteca ABC. Las declaraciones CLASS para los objetos que hemos
nombrado a través de la caja de didlogo Configure Edit in Place son generados para usted por
los templates ABC. Estas clases se derivan de la clase EditClass de la biblioteca ABC.

1. Escriba EditinPlace::DETAL:Cantidad.CreateControl en el campo Find what, y oprima el
boton Find next.

2. En el punto embebido inmediatamiente siguiente la a linea CODE (esto deberia ser [Priority
2500], escriba el siguiente codigo:

SELF.Feq = CREATE (0, CREATE:Spin) !Crea un control SPIN

ASSERT(~ERRORCODE()) IAsume que no hay error
RETURN IRetorna antes de llamar al método padre
# FichaPedido =] 3
Exit! File Edt Search

Yol 8 =T
* End of “Edit-In-Place Hanager Hethod Executable Data Section®

CODE

* Start of "Edit-In-Place Manager Executable Code Section

* [Priority 2588]

SELF.Feq = CREATE(@,CREATE:Spin) *Grea un control SPIN

ASSERT{~ERRORCODE()) tAsume que no hay error

RETURH *Retorna antes de 1llamar al nétodo Padre]

* Parent Call

PARENT .CreateControl()

t [Priority 75088]

* End of "Edit-In-Place Manager Executable Code Section™
EditInPlace::DETAL :Cantidad.Init PROCEDURE{UNSIGHED FieldHumber ,UNSIGHED ListRav =2 llicallaey

Paopulate Field
? Start of “Edit-In-Place Hanager Hethod Executable Data Section™ Detalle - Detalles (linzas) de ]
N il
JAPIOPIE) SCLL I eyMNurnProducta [KEY)
n - I eyMumPedido [KEY

% End of “Edit-In-Place Hanager Hethod Executable Data Section® Ni’ﬁnp';r;ideo[gﬂ[gm]]

CODE MumProducto [SHORT)

t Start of "Edit-In-Place Manager Executable Code Section” Cantidad [SHORT)

* [Priority 25808 ProdPrecio [DECIMAL)

L Y 1 Bzcal X 7 acalmponible [DECIMAL

;n:gml:nl:ngz%;ieldmmher,Li Bussar [lece-DETAL Cantidad CrzateContiol

EIEEL0GEYR75 0] [C 56lo palabra complata Di'ECCié"—‘

* End of “Edit-In-Place Mar [* mayisculas y mindsculas ’Vr' fiba % Abgic _I

~ KN Jul||

[T
|Embed Edit-In-Place Manager Esecutable Code Section [2500] [Lr: 4820 |Col 77 [Insert | Modified
Hinicio | & & A ¥ || Syerson dcii [ A Clarion 5 (.. Microsoft W, | [ Dibvio - Paint | | SRRLBE s

Este codigo crea un control SPIN y asume que no habra errores. La sentencia RETURN es
necesaria ya que necesitamos estar seguros que no ocurrira la llamada al método padre.

3. Desplacese hasta el método EditinPlace::DETAL:Cantidad.Init (éste deberia estar
inmediatamente debajo del método EditInPlace::DETAL:Cantidad.CreateControl).



4. En el punto embebido inmediatamente siguiente a la linea
PARENT.Init(FieldNumber,ListBox,UseVar), (que deberia ser [Priority 7500], escriba el
siguiente codigo:

SELF.Feg{PROP:Text} = ListBox{PROPLIST:Picture,FieldNumber}
IMascara de ingreso de datos

SELF.Feg{PROP:RangeLow} = 1 IConfigurara el rango de valores
SELF.Feg{PROP:RangeHigh} = 9999 Idel SPIN
# FichaPedido 0] ]
Exitl File Edit Seach
& a B
EditInPlace::DETAL:Cantidad.Init PROCEDURE{UMSIGMED FieldHumber ,UNSIGHED ListBox,*? UseUar)
* Start of "Edit-In-Place Hanager Hethod Executable Data Section™
* [Priority 5880]
? End of "Edit-In-Place HManager Method Executable Data Section™
CODE
* Start of "Edit-In-Place Hanager Executable Code Section"
* [Priority 2588]
* Parent Call
PARENT . Init(FieldHumber ,ListBox,Uselar)
* [Priority 7588]
SELF.Feq{Prop:Text} = ListBox{PROPLIST:Picture,FieldNumber} tHiscara de ingreso de datos
SELF .Feq{Prop:RangeLow} = 1 tConfigura rango de valores del SPIN
SELF .Fegq{Prop:RangeHigh} = 9999
* End of "Edit-In-Place Hanager Executable Code Section™
Fopulate Field
EditInPlace::DETAL:Cantidad.Kill PROCEDURE Detalle - Detalles (linsas) de x|
s F.ewMumProducts (KEY]
] gl o Sk [ Koo K
* [Priority 5880] M umPedida (SHORT)
_ - - = MumProducta (SHORT)
 End 6F “EditSTn-Place Hanag 2W°  JlacerDETAL Cantidad CresteCortrol Canlidad (SHORT)
HILTE Clscepeer et Direcein———— e e DEGHAL
t Start of “Edit-In-Place 250 PSRN GOMPIES ® fotim B A1 | asalmponie. | ) 1
* [Priority 2588] ™ Maptisculas y mindsculas e =0
KT B =
I
|Embed Edit-In-Place Manager Executable Code Section [7500] [Ln: 4844  [Col 2 [Insert [Modified

Este codigo establece la mascara de ingreso de datos y el rango de valores valido para el
control SPIN.

5. Desplacese hasta el método EditinPlace::DETAL:Cantidad.SetAlerts (éste deberia estar
inmediatamente debajo del método EditInPlace::DETAL.:Cantidad.Kill).

6. En el punto embebido inmediatamiente siguiente la a linea PARENT.SetAlerts() (esto deberia
ser [Priority 7500], escriba el siguiente cddigo:

SELF.Feq{PROP:AIrt,5} = *
SELF.Feq{PROP:AIr,6} = *

Este codigo “desalerta” dos de las teclas estandar que alerta el método SetAlerts de la
EditClass, que son los flechas Up y Down. Necesitamos hacer esto porque el control SPIN las
emplea para operar, aumentando y disminuyendo el valor del campo respectivamente, cuando
son presionadas.

Para ver el cddigo que vamos a sobre-escribir, busque la EditClass en el archivo
\CLARIONS\LIBSRC\ABEIP.CLW.
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EditInPlace::DETAL :Cantidad .SetAlerts PROCEDURE

Start of "Edit-In-Place Manager Method Executable Data Section™
[Priority 5888]

End of "Edit-In-Place Hanager HMethod Executable Data Section”
CODE

¢ Start of "Edit-In-Place Manager Executable Code Section™

! [Priority 2588]

! Parent Call

PARENT .SetAlerts()

! [Priority 7500]

SELF .Feq{PROP:A1Ft,5} = *°
SELF.Feq{PROP:Alrt,6} = *°
* End of "Edit-In-Place Hanager Executable Code Section™

tDesactiva alerta para las flechas Up y Doun

Populate Field

EditInPlace::DETAL :Cantidad.SetReadOnly PROCEDURE{BYTE State)

Ditalle - Dietalles [lineas] de x|

K.epHumProducto [KEY]
K.eyMumPedido [KE'Y]
MumPedido (SHORT]
MumProducta (SHORT)
Cantidad [SHORT]
ProdFrecio [DECIMAL)

T asalmponible [DECIMAL)

* Start of “Edit-In-Place Manager Method Executable Data Section™
* [Priority 5888] o

Ilacs DETAL:Cantidad CreateContral
[ 5élo palabra completa ’—Direccwén—l

t End of “Edit-In-Place Hanac p ...
CODE -
! Start of “Edit-In-Place
! [Priority 2500]

o *
[ Mayiisculas y mindsculas (i (D (Al —I
t Parent Call a1 ﬂ_'j
A
| Embed Edit-In-Place Manager Executable Code Section [7500] [Ln: 4878 [Col E6 [Insert [ Modified

Escriba EditInPlace::DETAL:NumProducto.TakeEvent en el campo Find what, y oprima el
botén Find next.

En el punto embebido inmediatamiente siguiente la a linea de codigo que dice ReturnValue =
Parent.TakeEvent() (esto deberia ser [Priority 7500], escriba lo siguiente:

UPDATE(SELF.Feq)
IF ReturnValue and ReturnValue <> EditAction:Cancel

I Actualizar el campo Q

I'Si el Padre devueve una accion

l'y es diferente de Cancelar

PRO:NumProducto = BRW5.Q.DETAL:NumProducto ! Configurar consulta

IF Access:Productos.Fetch(PRO:KeyNumProducto) ! Si no existe el producto ingresado
GlobalRequest = SelectRecord I consultar registros de productos

VerProductos
IF GlobalResponse <> RequestCompleted I'Si no selecciona producto
CLEAR(PRO:Record) IHimpiar el buffer
ReturnValue = EditAction:None I configurar accién para continuar
END I'en el mismo campo
END

BRWS5.Q.DETAL:NumProducto=PRO:NumProducto
BRWS5.Q.DETAL:ProdPrecio = PRO:Precio
BRWS5.Q.DETAL:Descipcion = PRO:Descripcion

I Asignar valores del archivo de
I productos a los campos del
I Browse Queue y mostrarlos

DISPLAY
END

Este codigo es realmente interesante. Advierta que la primera sentencia ejecutable (generada
para usted) es una llamada al método PARENT.TakeEvent. Esto llama al método
EditClass.TakeEvent que estamos “pasando por alto” para que pueda hacer lo que
habitualmente hace (codigo muy similar al de TakeEvent que usted ya escribi6 para el control
SPIN de DETAL.:Cantidad).
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b nia Eexx 518
EditInPlace::DETAL :NumProducto .TakeEvent PROCEDURE(UHSIGHNED Event) ;l

Fopulate Field

ReturnUalue BYTE,nUTD
* Start of "Edit-In-Place Hanager Hethod Executable Data Section™
t [Priority 5880]

Productos - Productos en ve x|

ey umProducto [KEY)
Buscar \x|| |KeyDescripeion (KEY)
MNurmProducta [SHORT

* End of “Edit-In-Place Hanag -
e Buscar  [lac=: DETALNumProducta.T skeEven R
t Start of "Edit-In-Place H o T asalmponible [DECIMAL)
+ [Priority 2500] B G ek e [Dueccmnil

I Mapisoul o] € Agiba % Abasjc
? Parent Call Mayusculas y minusculas % . .
ReturnUalue =PARENT.TakeEve| J—l J
! [Priority 7500]
UPDATE({SELF .Feq) tactualizar el Campo Q
IF ReturnUalue AND ReturnUalue <> EditAction:Cancel *5i el Padre devuelve una accidn
*y es diferente de Cancelar
PRO:NumProducto = BRYS.(Q.DETAL :HumProducto *Configurar consulta
IF Access:Productos.Fetch{PRO:KeyNunProducto) 151 no existe el producto ingresado
GlobalRequest = SelectRecord tconsultar registros de productos
VerProductos
IF GlobalResponse <> RequestCompleted *5i no selecciona producto
CLEAR{PRO:Record) tlimpiar el buffer
ReturnUalue = EditfAction:Hone tconfigurar accidn para continuar
END *en el mismo campo
END
BRWS .Q.DETAL :NumProducto = PRO:NumProducto TAsignar valores del archivo de
BRUWS . .DETAL :ProdPrecio = PRO:Precio tproductos a los campos del
BRW5.0.PRO:Descripcion = PRO:Descripcion *Brouse Queue y mostrarlos |
DISPLAY
EHD hd
CA | »
| Embed Edit-In-Place Manager Executable Code Section [7500] [Ln: 4818 [Col 9 [Insert [ Modified

Todo el resto del codigo es para dar a esta clase derivada una funcionalidad extra no presente
en su clase padre. Este es el poder real de la POO: si uno quiere todo lo que hace el padre, mas
algo mas, no es necesario duplicar todo el cédigo del padre, sino que basta con Illamarlo. En
este caso, todo el cadigo extra es para realizar algunas tareas estandar de validacion de datos.
Este codigo verificara si el usuario tipio un ndmero de producto valido v, si no lo hizo, llamara
al procedimiento VerProductos para que escoja de una lista.

“Pasar por alto” los métodos

Hay un punto muy importante a comprender sobre el trabajo en el Editor de puntos de insercion,
cuando se “pasan por alto” los métodos: apenas escribe algo en un punto de insercion de un
método que puede pasarse por alto, jya lo ha hecho!. Incluso una simple linea de comentario (!)
puede hacerlo, porque el Generador de Aplicaciones advierte que usted ha escrito algo de cédigo,
y genera el correspondiente prototipo del método dentro de la declaracion local de CLASS. Para
evitar que usted accidentalmente escriba un comentario que provoque “pasar por alto” el método y
que destruya su funcionalidad, los templates ABC generan automaticamente llamadas al método
PADRE (PARENT) y retornan (RETURN) sentencias para usted, segin se necesite.

Advertira que todos nuestros métodos “pasados por alto” contenian llamadas generadas a su
método PARENT, y que los métodos TakeEvent también tenian sentencias RETURN generadas.
A veces, usted desea que esas sentencias se ejecuten; aunque a veces, no. Para estos Ultimos casos,
simplemente escriba el codigo en el punto de insercién que estd antes de la llamada al método
PARENT y escriba su propia sentencia RETURN al final del codigo (como lo hicimos al final del
codigo que escribimos para los métodos EditinPlace::DETAL:Cantidad.CreateControl).
Esto significa que el método PARENT generado y la sentencia RETURN nunca se ejecutaran. El
compilador de Clarion tiene la suficiente inteligencia para reconocer que esas sentencias nunca se
ejecutaran, y optimiza el codigo objeto, quitandolas de él.

Elija Exit! para cerrar el Editor de puntos de insercion.



Actualizacion del arbol de procedimientos

El método EditInPlace::Detal:NumProducto.TakeEvent llama al procedimiento VerProductos

de dentro de su codigo.

Dado que este es cédigo insertado, el Generador de | [FichaCierts- *_ |
. . . FichaPedido -
Aplicaciones ignora que usted ha llamado a este FehaProdicto- Cancel |
- - - - 4 -
procedimiento, y necesita ser informado (0 Se | [splshscreen-
7 - - erClientes - il
generaran errores de compilacion), para que pueda erPedidos - e

serroductos -

generar la estructura MAP correcta para el médulo
que contiene este procedimiento.

1. Dé cLic DERECHO sobre FichaPedido y elija
Procedures del menu contextual.

2. Destaque VerProductos y oprima el botén OK.

3. Elija File » Save, u oprima el botén Guardar
para guardar su trabajo.

Select Al || DeSelectal

Generacion de codigo

1. Elija Project » Generate para generar el cédigo fuente de su aplicacion.

# Clarion 5 [tutuorial. app) - [C:\clarionS\tutuorial\tutuo008. clw]

D File Archive DataModeler Edit Search Project Setup “Window Help _|5‘|5|
9 DEH2e®| v nnaE |
HAP =]
IHCLUDE{ " TUTUO®GS . IHC") ,0NHCE *Local module prodecure declarations
IHCLUDE{ " TUTUOG83 . IHC") ,0NCE *Req'd for module callout resolution _I
INCLUDE({ " TUTUOBBG6 . IHC* ) ,0NCE *Req’'d for module callout resolution
END
FichaPedido PROCEDURE tGenerated from procedure template - Window
FilesOpened BYTE
ActionHessage CSTRING(48)
ItemTotal DECIMAL(7,2)

BRWS : :Uiew:Brouse UIEW(Detalle)

PROJECT(DETAL :HumProducto)

PROJECT{DETAL:Cantidad)

PROJECT{DETAL:ProdPrecio)

PROJECT{DETAL :HumPedido)

JOIH(PRO:KeyHumProducto ,DETAL :HumProducto)
PROJECT{PRO:Descripcion)
PROJECT{PRO:NumProducto}

END
END
Queue :Brouse QUEUE fQueue declaration for browse/combo box usir
DETAL :NumProducto LIKE(DETAL :HumProducto) fList box control Field - type derived From
DETAL :Cantidad LIKE(DETAL:Cantidad) fList box control field - type derived from
DETAL :ProdPrecio LIKE(DETAL:ProdPrecio) tList box control field - type derived from
ItemTotal LIKE{ItemTotal) tList box control field - type derived from
PRO:Descripcion LIKE{PRO:Descripcion) fList box control Field - type derived From
DETAL :NumPedido LIKE{DETAL :HumPedido} !Browse key field - type derived from field
PRO:NunProducto LIKE{PRO:NumProducto) fRelated join file key field - type derived
HMark BYTE !Stores entry’s marked status i
4| I »

[ [Line: 19 [Cal 1 [Insert [

2. Dé cLic berecHo sobre FichaPedido y seleccione Module del men( contextual. Aparece el
Editor de Texto que contiene el codigo fuente generado para el procedimiento FichaPedido.
Adviértase que hay mucho menos codigo aqui que lo que habia en el Editor de Puntos de
Insercién. Alli todo el codigo estaba presente para que usted pudiera apreciar el contexto, y
para ofrecerle puntos de insercion mediante los cuales “pasar por alto” los métodos, si hubiere
necesidad. Sin embargo, el Generador de Aplicaciones y los Template ABC de Clarion tienen
la suficiente inteligencia para generar solamente el codigo necesario, cuando es necesario.

3. Elija Exit! para cerrar el Editor de Texto.
Ahora es un buen momento para probar la aplicacién. Estan listas todas las partes de ingreso de
datos, y lo Unico que queda por hacer son los informes, que trataremos en la préxima leccién.
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12 - CREACION DE INFORMES

Un simple listado de clientes

El dltimo punto a cubrir en este cursillo son los informes. Primero, crearemos un simple listado
de clientes para presentarle el Disefiador de Informes.

Después crearemos un Informe de Pedidos para demostrar lo facil que es crear informes
relacionales, con segmentos multinivel, totales de grupo, y disefio de paginas. Luego, copiaremos
el Informe de Pedidos y limitaremos la impresion a los Pedidos de un cliente y, por Gltimo a un
solo Pedido.

Punto de inicio:
Debe estar abierto el archivo TUTORIAL. APP

Actualizaciéon del menu principal

Primero, necesitamos afiadir selecciones al menu, de manera que el usuario pueda llamar los
informes, y asi el Generador de Aplicaciones podra llamar a los procedimientos “ToDo” que
correspondan.

Nuevo item de menu

1. Dé cLic DERECHO sobre el procedimiento Main en el arbol de la aplicacion y elija Window
del menu contextual.

2. ElijaMenu > Edit Menu del menu del Disefiador de Ventanas.

3. Destaque el item P&rint Setup en la lista del Editor de MenUs. Si lo desea, puede editar el
campo Menu Text y traducirlo a: Configuracion de &lmpresora.

4. Oprima el botén Item.

5. Escriba Imprimir Lista &Clientes en el campo Menu Text, y oprima TAB.

Especificar la accion del nuevo item

1. Elijala lengueta Actions.
2. Elija Call a Procedure de la lista desplegable When Pressed.
3. Escriba InformeClientes.

4, Marque la casilla Initiate Thread.

Adicién de un sequndo menu

1. Oprima el bot6n Item.
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Escriba Imprimir &Pedidos en el campo Menu Text.

Elija la lenglieta Actions.

2
3
4. Elija Call a Procedure de la lista desplegable When Pressed.
5. Escriba InformePedidos en el campo Procedure Name.

6

Marque el casillero Initiate Tread.

Adicion de un tercer item al menu

Oprima el botén Item.

Escriba Imprimir Pedidos por &Cliente en el campo Menu Text.
Elija la lenglieta Actions.

Elija Call a Procedure de la lista desplegable When Pressed.
Escriba InformePedidosCliente en el campo Procedure Name.

Marque el casillero Initiate Thread.

Oprima el botén Close para cerrar el Editor de Mends.

© N o 00~ 0w DD P

Elija Exit! para cerrar el Disefiador de Ventanas (y guarde su trabajo).

Creacion del Informe

Ahora podemos crear el primer informe, utilizando el Disefiador de Informes.
1. Destaque el procedimiento InformeClientes en el arbol de aplicaciones.
2. Oprima el bot6én Properties.

3. Destaque Report en la caja de dialogo Select Procedure Type, despeje el casillero Use
Procedure Wizard (utilizar el Asistente de Procedimientos), y oprima el botén Select.

I | Select I
=1-((3 Class ABC - Application Builder Class Templates
Browse - Browse Fields in a Page-Loaded List Box ﬂl
External - External Procedurs
Farm - Yiew / Edit a Record from a File
Frame - Multiple Document Main Menu Help |

Menu - Single Document Menu
Process - Sequential Record Processor
Repart - Generic Reporting Procedurs

Source - Source Procedure

Splazh - Splash Window

Wiewer - Yiew a ASCI [text] file
Window - Generic Window Handler

00000000000

4 »
[T Uze Procedure Wizard

4, Oprima el botén Report en la caja de dialogo Procedure Properties.
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Aparece el Disefiador de Informes. Aqui puede editar visualmente el informe y sus controles.
El disefiador de Informe representa las cuatro partes basicas de la estructura de datos
REPORT mostrando cuatro bandas: Page Header (Encabezado de pagina), Detail (Detalle),
Page Footer (Pie de pagina), y Form (Formulario). Cada banda es una unidad funcional, que
se imprime toda junta. Vea el capitulo de la User’s Guide titulado Using the Report
Formatter para mas informacion sobre las partes del informe y el modo en que las genera el
motor de impresion.

# Report Formatter H[=] 3

Exit! Edit Controlz Alignment Bands “iew Populate Option  Previewl

v x @lanaa:sa

Page Header

Page Footer

Page Form

[ [ [ Lagical view [11000 Inches

Para este informe, colocara controles de ndmero de pagina en el encabezamiento, y colocara
los campos del archivo Clientes en la banda de Detalle.

Colocacién de una cadena

1.

4.

Elija Controls » String, o tome la herramienta String de la caja de herramientas

Controls.

Dé cLic sobre la banda Page Header.
Dé cLic DERECHO sobre el control, y elija Properties desde el menu contextual.
Aparece la caja de didlogo String Properties.

Escriba Pag. N°: en el campo Text, y oprima el boton OK.

Colocacion de un template de control para imprimir el numero de

pagina

1.

Elija Populate » Control Template, o “pique” sobre la herramienta Control Template de
la caja de herramientas Controls.
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2.
3.
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Destaque ReportPageNumber y oprima el botén Select.

Dé cLic a la derecha de la cadena ubicada previamente.

Disefio del Detalle

Se imprime una banda de Detalle (Detail) por cada registro del informe. Para este procedimiento,
colocara los campos en un arreglo de blogque, que produce un informe de etiquetas de correo.

1.

g &~ w Db

© © N o

Elija Populate » Multiple Fields, o dé cLic sobre el control Dictionary Field en la caja de
herramientas Controls.

En la caja de didlogo Select Field, destaque la carpeta “ToDo”, y oprima el bot6n Insert.
Seleccione el archivo Clientes de la caja de didlogo Insert File, y oprima el boton Select.
Oprima el botén Edit.

Destaque KeyNumCliente en la caja de didlogo Change Access Key, y oprima el bot6n
Select.

Destaque CLI:Empresa en la lista Fields y oprima el boton Select.
Dé cLic dentro de la banda Detail, cerca del angulo superior izquierdo.
Destaque CLI:Nombres en la lista Fields y oprima el botén Select.

Dé cLic dentro de la banda Detail, justo debajo del primer control.

10. Destaque CLI:Apellidos en la lista Fields y oprima el boton Select.

11. Dé cLic dentro de la banda Detail, a la derecha del control que acaba de colocar.

12. Destaque CLI:Direccion en la lista Fields, y oprima el boton Select.

13. Dé cLic dentro de la banda Detail, debajo del segundo control que acaba de colocar.

Ajuste de la banda de detalle

En este punto, probablemente quede muy poco lugar en la banda, y haya que agrandarla.

1.
2.

Oprima el botén Cancel para salir del modo de llenado multiple.

Dé cLic dentro de la banda Detail, pero no en uno de los controles de cadena. Aparecen las
asas del area de detalle.

Ajuste el tamafio, ARRASTRANDO el asa central inferior, deje lugar para una o mas lineas.

Coloque el resto de los campos

1.

g &~ w DN

Elija Populate » Multiple Fields, o dé cLic sobre la herramienta Dictionary Field en la
caja de herramientas Controls.

Destaque CLI:CP en el campo Fields, y oprima el boton Select.
Dé cLic sobre la banda Detail, debajo del Gltimo control que ha colocado.
Destaque CLI:Ciudad en el campo Fields, y oprima el botén Select.

Dé cLic sobre la banda Detail, a la derecha del Gltimo control que ha colocado.
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6. Destaque CLI:Provincia en el campo Fields, y oprima el botén Select.
7. Dé cLic sobre la banda Detail, a la derecha del dltimo control que ha colocado.
8. Oprima el botén Cancel para salir del modo de llenado multiple.

Advierta que tiene el mismo grupo de herramientas de alineacion en el Disefiador de
Informes que en el Disefiador de Ventanas (elija Option > Show Alignbox, para mostrar
esa caja flotante de herramientas).

£ Report Formatter (O] =]
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Seleccidon de una fuente base para el informe

1. Elija Edit »Report Properties para configurar los atributos por omision.

2. Oprima el botén Font.

3. Seleccione una fuente, estilo y tamafio para usar como base del informe.
Si no elige una fuente, se usa la fuente por omision de la impresora.

4. Oprima el Boton OK para cerrar la caja de dialogo Select Font.

5. Oprima el botén OK para cerrar la caja de didlogo Report Properties.

Vista preliminar del informe

1. Elija Preview! para visualizar como quedara la pagina impresa.
2. Destaque Detail en la lista Details y oprima el boton Add varias veces.

Esto llena la vista preliminar con varias bandas “impresas” para poder ver como quedan.
Debido a que cada informe puede contener varias bandas de distinto tipo, hay que seleccionar



cual desea ver antes de la previsualizacion. De este modo, el Disefiador de Informes sabe qué
debe componer sobre la pantalla.

Preview Print Details

Detailz Selected Details ak
m detai [ = |
detail
detai Cancel _|
detail
| detail Help |

]

3. Oprima el botén OK.

£ Report Formatter (O] =]

Exit! Edit Controlz Alignment Bands ‘iew Populate Option  Band Yiew

| Prew/Mest Page: Pglp/PgDn |~ Press Esc to exit - | Preview [1/1000 Inches

Cuando ha terminado de “previsualizar”, elija Band View!
Elija Exit! para regresar a la caja de didlogo Procedure Properties (y guarde su trabajo).

Oprima el botén OK para cerrar la caja de dialogo Procedure Properties.

N o g &

Elija File > Save, u oprima el boton Guardar en la barra de herramientas para guardar su
trabajo.
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Informe Pedidos

A continuacion, crearemos uno de los tipos de informe mas comunes. Un pedido usa la mayor
parte de los archivos del diccionario de datos, y demuestra como crear saltos de grupo v totales.
También le mostrara codmo controlar la paginacion basada en los saltos de grupo.

Creacion del Informe

1. Destaque el procedimiento InformePedidos.
2. Oprima el botén Properties.

3. Destaque Report en la caja de didlogo Select Procedure Type, evite el uso del Asistente
de Procedimiento (despeje el casillero Use Procedure Wizard), y oprima el botén Select.

Aparece la caja de didlogo Procedure Properties.

Archivos del informe

1. Oprima el boton Files en la caja de dialogo Procedure Properties.

Aparece la caja de didlogo File Schematic Definition.

Destaque la carpeta “ToDo”, y oprima el boton Insert.

Seleccione el archivo Clientes de la caja de dialogo Insert File, y oprima el botén Select.

Oprima el botén Edit.

g~ o Dn

Destaque CLI:KeyNumCliente en la caja didlogo Change Access Key, y oprima el bot6n
Select.

Este informe procesara todos los registros del archivo Clientes ordenados por NumCliente.

6. Destaque el archivo Clientes, y oprima el botdn Insert.

7. Seleccione el archivo Pedidos de la caja de didlogo Insert File, y oprima el botén Select.
Esto procesara todos los Pedidos de cada Cliente.

8. Destaque el archivo Pedidos, y oprima el boton Insert.

9. Seleccione el archivo Detalle de la caja de didlogo Insert File, y oprima el botén Select.
Cada Pedido se imprimira con todas las lineas de Detalle que le corresponden.

10. Destaque el archivo Detalle, y oprima el botén Insert.

11. Seleccione el archivo Productos de la caja de didlogo Insert File, y oprima el botén Select.

Cada registro de Detalle buscara el registro vinculado del archivo Productos. En este punto,
el arbol de archivos se vera asi:
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12. Oprima el boton OK para volver a la caja de dialogo Procedure Properties.

File Schematic D
Files -

=2 File Schematic

£ ~[C Filefs] to Frocess

z <[I3 Clientes - CLI:KeyMumClisnte

210 Pedidos
217 Detalle
E Produ

-[C7] OTHER FILES
[ GLOBAL DATA
[C] MODULE DATA tutuo010.clw
-1 LOCAL DATA InformePedidos

KAl 2
Inzert I Edit | Delete |
OF | [HEw | Cancel | Help |

Configuracién de las caracteristicas predeterminadas
1. Oprima el botén Report.

2. Elija Edit » Report Properties para configurar las caracteristicas predeterminadas del
informe.

3. Oprima el botén Font.

4. Elija una fuente, estilo y tamafio para usar como fuente basica de este informe.

Select Font E
Fuente: Estilo de fuente: Tamafio:
Iﬁ«rial lN ormal m | fceptar I
Auial Black 1 |Cursiva
T Avial Marrow Megrita
Hr &ial Rounded MT Bl Megrita Cursiva
Baskervile
T Binner Gothic
B Book Antiqua N
H Bookman Old Style ﬂ
~Efecta: ~Ejemplo
[ Tachado
[ Subrapade AaBbYyiz
LColor:
I- Negro v I Alfabeta:
I Occidental LIJ

Si no elige una fuente para el informe, se imprimira utilizando la fuente por omision de la
impresora. Debe elegir una fuente que usted sepa que el usuario tendra instalada (en general,
pueden considerarse seguras las fuentes que vienen con Windows).

5. Oprima OK para cerrar la caja de didlogo Select Font.

6. Oprima OK para cerrar la caja de didlogo Report Properties.
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Llenado de la banda de pagina base

La banda “pagina base” (Page Form) se imprime una vez por cada pagina del informe; pero su
contenido se compone solo una vez, al abrir el informe. Esto la hace (til para informacién
constante, que estara presente en cada pagina.

Colocacion de una cadena de caracteres

1. Elija Controls »String, o tome la herramienta String de la caja de herramientas Controls.
2. Dé cLic sobre la banda Page Form.
3. Dé DOBLE cLic sobre el control.
Aparece la caja de didlogo String Properties.
4. Escriba Nota de Pedido en el campo Text.
5. Oprima el botén Font.

6. Elija una fuente, estilo y tamafio para el texto (aqui seria adecuada una tipografia grande, en
negritas).

7. Oprima el botén OK para cerrar la caja de dialogo Select Font.
8. Oprima el botén OK para cerrar la caja de dialogo String Properties.

9. Ajuste el tamafio del control para que pueda contener el texto, ARRASTRANDO las asas.

Colocaciéon de la siguiente cadena de caracteres

1. Elija Controls » String, o elija la herramienta String de la caja de herramientas
Controls.

2. Dé cLic en la parte superior de la banda Page Form, justo debajo de la Gltima cadena de
caracteres que ha colocado.

3. Dé cLic DERECHO sabre el control, y elija Properties del menu contextual.
4. Escriba el nombre de su empresa en el campo Text.

5. Oprima el botén Font y elija una fuente, estilo y tamafio adecuados (algo ligeramente mas
pequefio que el campo anterior estaria bien aqui).

6. Oprima el botén OK para cerrar la caja de dialogo Select Font.
7. Oprima el botén OK para cerrar la caja de dialogo String Properties.

8. Ajuste el tamafio del control, para que pueda contener el texto, ARRASTRANDO las asas.
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£ Report Formatter (O] =]

Exitl Edit Controlz Alignment Bands “iew Populate Option  Preview!
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Poblando la banda de detalle

La banda de detalle (Detail) se imprimird cada vez que se lea nueva informacién del archivo
“Hijo” en el nivel mas bajo del arbol de archivos. Para este informe de Pedidos, el nivel inferior
es el archivo “Detalle” (recuerde que Productos es un archivo de “consulta” de muchos-a-uno
desde el archivo Detalle).

1.

o g & w

~

Elija Populate » Multiple Fields, o dé cLic sobre la herramienta Dictionary Field en la
caja de herramientas Controls.

Destaque Detalle en la lista Files y elija DETAL:Cantidad en la lista Fields y oprima el
boton Select.

Dé cLic dentro de la banda Detail, cerca del angulo superior izquierdo.
Destaque DETAL:NumProducto en la lista de Fields, y oprima el botén Select.
Dé cLic dentro de la banda Detail, a la derecha del primer control.

Destaque Productos en la lista Files, y elija PROD:Descripcion en la lista Fields y oprima
el boton Select.

Dé cLic dentro de la banda Detail, a la derecha del control anterior.

Destaque Detalle en la lista Files, y elija DETAL:ProdPrecio en la lista Fields y oprima el
boton Select.

Dé cLic dentro de la banda Detail, a la derecha del control anterior.
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10. Destaque LOCAL DATA InformePedidos en la lista Files, y oprima el boton New.

Asi podra afiadir una variable local sin tener que ir hasta la ventana Procedure Properties,
y oprimir el botén Data. Esta variable se usara para mostrar el precio total para cada linea del
pedido.

11. Escriba ItemTotal en el campo Field Name.

12.Elija DECIMAL de la lista desplegable Data Type.

13. Escriba 7 en el campo de caracteres (Characters).

14. Escriba 2 en el campo de decimales (Places) y oprima el botén OK.

15. Dé cLic dentro de la banda Detail, a la derecha del Gltimo control colocado.
16. Oprima el boton Cancel para salir de este modo de operacion.

17. Mueva todos los controles a la parte superior de la banda Detail, alineelos horizontalmente, y
ajuste el tamafio de la banda, para que sea apenas mas alta que los controles mismaos.

Adicion de saltos de grupo

Necesitamos imprimir distintos tipos de informacion en cada pedido. Por lo tanto, necesitamos
crear estructuras de salto (BREAK) para que se imprima algo cada vez que cambia la
informacion en el archivo Pedidos y cada vez que cambia la informacion del archivo Clientes.

1. ElijaBands » Surrounding Break, y luego dé cLIc sobre la banda Detail.
Aparece la caja de didlogo Break Properties.
2. Oprima el bot6n de puntos suspensivos (...) junto al campo Variable.

3. Destaque Clientes en la lista Files y elija CLI:NumCliente en la lista Fields y oprima el
boton Select.

4. Escriba CLI:NumClienteBreak en la etiqueta Label, y oprima el botén OK.

Break Properties

General |E:-:t@ I Actions I

Wariable: IELI:NumEIiente J
Lahel: IELI:NumEIienteBreak

Uaze: I

fode

’7 [T Freeze

Cancel | Help |

Aparece una banda de salto (Break [CLI:NumCliente]) sobre la banda Detalle, con una
sangria a la izquierda, lo que esta dentro de la estructura Break.
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Elija Bands » Sorrouding Break, y dé cLic sobre la banda Detail.
Aparece la caja de didlogo Break Properties.
Oprima el botén de puntos suspensivos (...) junto al campo Variable.

Destaque Pedidos en la lista Files y elija PED:NumPedido en la lista Fields y oprima el
boton Select.

Escriba PED:NumPedidoBreak en el campo Label y oprima el botén OK.

Ahora el informe se ve asi:
£ Report Formatter |_ (O] =]

Exitl Edit Controlz Alignment Bands “iew Populate Option  Preview!
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Page Header

Break [CLI:NumCliente] =
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Creacion de las cabeceras y pies de grupo

1.

Elija Bands » Group Header, y dé cLic sobre la banda Break (PED:NumPedido).

La banda Group Header (PED:NumPedido) aparece encima de la banda Detalle. Esta
banda se imprimira cada vez que el valor del campo PED:NumPedido cambie, al principio
de cada nuevo grupo de registros. Lo usaremos para imprimir el nombre y direccion de la
empresa, junto con el nimero de pedido y su fecha.

Elija Bands » Group Footer, y dé cLic sobre la banda Break (PED:NumPedido).

Aparecera la banda Group Footer (PED:NumPedido) debajo de la banda Detail. Esta
banda se imprimira cada vez que el valor de PED:NumPedido cambie, al final de cada grupo
de registro. La usaremos para imprimir el total del pedido.

Dé crLic DERECHO sobre la banda Group Footer (PED:NumPedido) y elija
Properties del men( contextual.

Aparece la caja de didlogo Page/Group Footer Properties.
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4. Marque el casillero Page after.

Esto hara que el motor de impresion imprima esta banda, y luego inicie el proceso de
deshordamiento de pagina (Page Overflow). Se compondra la banda de pie de pagina (Page
Footer), se enviara una orden de “pagina nueva” a la impresora, y luego se compondra la
banda de encabezado (Page Header) de la pagina siguiente.

5. Oprima el botén OK.
6. ElijaBands » Group Footer, y dé cLic sobre la banda Break (CLI:NumCliente).

Esta banda aparece debajo de la del Group Footer (Ped:NumPedido). Se imprimira cada
vez que el valor del campo CLI:NumCliente cambie, al final de cada grupo de registros.
Usaremos esto para imprimir la informacion resumida sobre pedidos de cada empresa cliente.

7. Dé cLic DERECHO sobre la banda Group Footer (CLI:NumCliente) y elija Properties
del menu contextual.

8. Marque el casillero Page after.
9. Oprima el botén OK.

£ Report Formatter (O] =]

Exitl Edit Controlz Alignment Bands “iew Populate Option  Preview!
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Llenado de la banda cabecera de grupo

Colocaciéon de los campos de Clientes

1. Elija Populate » Multiple Fields, o dé cLic sobre la herramienta Dictionary Field en la
caja de herramientas Controls.
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Destaque Clientes en la lista Files y elija CLI:Empresa en la lista Fields y oprima el bot6n
Select.

Dé cLic dentro de la banda Group Header (PED:NumPedido) cerca del angulo superior
izquierdo.

Destaque CLI:Nombres en la lista Fields y oprima el botén Select.
Dé cLic dentro de la banda Group Header (PED:NumPedido), debajo del primer control.
Destaque CLI:Apellidos en la lista Fields y oprima el botén Select.

Dé cLic dentro de Group Header (PED:NumPedido), a la derecha del control ya
colocado.

Destaque CLI:Direccion en la lista Fields y oprima el botén Select.

Dé cLic dentro de Group Header (PED: NumPedido), debajo del segundo control que ha
colocado.

10. Destaque CLI:CP en la lista Fields y oprima el boton Select.

11. Dé cLic dentro de Group Header (PED:NumPedido), debajo de la direccién.

12. Destaque CLI:Ciudad en la lista Fields, y oprima el boton Select.

13. Dé cLic dentro de Group Header (PED:NumPedido), junto al Gltimo control que colocé.

14. Destaque CLI:Provincia en la lista Fields, y oprima el boton Select.
15. Dé cLic dentro de Group Header (PED:NumPedido), a la derecha de CLI:Ciudad.

Cologue los campos del archivo Pedidos

1.

Marque Pedidos en la lista Files y elija PED:NumPedido en la lista Fields y oprima el
boton Select.

Dé cLic dentro de Group Header (PED:NumPedido), cerca del angulo superior derecho.
Destaque PED:FechaPedido en la lista Fields, y oprima el boton Select.

Dé cLic dentro de la banda Group Header (PED:NumPedido), debajo del tltimo control
colocado.

Oprima el boton Cancel para cerrar la caja de didlogo Select Field y salir de este modo de
trabajo.

Colocacién del texto permanente y de las cabeceras de columna

1.

Elija Controls » String, o “pique” sobre la herramienta String de la caja de herramientas
Controls.

Dé cLic dentro de la banda Group Header (PED:NumPedido), a la izquierda del control
de nimero de pedido que acaba de colocar.

Escriba Pedido N°: en el campo Text de la caja de herramientas Property, y oprima TAB.
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4. Elija Controls » String, o “pique” sobre la herramienta String de la caja de herramientas
Controls.

5. Dé cLic dentro de la banda Group Header (PED:NumPedido), a la izquierda del control
de fecha.

6. Escriba Fecha: en el campo Text de la caja de herramientas Property, y oprima TAB.

7. Elija Controls » String, o “pique” sobre la herramienta String de la caja de herramientas
Controls.

8. Dé cLic dentro de la banda Group Header (PED:NumPedido), a la izquierda debajo de
Cliente.

9. Escriba Cantidad en el campo Text de la caja de herramientas Property, y oprima TAB.

10. Elija Controls » String, o “pique” sobre la herramienta String de la caja de herramientas
Controls.

11. Dé cLic dentro de la banda Group Header (PED:NumPedido), a la derecha del dltimo
control colocado.

12. Escriba Producto en el campo Text de la caja de herramientas Property, y oprima TAB.

13.Elija Controls > String, o “pique” sobre la herramienta String de la caja de herramientas
Controls.

14. Dé cLic dentro de la banda Group Header (PED:NumPedido), a la derecha de la Gltima
cadena de caracteres colocada, encima del control DETAL:Precio en la banda Detail.

15. Escriba Precio Unitario en el campo Text de la caja de herramientas Property, y oprima
TAB.

16. Elija Controls > String, o “pique” sobre la herramienta String de la caja de herramientas
Controls.

17.Dé cLic dentro de la banda Group Header (PED:NumPedido), a la derecha de la Gltima
cadena de caracteres ubicada, directamente encima del control IltemTotal en la banda Detail.

18. Escriba Total Item en el campo Text de la caja de herramientas Property, y oprima TAB.

Colocacién de unalinea gruesa bajo los encabezamientos

1. Elija Controls > Line, o pique sobre la herramienta Line de la caja de herramientas
Controls.

2. Dé cLic dentro de la banda Group Header (PED:NumPedido), bajo la cadena Cantidad.

3. Ajuste la linea  ARRASTRANDO las asas hasta que se aparezca a lo ancho de todos los
encabezados de columna.

4. Dé cLIc DERECHO y elija PROPERTIES del menu contextual.

5. Escriba 50 en el campo de ancho de linea (Line Width).
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6.

Asi se engrosa la linea.
Oprima el botén OK para cerrar la caja de dialogo Line Properties.

El informe deberia verse ahora aproximadamente asi:

£ Report Formatter (O] =]
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Relleno de la banda de pie de grupo

Colocaciéon del texto constante y del campo de total

1.

Elija Controls > String, o "pique" sobre la herramienta String de la caja de herramientas
Controls.

Dé cLic dentro de la banda Group Footer (PED: NumPedido), en el medio de la banda.

Escriba Total del Pedido: en el campo Text de la caja de herramientas Property, y oprima
TAB.

Elija Controls > String, o "pique" sobre la herramienta String de la caja de herramientas
Controls.

Dé cLic dentro de la banda Group Footer (PED:NumPedido), a la derecha de la cadena
que acaba de colocar.

Dé cLic DERECHO Y elija Properties del menu contextual.

Marque el casillero Variable String.
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8. Oprima el botén de puntos suspensivos (...) del campo Use.

9. Destaque LOCAL DATA InformePedidos en la lista Files, elija ItemTotal del campo Fields,
y oprima el botén Select.

10. Escriba @n9.2 en el campo de formato de visualizacion (Picture). Esto dara formato "en
espafiol” al total: con puntos en las separaciones de miles, y una coma como separador
decimal.

11. Elija Sum de la lista desplegable Total Type.
12. Elija PED:NumPedidoBreak de la lista desplegable Reset On.

String Properties

General |E>:t@ Ignlur |Eusiti0n I gctionsl

Ficture: I =nd.2

Usge IItemTotaI

B
o

Justification: IDefauIl vI Offzat: I Da:
I—

[ “ariable String

Total twpe: Sum - zing:

Reszet on: IF'ED:NumF'edidoBr vI

tade
[ Hide [T Disable [ Skip W Transparant
[ Freeze

Font... |

Cancel Help

13. Oprima el boton OK.

Asi se sumaran todos los contenidos del ItemTotal del pedido, y volverd a cero cuando
cambie el valor en PED:NumPedido.

Colocacién de una linea sobre el total

1. Elija Controls > Line, o pique sobre la herramienta Line de la caja de herramientas
Controls.

2. Dé cLic dentro de la banda Group Footer (PED:NumPedido), sobre los controles que
acaba de colocar.

3. Ajuste la linea ARRASTRANDO las asas hasta que aparezca a lo ancho de todos los controles.
4. Dé cLic DERECHO Y elija Properties del men( contextual.
5. Escriba 20 en el campo de ancho de linea (Line Width).

Asi se engrosa un poco la linea.

6. Oprima el boton OK para cerrar la caja de dialogo Line Properties.
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£ Report Formatter (O] =]
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Llenado de la banda de pie de grupo “Clientes”

Colocacién del texto constante.

1. Elija Controls > String, o "pique" sobre las herramientas String de la caja de
herramientas Controls.

2. Dé cLic dentro de la banda Group Footer (CLI:NumCliente), a mitad de la banda.

3. Escriba Resumen de Pedidos para: en el campo Text de la caja de herramientas
PropertyBox.

4. Elija Controls » String, o "pique" sobre la herramienta String de la caja de herramientas
Controls.

5. Dé cLic dentro de la banda Group Footer (CLI:NumCliente), debajo del texto que acaba
de colocar.

6. Escriba Total Notas de Pedido: en el campo Text de la caja de herramientas PropertyBox,
y oprima TAB.

Colocacién de los campos de total

1. Elija Controls > String, o "pique" sobre la herramienta String de la caja de herramientas
Controls.

2. Dé cLic dentro de la banda Group Footer (CLI:NumCliente), a la derecha del texto que
acaba de colocar.
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Dé cLIc DERECHO Y elija Properties del menu contextual.

Marque la casilla Variable String.

Oprima el botén de puntos suspensivos (...) del campo Use.

Destaque LOCAL DATA InformePedidos en la lista de Files, y oprima el botéon New.

~ o oA w

Escriba ContadorPedidos en el campo Name.

Este campo imprimira el ndmero de pedidos impresos para cada cliente.

o

Elija LONG de la lista desplegable Data Type.
9. Escriba @N3 en el campo Picture, y oprima el botén OK.

General |Aﬂributes| Coaniments I Dgtionsl Help I Walidity Checks I window I Beportl
Field Marme: | ContadarPedidos

Denved From: | J&I
Description: |

Data Type: ILDNG ;l Prefis: I— [ Reference
Base Type: | J

Characters: IW Places: Iﬂ

Dimenzions: | || = 0| 0=

Fecord Picture: |

Seieen Picture:  [@n3

Prarmpt T ext: | Contadar Pedidos:

Column Heading: | Cantadar Pedidos
[T Fieeze

10. Seleccione Count (contar) de la lista desplegable Total type.
11. Selecciones CLI:NumClienteBreak de la lista desplegable Reset On.

Este es el mismo tipo de campo totalizador que colocamos en el pie del grupo
PED:NumPedido, pero solamente se restaurara cuando cambie CLI:NumCliente.

12. Seleccione la lengiieta Extra.
13. Destaque PED:NumPedidoBreak de la lista de marcadores (Tallies), y oprima el boton OK.

Este campo totalizador contara el nimero de pedidos que se imprimen de cada cliente. La
lista de marcadores (Tallies) le permite seleccionar los puntos en que se incrementa el total.
Seleccionado PED:NumPedidoBreak de la lista, la cuenta solo se incrementara al comenzar
cada nuevo pedido.

14.Elija Controls » String, o "pique" sobre la herramienta String de la caja de herramientas
Controls.

15. Dé cLic dentro de la banda Group Footer (CLI:NumCliente), a la derecha de la cadena
de caracteres que acaba de colocar.
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16. Dé cLIc DERECHO Y elija Properties del menu contextual.
17. Marque el casillero Variable String.
18. Oprima el boton de puntos suspensivos (...) del campo Use.

19. Destaque LOCAL DATA InformePedidos en la lista Files, y elija ItemTotal en la lista
Fields y oprima el botén Select.

20. Elija Sum de la lista desplegable Total Type.
21. Seleccione CLI:NumClienteBreak de la lista desplegable Reset On.

Este es el mismo tipo de campo totalizador que ubicamos en el pie de grupo
PED:NumPedido, pero solamente se restaurara cuando cambie el nimero CLI:NumCliente.

22.Oprima el botén OK.
Colocacién del campo v salida

1. Elija Populate » Multiple Fields, o dé cLic sobre la herramienta Dictionary Field en la
caja de herramientas Controls.

2. Destaque Clientes en la lista Files y seleccione CLI:Empresa en la lista Fields y oprima el
boton Select.

3. Dé cLic dentro de la banda Group Footer (CLI: NumCliente), a la derecha del texto
Resumen de Pedidos para: que se ha colocado.

4. Oprima el botén Cancel para salir de este modo de operacion.

El disefio del informe esta completo.
4 Report Formatter [_ O] ]

Exitl Edit Contiolz  Alignment Bands “iew Populate Option  Preview!

¢ x & al==a s

Page Header
Break [CLI:NumCliente]
Break [PED:NumPedido]
Group Header[PED:NumPedido]
CERERRFRFEREREREREEE ¢
FISFSEEITEETEEEEEEE
FHEEEEEIPEEEIEEEEEEE
FEFEIFFEFFEFFEEFEEEE ¢

FEITIITEIERITTIIIIREIRIET . copan

Page Footer

Property

JJIext: [ User | Font: | [x] Size: | x] BFu - |

[ [ [ Logical view [1/1000 Inches

5. Elija Exit! para volver a la caja de didlogo Procedure Properties (asegurese de guardar el
disefio).
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Adicidn de una féormula

Para hacer que el campo ItemTotal contenga el monto adecuado de cada registro de Detalle del
pedido, debe afiadir una férmula al procedimiento.

1. Oprima el boton Formulas en la caja de dialogo Procedure Properties.
2. Oprima el boton New en la caja de didlogo Formulas.

Aparece el Editor de Formulas.
3. Escriba Item Total Formula (u otra expresion similar) en el campo Name.
4. Oprima el botén de puntos suspensivo (...) en el campo Class.

5. Destaque Before Print Detail (“Antes de imprimir el detalle”) en la lista Template
Classes.

La clase Before Print Detail le indica a la plantilla de Informe que realice el calculo cada vez
que esta por imprimir un Detalle.

6. Oprima el botdn de puntos suspensivos (...) en el campo Result.

7. Destaque LOCAL DATA InformePedidos en la lista Files, seleccione ItemTotal de la lista
Fields, y oprima el boton Select.

8. Oprima el botén Data en el grupo Operands.

9. Destaque el archivo Detalle en la lista Files, seleccione DETAL:Cantidad de lista Fields, y
oprima el botén Select.

Esto coloca el campo seleccionado dentro de Statement. Este Gltimo contiene la expresién
que se esta construyendo. También es posible escribir directamente dentro de este campo, si
se desea.

10. Oprima el boton * en el grupo Operators.
11. Oprima el boton Data en el grupo Operands.

12. Destaque el archivo Detalle en el listado Files, seleccione DETAL:ProdPrecio de lista
Fields, y oprima el boton Select.

13. Oprima el boton Check para verificar la sintaxis de la expresion.
14. Oprima el boton OK para cerrar el Editor de Férmulas.

15. Oprima el botén OK para cerrar la caja de didlogo Formulas vy volver a Procedure
Properties.

Adicion de un filtro de registros

Para asegurarnos que el informe solamente imprime Notas de Pedido para las empresas que
tienen pedidos, incluiremos un filtro de registros(record filter).

1. Oprima el botén Report Properties en la caja de didlogo Procedure Properties.

Aparece la caja de didlogo Report Properties.



2. Escriba PED:NumPedido <> 0 en el campo Record Filter.

Report Properties

Help

General |Bange Limits I Preview Dplionsz w]
v Cancel |

v Quick-5can Records
Becord Filter: |F‘ED:NurnF'edido <x 0 |

Additional Sort Fields |

Record Count Dwerride: | 1]

Progrezs Bar Linit
[~ Set progress bar limits manually?

Low Progress Bar Limit: |

High Progress Bar Limit: |

Esto eliminara a todos los clientes que no hayan hecho pedidos. Internamente, el Report
Template genera una estructura VIEW (véase la Language Reference). Esta estructura VIEW
realiza un “Join externo” de los archivos del arbol de archivos. “Join externo” (outer join) es
una expresion comdn en la teoria de bases de datos relacionales: significa que la VIEW
invocara todos los registros del archivo Padre, sea que hayan registros Hijos vinculados o no.
Si encuentra un registro Padre sin Hijo, los campos de éste Gltimo se consideran en blanco o
“cer0”, aunque hay datos validos en el archivo Padre. Por lo tanto, esta es la condicion que
verificaremos.

La expresion PED:NumPedido <> 0 verifica si el campo del mismo nombre tiene un valor
distinto a cero. Dado que éste es el campo clave del archivo de Pedidos que crea el vinculo al
registro relacionado de Clientes, debe contener un valor, si existen Pedidos para el Cliente
actual. Si PED:NumPedido esté en cero, el actual registro de Cliente se saltea (es “filtrado”).
Esto elimina la impresion de registros Padre sin Hijos vinculados (en este caso, Clientes sin
Pedidos).

Nota: si tiene dificultad para poner los sighos <y > (ALT+60 y ALT+62), puede
utilizar la expresién equivalente “NOT =". Quedaria asi:
PED:NumPedido NOT = 0.

3. Oprima el botén OK.

Cambio de la Ventana indicadora

1. Oprima el botén Window en la caja de didlogo Procedure Properties.
2. Escriba Cargando los pedido... en el campo Text de la caja de herramientas Property.

3. Elija Exit! para regresar a la caja de didlogo Procedure Properties.

Salida y guardado

1. Oprima el botén OK en la caja de didlogo Procedure Properties para cerrarla.

2. Elija File > Save, u oprima el botén Guardar en la caja de herramientas.



Informe de alcance limitado
(Range Limited Report)

Ahora, limitaremos el alcance de los registros para imprimir.

Creacion del informe

1.
2.

Destaque el informe InformePedidos.
Copiaremos el procedimiento: Elija Procedure » Copy...
Aparece la caja de didlogo New Procedure.
Escriba InformePedidosCliente y oprima el boton OK.

El procedimiento copiado aparece en el arbol de la aplicacién, reemplazando el
procedimiento “por hacer” (“ToDo”) que estaba en su lugar.

Modificacién del nuevo informe

© © N o

1. Destaque el procedimiento InformePedidosCliente.

2. Dé cLic DERECHO Y elija Properties del mend contextual.
3.
4

. Presione el botén Contract All.

Oprima el botén Embeds.

Esto hara mas facil localizar el punto embebido deseado.
Ubique la carpeta Local Objects, y dé cLIc en el signo + para expandir su contenido.

Los templates ABC generan codigo orientado a objetos. Cada procedimiento instancia un
conjunto de objetos que son derivados de la Biblioteca ABC. La carpeta de Objetos Locales
(Local Objects) muestra todos los objetos y métodos que pueden ser sobre-escritos en el
procedimiento, simplemente embebiendo cddigo propio, para incrementar la funcionalidad de
la Biblioteca ABC, Para mayor informacion sobre esta poderosa técnica, vea los articulos
Easy into OOP y Object Oriented Programming en el manual Programer’s Guide.

Ubique la carpeta ThisWindow, dé cLIc para expandirla.

Ubique la carpeta Init PROCEDURE(),BYTE,VIRTUAL, y dé cLic para expandirla.
Ubique la carpeta CODE, y de cLIc para expandirla.

[lumine Open Files y oprima el botén Insert.

Este punto embebido esta al principio del procedimiento, antes que el informe haya
comenzado a procesar la informacion. Es importante que los archivos para el informe estén
ya abiertos porque llamaremos otro procedimiento para que el usuario seleccione un registro
de Clientes. Si los archivos del informe no estuvieran ya abiertos, el procedimiento que
Ilamamos abriria el archivo Clientes para su propio uso, y luego lo cerraria, con lo que
perderiamos la informacién que necesitamos para el informe. Esto tiene que ver con los
multiples hilos de ejecucion y la Interfaz de Mltiples Documentos (MDI); para mas datos,
consulte THREAD en Language Reference.

10. Destaque Source (“Fuente™) y oprima el botén Select para llamar al Editor de Texto.



11. Escriba el siguiente cadigo:
Global Request = SelectRecord

Este cdédigo configura un procedimiento Browse para elegir un registro (habilita el botdn
Select del procedimiento Browse).

12.Elija EXIT! para volver a la caja de didlogo Embedded Source.

13. Destaque el cédigo fuente (SOURCE) que acaba de escribir y oprima el botén Insert.
14. Destaque Call a procedure y oprima el boton Select.

15. Elija VerClientes de la Lista desplegable y oprima el botén OK.

Asi se generard una llamada al procedimiento VerClientes (browse) para permitir que el
usuario seleccione el Cliente cuyos pedidos va a imprimir

% Embedded Source =]
Exit Edit Miew Mavigate
BNy A= G E e |
| Inzert |
rit PROCEDURE[EYTE WIRTUAL - Epaies
" & ot
L. # CooE Delete |
-~ [E] Enter procedure scope Priority———
-~ [E] Snap-shot GlobalR equest '_i'l ?l
-] Parent Call e
- [E] Set options from global values b = —
] Setup Toolbar Object
£ Initialize the procedure Source |
-« [E] Procedure setup standard formulas
- [E] Open Files Close |
-] SOURCE [GlobalR equest = SelectRecard)
BNEE FROCEDURE YerClientes Help
= _|;|
4 »

Adviértase que aparecen ahora dos entradas bajo el punto de insercion. En cada punto, puede
poner tantos items como desee, mezclando plantillas de cddigo (Code Templates) con sus
propias llamadas al coédigo fuente (SOURCE) o a procedimientos (PROCEDURE).
También puede mover los items individuales en torno al punto de insercién, cambiando el
orden légico de la ejecucion (el que se ve primero es el primero en ejecutarse). Tenga en
cuenta que moverlos cambiara la opcién de Prioridad (Priority) asignada al item movido si
intenta mover un item de més alta prioridad frente a otro con una prioridad menor.

16. Oprima el boton Close para regresar a la caja de didlogo Procedure Properties.

Configuraciéon del limite de alcance

1. Oprima el boton Report Properties.

Aparece la caja de didlogo Report Properties. Esta caja le permite configurar filtros de
registros o limites de alcance (ademas de los Hot Fields y filtros de detalle): véase la User’s
Guide.

Los filtros de registros (record filters) y los limites de alcance o de bisqueda (range limites)
son muy similares. Un filtro de registros es una expresién condicional para eliminar registros
indeseados del informe, mientras que un limite de alcance limita los registros impresos a
solamente aquellos que coinciden en sus claves. Ambos pueden usarse para crear informes
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sobre un subconjunto de los archivos. La diferencia es que el limite de alcance opera sobre
una clave, mientras que los filtros, no. Asi, éstos Gltimos son muy flexibles; y los limites de
alcance, muy rapidos. Se pueden usar simultdneamente, seleccionando un limite de alcance y
luego filtrando los registros innecesarios dentro de ese limite.

Seleccione la lengiieta Range Limits.
Oprima el botén de puntos suspensivos (...) de Range Limit Field.

Destaque CLI: NumCliente, y oprima el botén Select.

g &~ w Db

Deje el Range Limit Type (tipo de limite de alcance) como “valor actual” (Current Value),
y oprima el botén OK.

Esto indica que cualquier valor (Current Value) presente en el campo al iniciarse el informe,
sera su limite de alcance. Dado que el usuario elegird un registro de Clientes en el
procedimiento VerClientes, el valor correcto estara en el campo CLI:NumCliente al
comenzar.

Salir y Guardar

1. Oprima el boton OK en la caja de didlogo Procedure Properties para cerrarlo.

2. Elija File » Save, u oprima el botén Guardar en la barra de herramientas para grabar su
trabajo.

Informe Pedido Individual

A continuacion, imprimiremos un pedido individual elegido desde la lisa de visualizacion
(browse) de pedidos.

Creacion del informe

1. Destaque el procedimiento InformePedidosCliente.
2. ElijaProcedure » Copy...
Aparece la caja de didlogo New Procedure.
3. Escriba InformeUnPedido en la caja de ingreso de datos, y oprima el botén OK.
4. Oprima el botén Same (el mismo nombre) en la caja de didlogo Procedure Name clash.

El procedimiento copiado aparece en el arbol de aplicaciones, aislado. Al terminar el
informe, “conectaremos las lineas”.

Borrado del cédigo insertado

. Destaque el procedimiento InformeUnPedido.
. Dé cLic DERECHO Y elija Properties del men contextual.

. Oprima el botén Embeds.

1
2
3
4. Oprima el botén Next Filled (en el extremo derecho de la barra de herramientas).
5. Presione el bot6n Delete.

6

. Responda Yes ( 0 “Si”) a la pregunta sobre si esta seguro (Are you sure?)
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7. Presione nuevamente Delete y responda Yes (0 “Si”) a la pregunta sobre si esta seguro.

8. Oprima el botén Close.

Cambio del arbol de archivos

En primer lugar, necesitamos cambiar el orden del arbol de archivos. Terminaremos con los
mismos archivos, pero en lugar del archivo Clientes como archivo Primario (el primero del
arbol), necesitamos que el archivo Pedidos sea el archivo Primario para este procedimiento, para
poder limitar facilmente el alcance a un Unico pedido.

1. Oprima el botén Files.
2. Destaque el archivo Clientes, y oprima el boton Delete.
Esto hace que todos los archivos desaparezcan.
3. llumine la carpeta “ToDo”, y oprima el botén Insert.
4. Seleccione el archivo Pedidos de la caja de dialogo Insert File, y oprima el botén Select.
5. Oprima el bot6n Edit.

6. llumine KeyNumPedido en la caja de didlogo Change Access Key, y oprima el boton
Select.

7. Destaque el archivo Pedidos, y oprima el boton Insert.

8. Seleccione el archivo Detalle de la caja de didlogo Insert File, y oprima el botén Select.

9. Destaque el archivo Detalle, y oprima el boton Insert.

10. Seleccione el archivo Productos de la caja de didlogo Insert File, y oprima el botén Select.
11. llumine de nuevo el archivo Pedido, y oprima el botén Insert.

12. Seleccione el archivo Clientes de la caja de didlogo Insert File, y oprima el botén Select.
En este punto, el arbol de archivos deberia verse asi:

=-[C3 File Schematic
= D Report Procedurs
=1-[Z3 Pedidos - PED:K.epNumPedido

B Clienies
2.3 Detalle
E Productoz
-] OTHER FILES
(] GLOBAL DATA
-] MODULE DATA, tutuoll 2. clw
[ LOCAL DATA InformelnPedida

AN 2
Inzert I Edit | Delete |
ak. | e | Cancel | Help |

Hemos seleccionado los mismos archivos, pero ahora el archivo primario es Pedidos, y se
hara una consulta al registro vinculado de Clientes. Esto es importante, porque debemos
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limitar este informe a un Unico pedido y eso seria mucho mas dificil de hacer si el archivo
primario fuese Clientes.

13. Oprima el boton OK.
Configuraciéon del limite de alcance

1. Oprima el boton Report Properties.

2. Seleccione la lengieta Range Limits.

3. Oprima el botén de puntos suspensivos (...) junto a Range Limit Field.

4. Destaque PED: NumPedido y oprima el botén Select.

5. Deje “Valor Actual” (Current value) como Range Limit Type y oprima el botén OK.

Current Value indica que el valor que esté en este campo cuando empieza el informe es el
valor al que este se limitard. Dado que el usuario lo ejecutard desde el procedimiento
VerPedido, el valor correcto estard en el campo PED:NumPedido cuando empieza ¢l
informe.

Modificacién del nuevo informe

Ahora tenemos que cambiar el informe mismo, para que imprima un Unico pedido.
1. Oprima el boton Report.

2. Dé cLic perecHo sobre la banda Break(CLI:NumCliente) y elija Delete del menu
contextual.

# Report Formatter M= &3

Exitl Edit Controls Alignment Bands “iew Populate Option  Preview!

|l % & ax=3 i a

Page Header

Break [PED:NumPedido]

Hlext. [ User | Font: | =] Size: | Izl Bru |~ |

[ | Break [CLI:NumCliente] | Logical view [1/1000 Inches

Esto quita no solamente el salto de grupo(Group Break), sino también el Pie de Grupo
correspondiente, lo que nos deja con un informe parecido a éste:
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3. Elija Exit! para regresar a la caja de dialogo Procedure Properties.

Salida y gquardado del trabajo

1. Oprima el boton OK en la caja de didlogo Procedure Properties para cerrarla.

2. Elija File > Save, u oprima el boton Guardar de la barra de herramientas para guardar su
trabajo.

Conectando las lineas

1. Destaque el procedimiento VerPedidos.
2. Dé cLic DERECHO Y elija Window del mend contextual.

3. Elija Populate » Control Template, o de cLic sobre la herramienta Control Template de
la caja de herramientas Control (en el extremo inferior izquierdo).

Ilumine BrowsePrintButton y presione el botén Select.

llumine BrowsePedidos y presione el boton Select.

. Dé cLic bERECHO sobre el nuevo botdn y escoja Properties del mend contextual.

4
5
6. Dé cLic a la derecha del botén Delete para ubicar el nuevo botén control.
7
8. Escriba Imprime &Pedido en el campo Field.

9

. Escriba ?ImprimePedido en el campo Use.
10.Elija la lengiieta Actions.
11. Seleccione InformeUnPedido de la lista desplegable Print Button.

Este Control Template esta especificamente disefiado para llamar a un reporte de alcance
limitado segun el registro iluminado en la caja de listado seleccionada (Browse on Pedidos).
El buffer del registro del archivo Pedidos contendra el valor correcto para que funcione el
alcance limitado al Current Value en el informe para un pedido. Ademas, la accién queda
automaticamente afiadida al men( contextual del Browse.

12. Oprima el boton OK. El disefio de la pantalla debera verse aproximadamente asi:
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Ezit! Edit Control Alignment Menu Toolbar Populate Wiew Preview!
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13. Elija Exit! para volver al Arbol de la Aplicacion.

14.Elija File » Save, u oprima el botdn Guardar de la barra de herramientas para guardar su
trabajo.

¢, Qué sigue?

Felicitaciones, usted ha llegado al final del cursillo sobre el Generador de Aplicaciones.
iBienvenido o bienvenida a la creciente comunidad de desarrolladores Clarion!.

Aunque la aplicacion que hemos realizado no tiene la amplitud de un "programa comercial", ha
servido para demostrar el proceso normal de usar el Generador de Aplicaciones y todas sus
herramientas para crear una aplicacién que realiza algunas tareas bastante elaboradas. En el
camino, usted ha usado la mayor parte del conjunto de herramientas de alto nivel de Clarion, y
ha visto cuanto puede éste hacer por usted, sin necesidad de escribir cédigo. También ha visto
como un poquito de cédigo fuente insertado puede afiadir funcionalidad extra al codigo generado
por los templates, y qué facilmente pueden pasarse por alto las clases preconfiguradas de la
biblioteca ABC.

Una breve recorrida por los recursos a su disposicion

Usted tiene muchos recursos a mano para ayudarle a programar con Clarion. He aqui una breve
recorrida por dos de los mas importantes de que se dispone:

1. ElijaHelp » Contents.
Esta es la pagina de Contenidos del extenso sistema de ayuda en linea.
2. Oprima el botén How do I ...?(" ;C6mo hago para ... ?).

Esto abre el archivo de ayuda de Clarion, y lo lleva a una seccion de preguntas comunes, con
sus respuestas. Esta lista de temas es el primer lugar donde buscar cuando usted se haga
cualquier pregunta sobre la programacion en Clarion, que comienza con " ;Cémo hago
para...?". Estos temas resuelven muchas de las preguntas comunes que tienen los recién
Ilegados a Clarion. A menudo, las respuestas las encontrara alli.

3. Oprima el botén Back, y luego el boton Guide to Examples.

Este tema ofrece saltos hipertextuales al tratamiento de todos los programas de ejemplo que
vienen con Clarion. Alli encontrard variadas sugerencias, trucos, y técnicas demostradas en
los ejemplos, para adaptarlos a sus propios programas.

4. Oprima el boton Back, y luego el boton Late Breaking News.

Este tema le ofrece la informacién mas reciente y actualizada sobre la versién de Clarion
mas reciente que haya instalado. Siempre debe consultar esta seccion cuando haya una
actualizacion del programa. Hay generalmente detalles de Gltimo minuto que se documentan
solamente en esta seccion. Esto hace muy recomendable la lectura.

5. Cierre la ayuda en linea y, sin salir del programa, active el administrador de archivos del
sistema operativo(el Explorador de Window 95,98,0 NT).

6. Ponga el CD de Clarion en el dispositivo de CD, y navegue hasta el subdirectorio \DOCS.

7. Dé poBLE cLic sobre el archivo C5-UG.PDF (tiene que haber instalado Acrobat Reader del
CD Clarion para leer este archivo).



Esto llamara a la User’s Guide en el Acrobat Reader. Este es el libro integro, en linea, y
disponible desde el CD ( o disco rigido,si lo copia alli ). Esto significa que por el tamafio y el
peso de un CD puede tener disponible toda la documentacion de Clarion en cualquier parte (
Aprovechando las bisquedas de texto de Acrobat). Advierta que a la izquierda hay un grupo
de "saltos" disponibles desde la Tabla de Contenidos. También puede ir directamente a
cualquier pagina individual que elija (y ahora le ensefiaremos cémo).

Oprima el control VCR de "fin de documento”(el triangulo que apunta a la derecha con una
linea vertical en el extremo), y oprima un par de veces el botén de control de "pagina
previa“(se ve como un tridngulo que apunta a al izquierda).

Ahora esta mirando a la posicion del Indice de la User’s Guide.

Seleccione la herramienta “zoom in" (una lupa con signo +), y dé cLIc en cualquier parte de
la pagina (si el cursor cambia a un "dedo apuntando™ entonces ira directamente al item al
que apunta, en lugar de hacer un acercamiento).

Puede hacer "zoom in" a cualquier texto que elija utilizando esta herramienta. Anote el
nimero de pagina de cualquier item que desee.

10. Dé cTRL+CLIC para volver a la vista anterior.

11.Oprima el crRTL+5 para ir a la caja de didlogo Go To Page, ingrese el ndmero de pagina

que anotd, y oprima el boton OK.

Ahora puede ver lo facil que es ir a cualquier lugar que desee.

12. Cierre el archivo y salga de Acrobat Reader.

¢;Doénde aprender mas?

¢, A donde deberia ir desde aqui para aprender mas? Los mejores lugares (aparte de crear una
aplicacion propia) son:

*

El Application HandBook explica los Clarion ABC Templates y la biblioteca ABC; todas las
herramientas que le ofrece el Generador de Aplicaciones.

El Cursillo sobre el Lenguaje Clarion en el capitulo siguiente es el mejor lugar para empezar
a aprender el lenguaje.

Los usuarios registrados de la Argentina y otros paises de habla hispana tienen acceso a
apoyo técnico via Internet en la direccion http://www.unisoft.com.ar (o, también,
www.clarion.com.ar. Correo electronico: soporte@unisoft.com.ar) mediante Servicios de
Newsgroup y FTP. Un equipo de experimentados técnicos locales (CST: Clarion Support
Team Argentina) respondera a sus dudas. Pueden también dirigirse al fax: (+541) 374-9469.

TopSpeed ofrece seminarios educativos en varias localidades. Llame a Servicio al Cliente a
los ndmeros (800)354-5444 o (954)785-4555 para informarse.

En CompuServe escriba GO TOPSPEED para ingresar al foro de apoyo técnico de
TopSpeed, o - En Internet, ingrese al grupo de noticias comp.lang.clarion, mediante
cualquier servidor de Usenet (j Muy recomendado!).

Muy buena suerte, y continte trabajando: jel poder de programacion que Clarion pone en sus
manos va creciendo a medida que aprende mas sobre él!
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)y - CURSILLO SOBRE LENGUAJE CLARION

Clarion como lenguaje de programacion

La base del entorno de desarrollo de aplicaciones Clarion es el lenguaje de progamacion Clarion.
Se trata de un lenguaje de cuarta generacién /4GL) que se orienta a aplicaciones empresariales y a
propositos generales. La primera orientacion significa que contiene estructuras de datos y érdenes
altamente optimizadas para la programacion y el mantenimiento de bases de datos. También es de
proposito general porque es un lenguaje compilado (no interpretado) y tiene un conjunto de
ordenes funcionalmente similar a otros lenguajes de tercera generacion (tales como c/c++,
Modula-2, Pascal, etc.). Tratamos mas ampliamente esta distincién en las primeras paginas de la
Lenguage Reference.

A esta altura, usted debe de haber terminado todos los cursillos sobre el Generador de
Aplicaciones en los capitulos precedentes. El prop6sito del presente cursillo es presentarle los
aspectos fundamentales del lenguaje Clarion, particularmente en su orientacion a la programacion
empresarial utilizando el paradigma de manejo de eventos propios de Windows. Las palabras
claves (language keywords) del lenguaje se muestran EN MAYUSCULAS, y este cursillo se
concentra en el uso de cada palabra clave y su interaccion con otros elementos del lenguaje
solamente en el contexto especifico en la que se esta utilizando. Debe consultarse siempre la
Lenguage Reference para una explicacion mas completa de cada palabra clave individual y sus
capacidades.

Cuando complete este breve cursillo, se habra familiarizado con:
¢ La estructura basica de un programa Clarion.
¢ La estructura de codigo mas comdn para el manejo de eventos.

¢ Coémo compilar y linkear programas escritos a mano.

Programacién en base a eventos

Los programas de Windows se manejan mediante eventos. El usuario causa un evento dando un
CLIC con el mouse sobre un control de la pantalla, u oprimiendo una tecla. Cada accién del
usuario hace que Windows envie un mensaje (o evento) al programa propietario de la ventana,
indicandole lo que ha hecho el usuario.



Una vez que Windows ha enviado el mensaje que indica un evento, el programa tiene la
oportunidad de manejarlo de modo apropiado. Esto significa que el paradigma de programacion de
Windows es exactamente lo opuesto a lo que ocurre en DOS. En Windows el sistema operativo le
dice al programa lo que el usuario ha hecho, en lugar de que el programa le indique al sistema
operativo lo qué debe hacer.

Este es el concepto mas importante de la programacion en Windows: que el usuario esta siempre al
control (o deberia estarlo). Por lo tanto, estos programas son reactivos, mas que proactivos;
siempre tratan con lo que el operador ha hecho, en lugar de indicarle qué hacer después. El
ejemplo mas comuln de esto es la caja de dialogo de ingreso de datos. En la mayor parte de los
programas DOS el usuario debe seguir un camino de campo en campo para ingresar datos.
Siempre deben ingresar datos en un campo antes de seguir al préximo. Esto hace que la validacion
de datos sea simple: basta con ejecutarla apenas el usuario ha dejado el campo.

En los programas Windows el operador puede utilizar el mouse o un atajo de teclado para ir de un
control a otro, en cualquier momento, sin seguir un orden determinado, y omitiendo pasar por los
controles que le parezca. Por lo tanto, se debe ejecutar dos veces la validacion de los ingresos de
datos, para estar seguros de que se ejecuta al menos de una vez: cuando el usuario acaba de
ingresar datos a un control, y nuevamente cuando oprime OK para salir de la caja de didlogo. Si no
se ejecutara entonces, podrian omitirse datos importantes. Esto hace que los programas Windows
sean reactivos, antes que proactivos.

Hola Windows

Tradicionalmente, todos los cursillos sobre un lenguaje de programacion empiezan por la creacion
de un programa tipo: “Hola, mundo”, y éste también.

Punto inicial:
El entorno Clarion debe estar abierto, y la aplicacion
TUTORIAL.APP, cerrada.

Creacion del archivo fuente

1. Mediante la herramienta apropiada de su sistema operativo (Administrador de Archivos,
Explorador, etc.), cree un nuevo directorio llamado Language bajo el subdirectorio Clarion5.
(En Windows 95, puede oprimir TECLA-DE-VENTANA+E para acceder al Explorador).

2. Regrese a Clarion
3. ElijaFile » New » Source.

Aparece la caja de dialogo New. Es una caja de dialogo Windows estandar Open File, que le
permite cambiar el directorio y escribir el nombre del archivo.
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New I

Guardar en: I 3 Languaje

Meombre de archivo: |HOIa

Guardar como tipo: |I:Iarion source [*.chy, inc.” tm) j Cancelar |

4. Seleccione el directorio \CLARIONS\LANGUAGE.
5. Escriba Hola en el campo File Name.

6. Oprima el botdn Save.

Esto crea un archivo HOLA.CLW vacio (.CLW es la extension estandar para los archivos de
cédigo fuente), y abre el Editor de texto.

Creacion del archivo de Proyecto

1. ElijaProject » New.

Aparece la nueva caja de dialogo New Project. Cuando se codifica completamente a mano,
también se necesita un archivo de proyecto (HOLA.PRJ) que controle el proceso de
compilacién y linkeado.

2. Elija el bot6n de radio de proyecto escrito a mano (Hand Coded Project).

Mew Project BE

~Use
' Quick Start
" Application Generator Cemeel
%' Hand Coded Project

wiarking Directomny

I C:hclarion5\Languaje

s

Help

3. Escriba C:\CLARIONS\LANGUAGE en la casilla del directorio de trabajo (Working
Directory) u oprima el botén de puntos suspensivos para elegir el directorio en la caja de
dialogo Change Working Directory.

Cuando se escribe un programa a mano, el directorio que contiene el archivo de proyecto(.PRJ)
se convierte en el directorio de trabajo del proyecto. Cuando se selecciona, Clarion cambia
automaticamente a ese directorio.

4. Oprima el botén OK.

Aparece la caja de didlogo New Project File.



5. Escriba Hola Windows en la caja Project Title, y oprima TAB.
6. Escriba HOLA.CLW en la caja Main File, y oprima TAB.

Una vez que haya nombrado el moédulo fuente principal del proyecto, el resto de los controles
se llenan automéaticamente con los valores preconfigurados.

Erofect THE: [Hols ‘windows L
Main file: IHc-Ia.ch = Cancel |
Target file: IHD|E|.E:-:E - Help |
Project File: I Hala.pri J

Target Type: IEHE vl

7. Oprima el botén OK.

Aparece la caja de didlogo Project Editor. Esto controla los médulos fuente que el compilador
incluye en el proyecto y las bibliotecas que se linkean para crear el programa ejecutable.
Cuando se escribe una aplicacion completa a mano, debe también actualizar el archivo de
Proyecto para incluir todos los mddulos de cédigo fuente, controladores de archivo, iconos y
bibliotecas externas que utiliza el programa. Vea el capitulo Using the Project System en la
User’s Guide para méas informacion sobre cdmo mantener el Proyecto.

ZZ C:ACLARIONSALanguaje\Hola. pri | [O] x|
Froject Tree
- OR

-2 Prajects ta include
-2 Application ican
-2 Generated source files
—1-[Z3 Esternal source files Bemove File
E Huola.clhw

-2 Database driver libraries

|2 Library, object, and resaurce files
—--[[3 Target file

“oF Hola.exe
[:| Programs o execute

Add File...

Edit

Cancel

Help

=
e

8. Oprima el botén OK.
El foco pertenece ahora al archivo HOLA.CLW
.Advierta que la barra de titulo del entorno de programacion dice ahora:

Clarion5 (HOLA.PRJ) — (C:\CLARION5S\LANGUAGE\HOLA.CLW). Esta linea siempre indica
el proyecto y el directorio de trabajo actuales. Es importante atender a esto cuando se codifica a
mano, porque el mero hecho de abrir un archivo fuente en el Editor de texto no cambia el
proyecto actual para el compilador.



Escriba el programa

1. Escriba el siguiente cadigo:

PROGRAM
MAP
END
MyWin WINDOW/((‘Hola Windows’), SYSTEM
END
CODE
OPEN(MyWin)
ACCEPT
END

Este codigo comienza con la sentencia PROGRAM. Esta debe ser la primera sentencia (que no
sea un comentario) en todo programa Clarion. Advierta que la palabra clave PROGRAM esta
sangrada con respecto a MyWin. En Clarion, las Gnicas sentencias que comienzan en la columna
uno (1) del codigo fuente son las sentencias-etiqueta. Por definicion, una etiqueta debe empezar en
la columna uno (1). La sentencia PROGRAM da comienzo con la seccidn de declaracion de datos
globales (Global).

Ahora tenemos una estructura MAP vacia. La sentencia END es una terminacion necesaria de la
estructura de datos MAP. Este tipo de estructura contiene los prototipos que definen tipos de datos
de parametros, tipos de datos de respuesta, y otras opciones que indican al compilador como debe
manejar las llamadas a procedimientos (tratamos todo esto mas adelante). Se necesita una
estructura MAP cuando se divide el codigo del programa en procedimientos (PROCEDURES). No
lo hemos hecho aun, pero igualmente necesitamos la seccidn ya que hay una sentencia OPEN en el
cadigo ejecutable.

Cuando el compilador procesa una estructura MAP, automaticamente incluye los prototipos en el
archivo \CLARIONS\LIBSRC\BUILTINS.CLW. Este archivo contiene prototipos de casi todos
los procedimientos incorporados del lenguaje Clarion (incluyendo la sentencia OPEN). Si la
estructura MAP vacia no se incluyera en el cédigo, el compilador generaria un error en la
sentencia OPEN.

MyWin es la etiqueta de la estructura de datos Window (la “M” debe estar sobre la columna 1).
En Clarion, las ventanas se declaran como estructuras de datos, y no se construyen dinamicamente
mediante sentencias de codigo ejecutable, como en otros lenguajes. Este es uno de los aspectos que
hacen de Clarion un lenguaje de cuarta generacion. Aunque Clarion puede construir cajas de
didlogo en forma dindmica durante la ejecucion, esto es innecesario. Usando una estructura de
datos, el compilador crea el recurso de Windows para cada dialogo, permitiendo mejor perfomance
al ejecutarse.

El pardmetro (‘Hola Windows’) sobre la sentencia WINDOW define la barra de texto del titulo
de la ventana. La sentencia SYSTEM afiade un sistema de menud estandar a la ventana. La
sentencia END es una terminacion requerida de la estructura de datos WINDOW. En Clarion,
todas las estructuras complejas (tanto codigo ejecutable como datos) deben terminar con un END o
con un punto (.). Esto significa que el cddigo que sigue es funcionalmente equivalente al anterior:



PROGRAM

MAP
END
MyWin WINDOW/((‘Hola Windows’), SYSTEM
END
CODE
OPEN(MyWin)
ACCEPT.

Aunque funcionalmente son equivalentes, este cddigo se vuelve mucho mas dificil de leer en
cuanto se afiade algo a las estructuras MAP, WINDOW, o ACCEPT. Convencionalmente,
utilizamos END para terminar esas sentencias complejas que abarcan varias lineas, colocando el
END en la misma columna que la palabra clave a la que esta dando terminacion, y sangrando todo
lo demas dentro de la estructura. Usamos el punto solamente para terminar estructuras de una sola
linea, como sentencias IF con una sola clausula THEN. Esta convencion hace que el codigo sea
mucho més facil de leer, y también que los “terminadores” faltantes sean mucho mas faciles de
ubicar.

La sentencia CODE se necesita para identificar el principio de la seccion de cddigo ejecutable.
Los datos (variables de memoria, archivos de datos, estructuras de ventana, informes, etc.) se
declaran en una seccion de datos (anterior a la sentencia CODE), y las sentencias ejecutables solo
pueden venir después de la sentencia CODE.

Dado que este programa no contiene ningin PROCEDURE (los trataremos mas adelante),
solamente tiene una seccion Global Data seguida por tres lineas de cddigo ejecutable. Las
variables declaradas en esta seccién son visibles y disponibles para su uso en cualquier parte del
programa.

La sentencia OPEN(MyWin) abre la ventana, pero no la muestra. La ventana solamente aparecera
en la pantalla cuando se ejecute una sentencia DISPLAY o ACCEPT. Esta caracteristica permite
cambiar dindmicamente las propiedades de la ventana, o cualquier control sobre ella, antes de que
aparezca en la pantalla.

ACCEPT es el procesador de eventos. La mayoria de los mensajes (eventos) provenientes de
Windows son manejados internamente por ACCEPT. Estos son los eventos comunes manejados
por la biblioteca de tiempo de ejecucidn (redibujo de la pantalla, etc.). Solamente aquellos eventos
que requieren accion del programa son pasados por ACCEPT al cédigo Clarion. Esto simplifica la
programacion, permitiendo que el programador se concentre solamente en los aspectos de alto
nivel.

La sentencia ACCEPT tiene una sentencia END como terminacion, lo que significa que es una
estructura de codigo compleja. ACCEPT es una estructura reentrante, o en lazo (loop), que “pasa a
través” de todos los eventos que el programador podria querer manejar (ninguno, en este caso;
aunque luego veremos algunos), y luego volviendo para manejar el evento siguiente.

Es necesario un lazo ACCEPT para cada ventana abierta en un programa Clarion. Una ventana
abierta “se pega” al siguiente lazo ACCEPT que encuentra en el cddigo, y lo toma como su
procesador de eventos.

Para este programa, ACCEPT maneja internamente todo lo que hace el mend del sistema (ubicado
en la ventana mediante el atributo SYSTEM). Por lo tanto, cuando el usuario utiliza el menu del
sistema para cerrar la ventana, ACCEPT pasa automaticamente el control a cualquier sentencia
que siga a su terminador END. Dado que no existe ninguna otra sentencia Clarion que ejecutar, el
programa termina. Cuando cualquier programa Clarion llega al fin del codigo ejecutable, se
gjecuta un RETURN implicito que, a su vez, vuelve al usuario al sistema operativo.



2. Dé cLIC sobre el boton Ejecutar (Run).

El programa se compila, linkea y ejecuta. La ventana del titulo muestra el mensaje “Hola
Windows”, y debe cerrar la ventana con el menu del sistema.

Hola Windows con controles

Este programa es el mas pequefio que puede crearse en Clarion. Ahora lo expandiremos un poquito
para demostrar como se afiaden algunos controles a la ventana y cdmo se manejan los eventos
generados por esos controles.

Cambio del cédigo fuente
1. Modifique el cédigo para que diga:

PROGRAM
MAP
END
MyWin WINDOW(‘Hola Windows’), AT(,,100,100),SYSTEM ICambiado
STRING(‘Hola Windows"),AT(26,23),USE(?String1) IAfadido
BUTTON('OK"),AT(34,60),USE(?0k),DEFAULT IAfadido
END
CODE
OPEN(MyWin)
ACCEPT
IF ACCEPTED() = 70k THEN BREAK. IAfadido
END

Nota: El Disefiador de Vantanas esta disponible en el Editor de Texto, igual
gue en el Generador de Aplicaciones. Para llamar al Disefiador de
Ventanas, coloque el punto de insercion (el cursor) en cualquier punto
dentro de la estructura WINDOW y oprima CTRL+F. Las Unicas
restricciones son que las herramientas Control Template y Dictionary
Field no estan disponibles (ya que son especificas del Generador de
Aplicaciones).

El cambio es la adicion de los controles STRING y BUTTON a la estructura WINDOW.
“STRING” coloca texto constante en la ventana, y BUTTON afiade un boton de 6rdenes.

La Gnica otra adicion es la sentencia IF ACCEPTED() = 7?0k THEN BREAK. Esta sentencia
detecta cuando el usuario ha presionado el boton OK y rompe (BREAK) el lazo ACCEPT,
terminando el programa. El procedimiento ACCEPTED devuelve el nimero de campo del control
para el cual acaba de generarse el evento EVENT:Accepted. (EVENT:Accepted es una
equivalencia 0 EQUATE, contenido en el archivo \CLARIONS\LIBSRC\EQUATES.CLW, que el
compilador incluye automéaticamente en todos los programas).

?0k es la equivalencia (Field Equate Label) del control BUTTON, definida por el atributo USE
del control (consulte Field Equate Labels en la Language Reference). El compilador



automaticamente iguala ?Ok al nimero de campo que asigna al control (el uso de las equivalencias
facilita la lectura del c6digo).

Cuando el procedimiento ACCEPTED devuelve un valor igual al nimero de campo asignado por
el compilador al botén OK, se ejecuta la sentencia BREAK y se termina el lazo ACCEPT.

2. DécLic sobre el botén Run.

El programa se compila y ejecuta. El titulo de la ventana muestra aun el mensaje “Hola Windows”
y , ahora, también lo hace el texto constante en medio de la ventana. Puede cerrar la ventana con el
menu del sistema, o el boton OK.

Forma comun del codigo fuente

Hay otras formas de escribir el cddigo en el lazo ACCEPT para lograr lo mismo. Iremos a la forma
mas directa, debido a que se parece mas al estilo de codigo que produce el Generador de
Aplicaciones a partir de los Templates Clarion ABC.

1. Modifique el cédigo de la siguiente manera:

PROGRAM
MAP
END
MyWin WINDOW/(‘Hola Windows"), AT(,,100,100),SYSTEM
STRING(‘Hola Windows’),AT(26,23),USE(?Stringl)
BUTTON('OK’),AT(34,60),USE(?0k),DEFAULT

END
CODE
OPEN(MyWin)
ACCEPT
CASE FIELD() IAfiadido
OF ?0k IAfadido
CASE EVENT() IAfiadido
OF EVENT:Accepted IAfadido
BREAK IAfiadido
END IAfadido
END IAfadido
END

En este cédigo hay una estructura CASE anidada en otra. Una estructura CASE busca una
coincidencia exacta entre la expresién que sigue inmediatamente a la palabra clave CASE y otra
expresion que sigue inmediatamente a la clausula OF (aunque en este caso se muestra solamente
una clausula OF en cada caso, una estructura CASE puede tener tantas como sea necesario.)

La estructura CASE FIELD() determina a qué control se aplica el evento actual. Cuando el
procedimiento FIELD() devuelve un valor igual al ndmero de campo del boton OK (la
equivalencia del campo ?0k ), ejecuta entonces la estructura CASE EVENT().

Esta estructura determina qué evento se generd. Cuando el procedimiento EVENT devuelve un
valor igual a EVENT:Accepted (un EQUATE que se contiene en el archivo
\CLARION\LIBSRC\EQUATES.CLW) ejecuta entonces la sentencia de romper el lazo (BREAK).

Anidar CASE EVENT() dentro de CASE FIELD() le permite poner todo el codigo vinculado a un
control determinado en un lugar Unico. También podria anidarse una estructura CASE FIELD(()
dentro de una estructura CASE EVENT(), invirtiendo el cédigo, pero esto desperdigaria el cédigo
asociado a un control por maltiples lugares.
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2. DécLic en el botén Run.

De nuevo, es posible cerrar la ventana tanto con el menu del sistema, o el botén OK, como ocurria
con el cédigo anterior, pero ahora el codigo esta estructurado segun el estilo comun.

“Hola Windows” con manejo de eventos

Hay dos tipos de eventos pasados al programa por los eventos ACCEPT:Field-specific y Field-
independent.

Un evento Field-specific (especifico del campo) ocurre cuando el usuario hace cualquier cosa
que requiera que el programa tome una accion especifica relativa a un control en particular. Por
ejemplo, cuando el operador oprime TAB después de entrar datos en un control, se genera el
evento especifico del campo EVENT:Accepted.

Un evento Field-independent (independiente del campo) no se vincula a ningin control en
particular, pero puede requerir alguna accion del programa (por ejemplo, cerrar una ventana, o
cambiar los hilos de ejecucion).

Anidar dos estructuras CASE, como hemos visto, es el modo mas comdn de manejar eventos
especificos al campo. EI método mas habitual de tratar con los eventos independientes del campo
es una estructura CASE EVENT() sin anidar, en general ubicada inmediatamente antes de la
estructura CASE FIELD().

Cambio del cédigo fuente
1. Modifique el cédigo fuente del siguiente modo:

PROGRAM
MAP
END
MyWin WINDOW/(‘Hola Windows'), AT(,,100,100),SYSTEM
STRING(‘Hola Windows'),AT(26,23),USE(?Stringl)
BUTTON('OK"),AT(34,60),USE(?0k),DEFAULT

END
CODE
OPEN(MyWin)
ACCEPT
CASE EVENT() IAfiadido
OF EVENT:OpenWindow IAfadido
MESSAGE(‘Opened Window’) IAfadido
OF EVENT:GainFocus IAfadido
MESSAGE(‘Gained Focus’) IAfadido
END IAfadido
CASE FIELD()
OF ?0k

CASE EVENT()
OF EVENT:Accepted
BREAK
END
END
END
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La nueva estructura CASE EVENT() maneja dos eventos independientes del campo:
EVENT:OpenWindow y EVENT:GainFocus. El procedimiento MESSAGE usado en este codigo
es simplemente para mostrar visualmente, durante la ejecucion que se disparé el evento. En lugar
del procedimiento MESSAGE, podria afiadirse aqui cualquier otro codigo que el programa
necesite ejecutar cuando esos eventos son disparados por el usuario.

Esto demuestra el flujo logico y la estructura de cddigo para los procedimientos de ventana: un
lazo ACCEPT que contiene una estructura CASE EVENT() que maneja todos los eventos
independientes de campos, seguidos por una estructura CASE FIELD() con estructuras anidadas
CASE EVENT() para manejar todos los eventos especificos de los campos.

2. Dé CLIC sobre el boton Run.

Advierta que se generan los eventos EVENT:GainFocus y EVENT:OpenWindow cuando la
ventana se abre por primera vez (en ese orden). EVENT:GainFocus (entrar en foco) se regenerara
cuando el usuario haga ALT+TAB hacia otra aplicacién, y luego vuelva nuevamente a Hola
Windows! mediante la misma combinacion de teclas.

Adicion de un PROCEDIMIENTO

En Hola Windows tenemos un ejemplo de un programa muy simple. La mayoria de los programas
empresariales actuales no tienen esa simplicidad; requieren el uso de técnicas de programacion
estructurada. Esto significa que el codigo se divide en secciones funcionales que realizan cada una
de ellas una Unica tarea ldgica. En el lenguaje Clarion, esas secciones funcionales se llaman
Procedimientos (PROCEDURES).

En primer lugar, afiadiremos un Procedimiento al programa Hola Windows.

Cambio del cédigo fuente

1. Modifique el cédigo fuente de esta manera:

PROGRAM
MAP
Hola PROCEDURE IAfiadido
END
CODE IAfiadido
Hola IAfadido
Hola PROCEDURE IAfiadido
MyWin WINDOW(‘Hola Windows’), AT(,,100,100),SYSTEM

STRING(‘Hola Windows’),AT(26,23),USE(?Stringl)
BUTTON('OK"),AT(34,60),USE(?0Ok),DEFAULT
END
CODE
OPEN(MyWin) IAfadido
ACCEPT
CASE EVENT()



OF EVENT:OpenWindow
MESSAGE(‘Opened Window’)
OF EVENT:GainFocus
MESSAGE(‘Gained Focus’)
END
CASE FIELD()
OF ?0k
CASE EVENT()
OF EVENT:Accepted
BREAK
END
END
END

Los Unicos cambios estan aqui al principio del programa. Dentro de la estructura MAP vemos
ahora la sentencia Hola PROCEDURE que hace de prototipo al procedimiento Hola. Un prototipo
es la declaracion del procedimiento para el compilador, para indicarle qué esperar cuando el
cadigo Ilame al procedimiento. Este prototipo indica que el procedimiento no lleva parametros y
no devuelve un valor. Todos los PROCEDURES de su programa deben tener su prototipo en una
estructura MAP. Consulte PROCEDURE Prototypes en la Language Reference para conocer los
demas prototipos.

La palabra clave CODE inmediatamente a continuacion de la estructura MAP termina la seccion
de datos globales (Global data) y marca el principio de la seccién Global de codigo ejecutable, que
solamente contiene la sentencia Hola, que es una llamada para ejecutar el procedimiento Hola. Un
PROCEDURE que no devuelve un valor siempre se llama con una Unica sentencia con su nombre
en el cadigo ejecutable.

La segunda sentencia Hola PROCEDURE termina la seccion Global de cddigo ejecutable y
marca el comienzo de la definicion mediante codigo del procedimiento Hola.

Un PROCEDURE contiene una seccién de declaracion de datos del mismo modo que lo hace un
programa (PROGRAM) y también requiere de la palabra clave CODE para definir el limite entre
las declaraciones de datos y el codigo ejecutable. Es por esto que el resto del cddigo no cambi6 en
el ejemplo previo. Esta es la declaracion de datos locales (Local data declaration) para el
PROCEDURE.

La mayor diferencia entre las declaraciones de datos Global y Local esta en el alcance de los datos
declarados. Cualquier dato declarado en la seccion Local es visible solamente al procedimiento
que lo declara, mientras que cualquier dato declarado en la seccién Global es visible en todas
partes del programa. Consulte Data Declarations and Memory Allocation en la Language
Reference para un tratamiento mas completo de las diferencias.

2. Dé cLic sobre el botén Run.

El programa se ejecuta exactamente como antes. La Unica diferencia es que el Hola
PROCEDURE puede ser llamado ahora desde cualquier parte dentro del programa, incluso
desde otro PROCEDURE. Esto significa que aunque el programa ejecute el procedimiento
muchas veces, el codigo necesario se escribe una sola vez.
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Adicién de un Procedimiento

Un PROCEDURE Clarion que no devuelve (RETURN) un valor puede ser llamado solamente en
una sentencia ejecutable separada; no puede usarselo en una expresion, lista de parametros, o una
asignacion. Un Procedimiento que si devuelve un valor debe siempre contener una sentencia
RETURN vy puede utilizarse en expresiones, listas de parametros, y sentencias de asignacion. Se
puede llamar a un PROCEDURE que si devuelve (RETURN) un valor como una sentencia
separada si no desea el valor retornado, pero esto genera una advertencia del compilador (a menos
que el prototipo del PROCEDURE tenga el atributo PROC).

Estructuralmente, ambos tipos de PROCEDURE son equivalentes; ambos tienen secciones locales
de datos, seguidas por una seccion de cddigo ejecutable que comienza con la palabra clave CODE.

Cambio del Cédigo Fuente

1. Modifique la estructura MAP del siguiente modo:

MAP

Hola PROCEDURE

EventString PROCEDURE(LONG PassedEvent),STRING I Agregado
END

Esto afiade el prototipo para EVENTString PROCEDURE. EventString recibe un parametro
LONG llamado PassedEvent que no puede ser omitido, y devuelve una STRING. Los tipos de
datos de todos los parametros pasados a un PROCEDURE se especifican dentro de los paréntesis
que siguen a PROCEDURE, cada uno separado por una coma (si hay parametros multiples). El
tipo de dato del valor devuelto de un PROCEDURE se especifica siguiendo el paréntesis de cierre
de la lista de parametros. Ambos tipos de PROCEDURESs pueden recibir parametros, consulte la
seccion Prototype Parameter List en la Language Reference para un tratamiento mas completo del
paso de parametros.

2. Afada la definicién del procedimiento EventString al final del archivo:

EventString PROCEDURE(LONG PassedEvent)
ReturnString String(255)
CODE
CASE PassedEvent
OF EVENT:OpenWindow
ReturnString = ‘Opened window’
OF EVENT:GainFocus
ReturnString = ‘Gained Focus’
ELSE
ReturnString = ‘Unknown Event: ‘ & PassedEvent
END
RETURN(ReturnString)



Hacia

La etiqueta EventString (recuerde que por ser una etiqueta, debe estar sobre la columna 1) de la
sentencia PROCEDURE da nombre a este procedimiento, mientras que la lista de parametros
unidos a la palabra clave PROCEDURE da nombre al parametro LONG, llamado PassedEvent.

Debe existir siempre un nimero igual de nombres de parametro listados en la sentencia
PROCEDURE como existen tipos de datos listados en el prototipo para ese PROCEDURE.

ReturnString es una variable local declarada como un campo alfanumérico (STRING) de 255
caracteres, en la pila. La sentencia CODE termina la seccion de datos locales (Local data) del
procedimiento. La estructura CASE PassedEvent debe verse conocida, dado que es la misma
que en una estructura CASE EVENT(), pero su condicion CASE es el PassedEvent, en lugar del
procedimiento EVENTY(). Esta estructura CASE simplemente asigna el valor correspondiente a la
variable ReturnString para cada evento que se pasa al procedimiento.

El codigo interesante es aqui la sentencia RETURN(ReturnString). Un PROCEDURE sin un
valor de devolucion no requiere de un RETURN especifico, dado que siempre ejecuta un
RETURN implicito cuando no hay mas cddigo que ejecutar. Sin embargo, un PROCEDURE
indicado como prototipo para retornar un valor siempre contiene una sentencia RETURN explicita
que especifica el valor a retornar. En este caso, la sentencia RETURN devuelve cualquier valor
que le fue asignado a la ReturnString en la estructura CASE.

3. Moadifique el procedimiento CASE EVENT() para que diga:

CASE EVENT()
OF EVENT:OpenWindow

MESSAGE(EventString(EVENT:OpenWindow)) I Cambiado
OF EVENT:GainFocus

MESSAGE(EventString(EVENT:GainFocus)) I Cambiado
END

Esto cambia los procedimientos MESSAGE para que muestren el valor devuelto del
procedimiento EventString. EI nimero de evento es pasado a EventString como el equivalente
del evento (Event EQUATE) para hacerlo mas comprensible a la lectura.

4. Dé cLic sobre el boton Run.

El programa alin se ejecuta exactamente como antes.

el mundo real: adiciéon de un menu

Hola Windows es un lindo programita de demostracion, pero en realidad no le ensefia mucho sobre
como realizar verdadera programacion comercial. Por lo tanto, lo expandiremos para que incluya
algo de funcionalidad til, comenzando por un mend.

Cambio del Codigo Fuente

1. Modifique el principio del archivo de este modo:



240

CLARION 5™ APRENDIENDO CLARION

PROGRAM
MAP
Main PROCEDURE I Agregado
Hola PROCEDURE
EventString PROCEDURE(LONG PassedEvent), STRING
END
CODE
Main I Cambiado

Esto afiade el prototipo del Main PROCEDURE a la estructura MAP y reemplaza la llamada a
Hola con una llamada al procedimiento Main.

2. Afada la definicién del PROCEDURE al final del archivo:

Main PROCEDURE
AppFrame  APPLICATION(*Hola Windows'), AT(, ,280,200), SYSTEM, RESIZE, MAX
MENUBAR

MENU(* &File’), USE(?File)
ITEM(‘&Browse Telefono’), USE(?FileBrowseTelefono)
ITEM, SEPARATOR
ITEM(‘E&xit’), USE(?FileExit), STD(STD:close)
END
ITEM(‘&About!"), USE(?About)
END
END
CODE
OPEN(AppFrame)
ACCEPT
CASE ACCEPTED()
OF ?About
Hola
END
END

El procedimiento Main no acepta parametros. Contiene la estructura AppFrame
APPLICATION. Una estructura APPLICATION es la clave para la creacion de programas con
Interfaz de Documentos Mdltiples (MDI). Una aplicacion MDI puede contener multiples hilos de
gjecucién. Este es el marco “padre” MDI que se necesita para crear una aplicacion MDI.

La estructura MENUBAR define los items del mend disponibles al usuario. La estructura
MENU('&File") crea el menu File estandar que aparece en casi todos los programas Windows. El
signo (&) que precede a la “F” especifica que éste es el “atajo del teclado”, y el sistema operativo
la subrayara durante la ejecucion.

La opcion ITEM(‘&BrowseTelefono’) crea un item de mend que usaremos para llamar a un
procedimiento (como pronto veremos). La sentencia ITEM,SEPARATOR crea una linea divisoria
en el menu a continuacion de la seleccion Browse Telefono.

El ITEM(‘E&xit’) crea un item del men para salir del procedimiento (y del programa, dado que
este procedimiento es el Unico llamado desde el cddigo ejecutable Global). El atributo
STD(STD:Close), especifica la accion estandar de cerrar una ventana para salir del lazo
ACCEPT. Esto esporque no se vé ningun codigo ejecutable asociado a este item de menu en el
lazo ACCEPT: la biblioteca Clarion de tiempo de ejecucion se encarga automaticamente.
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La sentencia ITEM(‘&About’) crea un item de men( sobre la barra de accion, a la derecha del
menu Files. El signo de admiracion (!) es una convencion para indicar a los usuarios que este item
gjecuta una accién, y no despliega un men(, a pesar de que se encuentra en la barra de accién.

El lazo ACCEPT contiene Gnicamente una estructura CASE ACCEPTED(). El procedimiento
ACCEPTED (aceptado) devuelve el nimero de campo del control con foco, cuando se genera un
EVENT:Accepted. Podemos usar el procedimiento ACCEPTED aqui, en lugar de los
procedimientos FIELD y EVENT porque los items de menu solo generan EVENT:Accepted. La
clausula OF ? About simplemente llama al procedimiento Hola.

3. Dé cLic sobre el botén Run.

El programa se ejecuta y solamente los items About! y File > Exit hacen algo. Advierta, sin
embargo que File » Exit hace terminar el programa, aunque no hemos escrito codigo para
realizar tal accion.

Més hacia el mundo real: adicion de un listado y un formulario

Tener un mend es agradable, pero ahora debiéramos hacer algo de programacion empresarial
verdadera. Ahora afiadiremos un archivo de datos y los procedimientos para mantenerlo.

Cambio del Cédigo Global

1. Modifique el principio del archivo para que diga:

PROGRAM
INCLUDE(‘KeyCodes.CLW’) I Agregado
INCLUDE(‘Errors.CLW’) I Agregado
MAP
Main PROCEDURE
BrowseTelefono PROCEDURE I Agregado
UpdateTelefono PROCEDURE(LONG Action), LONG I Agregado
Hola PROCEDURE
EventString PROCEDURE(LONG PassedEvent), STRING
END
Telefono FILE, DRIVER(‘TopSpeed’), CREATE I Agregado
KeyNombre Key(Nombre),DUP, NOCASE I Agregado
Rec RECORD I Agregado
Nombre STRING(20) I Agregado
Numero STRING(20) I Agregado
END I Agregado
END
I Agregado
InsertRecord EQUATE(1) I Agregado
ChangeRecord EQUATE(2) I Agregado
DeleteRecord EQUATE(3) I Agregado
ActionComplete EQUATE(1) I Agregado
ActionAborted EQUATE(2) I Agregado
CODE

Main



Las dos nuevas sentencias INCLUDE afiaden los EQUATES estandar para los cddigos de tecla y
los nimeros de error. El uso de las equivalencias (EQUATES) en lugar de los nimeros hace mas
comprensible el cadigo y, por lo tanto, mas facil de mantener.

La estructura MAP ha adquirido otros dos prototipos de procedimientos: el BrowseTelefono
PROCEDURE y UpdateTelefono PROCEDURE(LONG Action),LONG. El procedimiento
BrowseTelefono mostrara una lista de los registros en el archivo y UpdateTelefono actualizara los
registros individuales.

En interés de mantener la simplicidad del cddigo (trataremos esto enseguida), el procedimiento
BrowseTelefono se limitara a mostrar todos los registros del archivo en un control LIST. Esto no
es exactamente lo mismo que un procedimiento Browse del cédigo generado por los templates
(que se carga de a paginas para poder manejar archivos muy grandes), pero servira al mismo fin
aqui.

La declaracion Telefono FILE crea un archivo de datos simple utilizando el controlador
TopSpeed. Hay dos campos de datos: Nombre y Numero, declarados ambos como
alfanuméricos: STRING(20). La declaracion del campo de nimero de este modo le permite
contener nimeros telefénicos de cualquier pais del mundo (pronto mas sobre esto)

Las cinco sentencias EQUATE definen valores constantes que hacen mas legible el cédigo.
InsertRecord, ChangeRecord y DeleteRecord definen acciones que deben pasarse como
parametros al procedimiento UpdateTelefono. Las equivalencias ActionComplete vy
ActionAborted definen los dos posibles valores devueltos por el procedimiento UpdateTelefono.

2. Modifique el codigo CASE ACCEPTED() del procedimiento Main, de este modo:

CASE ACCEPTED()
OF ?FileBrowseTelefono I Agregado
START(BrowseTelefono,25000) I Agregado
OF ?About
Hola
END

La sentencia START(BrowseTelefono,25000) se ejecuta cuando el usuario elige la seleccidn
del ment Browse Telefono. El procedimiento START crea un nuevo hilo de ejecucién para el
procedimiento BrowseTelefono y el segundo parametro (25000) especifica el tamafio (en bytes) de
la pila del nuevo hilo de ejecucién. Puede utilizarse el procedimiento START cuando esta
I[lamando a un procedimiento que contiene una ventana MDI hija desde el marco de la
APPLICATION, debido a que cada ventana hija MDI debe estar sobre un hilo de ejecucion
separado. Si usted no abre (START) la hija MDI, durante la ejecucion aparecera el error “Unable
to open MDI window on APPLICATION’s thread” cuando intente llamar el procedimiento
BrowseTelefono y el programa se terminara inmediatamente.

Una vez que ha comenzado un nuevo hilo de ejecucién, un hijo MDI puede simplemente llamar a
otro hijo MDI en su mismo hilo sin necesidad de empezar uno nuevo. Esto significa que, aunque



BrowseTelefono y UpdateTelefono ambos contienen ventanas MDI, solamente BrowseTelefono
debe empezar (START) un nuevo hilo, dado que es llamado desde la ventana de la aplicacion.

Afnadir el procedimiento BrowseTelefono

1. Afiada la seccion de datos de la definicién BrowseTelefono PROCEDURE al final del archivo:

BrowseTelefono PROCEDURE

TelefonoQue QUEUE

Nombre STRING(20)

Numero STRING(20)

Position STRING(512)
END

Window WINDOW(‘Browse Telefono’), AT(, , 185,156), SYSTEM, GRAY,RESIZE,MDI

LIST, AT(6,8,173,100),ALRT(MouseLeft2),USE(?List), |
FORMAT(‘84L|M~Nombre~80L~Numero~"),FROM(TelefonoQue),VSCR
OLL

BUTTON('&Insert’),AT(20,117),KEY (InsertKey),USE(?Insert)

BUTTON('&Change’),AT(76,117,35,14),KEY(EnterKey),USE(?Change)

BUTTON('&Delete’),AT(131,117,35,14),KEY (DeleteKey),USE(?Delete)

BUTTON('Close’),AT(76,137,35,14),KEY (EscKey),USE(?Close)

END

La estructura de “cola” TelefonoQue QUEUE define la estructura de datos que contendréa todos los
registros del archivo Telefono y los mostrara en el control LIST. Una “cola” (QUEUE) de Clarion
es similar a un archivo de datos debido a que tiene un buffer de datos y permite un nimero
indeterminado de registros, pero solamente existe en memoria durante la ejecucion. Una cola
también puede asimilarse a una matriz asignada dinamicamente en tiempo de ejecucion. Consulte
el capitulo Memory Queues en la Language Reference para mas informacién sobre estas
estructuras.

La cola TelefonoQue contiene tres campos. Los campos Nombre y Numero duplican los
campos en la estructura del archivo Telefono, y se mostraran en las dos columnas definidas por el
atributo FORMAT del control LIST. EI campo Position contendra el valor de devolucion del
procedimiento POSITION de cada registro del archivo Telefono. Guardar la posicién de cada
registro nos permitird reubicar inmediatamente el registro desde el archivo de datos, antes de
[lamar a UpdateTelefono para cambiar o borrar un registro.

La estructura window WINDOW contiene un control LIST y cuatro botones (BUTTON). El
control LIST es la clave de este procedimiento. La alerta ALRT(MouseL eft2) sobre LIST alerta
sobre un posible DOBLE cLIC para que la sentencia ACCEPT pase un EVENT:AlertKey al cddigo
Clarion. Esto nos permitira escribir cddigo para traer el procedimiento UpdateTelefono para
cambiar el registro sobre el que el usuario da DOBLE CLIC.
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La barra vertical (| ) al final de la sentencia LIST es el caracter de continuacion de Clarion, lo que
significa que el control LIST continla en la linea siguiente con el atributo
FORMAT(‘84L|M~Nombre~80L~Numero~'), aunque si lo desea puede poner todo en una
sola linea, sin la barra de separacion. El parametro del atributo FORMAT define la apariencia del
control LIST en tiempo de ejecucion.

Es mejor dejar la herramienta de Disefio de Listados en el Disefiador de Ventanas que escriba las
cadenas de formato, dado que rapidamente se vuelven muy complejas. Este formato define dos
columnas. La primera columna tiene 84 unidades de dialogo de ancho (84), esta justificado a la
izquierda (L), tiene un borde derecho ( | ) ajustable (M) y la palabra “Nombre” es su
encabezamiento (~Nombre~). La segunda columna tiene 80 unidades de didlogo de ancho (80),
con justificacion a la izquierda (L), y su encabezamiento es “Numero” (~Numero~).

FROM(TelefonoQue) en la LIST especifica que la cola (QUEUE) que mostrara el control LIST,
y VSCROLL afade la barra de deslizamiento vertical. La LIST desplegara los campos Nombre y
Numero de todos los items en la TelefonoQue ignorando el campo Position, dado que el atributo
FORMAT sélo especificé dos columnas.

La LIST automaticamente permite a los usuarios desplazarse por la lista sin necesidad de
codificacion adicional. La LIST hace esto porque no esta presente el atributo IMM (inmediate). Si
éste existiera, deberiamos escribir cédigo para manejar el desplazamiento (scrolling) de los
registros, como ocurre en la plantilla Browse.

La sentencia BUTTON('&Insert) define un boton de 6rdenes que el usuario oprimira para afadir
un nuevo registro. El atributo KEY(InsertKey) especifica que el botdn se oprime
automaticamente para el usuario al pulsar la tecla INSERT. Advierta que los otros tres controles
BUTTON tienen similares atributos KEY. Esto significa que no es necesario escribir cddigo
especial alguno para manejar el acceso mediante el teclado, si el usuario lo prefiere al mouse.

2. Afada el principio de la seccion de codigo ejecutable de la definicion del BrowseTelefono
PROCEDURE al final del archivo:

CODE
DO OpenFile
DO FillQue
OPEN(window)
ACCEPT
CASE EVENT()
OF EVENT:OpenWindow
DO QueRecordsCheck
OF EVENT:Alertkey
IF KEYCODE() = MouseLeft2
POST(EVENT:Accepted, ?Change)
END
END
END



El principio de la seccion CODE empieza con la sentencia DO OpenFile. DO ejecuta una
ROUTINE, en este caso OpenFile, y cuando ha terminado este cédigo, el control regresa a la
siguiente linea de cddigo después de la sentencia DO que llamé a ROUTINE.

El cédigo que define una ROUTINE debe estar al final del procedimiento, luego de toda la légica
principal, debido a que la sentencia ROUTINE da fin a la seccion de cddigo ejecutable de un
PROCEDURE.

Hay dos razones para usar una ROUTINE dentro de un PROCEDURE: para escribir un grupo de
sentencias de codigo que deben ejecutarse en multiples puntos Idgicos dentro del procedimiento, o
para hacer el codigo mas comprensible al sustituir con una simple sentencia DO un grupo de
sentencias que realizan una Unica labor l6gica.

En este caso, la sentencia DO OpenFile sirve al segundo propdsito, moviendo el cédigo que abre o
crea el archivo fuera de la logica principal del procedimiento. A continuacion, la sentencia DO
FillQue ejecuta el cédigo que llena la estructura TelefonoQue QUEUE con todos los registros
tomados del archivo. Las dos sentencias DO hacen muy facil seguir el flujo I6gico del
procedimiento.

Las estructuras CASE EVENT() de la clausula légica OF EVENT:OpenWindow ejecutan DO
QueRecordsCheck para llamar a una ROUTINE que verifica para ver si hay registros en
TelefonoQue.

A continuacion, la clausula OF EVENT:AlertKey contiene la estructura IF KEYCODE() =
MouselLeft2 para verificar si hay DoBLE cLic en la LIST. Dado que el atributo
ALRT(MouseLeft2) solamente aparece sobre el control LIST, sabemos que la sentencia
POST(EVENT:Accepted,?Change) se ejecutara solamente cuando el usuario de DOBLE CLIC
sobre la LIST.

La sentencia POST le indica a ACCEPT que “remita” el evento en su primer pardmetro
(EVENT:Accepted) al control en su segundo parametro (?Change). El efecto es que se ejecute el
cadigo del boton Change, como si el usuario hubiese oprimido el boton con el mouse o con el
teclado.

Esto ilustra una excelente practica de programacion: escribir codigo especifico una vez y llamarlo
desde muchos lugares. Este concepto de la programacion estructurada nos brind6 los
Procedimientos y las Rutinas. Aunque el codigo EVENT:Accepted para el botén Change no esta
separado en un PROCEDURE o ROUTINE, el uso de la sentencia POST(“enviar”) significa que
esa es la Unica seccion del codigo que debe mantener: si quiere cambiar la logica, basta hacerlo en
un solo lugar.

3. Afada el resto de la seccion de codigo ejecutable de la definicion del procedimiento
BrowseTelefono al final del archivo:



246 CLARION 5™ APRENDIENDO CLARION

CASE FIELD()
OF ?Close
CASE EVENT()
OF EVENT:Accepted
POST(EVENT:CloseWindow)
END
OF ?Insert
CASE EVENT()
OF EVENT:Accepted
IF UpdateTelefono(InsertRecord) = ActionComplete
DO AssignToQue
ADD(TelefonoQue)
IF ERRORCODE() THEN STOP(ERROR()).
SORT(TelefonoQue, TelefonoQue.Nombre)
ENABLE(?Change, ?Delete)
END
SELECT(?List)
END

OF ?Change
CASE EVENT()
OF EVENT:Accepted
DO GetRecord
IF UpdateTelefono(ChangeRecord) = ActionComplete
DO AssignToQue
PUT(TelefonoQue)
IF ERRORCODE() THEN STOP(ERROR()).
SORT(TelefonoQue, TelefonoQue.Nombre)
END
SELECT(?List)
END

OF ?Delete
CASE EVENT()
OF EVENT:Accepted
DO GetRecord
IF UpdateTelefono(DeleteRecord) = ActionComplete
DELETE(TelefonoQue)
IF ERRORCODE() THEN STOP(ERROR()).
DO QueRecordsCheck
SORT(TelefonoQue, TelefonoQue.Nombre)
END
SELECT(?List)
END
END
FREE(TelefonoQue)
CLOSE(Telefono)

Siguiendo la estructura CASE EVENT() se ubica la estructura CASE FIELD(). Advierta que cada
clausula OF contiene su propia estructura CASE EVENT(), y cada una solamente contiene una
clausula OF EVENT:Accepted. Debido a esto, podriamos haber reemplazado la estructura



CASE FIELD() con un case ACCEPTED() y eliminado los CASEs anidados. Esto hubiera
mejorado ligeramente el desempefio; pero demasiado poco como para notarlo en la pantalla. No lo
hicimos para mantener la coherencia; habrd muchas ocasiones en que se deban capturar mas
eventos especificos al campo que sélo EVENT:Accepted, y cuando esto ocurre, esta estructura
anidada Case es la logica a usar, de manera que resulta bueno habituarse desde ahora. También
demuestra el tipo de estructura de codigo que generan los templates de Clarion en el Generador de
Aplicaciones.

La clausula OF ?CLOSE ejecuta el POST(EVENT:CloseWindow) cuando el usuario oprime
el boton Close. Dado que no hay un segundo parametro en la sentencia POST que nombra un
control, el evento envia a la WINDOW (y debe ser un evento independiente del campo).
EVENT:CloseWindow provoca la terminacion del lazo ACCEPT vy el control de la ejecucién cae a
la primera sentencia que sigue al END de terminacion del lazo ACCEPT. En este caso, el control
va a la sentencia FREE(TelefonoQue), lo que libera toda la memoria utilizada por los registros
de la cola, cerrandola, y cerrando el archivo. Dado que no hay otras sentencias que ejecutar, el
procedimiento realiza un RETURN implicito y vuelve al procedimiento Main (desde donde fue
[lamado).

La clausula OF ?INSERT contiene la estructura IF UpdateTelefono(InsertRecord)
=ActionComplete. Esto llama al procedimiento UpdateTelefono, pasandole el valor constante
InsertRecord que definimos en la seccion de datos Global, y luego verifica la devolucién del valor
ActionComplete.

La sentencia DO AssignToQue (asignar a la cola) se ejecuta solamente cuando el usuario afiade
un registro nuevo. AssingToQue es una rutina que asigna datos del buffer de registro del archivo
Telefono al buffer de la cola respectiva. Entonces, la sentencia ADD(TelefonoQue) afiade una
nueva entrada a la cola. La sentencia IF ERROCODE() THEN STOP(ERROR()) es una
comprobacion estandar de errores que deberia ejecutarse después de cada accién sobre un archivo
0 sobre una cola que tenga la posibilidad de devolver un error (para formarse otro buen habito).

La sentencia SORT(TelefonoQue,TelefonoQue.Nombre) alfabetiza la cola por el campo
Nombre. Dado que no hay un atributo PRE (prefijo) en la estructura TelefonoQue, debe
referenciar sus campos utilizando la sintaxis de calificacion de campos Clarion, anteponiendo el
nombre de la estructura que contiene el campo (TelefonoQue) al nombre del campo (Nombre),
conectandolos entre si con un punto, de este modo:TelefonoQue.Nombre. Consulte Field
qualification en la Language Reference para mas informacion.

La sentencia ENABLE(?Change, ?Delete) asegura que los botones de cambio y borrado estén
activos (si esta fue la primera entrada en la QUEUE, los botones estan grisados por la
QueRecodsCheck ROUTINE). La sentencia SELECT(?List) vuelve al usuario al control LIST.

El codigo en la clausula OF ?Change es casi idéntico al cédigo en la clausula OF ?Insert. Hay
una sentencia adicional DO GetRecord que llama una rutina para poner el registro iluminado de
TelefonoQue dentro del buffer del registro del archivo Telefono. La Unica otra diferencia es la
sentencia PUT (TelefonoQue) que incorpora los cambios del usuario en TelefonoQue.
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El cddigo en la clausula OF ?Delete es casi idéntico al cddigo en la clausula OF ?Change. La
diferencia es la sentencia DELETE(TelefonoQue) que quita el registro de TelefonoQue y la
llamada al DO QueRecordsCheck para comprobar si el usuario ha borrado el Gltimo registro.

4. Afada las rutinas llamadas en la definicién del procedimiento BrowseTelefono, al final del
archivo:

AssignToQue ROUTINE
TelefonoQue.Nombre = Telefono.Rec.Nombre
TelefonoQue.Numero = Telefono.Rec.Numero
TelefonoQue.Position = POSITION(Telefono)

QueRecordsCheck ROUTINE
IF NOT RECORDS(TelefonoQue)
DISABLE(?Change, ?Delete)
SELECT(?Insert)
ELSE
SELECT(?List,1)
END

GetRecord ROUTINE
GET(TelefonoQue,CHOICE(?List))
IF ERRORCODE() THEN STOP(ERROR()).
REGET(Telefono, TelefonoQue,Position)
IF ERRORCODE() THEN STOP(ERROR()).

OpenFile ROUTINE
OPEN(Telefono,42h)
CASE ERRORCODE()
OF NoError OROF IsOpenkErr
EXIT
OF NoFileErr
CREATE(Telefono)
IF ERRORCODE() THEN STOP(ERROR()).
OPEN(Telefono,42h)
IF ERRORCODE() THEN STOP(ERRORY()).
ELSE
STOP(ERRORY())
RETURN
END

FillQue ROUTINE
SET(Telefono,KeyNombre)
LOOP
NEXT(Telefono)
IF ERRORCODE() THEN BREAK.
DO AssignToQue
ADD(TelefonoQue)
IF ERRORCODE() THEN STOP(ERROR()).
END



Como puede observar, hay cinco rutinas en este procedimiento. Adviértase que, aunque esas
rutinas se ven similares a un procedimiento, no contienen sentencias CODE. Esto se debe a que
una rutina comparte los datos locales del procedimiento y no suele tener una seccién propia de
declaracion de datos (aunque si puede tenerla: vea ROUTINE en la Language Reference para un
tratamiento completo de este tema).

La rutina AssignToQue efectla tres asignaciones. La sentencia TelefonoQue.Nombre =
Telefono.Rec.Nombre copia los datos en el campo Nombre de buffer de registro y los coloca
en el campo Nombre de la cola. Dado que no hay prefijo (atributo PRE) en la estructura Telefono
FILE, debe también referenciar sus campos segun la sintaxis de calificacion de campos de Clarion,
uniendo el nombre del archivo (Telefono), el nombre del registro (Rec), y el nombre del campo
(Nombre), conectandolos con un punto (Telefono.Rec.Nombre). Consulte Field Qualification en la
Language Reference para mas informacion.

La sentencia TelefonoQue.Numero = Telefono.Rec.Numero asigna los datos en el campo
de nuimero del archivo de teléfono al campo de la cola TelefonoQue “Numero”. La sentencia
TelefonoQue.Position = POSITION(Telefono) asigna el valor devuelto por el procedimiento
POSITION ala campo TelefonoQue.Position. Este valor nos permite recuperar del disco el registro
especifico que esté actualmente en el buffer de teléfonos del archivo Telefono. El procedimiento
POSITION lo hace comunicandose con el controlador de archivos Clarion, y es por lo tanto el
método recomendado de toma de registros en todos los sistemas de archivos utilizados.

La QueRecordsCheck ROUTINE verifica para ver si hay registros en TelefonoQue. La
estructura IF NOT RECORDS(TelefonoQue) utiliza el operador l6gico NOT contra el valor
devuelto del procedimiento RECORDS. Si RECORDS(TelefonoQue) devuelve cero, el NOT hace
verdadera la condicion y se ejecuta el cddigo que sigue al IF (cero es siempre falso, y el NOT lo
hace verdadero). Si RECORDS(TelefonoQue) devuelve algo distinto de cero, el codigo que sigue
al ELSE se ejecutara (cualquier nimero que no sea cero es siempre verdadero, y el NOT lo hace
falso). Por lo tanto, si no hay registros en la cola TelefonoQue, DISABLE(?Change, ?Delete),
se ejecuta para inhabilitar los botones respectivos, y la sentencia SELECT(?Insert) coloca al
usuario sobre el boton Insert (la siguiente accién ldgica). Si hay registros en TelefonoQue la
sentencia SELECT (?List) coloca al usuario sobre la LIST.

La rutina GetRecord ROUTINE sincroniza el buffer del registro del archivo Telefono y el buffer
de datos de la cola TelefonoQue con el registro actualmente iluminado en la LIST. La sentencia
GET(TelefonoQue,CHOICE(?List) utiliza el procedimiento CHOICE para “apuntar” al
“registro” iluminado en la lista y recuperar (GET) el “registro” vinculado al buffer de
TelefonoQue (comprobando siempre si hay errores inesperados). Luego, la sentencia
REGET(Telefono,TelefonoQue.Position) utiliza la informacién guardada sobre el registro
grabado para recuperarlo y enviarlo al buffer del registro de la cola.

La rutina OpenFile ROUTINE abre o crea el archivo Telefono. La sentencia
OPEN(Telefono,42h) intenta abrir el archivo Telefono para ser compartido. El segundo
pardmetro es un nimero hexadecimal (condicion indicada por la “h”). Clarion admite los sistemas
numeéricos decimal, hexadecimal, binario y octal. Este nimero representa el acceso plenamente
compartido al archivo (Read/Write, Deny None) (consulte la sentencia OPEN en la Language
Reference para mas sobre los modos de acceso a los archivos). Pedimos acceso compartido porque



este es un programa MDI y el usuario podria llamar a copias multiples del mismo procedimiento
en el mismo programa. Sin embargo, este programa no hace todas las comprobaciones de acceso
concurrente que se requieren para una aplicacién multiusuario real. Consulte la seccién
correspondiente de la Programmer’s Guide para mas informacion sobre el tema.

La estructura CASE ERRORCODE() verifica cualquier error en el OPEN. La clausula OF
NoError OROF IsOpenErr (ahora puede ver porqué hemos incluido el archivo ERRORS.CLW)
ejecuta la sentencia EXIT para salir inmediatamente de esta rutina. ES muy importante no
confundir EXIT con RETURN, dado que este ultimo finaliza inmediatamente el procedimiento,
mientras que EXIT sdlo termina la rutina. Es vélido utilizar RETURN dentro de una rutina, pero
asegurese de que quiere terminar todo el procedimiento, y no solamente la rutina misma.

La clausula OF NoFileErr detecta que no hay un archivo de datos para abrir. La sentencia
CREATE(Telefono) creard un nuevo archivo de datos vacio. Debe asegurarse de que, si intenta
usar la sentencia CREATE que la declaracion FILE también contenga el atributo CREATE, o la
sentencia CREATE no podra trabajar. Esta sentencia no abre el archivo, lo que explica la sentencia
OPEN(Telefono,42h). El cédigo en la clausula ELSE se ejecuta si ocurre cualquier error distinto
de esos. La sentencia STOP(ERROR()) muestra el mensaje de error del procedimiento al usuario
en una ventana modal del sistema, lo que le da la oportunidad de cancelar el programa (regresando
a Windows) o ignorar el error. La sentencia RETURN termina el procedimiento si el usuario elige
esta Ultima opcién.

La rutina FillQue ROUTINE llena la cola TelefonoQue con todos los registros en el archivo
Telefono. La sentencia SET(Telefono.KeyNombre) prepara el orden de procesamiento y el
punto de comienzo del archivo Telefono. El parametro Telefono.KeyNombre hace el
procesamiento alfabético segiin el campo Nombre. La ausencia de un segundo parametro en la
sentencia SET hace del punto de comienzo el principio (o el fin) del archivo. La estructura LOOP
no tiene condicion, lo que significa que debe ponerse una sentencia BREAK en alguna parte del
LOOP, o tendria un lazo infinito. La sentencia NEXT(Telefono) recupera el registro siguiente del
archivo de datos Telefono, y luego la sentencia IF ERROCODE() THEN BREAK asegura que
salgamos (BREAK) del LOOP, cuando hayan sido leidos todos los registros. La sentencia DO
AssignToQue llama a la rutina del mismo nombre que ya hemos tratado, y
ADD(TelefonoQue) afiade el nuevo registro a la cola.

Adicion del procedimiento UpdateTelefono

1. Afiada la seccion de datos de la definicion del UpdateTelefono PROCEDURE al final del
archivo:




UpdateTelefono PROCEDURE(LONG Action)

ReturnValue LONG,AUTO

Window WINDOW('Update Telefono’), AT(, ,185,92),SYSTEM,GRAY,RESIZE,MDI,MASK
PROMPT(‘N&ombre:"),AT(14,14),USE(?Prompt1)
ENTRY(@s20),AT(68,13),USE(Telefono.Rec.Nombre),REQ
PROMPT(‘N&umero:’),AT(14,43),USE(?Prompt2)
ENTRY(@s20),AT(68,42),USE(Telefono.Rec.Numero)
BUTTON('OK"),AT(45,74),USE(?0k),REQ,DEFAULT
BUTTON('Cancela’),AT(109,74,32,14),USE(?Cancel)

END

La sentencia UpdateTelefono PROCEDURE(LONG Action), define un PROCEDURE que
recibe un Unico parametro LONG que se llamara “Action” dentro del procedimiento (sin importar
qué variable o constante se pase).

ReturnValue LONG,AUTO declara una variable LONG que permanece sin inicializar por el
compilador (debido al atributo AUTO). Por omision, las variables de memoria son inicializadas a
espacios en blanco o a cero (segun el tipo de datos). Especificar AUTO ahorra algo de memoria,
pero a condicién que el programador tenga la certeza de que asignara un valor a la variable sin
inicializar antes de verificar por primera vez su contenido, o se produciria un bug intermitente muy
dificil de localizar.

La estructura WINDOW posee el atributo de mascara (MASK), lo que significa que los patrones
de ingreso de datos son comprobados a medida que se ingresan datos, en lugar del comportamiento
estandar de Windows de ingreso de datos “de formato libre”.

Los dos controles PROMPT y ENTRY se combinan para el ingreso de datos. Los dos controles
BUTTON permitiran al usuario completar o cancelar la accion actual.

Los controles PROMPT definen las etiquetas de campos en pantalla, y la tecla “aceleradora” (o
atajo del teclado) para navegar hasta el control ENTRY que sigue al PROMPT. Los atajos del
teclado se forman utilizando ALT mas la letra que sigue al signo &. Por ejemplo (‘N&ombre:’)
indica que ALT+A dara foco al control del mismo nombre.

Los atributos USE de los controles ENTRY nombran los campos de datos que automaticamente
reciben el ingreso del usuario. La biblioteca de tiempo de ejecucion asegura que el valor actual en
la variable nombrada en el atributo USE muestra cuando el control tiene foco. Cuando el usuario
ingresa datos en el control ENTRY vy luego pasa a otro control, la biblioteca de tiempo de
gjecucién asegura que la variable nombrada en el atributo USE reciba el valor actual mostrado en
el control.

El atributo REQ del primer control ENTRY significa que el usuario no puede dejarlo en blanco,
mientras que el atributo REQ sobre el boton OK verifica que el usuario haya ingresado datos en
todos los controles de ingreso de datos que lo requieran. Esta verificacion sélo se hace cuando se
oprime el botén con el atributo REQ, porque el usuario puede ni siquiera haber pasado por el
control de ingreso con este atributo.
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2. Afada la légica principal del procedimiento UpdateTelefono al final del archivo:

CODE
OPEN(Window)
DO SetupScreen
ACCEPT
CASE FIELD()
OF ?Telefono:Rec:Numero
CASE EVENT()

OF EVENT:Selected
DO Setuplnsert

END

OF ?0k

CASE EVENT()

OF EVENT:Accepted
EXECUTE Action

ADD(Telefono)
PUT (Telefono)
DELETE(Telefono)
END
IF ERRORCODE() THEN STOP(ERRORY()).
ReturnValue = ActionComplete
POST(EVENT:CloseWindow)
END
OF ?Cancel

CASE EVENT()

OF EVENT:Accepted
ReturnValue = ActionAborted
POST(EVENT:CloseWindow)

END

END
END
RETURN(ReturnValue)

La sentencia DO SetupScreen llama a la SetupScreen ROUTINE para realizar algunas
funciones de inicializacion de la ventana. Advierta que sigue a la sentencia OPEN(Window).
Cuando se va a alterar dindmicamente la ventana en un procedimiento, debe ser abierta en primer
lugar.

La clausula OF ?Telefono:Rec:Numero en la estructura CASE FIELD() demuestra dos cosas
importantes. La primera es la equivalencia de campo (Field Equate Label) misma. El atributo
USE(Telefono.Rec.Numero) contiene puntos en el nombre del campo, y los puntos no son
validos para las etiquetas de cddigo Clarion. Por lo tanto, para construir una equivalencia para
Telefono.Rec.Numero, el compilador sustituye el punto por dos puntos (dado que los dos puntos
son validos en una etiqueta de Clarion).

El segundo punto a considerar es la clausula OF EVENT:Selected en la estructura CASE
EVENT(). EVENT:Selected genera cuando el control tiene foco para el ingreso de datos, pero
antes de que el usuario empiece a hacerlo. La sentencia DO Setuplnsert se ejecuta para ofrecer
al operador una opcién y configurar luego el formato de despliegue y de ingreso de datos para ese
control ENTRY.
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El cddigo OF EVENT:Accepted on OF ?0k es el cédigo que escribe el registro al disco. La
estructura EXECUTE Action ejecuta exactamente una de las sentencias ADD(Telefono),
PUT(Telefono), o DELETE(Telefono).

Una estructura EXECUTE es similar a las estructuras IF y CASE en que ejecuta codigo en forma
condicional, segun la evaluacion de una condicion. La condicion EXECUTE debe evaluar a un
entero en la gama de 1 a n (en que n es el nimero de sentencias de codigo dentro de la estructura
EXECUTE), luego ejecuta la linea de cddigo dentro de la estructura que corresponde al valor de la
condicion.

En este codigo, EXECUTE consulta el parametro Action, y luego ejecuta ADD(Telefono) si el
valor de Action es 1, PUT(Telefono), si es 2, 0o DELETE(Telefono) si es 3.

En general, cuando se evalla cual estructura de cdédigo Clarion debe usar para una clausula
condicional (IF/ELSIF, CASE o0 EXECUTE), la estructura IF/ELSIF es la mas flexible, y la menos
eficiente. CASE es menos flexible pero mucho mas eficiente que IF/ELSIF, y EXECUTE no es
flexible, pero muy eficiente. Por lo tanto cuando la condicion a evaluar puede resolverse en un
entero en el rango de 1 a n, utilice EXECUTE, de lo contrario, intente usar CASE. Si éste no
resulta lo suficientemente flexible, recurra a IF/ELSIF.

La sentencia IF ERRORCODE() THEN STOP(ERROR()) verificara que no haya errores, sin
importar cual sentencia ejecuté EXECUTE. La sentencia ReturnValue = ActionComplete
configura el regreso al procedimiento que hizo la llamada, sefialando que el usuario ha completado
la accion del archivo, y luego el POST(EVENT:CloseWindow) termina el lazo ACCEPT,
dejando caer el control a la sentencia RETURN(ReturnValue).

3. Afada las ROUTINEs llamadas en la definicién del procedimiento UpdateTelefono, al final
del archivo:

SetupScreen ROUTINE
CASE Action
OF InsertRecord
CLEAR(Telefono.Rec)
TARGET{PROP:Text} = ‘Agrega nimero nuevo’
OF ChangeRecord
TARGET{PROP:Text} = ‘Modifica nUmero telefénico de * |
& CLIP(Telefono.Rec.Nombre)
IF Telefono:Rec:Numero[1] <> '+
?Telefono:Rec:Numero[PROP:Text] = ‘@ P###-#iHt-H#HHHP’
END
OF DeleteRecord
TARGET{PROP:Text} = ‘Elimina numero telefonico de * |
& CLIP(Telefonos.Rec.Nombre)
DISABLE(FIRSTFIELD(),LASTFIELD())
ENABLE(?0k, ?Cancel)
END



Setuplnsert ROUTINE
IF Action = InsertRecord
CASE MESSAGE(‘Internacional?’, ‘Format’,ICON:Question, |
BUTTON:Si+BUTTON:No,BUTTON:No,1)
OF BUTTON:Si
TARGET{PROP:Text} = ‘Agrega numero internacional’
?Telefono:Rec:Numero{PROP:Text} = ‘@S20’
Telefono:Rec:Numero[1] = ‘+’
DISPLAY
Select(?,2)
OF BUTTON:No
TARGET{PROP:Text} = ‘Agrega nimero nacional’
?Telefono:Rec:Numero{PROP:Text} = ‘@ P#i##-#HH#-#HHP’
END
END

La SetupScreen ROUTINE comienza por evaluar CASE Action. Cuando el usuario esta
afiadiendo un registro (OF InsertRecord) la sentencia CLEAR(Telefono.Rec) limpia el buffer
de registro poniendo todos los campos en blanco o en cero. La sentencia TARGET{PROP:Text}
= ‘Agrega numero nuevo’ usa la sintaxis de propiedades en tiempo de ejecucion de Clarion
para cambiar dindmicamente la barra de titulo a “Agrega nimero nuevo”. La sintaxis de
propiedades permite cambiar dindmicamente cualquier propiedad (atributo) de una estructura
APPLICATION, WINDOW o REPORT en cddigo ejecutable. Vea Appendix C — Property
Assignaments en la Language Reference para mas sobre esto.

TARGET es una variable incorporada que siempre “apunta” a la estructura de WINDOW abierta.
Las llaves ({}) delimitan la propiedad misma, y PROP:Text es una equivalencia (contenida en
EQUATES.CLW) que identifica el parametro del elemento de datos (en este caso, la sentencia
WINDOW).

El codigo OF ChangeRecord que indica TARGET{PROP:Text} = ‘Modifica namero
telefonico de ‘ & CLIP(Telefono.Rec.Nombre) hace lo mismo, pero cambia la barra de
titulo para que muestre: “Modifica nimero telefénico de alguien”. El signo (&) es el operador de
concatenacion de cadenas alfanuméricas en Clarion, y el procedimiento CLIP
(Telefono.Rec.Nombre) remueve los espacios a la derecha del nombre. La estructura IF
Telefono:Rec:Numero[1] <> ‘+ verifica la presencia de un signo + como primer caracter del
campo de Numero. Este signo mas se usa aqui como una sefial de que se trata de un ndmero
internacional.

Advierta que el Telefono:Rec:Numero[1] apunta al primer byte del campo como si fuera una
matriz (array). Pero usted recordard que no habia atributo DIM en la declaracion (lo que hubiera
declarado un array). Todos los tipos de datos STRING, CSTRING, y PSTRING en Clarion
también son implicitamente una matriz de STRING(1),DIM(SIZE(StringField)). Esto significa que
puede referenciar directamente cualquier caracter individual de la cadena, sea que haya sido
declarada como una matriz, o no.



Si el ndmero no es internacional, la sentencia ?Telefono:Rec:Numero{PROP:Text} =
‘@P##H#-HHH-#HHHP utiliza el mismo tipo de sintaxis para cambiar la mascara de ingreso del
control. Advierta que PROP:Text se refiere a cualquiera sea el parametro del control. Por lo tanto,
en una WINDOW(‘texto del titulo’) se refiere al titulo, mientras que en ENTRY (@S20) se refiere
a la méscara (@S20).

El codigo OF DeleteRecord es similar al cédigo ChangeRecord. La sentencia
DISABLE(FIRSTFIELD(),LASTFIELD()), utiliza los procedimientos FIRSTFIELD() vy
LASTFIELD() para inhabilitar todos los controles en la ventana, y luego ENABLE(?OK,
?Cancel), habilita solamente los botones OK y Cancel.

La ROUTINE Setuplnsert se ejecuta justo antes de que el usuario vaya al control Numero
ENTRY. La sentencia IF Action = InsertRecord verifica el valor de Action y solamente ejecuta
la estructura CASE MESSAGE cuando el usuario esta afiadiendo un nuevo registro. El
procedimiento MESSAGE puede utilizarse para crear elecciones simples Si/No para los usuarios.
En este caso, se le pregunta si el nimero es internacional.

El cédigo OF BUTTON:Si se ejecuta cuando el usuario ha presionado el botén Yes de la caja de
didlogo MESSAGE. La sentencia TARGET{PROP:Text} = ‘Agrega numero internacional’
cambia el titulo de la barra de titulo, y luego ?Telefono:Rec:Numero{PROP:Text} = ‘@S20’
cambia la méscara de ingreso ENTRY. La sentencia Telefono:Rec:Numero[1] = ‘+’ coloca un
signo + en la posicién del primer caracter, luego lo muestra (DISPLAY) y SELECT(?,2) coloca
el punto de insercion del usuario en la segunda posicién del control actual.

El codigo OF BUTTON:No es similar cambiando el texto de la barra de titulo de la ventana, y la
mascara de ingreso del control.

Actualizacion del archivo de proyecto

Dado que hemos afiadido una estructura FILE al programa, debemos afiadir su controlador de
archivos (file driver) al proyecto, para que pueda ser “linkeado” al programa. Si no se hace, se
provocara un error similar a: “link error: TOPSPEED is unresolved in file Hola.obj”.

1. Elija Project » Edit...

Aparece la caja de didlogo Project.

Destaque Database Driver Libraries y oprima el boton ADD File...
Destaque TOPSPEED y luego oprima el botén OK.

Oprima el botén OK para cerrar la caja de dialogo Project.

a > WD

Dé cLic sobre el botén Run.

Se ejecuta el programa.
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Codigo POO generado por los templates ABC

Cuando examine el cédigo generado para usted por el Generador de Aplicaciones, observara
algunas diferencias fundamentales con respecto al cddigo que acabamos de escribir. Esto se debe a
que las plantillas utilizan la biblioteca de construccién de aplicaciones de alto nivel (Application
Builder Class [ABC] Library), que es un conjunto de clases de Programacion Orientada a Objetos
(POO).

El cédigo que acabamos de escribir es “procedural”, no POO. Ahora daremos una breve mirada al
cédigo POO generado para mostrar como lo que ha aprendido se vincula al cddigo que generan los
templates. Sera solamente un vistazo rapido, para destacar las diferencias principales.

Empezar una aplicacién con Quick Start

1. ElijaFile » New » Application.

2. Escriba Telefono en el campo File Name y marque el casillero Quick Start, y luego oprima
el boton Save.

3. Nombre el archivo Telefono, defina los campos Nombre y Numero ambos con mascara @S20,
e indique una clave Duplicate, y luego oprima el botén OK.

4. Elija Project » Generate para generar el codigo fuente.

Una mirada al programa fuente

Examinemos ahora el codigo fuente que se genero para usted.
1. Elijalalengiieta Module y destaque Telefono.clw
2. Dé cLic DERECHO Yy elija Module del men( contextual.

# Clarion 5 [Telefono.app] - [C:ACLARIONS\Languaje’T elefono. clw] HEE
D Fil=  Archive DataMaodeller Edit Search Project Setup Window Help _Iﬁ'lﬂ
G HSBE|ZCc%| v 0B 8 A

PROGRAM ﬂ

_ABCD11lHode_  EQUATE( @)
“ABCLinkHode  EQUATE(1)

INCLUDE( *ABERROR . INC *),0NCE
INCLUDE( *ABFILE.INC *),0NCE
INCLUDE( *ABUTIL .INC *),0NCE
INGLUDE( " ABWINDOW. [HC ") ,0NCE
INCLUDE( *EQUATES _CLY* ) ,0NCE
INCLUDE( *ERRORS .CLW" ) ,ONCE

INCLUDE( *KEVCODES .CLU" ) ,0NCE

HAP
MODULE( " TELEFBC.CLW")

DctInit PROCEDURE
DctKill PROCEDURE
EHD
?*--- Application Global and Exported Procedure Definitions
MODULE{ " TELEF881.CLY")
Hain PROCEDURE tClarion 5 Quick Application for C:\CLARIONS\LanguajeiyTelefono
EHD
END
Telefono FILE,DRIVER{ ' TOPSPEED' ) ,PRE{TEL),CREATE ,BINDABLE , THREAD
KeyNombre KEY({TEL :Hombre) ,DUP ,HOCASE
Record RECORD ,PRE( )
Nombre STRING{28)

Humero STRIHG{28)

END 7
I _'I_I

[ [Line: 1 |Cal: 1 [Insert [
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El Program Module

Este es el modulo PROGRAM (el cddigo deberia verse parecido a este, pero podria no ser
exactamente igual). La estructura basica de un programa Clarion POO es el mismo que utilizando
el lenguaje procedural. Las primeras dos sentencias son EQUATEs que definen valores constantes
que necesita la Biblioteca ABC. A continuacion hay varias sentencias INCLUDE. Estas le indican
al compilador que cologue el texto del archivo nombrado dentro del programa en el punto exacto
de la sentencia INCLUDE.

PROGRAM
_ABCD11Mode_ EQUATE(0)
_ABCLinkMode_ EQUATE(1)

INCLUDE(‘ABERROR.INC")
INCLUDE(‘ABFILE.INC")
INCLUDE(‘ABUTIL.INC)
INCLUDE(‘ABWINDOW.INC")
INCLUDE(‘EQUATES.CLW’)
INCLUDE('ERRORS.CLW’)
INCLUDE(‘KEYCODES.CLW’)

Los primeros cuatro archivos INCLUDE (todos empiezan con “AB” y terminan con “.INC”)
contienen definiciones CLASS para algunas de las clases de la biblioteca ABC. Los siguientes tres
archivos incluidos (todos con la extension “.CLW?™) contienen un nimero de sentencias EQUATE
utilizadas por los templates y la biblioteca.

MAP
MODULE(‘TELEFOCB.CLW’)
Dctlnit PROCEDURE
DctKill PROCEDURE
END
1--- Aplication Global and Exported Procedure Definitions -------------
MODULE
Main PROCEDURE ! Clarion 5 Quick Application
END
END

La estructura MAP contiene dos estructuras MODULE. La primera declara dos procedimientos
Dctlinit y DctKill que se definen en el archivo TELEFOCB.CLW. Estos dos procedimientos se
generan para inicializar y desinicializar correctamente los archivos de datos para su uso por la
biblioteca ABC. La segunda estructura MODULE simplemente nombra el primer procedimiento
que llamara la aplicacion (en este caso, Main).

Las siguientes dos lineas de cddigo son las primeras sentencias POO:

Access:Telefono &FileManager
Relate:Telefono &RelationManager



La sentencia Access:Telefono declara una referencia a un objeto del FileManager, mientras
que Relate:Telefono declara una referencia a un objeto del RelationManager. Esas dos
referencias son incializadas por el procedimiento Dctlnit, y desinicializadas por DctKill. Estas
sentencias son muy importantes, porque definen la manera en que usted debera dirigirse al archivo
en el cadigo POO.

Las siguientes dos lineas de cadigo declaran un objeto GlobalErrors y otro llamado INIMgr.

GlobalErrors ErrorClass
INIMgr INIClass

Estos objetos manejan todos los errores y el archivo .INI de su programa (si lo hay),
respectivamente. Estos objetos son usados extensamente por las demas clases de la biblioteca
ABC, de manera que deben estar presentes (como analizaremos muy pronto).

GlobalRequest BYTE(0),THREAD
GlobalResponse BYTE(0),THREAD
VCRRequest LONG(0),THREAD
Telefono FILE,DRIVER('TOSPEED’),PRE(TEL),CREATE,BINDABLE, THREAD
KeyNombre KEY(TEL:Nombre),DUP,NOCASE
Record RECORD,PRE()
Nombre STRING(20)
Numero STRING(20)
END
END

Siguiendo, hay tres declaraciones de variables globales que los templates ABC usan para
comunicar los procedimientos, seguidas por la declaracién Telefono FILE. Advierta que las
variables globales tienen todas el atributo THREAD. Este se requiere, dado que, por omisién, los
templates ABC generan una aplicacion MDI, lo que hace necesario tener copias separadas de las
variables globales para cada hilo de ejecucion activo (que es lo que hace el atributo THREAD).

La seccién global CODE tiene sdlo seis lineas:

CODE
GlobalErrors.Init
Dctlnit

Main

DctKill
GlobalErrors.Kill

Las primeras dos sentencias llaman a métodos Init (en la jerga de la POO, un procedimiento en
una clase es llamado “método™: consulte CLASS en la Language Reference y los dos articulos
sobre POO en la Programmer’s Guide). Estos son los métodos constructores para los objetos
GlobalErrors e INIMgr. Habra notado que este Gltimo método lleva un parametro. En la
biblioteca ABC, todos los métodos constructores de objetos son llamados explicitamente y
nombrados Init. Hay varias razones para esto. El lenguaje Clarion admite constructores (y
destructores) automaticos de objetos, y es perfectamente “legal” usarlos en cualquier clase que
usted escriba. Sin embargo, los constructores automaticos no pueden recibir parametros y muchos
de los métodos Init de la Biblioteca ABC deben recibir parametros. Debido a esto, y para mantener



la coherencia, todos los métodos constructores de objetos ABC son llamados explicitamente y
nombrados Init. Esta practica afiade el beneficio de una mayor legibilidad del cédigo, dado que
usted puede ver explicitamente que se estd ejecutando un constructor, mientras que con
constructores automaticos debe observar la declaracion CLASS para ver si hay uno para ejecutar o
no.

La llamada al procedimiento DctlInit inicializa las variables de referencia Access:Telefono y
Relate:Telefono, de manera que el cédigo generado por los templates (y cualquier cédigo que
usted inserte), puede referirse a los métodos de archivo de datos utilizando la sintaxis
Access:Telefono.Methodname o Relate: Telefono.Methodname. esto ofrece una forma
coherente de referenciar cualquier archivo en un programa generado por las plantillas ABC: cada
FILE tendra sus objetos Access: y Relate: correspondientes.

La llamada al procedimiento Main empieza la ejecucion del resto del programa. Una vez que el
usuario vuelve al procedimiento Main, DctKill y GlobalErrors.Kill efecttan las operaciones de
limpieza necesarias antes de regresar al sistema operativo.

El médulo UpdateTelefono

Examinemos ahora el cddigo fuente que fue generado en uno de los procedimientos.
Observaremos el procedimiento UpdateTelefono, que es representativo dado que todos los
procedimientos generados por las plantillas ABC seguiran basicamente el mismo patron
(advertimos de nuevo, el cédigo que usted encuentre sera similar a este, pero no necesariamente
igual)

1. ElijaFile » Close
2. Destaque UpdateTelefono, y dé cLIC DERECHO Y elija Module del menU contextual.

Lo primero que debe advertir es la sentencia MEMBER en la primera linea. Esta es una sentencia
requerida que indica al compilador a qué mddulo de programa “pertenece” este archivo fuente.
También sefiala el comienzo de una “Module Data Section”: un area del codigo fuente en que
pueden hacerse declaraciones de datos que son visibles a cualquier procedimiento en el mismo
modulo, pero no fuera de él (vea Data Declaration and Memory Allocation en la Language
Reference).

MEMBER(‘Telefono.clw’) IEste es un médulo miembro

INCLUDE(‘ABRESIZE.INC’)

INCLUDE(‘ABTOOLBA.INC")

INCLUDE(‘ABWINDOW.INC")

MAP

INCLUDE(‘TELEFO004.INC") IDeclaracion del procedimiento local del

mddulo

END

Los tres archivos INCLUDE contienen definiciones CLASS para algunas de las clases de la
biblioteca ABC. Adviértase que la lista de los archivos INCLUDE es distinta a la del nivel global.
Solamente es necesario incluir las definiciones de clase que el compilador precisa conocer para
compilar este codigo fuente Unicamente. Es por ello que la lista de archivos INCLUDE sea algo
diferente en cada modulo.

Advierta la estructura MAP. Por omision, los templates ABC general “local MAPS” que contienen
las sentencias INCLUDE para incluir los prototipos de los procedimientos definidos en el médulo
y cualesquiera otros llamados desde el médulo. Esto permite una compilacion mas eficiente, dado
que solamente se realizard una recompilacion global cuando cambie algin dato global, y no



meramente por afiadir un nuevo procedimiento a la aplicacion. En este caso, no hay otros
procedimientos llamados desde este médulo.

La sentencia PROCEDURE empieza el procedimiento UpdateTelefono (que también termina
la Module Data Section).

UpdateTelefono PROCEDURE IGenerado a partir del template — Window
CurrentTab String(80)

FilesOpened Byte

ActionMessage Cstring(40)

History::TEL:Record LIKE(TEL:RECORD),STATIC

A continuacién de la sentencia PROCEDURE hay cuatro declaraciones. Las primeras dos son
comunes a la mayor parte de los procedimientos generados. Proveen banderines locales usados
internamente por el codigo del template. Las declaraciones ActionMessage vy
History::TEL:Record son especificas de un procedimiento Form. Declaran un mensaje para el
usuario y un “area de guardado” para el uso de la tecla de historia del campo (Field History Key),
también llamada tecla “idem” ubicada en la barra de herramientas.

Después de la estructura WINDOW vienen las siguientes declaraciones de objetos:

ThisWindow CLASS(WindowManager)

Ask PROCEDURE(),VIRTUAL

Init PROCEDURE(),BYTE,PROC,VIRTUAL

Kill PROCEDURE(),BYTE,PROC,VIRTUAL
END

Toolbar ToolbarClass

ToolBarForn ToolbarUpdateClass

Resizer WindowResizeClass

Las tres Gltimas son simples declaraciones que crean los objetos locales que permitiran al usuario
utilizar la barra de herramientas y ajustar el tamafio de la ventana. Lo interesante aqui es la
declaracién ThisWindow CLASS. Esta estructura de CLASS declara un objeto derivado de la
clase WindowManager en la que los métodos Ask, Init, y Kill de la clase padre
(WindowManager) son “pasados por alto” localmente. Se trata de métodos VIRTUALEes lo que
significa que todos los métodos heredados de la clase WindowManager podran seguir llamando a
los métodos pasados por alto. Este es un concepto muy importante en la POO, que se trata mas
profundamente en las referencias a CLASS y OOP en Language Reference y Programmer’s Guide.

A continuacion viene el cédigo ejecutable de su procedimiento:

CODE
GlobalResponse = Thiswindow.Run()

Exactamente...juna Unica sentencia! jLa llamada a ThisWindow.Run es todo el cédigo ejecutable
del procedimiento! De esta manera que usted pregunta: “Pero, ;donde esta todo el cddigo que
realiza todas la funciones que veo ejecutarse cuando ejecuto el programa?” La respuesta es: ”jEn
la biblioteca ABC!”, o al menos, la mayor parte. Lo bueno es que todo el cédigo estandar para
operar cualquier procedimiento esta ya incorporado a la biblioteca, lo que disminuye notoriamente
el “peso” total del programa, dado que todos los procedimientos comparten el mismo conjunto de
cédigo comln que ha sido depurado (y que es improbable introduzca problema alguno a los
programas que usted genere).
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Toda la funcionalidad que especifica a este procedimiento se genera en los métodos “pasados por
alto”. En el caso de este procedimiento, hay solamente tres métodos que deben sufrir esa accién.
Segun sea la funcionalidad que usted solicita para el procedimiento, los templates ABC pasaran
por alto los métodos que haga falta. Usted también tiene puntos de insercién disponibles en cada
método que es posible “pasar por alto”, de manera que es facil forzar a los templates a “pasar por
alto” cualquier método que necesite funcionalidad algo diferente, simplemente afiadiendo su
propio cédigo en esos puntos de insercion (usando el Editor de puntos de insercion del Generador
de Aplicaciones).

Bien, veamos entonces los métodos “pasados por alto” en este procedimiento:
ThisWindow.Ask PROCEDURE

CODE
CASE SELF.Request
OF InsertRecord

ActionMessage = ‘Adding a Telefono Record’
OF Change Record

ActionMessage = ‘Changing a Telefono Record’
END
QuickWindow{Prop:Text} = ActionMessage
PARENT.Ask

La linea verdaderamente interesante de este procedimiento es la Gltima. PARENT.Ask Ilama al
método padre que ha sido “pasado por alto” por este mismo procedimiento, para que ejerza su
funcionalidad estandar. La palabra clave PARENT tiene mucho poder, ya que permite que un
método pasado por alto en una clase derivada llame al método que reemplaza para que haga su
trabajo, lo que permite al método pasado por alto incrementar la funcionalidad del método padre.

ThisWindow.Init PROCEDURE()

CODE

SELF.Request = GlobalRequest

IF PARENT.Init() THEN RETURN Level:Notify.
SELF.FirstField = ?TEL:Nombre:Prompt
SELF.VCRRequest &= VCRRequest

SELF.Errors &= GlobalErrors
CLEAR(GlobalRequest)

CLEAR(GlobalResponse)

SELF.AddItem(ToolBar)
SELF.AddUpdateFile(Access:Telefono)
SELF:HistoryKey = 734
SELF.AddHistoryFile(TEL:Record,History:: TEL:Record)
SELF.AddHistoryField(?TEL:Nombre, 1)
SELF.AddHistoryField(?TEL:Numero,2)
SELF.AddItem(?Cancel,RequestCancelled)
Relate:Telefono.Open

FilesOpened = True

SELF.Primary &= Relate:Telefono

SELF.OkControl = 20k

IF SELF.PrimeUpdate() THEN RETURN Level:Notify.
OPEN(QuickWindow)

OPEN(QuickWindow)

SELF.Opened = True
Resizer.Init(AppStrategy:Surface,Resize:SetMinSize)



SELF.AddItem(Resizer)
Resizer.AutoTransparent = True
ToolBarForm.HelpButton = ?Help
SELF.AddItem(ToolbarForm)
SELF.SetAlerts()

RETURN Level:Benign

Hay varias lineas interesantes en ThisWindow.Init PROCEDURE. Este es el método
constructor del objeto ThisWindow, de manera que todo el codigo que en él se incluye realiza las
tareas de inicializacion especificamente requeridas por el procedimiento UpdateTelefono.

La primera sentencia SELF.Request = GlobalRequest, recupera el valor de la variable global
y la coloca en la propiedad SEFT.Request. SELF es otra poderosa palabra clave de la POO en
Clarion, que siempre significa “el objeto actual”, o “yo”. SELF es el prefijo de objeto que permite
que los métodos de clase se escriban genéricamente para referirse a cualquier objeto, como
instancia de una clase, que se esta ejecutando.

La segunda sentencia llama al método PARENT.Init(() (el codigo del método padre para realizar
todas sus funciones estandar) antes de que se ejecute el resto del codigo de inicializacion
especifico del procedimiento. A continuacion hay una serie de sentencias que inicializan varias
propiedades necesarias. La sentencia Relate: Telefono.Open abre el archivo de datos Telefono
para su procesamiento, y si hubo archivos hijos relacionados necesarios para el procesamiento de
Integridad Referencia en este procedimiento, también los abriria (en este caso, no los hay).

Ademas de Ilamar al método PARENT .Kill() para realizar todas las funciones de cierre (como
cerrar la ventana), Thiswindow.Kill cierra todos los archivos abiertos en el procedimiento, y
configura la variable GlobalResponse.

Elija File » Close
Qué sigue después

Este cursillo ha sido solamente una breve introduccion al lenguaje de programacion Clarion vy al
codigo generado por los Templates ABC. Hay mucho més para aprender de lo que hemos cubierto
aqui, de manera que ...;ddnde continuar?

¢ Los articulos en la Programmer’s Guide. Estos cubren varios aspectos de la programacion en
este lenguaje. Aungque no son “cursillos”, proveen informacioén que tratan con profundidad
areas especificas, y hay varios que tratan especialmente la POO en Clarion.

¢ El Application Handbook documenta completamente la biblioteca ABC y los templates. Este
es el recurso fundamental para obtener lo méximo de la tecnologia del Generador de
Aplicaciones.

¢ La Language Reference es la “Biblia” del lenguaje Clarion. Siempre es buena idea leerlo por
completo.

+ Estudie el codigo fuente producido por el Generador de Aplicaciones. Después de haber hecho
este cursillo, la estructura basica del cédigo deberia resultarle familiar, aunque no la ldgica
especifica de determinadas secciones.



LECCION 13 CURSILLO SOBRE LENGUAJE CLARION 263

¢ La User’s Guide contiene cursillos sobre el uso de los Depuradores (Debuggers). Esto le
permitira ir paso a paso por el codigo Clarion a medida que se ejecuta para ver exactamente
qué efecto tiene cada sentencia en la ejecucién de un programa.

¢ Los usuarios registrados de la Argentina y paises de habla hispana tienen acceso a apoyo
técnico via Internet en la direccion http://www.unisoft.com.ar (o, también,
www.clarion.com.ar) Correo electrénico: soporte@unisoft.com.ar

& TopSpeed ofrece seminarios educativos en varias localidades. Llame a Servicio al cliente a los
numeros: (800) 354-5444 o (954) 785-4555 para informarse.

¢ En CompuServe escriba GO TOPSPEED para ingresar al foro de apoyo técnico de
TopSpeed,o, en Internet, ingrese al grupo de noticias comp.lang.clarion, mediante cualquier
servidor de Usenet (jiMuy recomendado!)

Muy buena suerte, y continde trabajando. Como ya dijimos: jel poder de programacion que
Clarion pone en sus manos va creciendo a medida que aprende mas sobre el!
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VOCABULARIO

Inglés Castellano

application builder class [ABC] library = biblioteca de construccion de aplicaciones de alto
nivel

application handbook = manual de aplicaciones

application wizard = asistente de aplicaciones

box = casillero (para poner tildes), caja

break = salto

browse = visualizacion de listados

buffer = area de almacenamiento temporal

business math library = biblioteca de funciones de matematica empresarial

conditional behavior = funcionamiento condicional

create = crear

default = por omision, preconfigurado

Dployment kit user’s guide = Guia para,el kit de instalacion

dialogue = caja de dialogo

Dictionary Editor = Editor del diccionario

drivers = controladores

edit-in-place = modificacion in situ

embed points = puntos de insercion

embedded code = codigo de insercién

enterprise tools = herramientas empresariales

entry box = casillero de ingreso de datos

equate = equivalencia

event-driven programming = programacion basada en eventos

field equate label = rotulo de campo equivalente

file =archivo

file schematic = arbol de archivos

finish = terminar, finalizar

forms = fichas

handle = asa, “manijita”

help = ayuda

help contents = contenido de la ayuda

incremental = progresivo

incrementally = progresivamente

initiate thread = iniciar hilo de ejecucion

keys = claves



label = rotulo; etiqueta

Languaje reference = referencia del lenguaje

List Box Formatter = Disefiador de Cajas de Listado

lookup = consulta (a un archivo relacionado)

map = mapa, mapeo, correlacién, correlacionar

master index = indice general

new = nuevo

next = siguiente

Objet Oriented Programming (OOP) = Programacién orientada a objetos (POO)

Page Form = pagina base (en informes)

page overflow = desbordamiento de pagina (en informes)

path = via o ruta de busqueda

picture format = formato de datos (P####P); patron de visualizacion y
archivo

picture token = mascara de ingreso (o visualizacion) de datos

popup menu = men0 contextual

print engine = motor de impresién (de informes)

procedure wizards = asistentes de procedimiento

progress window = ventana indicadora

quick load = (asistente de) “carga rapida”

quick start = (asistente de) “inicio rapido”

range limit = limite de alcance (limite de bdsqueda)

record filter = filtro de registros

record order = orden de los registros

report = informe

report formatter = disefiador de informes

reset on = reinicializarse sobre

run = ejecutar

save as type = guardar como ...

setup = instalacion, configuracion

tab = tabulador, tecla de tabulacion, lengiieta

utally = marcador

template = plantilla

thred = hilo de ejecucién

tip = acotacion (leyenda aclaratoria)

total type = tipo de total (suma, promedio, mas alto, mas bajo)

update = moadificacion, actualizacion

user’s guide = guia del usuario

Window Formatter = Disefiador de Ventanas

wizards = asistentes



Castellano

acotacién

arbol de archivos

archivo

asa

asistente de aplicaciones
asistentes

asistentes de procedimientos
ayuda

biblioteca de construccion de
aplicaciones de alto nivel

biblioteca de funciones de matematica
empresarial

caja

caja de dialogo

casillero

casillero o caja de ingreso de datos
claves

cddigo insertado
comprobaciones de validez
configuracion

consulta

contenido de la ayuda
controladores

crear

desbordamiento de pagina
Disefiador de informes
Disefiador de Ventanas
Editor del Diccionario
ejecutar

fichas

filtro de registros

formato (P####P) o “patrén de
visualizacion y archivo”

funcionamiento condicional
guardar como ...

Guia del programador

Guia del usuario

Guia para el kit de instalacion

herramientas empresariales

Inglés

=tip

= File Schematic

= file

= handle

= application wizard
= wizards

= procedure wizards

= help
= Application Builder Class [ABC] Library

= business math library
= box

= dialog, dialog box
= box

= entry box

= keys

= embedded code

= validity checks

= setup

= lookup

= help contents

= drivers

= create

page overflow

Report Formatter

Window Formatter
= Dictionary Editor
=run

= forms

= record filter

= picture format

= conditional behavior

= save as type

= Programmer’s Guide

= User’s Guide

= Deployment Kit User’s Guide

= enterprise tools



hilo de ejecucion

indice general

informe

iniciar hilo de ejecucién
instalacion

limite de alcance

limite de basqueda
manual de aplicaciones

marcador

mascara de ingreso (o visualizacion)

de datos
modificacion in situ
motor de impresion
nuevo

orden de los registros
pagina base

plantilla

programacion en base a eventos

Programacion orientada a objetos (POO) = Objet Oriented Programming (OOP)

puntos de insercién
referencia del lenguaje
rétulo

ruta (o via) de basqueda
salto

siguiente

terminar, finalizar
ventana indicadora
verificaciones de validez
via (o ruta) de busqueda

visualizador

= thread

= master index

= report

= initiate thread

= setup

= range limit

= range limit

= application handbook

= tally

= picture token, picture format
= edit-in-place

= print page

= new

= record order

= Page Form

= template

= event driven programming

= embed points

= language reference
= label

= path

= break

= next

= finish

= progress window
= validity cheks

= path

= browse



